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Centreon est un logiciel open source qui vous permet de superviser l’ensemble des éléments de votre système d’infor-
mations.

Comment gagner du temps avec Centreon IMP ?
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CHAPITRE 1

A propos

Centreon est une solution de supervision open source, édité par la société française Centreon.

Il s’agit d’une solution facile à mettre en œuvre, prête à l’emploi, qui inclut tout ce qui est nécessaire pour superviser
en temps-réel son Système d’Information :

— Un moteur de collecte de données universel
— Un catalogue de Plugin pour superviser la totalité du SI, depuis les couches applicatives jusqu’à tous les

éléments d’infrastructure sous-jacents
— Une interface web ergonomique, multi-utilisateurs
— Une gestion fine des droits utilisateurs basée sur des listes de contrôle d’accès (ACL)
— Une gestion complète des alertes et des notifications
— Des tableaux de bord temps réel, adaptables aux besoins de chacun
— Des rapports de disponibilité

La solution open source Centreon est au coeur de la suite logicielle Centreon EMS, laquelle ajoute les modules com-
plémentaires suivant :

— EPP, pour faciliter la configuration de la supervision
— MAP, pour créer des vues graphiques interactives temps réel
— BAM, pour corréler les éléments clé du SI avec les applications métier qui en dépendent
— MBI, pour créer des rapports aux normes ITIL qui facilitent la gestion de l’infrastructure

D’autres modules issus de la communauté open-source sont disponibles pour en étendre ses fonctionnalités.

Solution mature et fiable, Centreon propose plusieurs architectures de déploiement pour répondre aux besoins d’aug-
mentation du périmètre de supervision, de collecte de données sur un réseau fortement distribué, de redondance et de
résilience.

Enfin, la solution Centreon dispose de tous les outils facilitant son intégration au cœur des environnements de produc-
tion IT :

— Un jeu complet d’API pour automatiser la configuration de la supervision depuis des outils comme Salt, An-
sible, Puppet, Chef. . .

— Des connecteurs pré-intégrés vers les solutions ITSM les plus populaires comme ServiceNow, GLPI, Easyvista,
iTop, OTRS. . .

— Des connecteurs spécialisés vers des entrepôts de données comme Graphite ou InfluxDB, des solutions d’ana-
lyse de logs comme Elasticsearch ou Splunk ou vers des hyperviseurs comme BMC Truesight ou ServiceNow
Event Management...

3
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CHAPITRE 2

Notes de version

Vous trouverez dans ce chapitre toutes les notes de montée de version vous permettant de connaître la liste des chan-
gements intégrés dans chaque version de Centreon Web.

Voici les différentes notes de versions pour les versions majeures :

2.1 Centreon 18.10

Please find here the release notes dedicated to the last 18.10.x version of Centreon.

2.1.1 Centreon Web 18.10.3

Enhancements

Bug Fixes

2.1.2 Centreon Web 18.10.2

Enhancements

— [Configuration] Prevent time period to call itself via templates - PR #7024
— [Configuration] Re-add the PID column in the poller list page - PR #6993
— [Documentation] Add clean yum cache command for 18.10 upgrade - PR #7030
— [Documentation] Correct typo in RS architecture FR chapter - PR #6965
— [Downtimes] Apply ACL on resources to configure recurring downtimes - PR #6962
— [Translate] Add all date picker libraries for new translation - PR #7040
— [UX] Improve full screen mode - PR #6976

Bug fixes

— [Chart] Fix graph export when a curve is only displayed in legend - PR #7009
— [Documentation] Describe DBMS minimal version to prevent partitioning tables issue - PR #6974
— [Monitoring] Use all selected filter on refresh with “play” button - PR #6984
— [Extensions] Fix module upgrades using php scripts - PR #7073
— [Remote Server] Update default path of broker watchdog logs

5



Technical

— Update select2 component - PR #7034

2.1.3 Centreon Web 18.10.1

Enhancements

— [Install] Optimize db partitioning during fresh install - PR #6937
— [Documentation] Improve FAQ chapter - PR #6900
— [Documentation] Improve prerequisites chapter - PR #6922
— [Documentation] Improve installation chapter - PR #6942 #6973
— [Documentation] Improve architecture chapter - PR #6966
— [Documentation] Add chapter to manage custom centreon uri - PR #6903
— [Documentation] Improve upgrade chapter - PR #6905 #6907 #6908
— [Documentation] Global documentation improvement - PR #6896 #6906 #6931 #6933

Bug fixes

— [API] Fix PHP warning - PR #6917
— [API] Fix export of hostgroup services - PR #6948
— [Configuration] Fix host categories creation and update form - PR #6901
— [Configuration] Remove old wizard button - PR #6902
— [Configuration] Fix export of cbd watchdog logs path - PR #6919
— [Configuration/Widget] Fix widget upgrade if directory has changed - PR #6975
— [Remote Server] Fix incorrect variable name - PR #6915]
— [Translation] Update strings - PR #6899
— [Global] Remove duplicate() method in children classes - PR #6918
— [Global] Update topology extract where clause from db - PR #6898

Security fixes

2.1.4 Centreon Web 18.10.0

New features

Centreon Remote Server is a new building-block in the Centreon distributed monitoring architecture. It comes in
addition to the existing Centreon Central Server and Centreon Pollers.

Centreon Remote Server allows remote IT operations team to benefit from the full Centreon user experience, albeit
on a subset of Centreon Pollers. Monitoring configuration takes place on the Central Server and is automatically
synchronized with all Remote Servers. Monitoring Operations (Acknowledge, Downtime...) may take place both on a
Remote Server or the Central Server.

In case of network link failure between a Remote Server and the Central Server, data retention takes place and the two
Servers are synchronized as soon as the connection is up again.

Centreon Remote Server is integrated in Centreon Core. It fully replaces the Poller Display module.
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UI & UX Design

— Add new banner system and UX
— Add new menus system and UX
— Unique format of dates displayed according to user language settings
— Thanks to the community, Centreon is now available in Spanish and Portuguese (Portugal & Brazil)

Notice : The “Home > Poller Statistics” menu moved to “Administration > Server Status”. Moreover, this one is now
named “Platform Status”.

Enhancements

— [Stats] Add a Centreon Experience Improvement Program
— [API] Possibility to cancel flexible RTDOWNTIME - #6062
— [Install] Add possibility to install/update all modules in one time
— [Configuration] Add a new wizard to configure in one time a complete poller or Remote Server
— [Configuration] Add possibility to install/update all modules in one time
— [Configuration] Add possibility to install/update all widgets in one time
— [LDAP] Manage multiple LDAP group with same dn - PR #6714
— [LDAP] If user account is disabled in AD, user will be still able to connect in Centreon - #6240
— [LDAP] Update LDAP Attributes on authentication - #3402
— [LDAP] Problem with LDAP contact groups with name members with accent - #5368
— [LDAP] Improve group synchronization - #6203 #6239 #6241
— [Packages] New centreon-database package, helpful for standalone Centreon databases ;

Bug fixes

— [Install] Fix several PHP notices
— [Backup] Fix PHP paths in backup script - PR #6787
— [Chart] Fix graph search with ACL in performances page - PR #6798
— [Configuration] Meta Service using quotes in output format string - PR #6216
— [Configuration] Fix duplicate advanced matching SNMP traps rules - PR #6738
— [Configuration] Avoid duplicate entry in ACL table after host creation - PR #6810
— [Configuration] Fix host categories form - PR #6785
— [Configuration] fix regexp for trap argument ending by backslash - PR #6699
— [Downtime] Add a downtime for user linked to ACL - PR #5988
— [Downtime] Fix recurrent downtime form (period loading) - PR #6645
— [Monitoring] Display cancel button in comments page using ACL rights - PR #6857
— [Monitoring] Display cancel button in downtimes page using ACL rights - PR #6856
— [Monitoring] Persist search filters - #5109 #6161
— [Monitoring] Persist selected results limit & pagination - #6325 #6161 #6367
— [Monitoring] Invalid accentuated chars transcription in timeperiod exception models - #6359
— [Monitoring] Add missing style for button in service acknowledge form - PR #6805
— [Monitoring] Host number calculation with ACL is not correct in HG summary - PR #6855
— [Monitoring] Fix service by servicegroup page when using ACL #6863
— [Notification] Exclude services started by BA from BAM UI notification style - PR #6782

Security fixes

— [ACL] Fix XSS issue on the ACL list page - PR #6634
— [Administration] Fix XSS issue - PR #6635
— [Administration] Fix XSS security - PR #6633

2.1. Centreon 18.10
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— [Configuration : Adding security filters on the host list page - PR #6625
— [Configuration] Fix XSS security issue on adding poller macros - PR #6626
— [Downtime/comments] Fix XSS issue for host, service & downtime comments - PR #6637
— [General] Create new escape method to fix XSS issue (commit 5820a04)
— [General] Fix XSS issue - PR #6636
— [Monitoring] Fix XSS security issue - PR #6632
— [SNNP trap] Fix SQL injection on editing trap SNMP - PR #6627
— [Virtual metric] Fix SQL injection - PR #6628
— [ACL access groups] Fix XSS vulnerability - PR #6710

Technical architecture changes

— Upgrade from PHP 5.x to PHP 7.x compatibility (7.1/7.2)
— Upgrade jQuery libraries
— Add ReactJS technology for new interfaces
— Prevent memory leaks - #4764
— Upgrade from DB.php connector to PDO

Known bugs or issues

— Meta-services management with ACL (add/duplicate)
— Centreon AWIE issues when trying to export large configuration
— Got bogus version XX in httpd error logs #6851

2.2 Centreon 2.8

Please find here the release notes dedicated to the last 2.8.x version of Centreon.

2.2.1 Centreon Web 2.8.1

Released November 14th, 2016

The 2.8.1 release for Centreon Web is now available for download. Here are its release notes.

Changes

— New theme for Centreon web installation and update ;
— Add REST exposure for Centreon API, Centreon CLAPI still available ;
— Integration of Centreon Backup module in Centreon ;
— Integration of Centreon Knowledge Base module in Centreon ;
— Integration of Centreon Partitioning module in Centreon ;
— New design to display charts using C3JS.
— New filters available to select display charts
— Possibility to display charts on 1, 2 or 3 columns ;
— Apply zoom on one chart apply zoom for all displayed charts ;
— Merge of meta-services and services real-time monitoring display ;
— Strict inheritance of contacts and contacts groups from hosts on services notification parameters. Contacts and

groups of contacts from services definition will be erased during generation of configuration by settings from
host ;
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Features

— New servicegroups filters in real-time monitoring ;
— New display of chart in pop-up of services in real-time monitoring and status details
— Add poller name in pop-up of hosts in real-time monitoring ;
— Add monitoring command line with macros type password hidden (via ACL) in service status details ;
— Integration of poller’s name in “Monitoring > System Logs” page ;
— Integration of ACL action on poller for generation and export of configuration ;
— Add new notification settings to not send recovery notification if status of host or service came back quickly to

non-ok (issue for SNMP traps for example) ;
— Add geo-coordinates settings on hosts, services and groups. Used by Centreon Map product ;
— Possibility to define a command on multi-lines ;
— Add Centreon Broker graphite and InfluxDB export ;
— Add possibility for all Centreon web users to select their home page after connection ;
— Add possibility to define downtimes on hostgroups, servicegroups and multi-hosts ;
— Add an acknowledge expiration time on host and service ;
— Better ergonomy on selectbox for Mac OS and MS Windows users ;
— Add possibility to set downtimes on Centreon Poller display module ;
— Add possibility to reduce Centreon Broker input/output configuration ;
— Optimization of SQL table for logs access ;
— Add timezone on host’s template definition ;

Security Fixes

— #4668 : Autologin with invalid token for imported users with null password ;
— #4458 : User can create admin account

Bug Fixes

— #4703 : Macros are always listed on command line descriptions ;
— #4694 : Don’t display notification in pop-up for acknowledged or downtimes objects ;
— #4585, #4584, #4590 : Correction of CSV export in “Monitoring > Event Logs”, “Dashboard > Hostgroups”

and “Dashboard > Servicegroups” pages. Correction of XML error in “Dashboard > Hostgroups” and “Dash-
board > Servicegroups” pages ;

— #4617, #4609 : Complete contextual help in hosts and services forms ;
— #4147 : Fix ACL to add widget

Removed Features

— No possibility to split charts ;
— No possibility to display multi-period on one chart (Day, Week, Month, Year) ;

Known bugs or issues

— This release is not yet compatible with other commercial products from Centreon, like Centreon MBI, Centreon
BAM or Centreon Map. If your are using any of these products, you are strongly advised NOT to update
Centreon Web until new releases of the forementioned products are available and specifically mention Centreon
Web 2.8 compatibility ;

— Centreon Engine performance chart still in RRDTools PNG format ;
— Zoom out on chart change period on filters ;
— User with ACL can’t see it own previously created meta service ;
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— Problem with recurrent downtimes and DST ;
— Issues on SSO Authentication

2.2.2 Centreon Web 2.8.2

Released December 8th, 2016.

The 2.8.2 release for Centreon Web is now available for download. Here are its release notes.

Features

— #4779 : Centreon Web supports proxy configuration for use with its modules requiring external web access.
This notably concerns Centreon Plugin Pack Manager (component of the Centreon IMP offer).

Bug Fixes

— #4791 : Can’t delete host command on host/host template form ;
— #4773 : Centreon Clapi call and empty line at beginning ;
— #4752 : Options missing in notification tab ;
— #4728 : Avoid http warnings on first connection with ldap auto import ;

Known bugs or issues

— Centreon Engine performance chart still in RRDTools PNG format ;
— Zoom out on chart change period on filters ;
— User with ACL can’t see it own previously created meta service ;
— Problem with recurrent downtimes and DST ;

2.2.3 Centreon Web 2.8.3

Released January 11th, 2017.

The 2.8.3 release for Centreon Web is now available for download. Here are its release notes.

Features

— #4807 : clean generation page ;

Bug Fixes

— #4843 : SQL error in meta-service output ;
— #4775 : disabled service are displayed in graph page ;
— #4729 : command arguments are not displayed ;
— #4690 : make timeperiod exceptions work ;
— #4572 : poller duplication does not duplicate all fields ;
— #4838 : geo coord help menu not working on hostgroup page ;
— #4827 : remove old centreon-partitioning script ;
— #4826 : use correct configuration file when reloading centreontrapd ;
— #4809 : error during link between contact and LDAP contact group ;
— #4746 : fix login when SSO header is empty ;
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Known bugs or issues

— Centreon Engine performance chart still in RRDTools PNG format ;
— Zoom out on chart change period on filters ;
— User with ACL can’t see it own previously created meta service ;
— Problem with recurrent downtimes and DST ;

2.2.4 Centreon Web 2.8.4

Released February 8th, 2017.

The 2.8.4 release for Centreon Web is now available for download. Here are its release notes.

Features

No feature.

Bug Fixes

— Fix problem with the upgrade process - all Centreon systems coming from 2.7.x have a database problem -
column timezone was missing in the table $STORAGE$.hosts ; –> this problem prevents centreon-broker from
starting

Known bugs or issues

— Centreon Engine performance chart still in RRDTools PNG format ;
— Zoom out on chart change period on filters ;
— User with ACL can’t see it own previously created meta service ;
— Problem with recurrent downtimes and DST ;

2.2.5 Centreon Web 2.8.5

Released March 29th, 2017.

The 2.8.5 release for Centreon Web is now available for download. Here are its release notes.

Features

API

— Possibility to create an account to reach API without web access - #4980, PR #4992

Monitoring

— Better display in service detail with long output or long command - #4974, #4975, PR #5002
— Recurrent downtimes, extend specific period settings to select 2nd, 2td or 5th o month - #4207, #4908
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Charts

— Add split function in chart - #4803, #4990
— Add button to display curve legend (min/max/average) - #4595
— Add button to display multiple periods view - #4884
— Extend chart legend and add more information on helps - PR #5006
— Extend help for stacking and transparency - #4884

Ergonomics

— Add new Centreon style for some buttons - PR #5060, PR #5061, PR #5062, PR #5067, PR #5068
— Add possibility to copy-paste executed command ligne from service details page - PR #5065

Bug Fixes

ACL

— Incorrect redirection to error page with ACL - #4932
— Dashboard not works when using filter #4886, PR #5023
— Blank page on “Monitoring > Status Details > Hosts” with acl - #4960

Authentication

— Only logout are logged - #4924, PR #5004
— Autologin with any token - #4668
— generateImage.php problem with akey (auto-login) - ##4920, PR #4865

Monitoring

— “Executed Check Command Line” is wrong for services associated to hostgroups - #4955, PR #5037
— Poller delete stay on Poller list in Monitoring Tab - #5026, PR #5027
— Acknowledge - duplicate comments with external command on host monitoring page - #4862, PR #5015
— Do not display services downtimes (remove filter “h”) - #4918, #4947, #5000, PR #5001
— Column ‘sg_id’ in field list is ambiguous - #4938
— Remove ‘s’ in service popin for duration - PR 5051
— Select servicegroup does not work - #4907, #4885
— Escaping problem in executed command - #4976, PR #4985, PR #4999
— Fix problem on graph when user ask to display graphs of a hosts - PR #4991
— Cannot Export Event Log to CSV - #4943
— View logs for service does not work - #4958
— Centreontrapd and exec code - PR #5054

Graphs

— Curves colour on New graph is not equal to old graph - #5033
— Wrong host title in Graph - #4964 #4984
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Dashboard

— Incorrect CSS for reporting of a service - #4934, PR #5009

Configuration

— Exploit correlation with Centreon BAM - PR #5049
— Disable notification sounds not working - #4988, PR #4973
— Add user name in the generated configuration files - #4822
— Duplicate Poller and illegal characters - #4931, PR #4986, #4987
— Can view first help icon in Centreon Broker configuration - #4944, PR #5003
— Describe arguements does not work with % character in command line - #4930
— Generate and export SNMP traps - #4972, #4978
— Host marco did not save on host edit - #4951
— Do not check modification on disabled pollers - #4945

Custom view

— Rewrite system to share public views - PR #4823
— Rewrite system to share locked views to contacts or contactgroups
— Rewrite system to share non-locked views to contacts or contactgroups
— When user access to custom views menu, edition mode is disabled - #5008, PR #4811
— Listing of widget with infinite scroll displays at least 3 times each widget - #4892
— “Set Default” button not working - #5079

Documentation

— Improve installation chapters - #4970, PR #4967
— open_files_limit error during installation - #5017, #5038
— Menu “Legend” doesn’t exist in Centreon 2.8.x - PR #4968, PR #4969
— Update product lifecycle - PR 5044
— Correct contact creation example - PR #5035, - PR #5036

API

— Rename TIMEPERIOD object to TP - PR #4913, PR #4914
— CLAPI doesn’t work when Centreon BAM is installed - #4921, PR #5049, PR 5005
— DowntimeManager - do not remove downtimes not linked to objects to allows configuration with API - #5057

Backup

— Backup export does not work - #4726, PR #5019
— Backup won’t work without old deprecated variables - #4965, #PR #5007

Installation

— SQL script error for upgrade from 2.6.6 to 2.7.0RC1 - #5064, PR #5066
— Using sources, error with CentPlugins Trap on install - PR #4963
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Known bugs or issues

— Centreon Engine performance chart still in RRDTools PNG format ;
— Zoom out on chart change period on filters ;
— User with ACL can’t see it own previously created meta service ;
— Problem with recurrent downtimes and DST ;
— Issue with international keyboard and chrome when use accented characters ;

2.2.6 Centreon Web 2.8.6

Bug Fixes

KB

— Downtimes - Display real BA name instead of _Module_ - #5014, PR #5094
— InfluxDB broker output config : metric columns not stored properly - #5058, PR #5089
— Poller status still working when the poller is disabled - #5126
— Filter on the status host/service on the motiroring isn’t working #5131, #5140
— Fix acl on host categories for inheritance
— Avoid infinite loop in acl category
— Fix error message in install process
— Fix path to centengine and cbd init scripts
— Fix topcounter must count all meta services - #5071, PR #5100
— Fix access downtime page for users with ACL - #4952, #5025, PR #5093
— Centreon > Services - Services listed twice - #5158, PR #5010
— Custom views - problem with multiselect users when sharing View - #5029, PR #5074
— Massive change - impossible to add servive group - #5132
— Fix URL decode probelm with character ‘+’ in object’s name - #5128, PR #4883
— Fix CLAPI import
— Poller status still working when the poller is disabled - #5126, PR #5133

Enhancements

— Display inherited categories in host details page
— Do not check modification of configuration on disabled poller for better performance - PR #4928
— Improve access to services configuration page - PR #5077, PR #5076
— Improve global performance - PR #4900
— Improve Knowledge Base configuration
— Fix wiki links of objects with spaces in their name - #4306
— Improve documentation
— Set geo_coords parameter with clapi

If you already used a knowledge base, please execute following script :

php /usr/share/centreon/bin/migrateWikiPages.php

Known bugs or issues

— There’s an issue in the ldap configuration form. A fix is available and will be package with the next bugfix
version. Until then you can apply the patch available here

— There’s an issue on all listing pages. A fix is available and will be package with the next bugfix version. Until
then you can apply the available patch
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2.2.7 Centreon Web 2.8.7

Bug Fixes

— Fix various security issues
— Fix ldap configuration form
— Fix downtime popup in listing pages
— Fix object listing pages which are empty after some actions

2.2.8 Centreon Web 2.8.8

Bug Fixes

— Fix Centreon Engine configuration form
— Fix custom view sharing
— Fix Knowledge Base script compatibility with PHP < 5.4

2.2.9 Centreon Web 2.8.9

Bug Fixes

— Fix Incorrect style for “Scheduled downtime” in dashboard - #5240
— Apply new Centreon graphical charter to add and modify pages for metaservice indicator - #5255
— [2.8.6] : Double quote are converted in html entities in fields Args - #5205
— Duplicate host template doesn’t work - #5252
— [BUG] “Home > Poller Statistics > Graphs” only works for Central - #4954
— “Recovery notification delay” is not written to centreon-engine’s configuration - #5249 - PR #5268
— Severity of ‘host category’ - #5245
— [2.8.8] Deploy Service action won’t work - #5215
— [2.8.8] Issue when adding new connector - #5233
— [2.8.8] Data pagination - #5259
— Cannot modify metaservice indicator - #5254 - PR #5267
— [2.7.11] Migration 2.7.11 to 2.8.x does not work #5265
— 2.7 to 2.8 upgrade error - #5220
— Cannot insert numbers in service description field - #5275
— [2.8.7] - Timezone / Location BUG ! ! - #5218
— 2.8.8 Service Trap Relation empty - #5223
— [2.7.x/2.8.X] Old school style in popup - #5232
— [BUG] ACL - Servicegroup - #5101 - PR #5222
— [2.8.7] Missing argument 1 for PEAR : :isError() - #5214 - PR #5225
— [Reporting > Dashboard > Services] Unable to export CSV - #5170 - PR #5172

Graphs

— Graph are not correctly scaled - #5248
— [Chart] scale in charts using CPU template is wrong Kind/Bug Status/Implemented - #5130
— Graph scale values not working - #4815
— [2.8.5] Charts upper limit different from template - #5123
— Remove chart padding - #5288
— Base Graph 1000/1024 Kind/Bug Status/Implemented - #5069
— [2.8.6] non-admin user split chart permission - #5177
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— After using split chart, curves are not displayed anymore (period filter not applied) - #5198 - PR #5171
— [GRAPH] Problem with external graph usage (Widgets, Centreon BAM) - #5270
— Incorrect scale and position for rta curve (performance ping graph) - #5202
— Wrong tool tip display on chart with two units when one of the curves is disabled - #5203
— Splited chart png export misnamed doesn’t work with HTTPS - #5121 - PR #5171
— [2.8.5] Splited chart png export misnamed - #5120
— [Chart] curves units are displayed on incorrect side - #5113
— Assign good unit and curves to y axis when 2 axis - #5150
— remove curves artifacts - #5153
— Beta 2.8 Curve with an weird shape. - #4644
— The round of the curves - #5143
— The extra legend is option in chart. - #5156
— Add option for display or not the toggle all curves in views charts - #5159
— Use the base from graph template for humanreable ticks - #5149

2.2.10 Centreon Web 2.8.10

Enhancements

— Proposal break Ajax #5256
— Do not export empty Centreon Broker parameters with API #5284
— Remove duplicate $_GET[”autologin”] in test #5344
— Documentation improvement #5063
— Update engine reserved macros ($HOSTID$, $SERVICEID$, $HOSTTIMEZONE$) #5246
— Config generation is too long #5388
— Rename Centreon Broker Daemon option #5276

Bugfix

— Failure with special character in password for mysqldump #5173
— Unable to select all services in escalation form #5326 #PR5325
— Contacts/contactgroups inheritance #5396 PR #5400
— Check if wiki is configured and extend error message #5278 PR #5269
— Select All don’t work on service categories PR #5389
— Autologin + fullscreen options #5338 PR #5338
— Directory “/var/spool/centreon” not created by Centreon-common.rpm #5405
— “Fill in” option in graph doesn’t work with “VDEF” DEF type #5354
— Delete SNMP Traps #5282
— Can’t duplicate trap definition #5272 PR #5280
— Virtual Metric problems with French language package #5355
— Impossible to set manually a service to a meta service for non admin users #5358 PR #5391
— Graph period displayed does not match selected zoom period #5334
— Host configuration can not be saved or modified #5348

2.2.11 Centreon Web 2.8.11

Enhancements

— Fix typos in Enabled/Disabled filters PR #5251
— Do not list meta services in list of service to add to a SNMP trap #5418 PR #5419
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Bugfix

— Knowledgebase - Delete wiki page not functional #5059
— Massive Change don’t modify the Recovery notification delay of a host #5451
— Impossible to acknowledge several object from custom views #5420
— Load custom views - fixed database entry duplication PR #5260
— Adding SNMP traps definition : values set to fields in Relations tab are not saved #5406 PR #5415 PR #5417
— SNMP Trap, not all parameters are saved on creation #5361 PR #5415 PR #5417
— Page “Services by Servicegroup > Diplay > Summary” not working #5399 PR #5416
— [CLAPI] Duplicate CMD in export #5455
— [CLAPI] Fatal error with PDOException #5453 PR #5462

2.2.12 Centreon Web 2.8.12

Enhancements

— [API] Update documentation to remove non available functions
— [API] Export/Import LDAP configuration
— [API] Export/Import ACL Groups
— [API] Export/Import ACL Menus
— [API] Export/Import ACL Actions
— [API] Export/Import ACL Ressources
— [API] Replacing contact_name by contact_alias PR #5546
— [Configuration] Input text not aligned in Curves page #5534 PR #5553
— [Monitoring] Monitoring Services by Hostgroup : improvement order suggestion #5402 PR #5552
— [Monitoring] Increase perfs on EventLogs for non admin user PR #5480
— [Knowledge Base] Display API errors #5502
— [Knowledge Base] Refresh page after deletion #5503
— [Backup] Get correct datadir with CentOS7/MariaDB PR #5484

Bugfix

— [ACL] Bug on Access Groups #5189
— [ACL] The ACL of a contact and of a contact group is deleted during duplication #5497
— [API] CLAPI Import not working #5541
— [API] CLAPI export with select filter give PHP Warning and non result #5548
— [API] Missing functions setseverity and unsetseverity for services by hostgroup #5262
— [API] Problem with icon_image and map_icon_image of Hostgroup #5292
— [API] Missing function setservice for Service categories #5304
— [API] Problem with setting gmt in API #5291
— [API] Contact group additive inheritance isn’t implemented #5311
— [API] Contact additive inheritance isn’t implemented #5310
— [API] Problem with delmacro for services by hostgroup #5309
— [API] Several bugs on HG / CG when export is filtered #5297 PR #5297
— [Monitoring] Sorting by duration and Maximum page size change #5287 #5410 PR #5517
— [Configuration] Dependent host deleted during a service dependency duplication #5531
— [Configuration] All pollers had “config changed” #5549
— [Configuration] Unable to change the severity of an host template #5472
— [Configuration] Unable to change the severity of a service template #5559
— [Configuration] Meta service - unable to change the geo_coordinates #5493 PR #5505
— [Configuration] Meta service - unable to add more than one contact #5506 PR #5507
— [Configuration] Meta service - Implied contact is deleted during duplication #5495 PR #5508
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— [Configuration] Problem with escalation’s name during a duplication #5512 PR #5513
— [Configuration] Duplicate severity should remove link to objects #5478 PR #5509
— [Configuration] Fix search in trap select2
— [Configuration] Fix search in service template select2

2.2.13 Centreon Web 2.8.13

Enhancements

— [Doc] Improve centreon documentation #5611 PR #5612
— [Doc] clarify documentation of centreon clapi authentication #5625 PR #5628
— [Performance] Correct svc top counter with meta and merge SQL requests PR #5616

Bugfix

— [Top Counter] Metaservices not counted properly in statuses filter #5458 PR #5616
— [Configuration] Properly export interval length in storage endpoints #5461
— [Documentation] Time Range exceptions invalid format #5578
— [Chart] No graphics with backslash #5554 #5342 PR #5565
— [LDAP] Problem with LDAP autoimport and groupmapping with comma in CN #4867
— [Monitoring] No inheritance in query of notified contacts (Monitoring view) #4981

2.2.14 Centreon Web 2.8.14

Enhancements

— [API] Update CLAPI commands to show resources of a downtime PR #5705
— [API] Add possibility to grant access to children menu (or not) PR #5694
— [API] Add possibility to add and get list of on-demand downtime #5192 #5682 PR #5623 - beta
— [API] Add possibility to get realtime hosts status #5682 - beta
— [API] Add possibility to get realtime services status #5682 - beta
— [Documentation] Activate services at system startup PR #5698
— [Administration] Add possibility to test proxy configuration #5561 PR #5722

Bugfix

— [API] Fix list of hosts with gethosts method of Instance object #5300 PR #5603
— [Install] Add unique key on comments table PR #5665
— [Custom Views] Sharing View problem to select multiple users #5029
— [Configuration] Multiple ‘update mode’ fields in massive changes #5266 PR #5636
— [configuration] Massive Change on Hosts activate Stalking Option Up #4946
— [Reporting] Reporting Dashboard messed up #5491 #5520
— [Monitoring] No inheritance in query of notified contacts #4981
— [Monitoring] Top counter display too much resources with ACL #5713 PR #5703
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2.2.15 Centreon Web 2.8.15

Important notice

This version include a fix for the calculation of downtimes with daylight saving time (DST). The downtime end will
be calculate with the new hour.

For example, if you put a downtime from 1 AM to 5 AM, the duration of the downtime will be 5 hours if during the
DST you get 1 hour more (3 AM come back to 2 AM).

Enhancements

— [Documentation] Improve api documentation (url) #5792
— [Downtimes] Manage downtimes with dst (recurrent and realtime) #5780

Bugfix

— [Install] Fix foreign key upgrade of traps_group table PR #5752
— [CLAPI] Fix duplicate ldap serverPR #5769
— [CLAPI] Fix duplicate htpl in stpl #5774
— [CLAPI] Fix duplicate on stpl #5775
— [Chart] Add unit on y axis
— [Chart] Fix extra legend on period change
— [Chart] Fix export with empty metric
— [Configuration] Add obsess_over_hosts parameter in main centengine configuration PR #5746
— [Monitoring] Ranking of ascending / descending guests NOK #5695 PR #5744
— [Monitoring] fix variable name in centreontrapd.pm

2.2.16 Centreon Web 2.8.16

Enhancements

— [Administration] Improve ‘Server Status’ page PR #5820
— [API] Add exceptions for realtime PR #5735 #5795
— [Configuration] Broker remove non existing protocol #5830 PR #5832
— [Configuration] Check illegal charaters one time only PR #5831
— [Documentation] Wrong translation in documentation #5858 PR #5862
— [Documentation] Improve installation documentation #5825 PR #5844
— [Documentation] Improve Time Period documentation #5828 #5637 PR #5845 #5843
— [Documentation] Improve API realtime downtimes examples

Bugfix

— [Install] Properly place update to 2.8 from 2.7. #5809
— [ACL] centAcl cron LDAP sync removes all ContactGroups on unexpected error #5547
— [API] Parent/Child relation are not exported with CLAPI #5605 PR #5857
— [API] Authorize id 0 for object PR #5812
— [Chart] Add legend name when defined PR #5817
— [Configuration] Improve host/service macro visibility
— [Configuration] add massive change contact/cg update mode for host form #5878
— [Knowledge Base] Search function non functionnal for templates of services #5762 PR #5829
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— [Knowledge Base] Increase page limit for mediawiki migration PR #5798
— [Monitoring] Custom MACRO not interpreted in URL #5846 PR #5850
— [Monitoring] Display 0 in top counter if SQL result is empty #5758 PR #5826
— [Security] Some field was not encoded PR #5847

2.2.17 Centreon Web 2.8.17

Enhancements

— [API] Add Host getparam PR #5783
— [API] Delete/Cancel Real Time Downtime #5879 PR #5894
— [API] Display future downtime PR #5903
— [Documentation] Update lifecycle in documentation PR #5901
— [Documentation] Remove obsolete paragraph PR #5898

Bug Fixes

— [ACL] Undefined variable host id PR #5891
— [ACL] Use correct id for acl host relation PR #5896
— [Chart] Graphs in IE streched #5081
— [Configuration] Fix macro password visibility PR #5873
— [Configuration] Host search not saved when activate/desactivate a host #5711 PR #5827
— [Documentation] Correct API documentation for host/service relation #5854
— [Documentation] Improve documentation install using ISO #5772 PR #5851
— [Install] Script install.sh - Could not create user #5785 PR #5890
— [Knowledge Base] Correct typo of error message PR #5917
— [Monitoring] fix macro password with arguments in object details page PR #5928 #5881

Security

— Prepare query and execute it #5904
— Improve list of objects for Select2 #5918
— Update SQL query to prevent SQL injection in setRotate form #5915

2.2.18 Centreon Web 2.8.18

Enhancements

— [Administration] Add more actions and logging for ACL management - PR #5841
— [API] Validate input parameters - PR #5958
— [API] Check illegal char in add function for CLAPI - PR #5948
— [API] Improve error message - PR #5972
— [API] Get multiple parameters for host - PR #5946
— [Configuration] Add form to configure Centreon Broker generic stream connectors - PR #6024 #6053 #6052

#6042 (beta)
— [Documentation] Add new chapter for Centreon ISO el7 installation - PR #6019
— [Documentation] Describe get parameters for hosts #5783 - PR #5924
— [Knowledge-Base] Add option to disable SSL certificate - PR #6027
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Bug Fixes

— [Administration] Define default value for Broker - #6029 PR #6033
— [Configuration] Change low limit of EventMaxQueueSize for Centreon Broker configuration - PR #6013
— [Configuration] Avoid php notice when poller has no timezone - PR #6031
— [Install] Compatibility with PHP version 5.3 - PR #5976
— [Meta-service] Do not duplicate them on update - PR #5982
— [Meta-service] Possibility for user with ACL to display chart - PR #5952
— [Monitoring] Top Counter with ACL really slow - #5974 PR #5992
— [Monitoring] Centreon UI freezes when access to “View contact Notification” - #5760 PR #5954
— [Monitoring] Replace dot character in command line for better display - PR #5945
— [Monitoring] Fix add downtime on hostgroup or poller with ACL - PR #6023

2.2.19 Centreon Web 2.8.19

Enhancements

— [API] Return error when filtered object does not exist - PR #6074
— [API] Add clapi set option - PR #6065
— [UX] Add new loading css - PR #6066 #6072

Bug Fixes

— [API] Fix clapi export with hosts parent relations - #6061
— [API] Uninitialized array causing php warning - PR #6046 #6097
— [Monitoring] Top counter very slow since upgrade from 2.8.17 to 2.8.18 - #6085 PR #6093

2.2.20 Centreon Web 2.8.20

Enhancements

— [API] Add default poller - PR #6098
— [API] Link host with default poller if unknown poller - PR #6099
— [ACL] Improve performance - #6056 PR #6107
— [Documentation] Improve Centreon CLAPI usage - PR #6090 #6091
— [Documentation] Improve documentation to add a new poller - #6075 PR #6086
— [Documentation] Add notice for 64 bits support only - PR #6101
— [Monitoring] Display links in output and comments - #5943 PR #6113

Bug Fixes

— [ACL] Allow nested groups filter in ldap configuration - #6127 PR #6128
— [API] Export specific service, add host before service in CLAPI - PR #6100
— [API] CLAPI add resource export filter - PR #6125
— [API] CLAPI Export contact with contact group - PR #6131
— [API] CLAPI Export service categories - PR #6134
— [Configuration] SNMP trap poller generation uses ACL - #6043 PR #6069
— [Custom Views] Fix share custom view - PR #6109
— [Poller Stats] Poller Statistics Graphs are displayed in first column only - #6003 PR #6122
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Others

— Update copyright date on the login page - PR #6076
— Remove multiple debug in Centreon - PR #6138

2.2.21 Centreon Web 2.8.21

Enhancements

— [Documentation] Add chapter about how to write a stream connector - PR #6189
— [API] Separate REST API configuration and REST API realtime access - PR #6188

Bug Fixes

— [ACL] Manage filters (poller, host, service) on servicegroup - PR #6163
— [Configuration] Fix output stream connector name for fresh install - PR #6159 #6182
— [Configuration] No “Conf changed” flag set to “yes” when deploying services to selected hosts - #6160 PR

#6191

Other

— Fix php warning in realtime host API - PR #6174

2.2.22 Centreon Web 2.8.22

Enhancements

Bug Fixes

— [CLAPI] Fix host services deployment - PR #6212

Other

2.2.23 Centreon Web 2.8.23

Enhancements

— [Documentation] Correct typo - PR #6202
— [Documentation] Update icon to add metrics to a meta service - PR #6167
— [Documentation] Correct typo in documentation about stream connector howto #6261

Bug Fixes

— [ACL] fix select all checkbox in acl actions form - PR #6193
— [Administration] fix purge on pmax partition - PR #6232
— [Downtimes] fix recurrent downtimes on HG when no SG exist - PR #6201
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Security

— Update jquery ui libs +fix compat - PR #6181

Others

— fix(centAcl.php) : Dead code removed - PR #6262
— fix(lib) : allow chaining on jquery pagination plugin - PR #6219
— fix(jQuery) : fix broken input in reporting_dashboard - PR #6254
— fix(style) : fix style in widget preferences popin - PR #6197
— fix(style) : fix padding of buttons in custom views page - PR #6198
— fix(front) : retrieve jquery toggle function (renamed to toggleClick) - PR #6217
— fix(front) : fix acl actions checkboxes (check all / uncheck all) - PR #6309

2.2.24 Centreon Web 2.8.24

Bug Fixes

— Remove duplicate entries in centreon_acl table - PR #6366

Security

— Fix execution command by rrdtool command line - PR #6263
— Fix XSS on command form - PR #6260
— Fix XSS security on menu username - PR #6259
— Fix SQL injection on graphs - PR #6251
— Fix SQL Injection in administration logs - PR #6255
— Fix SQL injection in dashboard - PR #6250
— Fix SQL injection in Curve template - PR #6256
— Fix SQL Injection in Virtual Metrics - PR #6257

2.2.25 Centreon Web 2.8.25

Introduction to a new banner to preparate the next releases. This feature must be enabled for each user. After the
update, users will be asked to activate or not this feature. New banner will appear after refresh of the page. A rollback
is still possible through the “My account” menu.

Enhancements

— [UX] New banner in feature flipping mode - PR #6294
— [API] Submit result for passif resources - PR #6209
— [API] Export is too long when lot of parentship - PR #6372

Bug Fixes

— [API] Correct real time service filters - #6080 PR #6363
— [API] Restore broker configuration with clapi generate too much output and input - #5011 PR #6220
— [API] Partial / Filtered export does not work as expected for HC, SC, CG - #5294 PR #6355
— [API] Export uses resource macro name instead of id for setparam - #6221 PR #6222
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— [API] HTML Entities cause REST API Serialization Errors - #6110 PR #6234
— [API] Fix acl group setcontact export - PR #6224
— [API] Avoid to order parentship several times - PR #6373
— [Configuration] View contact notification service missing - #6073 PR #6340
— [Downtimes] Prevent permission denied centcore cmd for downtimemanager - PR #6289
— [LDAP] Remove contact password if ldap password storage is disabled - #5627 PR #6347
— [Monitoring] Sort by service name after status in service grid - PR #6290
— [Reporting] Avoid bug on partitioned tables - PR #6382

Security

— Fix SQL injection from metrics RPN’s field - PR #6356

Others

— Avoid PHP notice Undefined index : centreon in notifications.php - PR #6266
— Delete “Ping” and “Tracert” entries (no more used) - PR #6277
— Fix typo in FR documentation - PR #6375
— Fix “how to write a stream connector” chapter - PR #6296 #6295
— Add some missing developers in Centreon About - PR #6410 #6253
— Several fixes and improvements in documentation

2.3 Centreon 2.7

Please find here the release notes dedicated to the last 2.7.x version of Centreon.

2.3.1 Centreon 2.7.0

Released December 17, 2015

The 2.7.0 release for Centreon Web is now available for download. The full release notes for 2.7.0 follow :

Features and Bug Fixes

— Changing the graphic charter to be consistent with the new logo Centreon
— Flat design (CSS and icons)
— Custom view improvement

— Adding an editing or visualization mode
— Graphic widgets relief to be able to put more on a page

— Adding a fullscreen mode
— Menu Review for improved navigation and simplified user actions
— Review og pages dedicated hosts and services pages in monitoring to include more informations.
— Redesign of the reporting page
— Recasting bar searches and filters in each page of Centreon
— Redesign Event Logs page (removing treeview + Added search system + Improved performances)
— Redesign view page (removing treeview + Added search system + Improved performances)
— Merging downtimes pages for hosts and services
— Merging comments pages for hosts and services
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— Integration of a graphics module to replace a non-performing component QuickForm (Improved forms on multi
element selection)

— Simplifying the configuration of Centreon Broker (Temporary and Failover are automatically configured +
enhanced best practices)

— Ergonomic improvement of the configurations objects :

— Improved hosts form
— Improved services form
— Improved management macros : dynamic form system that provides the necessary inherited macros templates

for proper operation of the configuration
— Added ability to set a description of each macro used in commands
— Review of the pathway for the generation of the configuration
— Automatic creation of a configuration file for the poller when it is created

— Deleting configuration options in the Administration section, now automatically configured. This simplifies the
handling of Centreon

— Improved ACL system (Improved performances)
— Native integration of Centreon CLAPI
— Improved documentation

— Redesign Configuration part
— Redesign Exploitation part
— Integration of the API part

Changes

— Important web design changes can make interface not compatible with older modules. A refactoring work will
be needed to ensure optimal operation.

— Changing the timezone system : DST management (may need to check the timezones of each host and contact
after the update)

— Changing databases schemes for hostgroups and servicegroups in the real state database (centreon_storage) :
added id and deletion of alias, url, url note, icon.

— Changing the path for generating the configuration of Centreon Engine instances : no more specific page to
generate the configuration. The action is now available from the pollers list.

— Switching to InnoDB all Centreon tables (except logs and data_bin too big for an automatic update).
— PHP 5.1 no longer supported
— Browser compatibility : IE 11, FF 5 et Chrome 39 at least
— Shared views in custom views are not automaticaly loaded in views of others users. Now views are able to be

public and user can load them during the creation step.

Secutiry fixes

— Removing PHP session ID in the URL of the Ajax flow of certain pages.
— Integration of a CSRF token in all forms to prevent “Man in the middle” effect.

Removed Features

— Nagios and NDOutils are no longer compatible with Centreon web. Only Centreon Engine and Centreon Broker
are compatible from version 2.7.0

— Removing centstorage and logAnalyser executables.
— Removing the Nagios configurations load module.
— Removing the ability to configure the colors of graphics templates
— Removing color choices for menus
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— Removing choosing colors for monitoring status
— Removing the ability to configure Nagios CGI
— Transformation of the tactical overview in widget
— Transformation of the Monitoring Engine statistics Page in widget
— Deleting the Server Status page (phpsysinfo) become incompatible with the PHP version recommended for

Centreon
— Remove timeperiod exclusions in the UI. This function don’t work very fine whether with Centreon Engine 1.x

or Nagios. We prefer removing the function in order to avoid problems.

Known Bugs

— ACL of pages is not fully updated during the upgrade process. So please check all your ACL pages after the
migration. You may have problems with the followings pages :

— Monitoring > Hosts
— Monitoring > Services
— Monitoring > Performances (new page)
— Monitoring > Downtimes
— Monitoring > Comments
— Monitoring > Eventlogs > System logs

— Graph slip not working
— Pagination is broker when you go on the last page, change the number of line to the Max. Page become empty.
— If you have timeperiods used in exception or inclusion of timeperiod and now deleted, their ids stays in the

database in relation table. During the sql update process, this blocks an addition of constraint on this relation
table. To fix it, you have to remove old timeperiod id. :

mysql> DELETE FROM timeperiod_exclude_relations WHERE timeperiod_id NOT IN (SELECT tp_id FROM timeperiod) OR timeperiod_exclude_id NOT IN (SELECT tp_id FROM timeperiod);
mysql> DELETE FROM timeperiod_include_relations WHERE timeperiod_id NOT IN (SELECT tp_id FROM timeperiod) OR timeperiod_exclude_id NOT IN (SELECT tp_id FROM timeperiod);

How to Install ?

Now that you are aware about all specificities of this version, you can install it. If you install from zero your system,
please follow the installation guide. Else you can refer to the upgrade guide. Take care about prerequisits and all
upgrade steps in order to avoid data loss.

2.3.2 Centreon 2.7.1

Released January 07, 2016

The 2.7.1 release for Centreon Web is now available for download. The full release notes for 2.7.1 follow :

Notice

If you are upgrading from a version prior to 2.7.0, make sure to go through all the release notes available here.

CHANGELOG

Features and Bug Fixes

— Improved ergonomics of the select2 component
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— Improved performances of monitoring pages
— Improved performances of the event logs page
— Improved performances of downtimes configuration on host page
— Improved documentation
— Fixed problem when sharing views in Custom views page
— Fixed a right problem in CLAPI generation of the configuration
— Fixed problem in services per hostgroups pages
— Fixed problems in configuration generation when mysql is not using 3306 port

2.3.3 Centreon 2.7.2

Released February 24, 2016

The 2.7.2 release for Centreon Web is now available for download. The full release notes for 2.7.2 follow :

Notice

If you are upgrading from a version prior to 2.7.0, make sure to go through all the release notes available here.

CHANGELOG

Features and Bug Fixes

— Fix eventlogs pages for performances and right for non admin users
— Fix Recurent Downtimes behaviour with timezones
— Fix some broken relations in web interface
— Fix Reporting pages for non admin users
— Fix some elements with the generation of the configuration
— Fix encoding problems
— Fix filters in configuration pages
— Fix Poller duplication
— Fix various ACL problems
— Fix some SQL queries
— Fix export of Meta Services
— Improve ACL on Custom Views

Known Bugs

— Recurrent downtimes during for more than a day are not working
— It’s impossible to remove relations between usergroup and custom views
— With the update some widgets have to be deleted and recreated

2.3.4 Centreon 2.7.3

Released March 15,2016

The 2.7.3 release for Centreon Web is now available for download. The full release notes for 2.7.3 follow.

2.3. Centreon 2.7
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Notice

If you are upgrading from a version prior to 2.7.0, make sure to go through all the release notes available here.

CHANGELOG

Features and Bug Fixes

— Fix Recurent downtimes starting at 00 :00
— Fix search in Poller configuration page
— Fix problems when sharing custom views
— Fix description problem with custom macros containing dash
— Fix time Interval change isn’t being reflected in the polling Engine config
— Fix Missing GMT and UTC timezone
— Fix No performance graph for host group service
— Fix ACL were showing too much objects
— Fix Impossibility to delete custom macros on service
— Fix Split on multi graph
— Fix Design on Monitoring Performances page
— Fix CLAPI handled all broker parameters
— Fix Custom macros can contain dash
— Fix Time Interval change isn’t being reflected in the polling Engine config
— Fix UI doesn’t display the good limit of pagination
— Fix Some French translations were missing
— Enh Improve listing possibilities in Widget configuration (Pollers and categories)
— Enh Usuability of select2
— Enh Possibility to reload several pollers in one time
— Enh Add an API to send External Commands

2.3.5 Centreon 2.7.4

Released April 14,2016

The 2.7.4 release for Centreon Web is now available for download. The full release notes for 2.7.4 follow.

Notice

If you are upgrading from a version prior to 2.7.0, make sure to go through all the release notes available here.

Fix of an encoding problem

Following a change of encoding tables in centreon database which occurred in the 2.7.0 version, bad encoded charac-
ters appear in the Centreon web interface. Indeed, the change charset “latin1” to “utf8” was not followed by an update
of the content of tables in the database.

To restore a valid encoding of special and accented characters, it is necessary to manually run the script provided by
Centreon.
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Warning

This script should be run once and only once.

If an operator has modified/corrected special characters or accented since the 2.7.0 update, processing performed by
the script will truncate the string to turn on the first special or accented character. It will then be necessary to change
the impacted objects to manually update them. (The script can unfortunately provide the list of impacted objects.

All contents of table type “varchar”, “char” or “text” will be updated

Prerequisites

Don’t forget to backup your database before doing any operations.

Installation

Download and install the script in “/usr/share/centreon/bin/” with the command :

wget http://resources.centreon.com/upgrade-2.6-to-2.7/migrate_utf8.php -O /usr/share/centreon/bin/migrate_utf8.php

Execution

From a shell terminal, perform the script :

php /usr/share/centreon/bin/migrate_utf8.php

Validation

Connect to your web interface and check that there are no more bad encoded characters on it.

CHANGELOG

Features and Bug Fixes

— Fix : Contacts in contactgroups were exported with a wrong ID
— Fix : Error when saving “Administration > Parameters > Monitoring” page
— Fix : Zoom in Performance graph
— Fix : Select contactgroups / contacts in services & hosts configuration was not working
— Fix : Display only catagories and not severities on form
— Fix : Scroll bar in “Configuration - Hosts - Host Groups”
— Fix : Category Relation on host and host template form
— Fix : Order in More Actions Menu
— Fix : generateSqlLite not install with source
— Fix : SSO connection with LDAP user
— Enh : Add possibility to set local to “browser” when adding a contact by CLAPI

2.3.6 Centreon 2.7.5

Released July 06,2016

The 2.7.5 release for Centreon Web is now available for download. The full release notes for 2.7.5 follow.
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Notice

If you are upgrading from a version prior to 2.7.0, make sure to go through all the release notes available here.

CHANGELOG

Features and Bug Fixes

— Fix : Flapping configuration was not exported to Centreon Engine configuration files
— Fix : Option “test the plugin” didn’t working with special characters
— Fix : It was possible to select Meta Service or BA in performance page filters
— Fix : With non admin users, it was impossible to select services in Performances page
— Fix : Non admin users could not seen services in Reporting page
— Fix : Number of hosts in Hostgroups was not good for non admin users
— Fix : Max and Min was not correct for inverted curves
— Fix : It was impossible to create Virtual metrics with web UI in french language
— Fix : Exclude Desactivate poller in configuration generation page filter
— Enh : Add an error message when no pollers are selected in configuration genration page

2.3.7 Centreon 2.7.6

Released July 21,2016

The 2.7.6 release for Centreon Web is now available for download. The full release notes for 2.7.6 follow.

Notice

If you are upgrading from a version prior to 2.7.0, make sure to go through all the release notes available here.

CHANGELOG

Features and Bug Fixes

— Fix : Hard PATHs in some folders
— Fix : Correction of some typos
— Fix : contact_location default value incorrent
— Fix : Security fix linked to the configuration export
— Fix : Problem with custom view style when user was not able to edit the view then old style was used
— Fix : Centreontrapd issue if number of downtimes is greater than 1
— Fix : Service comments wrong request
— Enh : SQL Optimisation in handling service templates

2.3.8 Centreon 2.7.7

Released September 13,2016

The 2.7.7 release for Centreon Web is now available for download. The full release notes for 2.7.7 follow.
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Notice

If you are upgrading from a version prior to 2.7.0, make sure to go through all the release notes available here.

CHANGELOG

Features and Bug Fixes

— Fix : Non intialised value in Centreon ACL page
— Fix : Security issue with autologin when user has no password
— Enh : [Centreon Clapi] Add export filters

2.3.9 Centreon 2.7.8

Released November 09,2016

The 2.7.8 release for Centreon Web is now available for download. The full release notes for 2.7.8 follow.

Notice

If you are upgrading from a version prior to 2.7.0, make sure to go through all the release notes available here.

CHANGELOG

Features and Bug Fixes

— Fix : Improve graph rest API
— Fix : Two “update mode” lines for service groups in Massive change causing annoying behaviour

2.3.10 Centreon 2.7.9

Released March, 21th 2017.

The 2.7.9 release for Centreon Web is now available for download. The full release notes for 2.7.9 follow.

Notice

If you are upgrading from a version prior to 2.7.0, make sure to go through all the release notes available here.

Features and Bug Fixes

— Fix : allow full configuration export for Centreon Poller Display
— All graphs linked to a host aren’t displayed in performance page - #4731
— Documentation - correct example to use TP instead of TIMEPERIOD - PR #4915, Pr #4916
— Force CENGINE key in centreon database options to use Centreon Engine - #4922

2.3. Centreon 2.7
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2.3.11 Centreon 2.7.10

The 2.7.10 release for Centreon Web is now available for download. The full release notes for 2.7.10 follow.

Notice

If you are upgrading from a version prior to 2.7.0, make sure to go through all the release notes available here.

Bug Fixes

— Fix various security issues
— Fix ldap configuration form
— Fix downtime popup in listing pages
— Fix object listing pages which are empty after some actions

2.3.12 Centreon 2.7.11

The 2.7.11 release for Centreon Web is now available for download. The full release notes for 2.7.11 follow.

Notice

If you are upgrading from a version prior to 2.7.0, make sure to go through all the release notes available here.

Bug Fixes

— Fix ldap authentication #5216
— Fix CLAPI export using filters #5084
— Fix CLAPI poller generate (generate, test, move, restart/reload/ applycfg) #5224 #5221
— Fix Incorrect style for “Scheduled downtime” in dashboard #5240
— Fix Contact - import LDAP apply new CSS style #5235
— Fix HTML export with filters #4868
— Fix brokercfg export with filter
— Fix get command list query #5229
— Apply sso fixes from 2.8.x
— Improve performances #5157
— Convert string in UTF-8 #5118 #5244

2.3.13 Centreon 2.7.12

The 2.7.12 release for Centreon Web is now available for download. The full release notes for 2.7.12 follow.

Notice

If you are upgrading from a version prior to 2.7.0, make sure to go through all the release notes available here.
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Bug Fixes

— [CLAPI] Several bugs on HG / CG when export is filtered #5297 PR #5320
— [CLAPI] fix clapi ldap contact import
— Unable to load public custom view - No Layout... #5449
— Impossible to acknowledge several object from custom views #5420
— Security : avoid external command shell injection in comment

2.4 Centreon 2.6

Vous trouverez ici la liste des notes de versions pour les versions 2.6.x

2.4.1 Centreon 2.6.6

Released October 29, 2015

Notice

If you are upgrading from a version prior to 2.6.0, make sure to go through all the release notes available here.

CHANGELOG

Bug fixes

— #3812 : [2.6.3] Strange display of service group details page
— #3824 : PHP Warning : array_map() : Argument #2 should be an array
— #3840 : [2.6.4] Wrong reporting graph data with default user language fr_FR.UTF-8
— #3846 : [2.6.5] CRSF Token critical : Impossible to upgrade a plugin
— #3847 : [2.6.5] split component switch
— #3852 : [2.6.5] CSRF error appears in user massive change form
— #3854 : Cannot add new macro after deleting all macros already created
— #3855 : Cannot add new host template to host after deleting all templates
— #3861 : Comments shows only “A”
— #3864 : [2.6.5] CSRF when trying to upload a SNMP MiB

2.4.2 Centreon 2.6.5

Notice

If you are upgrading from a version prior to 2.6.0, make sure to go through all the release notes available here.

CHANGELOG

Security fixes

— #3831 : XSS injection in object lists (ZSL-2015-5266)
— #3835 : CRSF Issues on Centreon (ZSL-2015-5263)

2.4. Centreon 2.6
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Bug fixes

— #3821 : Upgrade from 2.6.1 to 2.6.3 kill Centreon Frontend
— #3826 : Split Component and zoom doesn’t work
— #3827 : Service Group Details page isn’t displayed for non admin in Centreon 2.6.3
— #3837 : Relation of passive service with SNMP traps problem with multihost link
— #3842 : Full logs display on event logs page for a non admin user

2.4.3 Centreon 2.6.4

Notice

If you are upgrading from a version prior to 2.6.0, make sure to go through all the release notes available here.

CHANGELOG

Bug fixes

— #3793 : Porblem when creating an empty hostgroup with non admin user
— #3795 : Update Centreon Administration About page (forge -> Github)
— #3796 : Problem when connect two time with same user in API
— #3797 : Password in macro
— #3800 : Current State Duration isn’t displayed
— #3803 : ACL : Manage multiple Resources group on the same ACL user group
— #3807 : Unable to enable status option on main.cfg

2.4.4 Centreon 2.6.3

Notice

If you are upgrading from a version prior to 2.6.0, make sure to go through all the release notes available here.

CHANGELOG

Bug fixes

— #564 : Filter field does not work in service groups monitoring screen
— #1000 : Services of service groups are dispatched on many pages
— #3782 : SQL Keyswords
— #3783 : index_data switch in option form
— #3788 : Problem with static keywords

2.4.5 Centreon 2.6.2

Notice

If you are upgrading from a version prior to 2.6.0, make sure to go through all the release notes available here.
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CHANGELOG

Features

— Modules can extend actions after restart/reload pollers

Security fixes

— #2979 : Secure the type of media which file can be uploaded (ZSL-2015-5264)
— Fix some SQL injections (ZSL-2015-5265)

Bug fixes

— #3559 : Fix query with MariaDB / MySQL configure in STRICT_TRANS_TABLES
— #3554 : Can send acknowledgement with multiline from monitoring page
— #3397 : Fix display graph with unicode characters in metric name
— #2362 : Correct value when use index_data inserted by Centreon Broker in configuration
— #1195 : Display correct number of pollers in status bar
— #196 : Display all columns when filter is applied on Monitoring services unhandled view

2.4.6 Centreon 2.6.1

Notice

If you are upgrading from a version prior to 2.6.0, make sure to go through all the release notes available here.

CHANGELOG

Bug fixes

— #5655 : Changing Host Templates doesn’t delete services
— #5925 : Popup Dialogs (Acknowledge, Downtimes etc.) not working with Internet Explorer
— #6224 : Special characters in LDAP are replaced by underscore
— #6358 : It’s possible to bypass ACLs on Event Logs page
— #6375 : servicegroups empty into servicegroups.cfg but ok in DB
— #6377 : PHP logs are too much verbose with PHP 5.4
— #6378 : PHP logs are too much verbose with PHP 5.3
— #6383 : Random severity on services
— #6390 : Escalations with contact groups containing space
— #6391 : Some traps are skipped
— #6396 : Warning and critical threshold display in centreon graph
— #6399 : Wrong condition in centreonLDAP.class.php
— #6410 : Do not limit to 20 the number of trap rules or macro in host and services config pages

Features

— #6035 : Removing Centreon Broker local module
— #6366 : New option for Centreon Engine log
— #6392 : Block choice of Nagios and NDO in installation processus
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2.4.7 Centreon 2.6.0

Notice

If you are upgrading from a version prior to 2.5.4, make sure to go through all the release notes available here.

What’s new ?

Compatibility with PHP 5.4.x

Centreon is now compatible with PHP in version 5.4.x. So, you do not need to downgrade to PHP 5.3.x version when
you install it on Debian 6, Ubuntu 13.04, Redhat 7 and CentOS 7.

Centreon proprietary module (Centreon BAM, Centreon BI, Centreon MAP, Centreon KB) is not compatible as yet
with this PHP version.

New options for Centreontrapd

It’s now possible with Centreontrapd to :
— Filter services on same host ;
— Transform output (to remove pipe for example) ;
— Skip trap for hosts in downtime ;
— Add custom code execution ;
— Put unknown trap in another file.

ACL and configuration modification with admin users

ACL management has been improved to allow for a greater number of simultaneous sysadmin users to work on the
same monitoring platform.

The synchronisation is more efficient in configuration page between admin and normal users.

Partial rebuild of events information

It’s now possible to partially rebuild events information with eventsRebuild script. You can now use option ‘-s’ when
rebuilding and the rebuild will start from this date.

Before, you had to rebuild from the beginning of the related data.

Criticality inheritance

Centreon 2.6 introduces a capability for the dependent services of a host to automatically inherit its configured critica-
lity. It’s also possible to define the levels of global criticality of a particular host and dependent services cluster thanks
to the use of templates.

Integration of Centreon new logo

The new Centreon logo has been integrated into this new version.
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CHANGELOG

Bug fixes

— #5655 : Changing Host Templates doesn’t delete services
— #5782 : Warning daemon_dumps_core variable ignored
— #5795 : ACL and configuration modification with admin users
— #5868 : Generation of services groups isn’t correct for poller
— #6052 : Month_cycle option in recurring downtime is not properly set
— #6119 : Filter doesn’t work on many pages in Administration -> Log
— #6163 : A template should not be able to inherit from itself
— #6336 : Problem with schedule downtime when using different timezones

Features

— #3239 : PHP-5.4 Compatibility
— #5238 : Criticality inheritance
— #5334, #6114, #6120 : Optimisation and customization on Centreontrapd
— #5952 : Add possibility to rebuild partially Events information
— #6160 : New Centreon logo

Note : Des versions plus récentes sont disponibles au téléchargement download portal. Il est vivement recommandé de
mettre à jour vitre plate-frome afin d’éviter les bugs et les problémes de sécurité.

2.5 Centreon 2.5

Vous trouverez ici la liste des notes de versions pour les versions 2.5.x

2.5.1 Centreon 2.5.4

Notice

If you are upgrading from a version prior to 2.5.3, make sure to go through all the release notes available here.

CHANGELOG

Bug fixes

— #5458 : Display problem with host groups
— #5924 : Generation of service configuration files does not work when “service_inherit_contacts_from_host” is

not enabled
— #5926 : Centreon-Broker-2.7.x compatibility
— #5929 : Fix problem in import service groups by cfg file
— #5942 : Fix compatibility with IE
— #5946 : Problem in reporting due to acknowledgement
— #5986 : Session’s Id does not change after logout

2.5. Centreon 2.5
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Features

— #5433 : Argument column larger in service configuration
— #5944 : Services inherit criticality from hosts

2.5.2 Centreon 2.5.3

Warning

This version include a couple of security fixes. Please proceed to the update of your platform if your centreon is not in
version 2.5.3 at least. If you’re using Debian or Suse before doing the update, you need to install php5-sqlite package.

The update can take some times due to the update to UTF-8 format (#5609)

Notice

If you are upgrading from a version prior to 2.5.2, make sure to go through all the release notes available here.

CHANGELOG

— #5895 : Security Issues : CVE-2014-3828 & CVE-2014-3829
— #5888 : Differences between update and fresh install for “Insert in index data” field
— #5829 : Add config file in parameters for all crons of Centreon in order to install centreon on different directo-

ries
— #5852 : Fix problem with massive change for “Inherit contacts from host” in service form
— #5841 : Empty dependences are now remove automaticaly
— #5840 : Fix problem with host duplication when this host has a “”’ in the alias
— #5790 & #5813 & #5750 : Fix problems on Tactical Overview
— #5786 : Fix problem when generating correlation config file.
— #5756 : Fix problem with centstorage => Table log is growing to much
— #5609 : Push Centreon Broker table to UTF-8
— #5589 : Fix problem with Contact inheritance between service and its template who doesn’t work
— #4865 : Fix problem with search in Eventlog

2.5.3 Centreon 2.5.2

Notice

If you are upgrading from a version prior to 2.5.1, make sure to go through all the release notes available here.

CHANGELOG

— #5593 : Fixes a bug where trap advanced matching rules were not working
— #5600 : Fixes a bug where it was impossible to add or modify a poller
— #5533 : Fixes a bug where it was impossible to update the severity level of a service
— #5307 : Tooltips messages were not translated in the Broker configuration form
— #5664 : Enhances loading time of the service detail page
— #5439 : Enhances loading time of the meta service page
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2.5.4 Centreon 2.5.1

WARNING

If you are upgrading from Centreon 2.5.0 make sure to read the following.

Warning : If you are upgrading from a version prior to 2.5.0, just skip this notice and follow this procedure
instead : https://blog.centreon.com/centreon-2-5-0-release/.

As usual, database backups are to be made before going any further.

It does not matter whether you run the commands below before or after the web upgrade ; do note that those scripts
may take some execution time depending on the size of your log tables.

You are using NDOUtils

If you are using NDOUtils, chances are that you have plenty of duplicate entries in your log table. Follow the procedure
in order to re insert the logs :

Copy all the log files from the remote pollers to the local poller in /var/lib/centreon/log/POLLERID/. To know the
POLLERID of each of your pollers, execute the following request against the MySQL server (centreon database) :

mysql> SELECT id, name FROM nagios_server;

Then, execute the following script :

/path/to/centreon/cron/logAnalyser -a

You are upgrading from Centreon 2.5.0

There was a bug in Centreon 2.5.0 that probably messed up your reporting data, you will have to recover by running
these commands :

/path/to/centreon/cron/eventReportBuilder -r

/path/to/centreon/cron/dashboardBuilder -r -s <start_date> -e <end_date>

start_date and end_date must be formatted like this yyyy-mm-dd ; they refer to the time period you wish to
rebuild your dashboard on.

2.5.5 Centreon 2.5

WARNING

If you are upgrading from Centreon 2.4.x make sure to read the following. As usual, database backups are to be
made before going any further. Then, follow these procedures in order to ensure the integrity of the RRD graphs. Not
following this may cause your graphs to malfunction !

2.5. Centreon 2.5
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If you are using Centreon Broker

— Check right of conf.pm file. Apache must have the right to modify conf.pm file
— Stop all the centreon-engine services
— Stop the centreon-broker daemon
— Upgrade Centreon-Broker on all the pollers
— Restart all the engines
— Upgrade Centreon (web install)
— Execute /path/to/centreon/bin/changeRrdDsName.pl
— Check that your graphs are showing properly on the web interface
— Start the centreon-broker daemon

If you are using NDO

— Stop centstorage
— Upgrade Centreon (web install)
— Execute /path/to/centreon/bin/changeRrdDsName.pl
— Start centstorage

What’s new

ACL on configuration objects

ACL rules are now applied to configuration objects. For more information regarding this feature, be sure to checkout
our blog post : http://blog.centreon.com/configuration-acl-with-centreon-2-5-2/

UI and sound notifications

It is now possible to get UI and sound notifications on Centreon, you can set your preferences in your profile page. A
quick overview there : http://blog.centreon.com/centreon-ui-notification-system/

Only available if you are using Centreon Broker as of now.

New system with SNMP traps

Centreon has evolved with a eaysiest way to handle SNMP traps. Some advantages of the new system :
— No more ‘snmptt’
— More advanced configuration in SQL Database
— Local database (sqlite) on Pollers

You have to look on the centreon documentation in order to configure Centreon using this new system. Go in section :
User guide > Advanced > SNMP TRAPS

Important notes

Centcore is now mandatory

External commands are now sent to centcore regardless of whether the poller is local or not. So be sure to have it
running all the time from now on.
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Note : Des versions plus récentes sont disponibles au téléchargement download portal. Il est vivement recommandé de
mettre à jour vitre plate-frome afin d’éviter les bugs et les problémes de sécurité.

2.6 Centreon 2.4

Vous trouverez ici la liste des notes de versions pour les versions 2.4.x

2.6.1 Centreon 2.4.5

Important notes

Connector

You can now linked a command to a connector from the connector form in Configuration > Commands > Connectors.

Centreon Broker

Centreon 2.4.x branch is now compatible with Centreon Broker 2.5.x branch. Also several options have been added in
Centreon Broker configuration form accessible in Configuration > Centreon > Configuration (Below Centreon-Broker
label in the left panel). Here the new options :

— “Write timestamp” in General tab : To enable or disbale timestamp logging in each log line (disable this option
is useful with when Centreon-Broker is used with Nagios)

— “Write thread id” in General tab : To enable or disable thread id logging in each log line
— “Write metrics” in Output tab with RRD - RRD file generator : To enable or disable the update of the perfor-

mance graph
— “Write status” in Output tab with RRD - RRD file generator : To enable or disable the update of the status

graph
— “Store performance data in data_bin” in Output tab with Storage - Perfdata Generator (Centreon Storage) : To

enable or disable insertion of performance data in data_bin table
— “Insert in index data” in Output tab with Storage - Perfdata Generator (Centreon Storage) : Allow Centreon-

Broker to create entries in index_data table (use with caution)

2.6.2 Centreon 2.4.4

Important notes

Graphs

It is now possible to set RRD graphs’ to “DERIVE” and “ABSOLUTE” type. In order to do so go to Administration
> Options > CentStorage > Manage, then click on the metric you would like to update. In the “More actions” toolbar,
you will now see the new data source types.

Monitoring consoles

A new option is available, allowing you to choose the display order of the monitored resources. The new option is
available in Administration > Options , in the Problem display properties section.

2.6. Centreon 2.4
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2.6.3 Centreon 2.4.1

Important notes

Connectors

If you are already using the Centreon Connectors, please note that the connector path is no longer called with user
variable $USER3$. It is instead in the Configuration > Centreon > Pollers > Centreon Connector
path. In that regard, be sure to fill this field and update the connector command line in Configuration >
Commands > Connectors by removing the $USER3$ prefix.
i.e : : $USER3$/centreon_connector_perl
should become : : centreon_connector_perl
Once you’re done with updating those configurations, you may delete the former $USER3$ as it will be no longer
used.

2.6.4 Centreon 2.4

What’s new

Better integration with Centreon Engine and Centreon Broker

The installation process has been reviewed : it is now possible to specify the monitoring engine (Centreon Engine or
Nagios) and the event broker module (Centreon Broker or NDOUtils). All you need to do right after a fresh installation
is export your configuration files, then reload your monitoring engine and the monitoring system should be up and
running !

This version offers the possibility to define the connectors for Centreon Engine. Obviously, you do not need to confi-
gure these connectors if you are still using Nagios.

It’s been said that Centreon Broker can be cumbersome to configure, especially if you are not familiar with its func-
tioning. Centreon 2.4 offers a configuration wizard now !

Custom views

This new page enables users to make their own views with various widgets and they are able to share their custom
views with their colleagues !

See the user guide to learn more about this feature.

Support for multiple LDAP servers

The LDAP authentication system is much more robust than before. Indeed, it is now possible to have multiple LDAP
configurations on top of the failover system. The LDAP import form will let you choose the LDAP server to import
from.

Make sure that all your LDAP parameters are correctly imported after an upgrade.

New autologin mechanism

A better autologin mechanism has been introduced in this version. Now using randomly generated keys, it allows you
to access specific pages without beeing prompted for a username and a password.
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Database indexes verification tool

If you upgrade from an old version of Centreon, now you can check the existence of all database indexes to ensure
maximum performance

Important notes

Administration

Communication with pollers The default system user used by Centcore to communicate with pollers has changed
from nagios to centreon.

Plugins For better performances, we advise you to use check_icmp instead of check_ping if you are in an
IPv4 network, that is (check_icmp is not yet compatible with IPv6). Switching from check_ping to check_icmp
should be quite simple as the plugins take the same parameters. All you have to do is change the check commands :
check_centreon_ping, check_host_alive and all the commands that call check_ping.

Web interface

Autologin A new autologin mechanism has been added in Centreon 2.4. More secured than the previous one, it will
soon replace it. If you currently use this feature, we recommend upgrading to the new one as soon as you can.

Centreon Broker init script If you are using Centreon Broker, make sure to fill the Start script for broker daemon
parameter in Administration > Options > Monitoring. RRD graphs cannot be rebuilt if this parameter is
omitted !

Centcore options Two parameters have been added into the Administration > Options > Monitoring
page :

— Enable Perfdata Synchronisation (Centcore)
— Enable Logs Synchronisation (Centcore)

For performance issues, these options must be disabled if your monitoring system is running with Centreon Broker.

Resource.cfg and CGI.cfg The resource and CGI configuration objects are now specific to each monitoring poller.
The values of $USERx$ macros can be different from one poller to another.

Interval length The interval_length is now a global parameter that you have to set in Administration >
Options > Monitoring, although it should be left at 60 seconds in most cases.

Centstorage

Supported data source types Centreon Broker now supports all of the RRDtool data source types (COUNTER,
GAUGE, DERIVE and ABSOLUTE). This support will not be added to Centstorage as it will soon be replaced by
Centreon Broker.

See the Centreon Broker documentation to learn how you can convert your existing plugins.

Note : Des versions plus récentes sont disponibles au téléchargement download portal. Il est vivement recommandé de
mettre à jour vitre plate-frome afin d’éviter les bugs et les problémes de sécurité.

2.6. Centreon 2.4
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Il est très important lorsque vous souhaitez mettre à jour votre système de vous reporter à cette section afin de connaître
les changements de comportement ou les changements majeurs qui ont été opérés sur cette version. Cela vous permettra
de connaître l’impact de l’installation de ces versions sur les fonctionnalités que vous utilisez ou sur les développe-
ments spécifiques que vous avez intégrés sur votre plateforme (modules, widgets, plugins).

Si vous avez des questions ou besoins de compléments relatifs au contenu des notes, vous pouvez poser vos questions
sur notre github.

Afin de régler les problèmes de vue concernant toutes les widgets vous devez vider votre cache.
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CHAPITRE 3

Politique de cycle de vie des solutions

À partir de Centreon 18.10, la société Centreon publiera de nouvelles versions de Centreon sur une cadence régulière,
permettant à la communauté, aux entreprises et aux développeurs de planifier leurs feuilles de route avec la certitude
d’avoir accès aux nouvelles sources ouvertes en amont capacités.

3.1 Les numéros de version sont AA.MM

Les versions de Centreon sont nommées par l’année et le mois de livraison. Par exemple, Centreon 18.10 a été livrée
en Octobre 2018. Tous les modules et composants de la collection de logiciels Centreon possède le même numéro de
version.

3.2 Cadence de publication

La société Centreon prévoit de publier 2 versions par an. La première en avril et la seconde en octobre. Entre ces deux
versions majeures, Centreon fournira de manière continue des versions mineures, y compris des correctifs de sécurité,
des correctifs et améliorations.

3.3 Mises à jour de maintenance et de sécurité

Le cycle de vie d’une version est divisé en 3 phases :

1. Première phase : bogues de toute criticité (minor, major, critical, blocking) et correction de sécurité seront
traités par priorité

2. Seconde phase : bogues et correction de sécurité de criticité major, critical et blocking seront traités par priorité

3. Troisième phase : bogues et correction de sécurité de criticité blocking seront traités par priorité

Note : La gravité et la hiérarchisation des bogues sont la responsabilité de l’équipe Centreon

La deuxième phase d’une version commence lorsque la prochaine version majeure est disponible. Par exemple, la
publication de Centreon 19.04 lance la deuxième phase de Centreon 18.10.

La troisième phase d’une version commence lorsque la deuxième version majeure suivante est disponible. Par exemple,
la sortie de Centreon 19.10 lance la troisième phase de Centreon 18.10 et la deuxième phase de Centreon 19.04.

Le schéma présente le cycle de vie Centreon :
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3.4 Tableau de maintenance des anciens produits

Note : Tous les autres produits non décrits dans les tableaux suivants ne sont plus pris en charge par Centreon.

3.4.1 Centreon OSS 3.4

Product Version Release date End of life State
Centreon Web 2.8.x 2016/11/14 Centreon 20.04 Blocking & security issues
Centreon Engine 1.8.x 2017/09/19 Centreon 20.04 Blocking & security issues
Centreon Broker 3.0.x 2016/11/14 Centreon 20.04 Blocking & security issues
Centreon DSM 2.x 2014/09/01 Centreon 20.04 Blocking & security issues
Centreon Open Tickets 1.2.x 2016/06/20 Centreon 20.04 Blocking & security issues
Centreon AWIE 1.x 2018/04/11 Centreon 20.04 Blocking & security issues
Centreon Poller Display 1.5.x 2018/04/11 Centreon 20.04 Blocking & security issues
Centreon Widgets 1.x N/A Centreon 20.04 Blocking & security issues
Centreon Plugins YYYYMMDD N/A Centreon 20.04 Blocking & security issues

3.4.2 Centreon IMP 3.4

Product Version Release date End of life State
Centreon OSS 3.4 2016/11/14 Centreon 20.04 Blocking & security issues
Centreon License Manager 1.1.x 2018/02/23 Centreon 20.04 Blocking & security issues
Centreon Plugin Packs Manager 2.4.x 2018/05/30 Centreon 20.04 Blocking & security issues
Plugin Packs 3.x N/A N/A All issues

3.4.3 Centreon EMS 3.4

Product Version Release date End of life State
Centreon IMP 3.4 2016/11/14 Centreon 20.04 Blocking & security issues
Centreon BAM 3.6.x 2018/02/22 Centreon 20.04 Blocking & security issues
Centreon MAP 4.4.x 2017/01/02 Centreon 20.04 Blocking & security issues
Centreon MBI 3.2.x 2018/07/09 Centreon 20.04 Blocking & security issues
Centreon Auto Discovery 2.3.x 2017/08/24 Centreon 20.04 Blocking & security issues
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CHAPITRE 4

Installation

Ce chapitre décrit les différentes étapes de mise en place d’une plate-forme de supervision basée sur Centreon.

La plate-forme de supervision peut-être installée de plusieurs manières. Cependant, nous vous recommandons vive-
ment d’utiliser Centreon ISO pour installer votre plate-forme. Profitez ainsi de nos travaux d’industrialisation de
l’installation et de la mise à jour de l’environnement. Profitez également des optimisations installées en standard par
le système.

L’installation de Centreon peut être effectuée à partir des sources (tar.gz) mais le travail est plus complexe. De plus
l’installeur ne sera supporté que par la communauté.

Avant toute installation, veillez à bien suivre les pré-requis d’installation et de dimensionnement (ressources CPU,
mémoire, disques, partitionnement, etc...). Prenez également soin de bien choisir le type d’architecture qu’il convient
de pour vos besoins.

Enfin, vous pourrez procéder à l’installation de la plate-forme.

4.1 Prérequis

L’interface Centreon web est compatible avec les navigateurs web suivants :
— Chrome (latest version)
— Firefox (latest version)
— Internet Explorer IE 11 (latest version)
— Safari (latest version)

Votre résolution doit être au minimum à 1280 x 768.

4.1.1 Logiciels

Système d’exploitation

Centreon propose un fichier ISO incluant la distribution CentOS 7 et tous les paquets nécessaires à l’installation.

Si vous préférez utiliser Red Hat OS vous devez installer une version 7 du système puis y installer les rpms disponible
dans nos dépôts de téléchargement.

Enfin, vous pouvez utiliser une autre distribution GNU/Linux mais l’installation de la plate-forme sera plus complexe
à partir des fichiers sources de chaque composant.

Note : Seuls les systèmes d’exploitation 64bits (x86_64) sont supportés.
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SGBD

Centreon vous recommande d’utiliser MariaDB plutôt que le moteur MySQL.

Logiciel Version
MariaDB >= 10.1.29
MySQL >= 5.6.16

Dépendances logicielles

Le tableau suivant décrit les dépendances logicielles :

Logiciel Version
Apache 2.4
GnuTLS >= 2.0
Net-SNMP 5.7
openssl >= 1.0.1k
PHP 7.1 & 7.2
Qt >= 4.7.4
RRDtools 1.4.7
zlib 1.2.3

4.1.2 Sélectionner votre architecture

Le tableau suivant présente les prérequis pour une installation de Centreon :

Nombre de services Nombre d’hôtes estimé Nombre de collecteurs Central Collecteur
< 500 50 1 central 1 vCPU / 1 GB
500 - 2000 50 - 200 1 central 2 vCPU / 2 GB
2000 - 7000 200 - 700 1 central + 1 collecteur 4 vCPU / 4 GB 2 vCPU / 4 GB
7000 - 14000 700 - 1400 1 central + 2 collecteurs 4 vCPU / 8 GB 2 vCPU / 4 GB
14000 - 21000 1400 - 2100 1 central + 3 collecteurs 4 vCPU / 8 GB 4 vCPU / 4 GB
21000 - 28000 2100 - 2800 1 central + 4 collecteurs 4 vCPU / 8 GB 4 vCPU / 4 GB
... ... ... ... ...

Note : Un collecteur peut superviser en moyenne 7000 services actifs. Les vCPU doivent avoir une fréquence avoi-
sinant les 3 GHz. Le nombre de vCPU par collecteur dépend principalement de la complexité des contrôles. Si vous
utilisez des connecteurs ou réalisez de nombreux appels vers des applications tierces, ajoutez des vCPU supplémen-
taires.

Ces informations sont à mettre en corrélation avec vos besoins techniques liés au découpage géographique ou topo-
logiques de votre système. Pour voir ce qu’il est possible de faire avec centreon à ce sujet, reportez vous au chapitre
Architectures possibles.

4.1.3 Définition de l’espace disque

L’espace disque utilisé pour supporter les données issues de la collecte dépend de plusieurs critères :
— Fréquence des contrôles
— Nombre de contrôles
— Durée de rétention programmée

Le tableau suivant propose une idée de la volumétrie de votre plate-forme :
— Les données sont collectées toutes les 5 minutes
— La période de rétention programmée est de 6 mois
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— Deux courbes sont présentes par graphique de performance
Nombre de services /var/lib/mysql /var/lib/centreon
< 500 10 GB 2.5 GB
500 - 2000 42 GB 10 GB
2000 - 10000 126 GB 30 GB
10000 - 20000 252 GB 60 GB
20000 - 50000 660 GB 150 GB
50000 - 100000 1.4 TB 600 GB

4.1.4 Définition des partitions

Note : Votre système doit utiliser LVM pour gérer vos partitions.

Serveur Centreon

Description des partitions :

Partition Taille
swap 1 à 1.5 la taille totale de la mémoire vive
/ au moins 20 Go
/var/log au moins 10 Go
/var/lib/centreon défini dans le chapitre précédant
/var/lib/centreon-
broker

au moins 5 Go

/var/cache/centreon/backupau moins 10 Go (penser à exporter les sauvegarde de manière régulière puis supprimer
les données exportées)

SGBD MariaDB

Note : 1 Go d’espace libre non alloué doit être disponible sur le volum group hébergeant la partition /var/lib/mysql
lorsque vous souhaitez utiliser le mode de sauvegarde snapshot LVM.

Description des partitions :

Partition Taille
swap 1 à 1.5 la taille totale de la mémoire vive
/ au moins 20 Go
/var/log au moins 10 Go
/var/lib/mysql défini dans le chapitre précédant
/var/cache/centreon/backupau moins 10 Go (penser à exporter les sauvegarde de manière régulière puis supprimer

les données exportées)

Collecteur de supervision

Description des partitions :

4.1. Prérequis
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Partition Taille
swap 1 à 1.5 la taille totale de la mémoire vive
/ au moins 20 Go
/var/log au moins 10 Go
/var/lib/centreon-
broker

au moins 5 Go

/var/cache/centreon/backupau moins 5 Go (penser à exporter les sauvegarde de manière régulière puis supprimer les
données exportées)

4.1.5 Utilisateurs et groupes

Note : Ces données sont présentées pour les systèmes Red Hat / CentOS. Les noms des groupes, utilisateurs et services
peuvent changer suivant la distribution GNU/Linux.

Description des logiciels et utilisateurs liés :

Logiciel Service Utilisateur Commentaire
Apache httpd apache démarrage automatique
MySQL (MariaDB) mysqld (mysql) mysql démarrage automatique
Centreon centcore centreon démarrage automatique
Centreon centreontrapd centreon démarrage automatique
Centreon Broker cbwd centreon-broker démarrage automatique
Centreon Broker cbd centreon-broker démarrage automatique
Centreon Engine centengine centreon-engine démarrage automatique

Description des logiciels optionnels et utilisateurs liés :

Logiciel Service Utilisateur Commentaire
Centreon VMware centreon_vmware centreon non installé par défaut
RRDtool rrdcached rrdcached non activé et non parémétré dans Centreon par défaut

Description des groupes et utilisateurs liés :

Groupe Utilisateurs
apache nagios,centreon
centreon centreon-engine,centreon-broker,apache
centreon-broker centreon,nagios,centreon-engine,apache
centreon-engine centreon-broker,apache,nagios,centreon

Description des utilisateurs, umask et répertoire utilisateur :

Utilisateur umask home
root 0022 /root
apache 0022 /var/www
centreon 0002 /var/spool/centreon
centreon-broker 0002 /var/lib/centreon-broker
centreon-engine 0002 /var/lib/centreon-engine
mysql 0002 /var/lib/mysql

4.2 Architectures possibles

Centreon permet plusieurs choix dans la composition de l’architecture de votre outil de supervision. D’une architecture
relativement simple avec un serveur hébergeant tous les services, l’architecture peut aussi être organisée autour d’un
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découpage stratégique permettant de répartir la charge de collecte sur plusieurs serveur avec la mise en place de points
de collecte sur plusieurs contninents.

Vous trouverez ici toutes les architectures supportées.

4.2.1 Architecture simple

Fonctionnement

L’architecture simple consiste à avoir toutes les entités de supervision au sein du même serveur, à savoir :
— L’interface web de Centreon
— La base de données (MySQL + RRD)
— Le moteur de supervision
— Le broker

Cette architecture est la plus simple qu’un utilisateur peut rencontrer.

Entités

Plusieurs entités servent à mettre en place cette architecture :
— Le serveur Apache est chargé d’héberger l’interface web de Centreon
— Plusieurs bases de données MySQL sont chargées de stocker la configuration de Centreon, les informations de

supervision ainsi que les données de performances
— Le moteur de supervision supervise le système d’informations
— Les informations de supervision sont envoyées via cbmod à Centreon Broker SQL
— Centreon Broker SQL est chargé d’insérer les données de supervision en base de données et de transmettre les

données de performances à Centreon Broker RRD
— Centreon Broker RRD est chargé de générer les fichiers RRD (qui servent à générer les graphiques de perfor-

mances)

Architecture

Le schéma ci-dessous résume le fonctionnement de l’architecture :
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4.2.2 Architecture distribuée

Fonctionnement

L’architecture distribuée consiste à avoir deux types d’entités :
— Le serveur central qui centralise les informations de supervision
— Un ou plusieurs collecteurs qui sont chargés de la supervision des équipements

Le serveur central regroupe les éléments suivants :
— L’interface web de Centreon
— La base de données (MySQL + RRD)
— Le moteur de supervision
— Le broker

Le serveur satellite a les éléments suivants :
— Le moteur de supervision
— Le module de broker qui permet l’envoi des informations de supervision vers le serveur central

Cette architecture a plusieurs intérêts :
— Elle permet la répartition de la charge de supervision entre plusieurs serveurs de supervision
— Isolation des flux réseaux : si votre infrastructure de supervision est chargée de superviser une DMZ, il est plus

simple (et sécurisant) de placer un serveur satellite sur le réseau DMZ
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Entités

Serveur central

Le serveur central fonctionne de la manière suivante :
— Le serveur Apache est chargé d’héberger l’interface web de Centreon
— Plusieurs bases de données MySQL sont chargées de stocker la configuration de Centreon, les informations de

supervision ainsi que les données de performances
— Le service CentCore est chargé d’exporter la configuration des moteurs de supervision vers le serveur central

et satellites ainsi que du redémarrage des moteurs de supervision
— Le moteur de supervision supervise le système d’informations
— Les informations de supervision sont envoyées via cbmod à Centreon Broker SQL
— Centreon Broker SQL est chargé d’insérer les données de supervision en base de données et de transmettre les

données de performances à Centreon Broker RRD
— Centreon Broker RRD est chargé de générer les fichiers RRD (qui servent à générer les graphiques de perfor-

mances)

Collecteur

Le collecteure fonctionne de la manière suivante :
— Le moteur de supervision supervise le système d’informations
— Les informations de supervision sont envoyées via cbmod au service Centreon Broker SQL hébergé sur le

serveur Central

Architecture

Le schéma ci-dessous résume le fonctionnement de l’architecture :

4.2.3 Architecture distribuée et base de données déportée

Fonctionnement

L’architecture distribuée avec base de données déportée consiste à avoir trois types d’entités :
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— Le serveur central qui centralise les informations de supervision
— Un serveur de base de données chargée de stocker toutes les bases de données
— Un ou plusieurs collecteur qui sont chargés de la supervision des équipements

Le serveur central regroupe les éléments suivants :
— L’interface web de Centreon
— Le moteur de supervision
— Le broker
— Les fichiers RRD

Le serveur de base de données est chargé de stocker la base de données MySQL.

Le collecteur regroupe les éléments suivants :
— Le moteur de supervision
— Le module de broker qui permet l’envoi des informations de supervision vers le serveur central

Cette architecture a plusieurs intérêts :
— Elle permet la répartition de la charge de supervision entre plusieurs serveurs de supervision
— Isolation des flux réseaux : si votre infrastructure de supervision est chargée de superviser une DMZ, il est plus

simple (et sécurisant) de placer un collecteur sur le réseau DMZ
— Avoir une base de données MySQL externalisée

Entités

Serveur de base de données

Le serveur de base de données sert uniquement à stocker la configuration de Centreon, les informations de supervision
ainsi que les données de performances au sein de la base de données MySQL.

Serveur central

Le serveur central fonctionne de la manière suivante :
— Le serveur Apache est chargé d’héberger l’interface web de Centreon
— Le serveur central récupère la configuration ainsi que les informations de supervision en se connectant au

serveur de base de données
— Le service CentCore est chargé d’exporter la configuration des moteurs de supervision vers le serveur central

et collecteurs ainsi que du redémarrage des moteurs de supervision
— Le moteur de supervision supervise le système d’informations
— Les informations de supervision sont envoyées via cbmod à Centreon Broker SQL
— Centreon Broker SQL est chargé d’insérer les données de supervision en base de données et de transmettre les

données de performances à Centreon Broker RRD
— Centreon Broker RRD est chargé de générer les fichiers RRD (qui servent à générer les graphiques de perfor-

mances)

Collecteur

Le collecteur fonctionne de la manière suivante :
— Le moteur de supervision supervise le système d’informations
— Les informations de supervision sont envoyées via cbmod au service Centreon Broker SQL hébergé sur le

serveur Central
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Architecture

Le schéma ci-dessous résume le fonctionnement de l’architecture :

4.2.4 Architecture distribuée redondante

Fonctionnement

L’architecture distribuée redondante consiste à avoir deux types d’entités :
— Le serveur central qui centralise les informations de supervision
— Un ou plusieurs collecteurs qui sont chargés de la supervision des équipements

Afin d’assurer une redondance, le serveur central est répliqué à l’identique.

Les serveurs centraux regroupent les éléments suivants :
— L’interface web de Centreon
— Le moteur de supervision
— Le broker
— Les bases de données (MySQL + RRD)

Le collecteur contient les éléments suivants :
— Le moteur de supervision
— Le module de broker qui permet l’envoi des informations de supervision vers le serveur central

Cette architecture a plusieurs intérêts :
— Elle permet la répartition de la charge de supervision entre plusieurs serveurs de supervision
— Isolation des flux réseaux : si votre infrastructure de supervision est chargée de superviser une DMZ, il est plus

simple (et sécurisant) de placer un collecteur sur le réseau DMZ
— Avoir une redondance au niveau des serveurs Centraux, si un serveur central tombe alors le second serveur

central existe toujours et permet d’assurer une continuité de service

Entités

Serveur centraux

Il existe deux types de serveur central :
— Un master qui fonctionne normalement
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— Un slave qui est configuré de la même manière que le serveur master mais qui n’a démarré que les services
Centreon Broker RRD et MySQL

Le serveur central master fonctionne normalement :
— Le serveur Apache est chargé d’héberger l’interface web de Centreon
— Plusieurs bases de données MySQL sont chargées de stocker la configuration de Centreon, les informations de

supervision ainsi que les données de performances
— Le service CentCore est chargé d’exporter la configuration des moteurs de supervision vers le serveur central

et collecteurs ainsi que du redémarrage des moteurs de supervision
— Le moteur de supervision supervise le système d’informations
— Les informations de supervision sont envoyées via cbmod à Centreon Broker SQL
— Centreon Broker SQL est chargé d’insérer les données de supervision en base de données et de transmettre les

données de performances aux 2 services Centreon Broker RRD (le premier se situe sur le master et l’autre sur
le slave)

— Centreon Broker RRD est chargé de générer les fichiers RRD (qui servent à générer les graphiques de perfor-
mances)

Une réplication MySQL permet de conserver la configuration de Centreon, les informations de supervision ainsi que
les données de performances entre les deux serveurs centraux.

Le serveur slave lui est uniquement chargé de générer les fichiers RRD.

En cas de panne du master, on démarre les services : Apache, CentCore, Centreon Engine ainsi que Centreon Broker
SQL sur le serveur slave. Le serveur slave remplace le serveur master.

La bascule master/slave ainsi que le démarrage et l’arrêt des services sont gérés par le couple Corosync + Pacemaker.

Architecture

Le schéma ci-dessous résume le fonctionnement de l’architecture :

4.2.5 Architecture distribuée avec Remote Server

Centreon Remote Server est un nouveau module de l’architecture de supervision distribuée Centreon. Il s’ajoute aux
serveurs Centreon Central et collecteurs Centreon existants.

Centreon Remote Server permet aux équipes d’exploitation informatiques distantes de bénéficier de l’expérience uti-
lisateur complète de Centreon, mais pour un sous-ensemble de Centreon Pollers. La configuration de la supervision
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s’effectue sur le serveur central et est synchronisée avec tous les serveurs distants. Les opérations de surveillance
(acquittement, temps d’arrêt, etc.) peuvent avoir lieu à la fois sur un serveur distant et sur le serveur central.

En cas de défaillance de la liaison réseau entre un serveur distant et le serveur central, les données sont conservées et
les deux serveurs sont synchronisés dès que la connexion est rétablie.

Centreon Remote Server est intégré au cœur de Centreon. Il remplace complètement le module Poller Display.

Fonctionnement

L’architecture distribuée avec Remote Server consiste à avoir trois types d’entités :
— Le serveur central qui centralise les informations de supervision et permet de configurer la supervision
— Un ou plusieurs collecteurs qui sont chargés de la supervision des équipements
— Un ou plusieurs Remote Server pour afficher et opérer sur un sous-ensemble des données collectées

Les serveurs centraux regroupent les éléments suivants :
— L’interface web de Centreon (configuration, présentation et opération)
— Le moteur de supervision
— Le broker
— Les bases de données (MySQL + RRD)

Le Remote Server regroupe les éléments suivants :
— L’interface web de Centreon (présentation et opération d’un sous-ensemble des données)
— Le moteur de supervision
— Le broker
— Les bases de données (MySQL + RRD)

Le collecteur contient les éléments suivants :
— Le moteur de supervision
— Une interface web de Centreon minimaliste

Cette architecture a plusieurs intérêts :
— Elle permet la répartition de la charge de supervision entre plusieurs serveurs de supervision
— Isolation des flux réseaux : si votre infrastructure de supervision est chargée de superviser une DMZ, il est plus

simple (et sécurisant) de placer un collecteur sur le réseau DMZ
— Disposer d’une interface web déportée afin de pouvoir consulter les éléments supervisés d’un sous ensemble

Entités

Serveur central

Le serveur central fonctionne normalement :
— Le serveur Apache est chargé d’héberger l’interface web de Centreon
— Plusieurs bases de données MySQL sont chargées de stocker la configuration de Centreon, les informations de

supervision ainsi que les données de performances
— Le service CentCore est chargé d’exporter la configuration des moteurs de supervision vers le serveur central

et collecteurs ainsi que du redémarrage des moteurs de supervision
— Le moteur de supervision supervise le système d’informations
— Les informations de supervision sont envoyées via cbmod à Centreon Broker SQL
— Centreon Broker SQL est chargé d’insérer les données de supervision en base de données et de transmettre les

données de performances à Centreon Broker RRD
— Centreon Broker RRD est chargé de générer les fichiers RRD (qui servent à générer les graphiques de perfor-

mances)

4.2. Architectures possibles
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Remote Server

Le Remote Server fonctionne normalement :
— Le serveur Apache est chargé d’héberger l’interface web de Centreon
— Plusieurs bases de données MySQL sont chargées de stocker les informations de supervision ainsi que les

données de performances
— Le service CentCore est chargé d’opérer sur les données collectées
— Le moteur de supervision supervise le système d’informations
— Les informations de supervision sont envoyées via cbmod à Centreon Broker SQL
— Centreon Broker SQL est chargé d’insérer les données de supervision en base de données et de transmettre

les données de performances à Centreon Broker RRD localement et vers Centreon Broker SQL du serveur
Centreon Central

— Centreon Broker RRD est chargé de générer les fichiers RRD (qui servent à générer les graphiques de perfor-
mances)

Collecteur

Le collecteur fonctionne de la manière suivante :
— Le moteur de supervision supervise le système d’informations
— Les informations de supervision sont envoyées via cbmod à l’adresse IP virtuel qui factorise les deux serveurs

centraux. En fonction du serveur actif, ces informations sont envoyées à un des deux services Centreon Broker
SQL. Les informations de supervision sont également envoyées au collecteur même qui les traite en utilisant
également Centreon Broker SQL.

Architecture

Le schéma ci-dessous résume le fonctionnement de l’architecture :
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4.2.6 Tableau des flux réseau

Tableaux des flux d’intégration de la plate-forme de supervision dans le SI

Depuis Vers Proto-
cole

Port Application

Central
server

NTP
server

NTP UDP 123 Synchronisation de l’horloge système

Central
server

DNS
server

DNS UDP 53 Résolution des nom de domaine

Central
server

SMTP
server

SMTP TCP 25 Notification par mail

Central
server

LDAP(s)
server

LDAP(s) TCP 389
(636)

Authentification pour accéder à l’interface web Centreon

Central
server

DBMS
server

MySQL TCP 3306 Accès aux bases de données Centreon

Central
server

HTTP
Proxy

HTTP(s) TCP 80,
8080 (443)

Si votre plate-forme nécessite un proxy web pour accéder
à la solution Centreon IMP

Central
server

Reposi-
tory

HTTP
(FTP)

TCP 80 (FTP
20)

Dépôt des paquets systèmes et applicatifs

Depuis Vers Protocole Port Application
Collecteur NTP server NTP UDP 123 Synchronisation de l’horloge système
Collecteur DNS server DNS UDP 53 Résolution des nom de domaine
Collecteur SMTP server SMTP TCP 25 Notification par mail
Collecteur Repository HTTP (FTP) TCP 80 (FTP 20) Dépôt des paquets systèmes et applicatifs

Note : D’autres flux peuvent être nécessaires suivant le moyen d’authentification sélectionné (RADIUS, etc.) ou le
moyen de notification mis en oeuvre.

Tableau des flux de la supervision

Depuis Vers Proto-
cole

Port Application

Central serveur Collecteur SSH TCP 22 Export des configurations Centreon
Collecteur Central serveur BBDO TCP

5669
Transfert des données de supervision
collectées

Collecteur Equipements réseau,
serveurs, etc.

SNMP UDP
161

Supervision

Equipements
réseau

Collecteur Trap
SNMP

UDP
162

Supervision

Collecteur Servers NRPE TCP
5666

Supervision

Collecteur Servers NS-
Client++

TCP
12489

Supervision

Note : Dans le cas où le serveur central Centreon fait office de collecteur, ne pas oublier d’ajouter les flux nécessaires
de supervision.

Note : D’autres flux peuvent être nécessaires dans le cas de la supervision de bases de données, d’accès à des API,
d’accès à des ports applicatifs, etc.

Si vous avez des feedbacks relatifs à vos besoins en terme d’architecture, n’hésitez pas nous en faire part sur github.
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4.3 Téléchargements

De manière générale, les logiciels Open Sources fournis par Centreon sont disponibles sous 4 formats :
— ISO Linux basée sur la distribution CentOS v7 (recommandé)
— Paquets RPM pour la distribution CentOS v7 (recommandé)
— Machines virtuelles ; basées sur les distributions CentOS v7, aux formats OVA (VMware) et OVF (VirtualBox

et autres).
— Archives contenant les sources

Les paquets RPM sont le meilleur format pour obtenir nos logiciels. Ces derniers ont été packagés par des experts
Centreon et permettent de ne pas se soucier du processus d’installation.

Si votre plate-forme ne supporte pas les paquets RPMs, vous devrez utiliser les archives contenant les sources des
versions stables de nos logiciels et installer ces derniers manuellement. La compilation manuelle de certains paquets
peut être complexe.

Note : Centreon recommande l’utilisation de la version packagée Centreon ISO. L’installation est détaillée au chapitre
A partir de Centreon ISO

Vous pouvez télécharger les sources de nos produits ici

4.4 A partir de l’ISO Centreon el7

4.4.1 Installation

Etape 1 : Démarrage

Afin d’installer Centreon, démarrez votre serveur sur l’image ISO de Centreon en version el7. Démarrez avec l’option
Install CentOS 7 :
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Etape 2 : Choix de la langue

Choisissez la langue du processus d’installation puis cliquez sur Done :

Etape 3 : Sélection des composants

Cliquez sur le menu Installation Type :

Il est possible de choisir différentes options :

4.4. A partir de l’ISO Centreon el7
CENTREON 46-52 RUE ALBERT FR75014 PARIS

61



— Central with database : Installe Centreon (interface web + base de données) ainsi que l’ordonnanceur et le
broker

— Central without database : Installe Centreon (interface web uniquement) ainsi que l’ordonnanceur et le broker
— Poller : Installe le serveur satellite (ordonnanceur et broker uniquement)
— Database only : Installe le serveur de base de données (utilisé en complément avec l’option Central server

without database)

Etape 4 : Configuration système

Partitionnement des disques

Cliquez sur le menu Installation Destination :
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Sélectionnez le disque dur et l’option I will configure partitioning puis cliquez sur “Done :

A l’aide du bouton + créez votre partitionnement suivant les prérequis de la documentation puis cliquez sur Done :
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Une fenêtre de confirmation apparaît, cliquez sur Accept Changes pour valider le partitionnement :

Configuration réseau

Cliquez sur le menu Network & Hostname :
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Activez toutes les cartes réseaux, saisissez le nom de votre serveur puis cliquez sur Done :

Configuration du fuseau horaire

Cliquez sur le menu Date & Time :
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Sélectionnez votre fuseau horaire et cliquez sur le bouton de configuration :

Activez ou ajouter des serveurs NTP, cliquez sur OK puis Done :
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Démarrage de l’installation

Une fois toutes les options configurées, cliquez sur Begin Installation :

Cliquez sur Root Password :
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Saisissez et confirmez le mot de passe de l’utilisateur root. Cliquez sur Done :

Patientez pendant le processus d’installation :
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Lorsque l’installation est terminée, cliquez sur Reboot.

Mise à jour du système d’exploitation

Connectez-vous via un terminal et exécutez la commande :

# yum update
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Acceptez toutes les clés GPG proposées :

Redémarrez votre système avec la commande :

# reboot

4.4.2 Configuration

Connectez-vous à l’interface web via http://[ADRESSE_IP_DE_VOTRE_SERVEUR]/centreon. L’assistant de confi-
guration de Centreon s’affiche, cliquez sur Next.

L’assistant de configuration de Centreon contrôle la disponibilité des modules, cliquez sur Next.
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Cliquez sur Next.

Cliquez sur Next.

Définissez les informations concernant l’utilisateur admin, cliquez sur Next.
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Par défaut, le serveur ‘localhost’ est défini et le mot de passe root est vide. Si vous utilisez un serveur de base de
données déporté, il convient de modifier ces deux informations. Dans notre cas, nous avons uniquement besoin de
définir un mot de passe pour l’utilisateur accédant aux bases de données Centreon, à savoir ‘centreon’.

Cliquez sur Next.

Note : Si le message d’erreur suivant apparaît Add innodb_file_per_table=1 in my.cnf file under the [mysqld]
section and restart MySQL Server, Effectuez les opérations ci-dessous :

1. Connectez-vous avec l’utilisateur ‘root’ sur votre serveur

2. Editez le fichier suivant /etc/my.cnf
3. Ajoutez la ligne suivante au fichier :

[mysqld]
innodb_file_per_table=1

4. Redémarrez le service mysql :

# systemctl restart mysql

5. Cliquez sur Refresh

L’assistant de configuration configure les bases de données.

Cliquez sur Next.

72
CENTREON 46-52 RUE ALBERT FR75014 PARIS

Chapitre 4. Installation



L’assistant de configuration propose ensuite d’installer les modules présents sur le serveur Centreon.

Cliquez sur Install.

Une fois les modules installés, cliquez sur Next.

À cette étape une publicité permet de connaître les dernières nouveautés de Centreon. Si votre plate-forme est connec-
tée à Internet vous disposez des dernières informations, sinon l’information présente dans cette version sera proposée.
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L’installation est terminée, cliquez sur Finish.

Vous pouvez maintenant vous connecter.

Dans un premier temps, il est nécessaire de passer l’interface en version française. Pour cela :

1. Cliquez sur votre profil utilisateur en haut à droite de l’interface

2. Cliquez sur le bouton Edit profile
3. Dans le champ Language, remplacez en_US par fr_FR.UTF-8
4. Cliquez sur Save
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Pour démarrer l’ordonnanceur de supervision :

1. Sur l’interface web, rendez-vous dans le menu Configuration > Collecteurs
2. Laissez les options par défaut, et cliquez sur Exporter la configuration
3. Sélectionnez le collecteur Central dans la liste de sélection

4. Décochez Générer les fichiers de configuration et Lancer le débogage du moteur de supervision (-v)
5. Cochez Déplacer les fichiers générés ainsi que Redémarrer l’ordonnanceur
6. Cliquez à nouveau sur Exporter
7. Connectez-vous avec l’utilisateur ‘root’ sur votre serveur

8. Démarrez le composant Centreon Broker

# systemctl start cbd

9. Démarrez Centreon Engine

# systemctl start centengine

10. Démarrez centcore

# systemctl start centcore

11. Démarrez centreontrapd

# systemctl start centreontrapd

La supervision est maintenant opérationnelle.

Activer le lancement automatique de services au démarrage.

Lancer les commandes suivantes sur le serveur Central :

# systemctl enable centcore
# systemctl enable centreontrapd
# systemctl enable cbd
# systemctl enable centengine

L’interface web de Centreon est composée de plusieurs menus, chaque menu a une fonction bien précise :
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— Le menu Accueil permet d’accéder au premier écran d’accueil après s’être connecté. Il résume l’état général
de la supervision.

— Le menu Supervision regroupe l’état de tous les éléments supervisés en temps réel et en différé au travers de
la visualisation des logs

— Le menu Vues permet de visualiser et de configurer les graphiques de performances pour chaque élément du
système d’informations

— Le menu Rapports permet de visualiser de manière intuitive (via des diagrammes) l’évolution de la supervision
sur une période donnée

— Le menu Configuration permet de configurer l’ensemble des éléments supervisés ainsi que l’infrastructure de
supervision

— Le menu Administration permet de configurer l’interface web Centreon ainsi que de visualiser l’état général
des serveurs

4.4.3 Configurez votre supervision facilement

En lui-même Centreon est un excellent outil de supervision et peut être configuré pour correspondre exactement à
vos besoins. Cependant vous trouverez peut-être utile d’utiliser Centreon IMP pour vous aider à configurer rapide-
ment votre supervision. Centreon IMP vous fournit des Plugin Packs qui sont des paquets contenant des modèles de
configuration qui réduisent drastiquement le temps nécessaire pour superviser la plupart des services de votre réseau.

Centreon IMP nécessite les composants techniques Centreon License Manager et Centreon Plugin Pack Manager pour
fonctionner.

Si vous n’avez pas installé les modules durant l’instalaltion de Centreon, Rendez-vous au menu Administration >
Extensions > Modules.

Clicquez sur le bouton Install/Upgrade all et validez l’action :

Une fois l’instalaltion terminée, cliquez sur Back. Les modules sont maintenant installés :
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Vous pouvez maintenant vous rendre au menu Configuration > Extensions -> Plugin Packs. Vous y trouverez vos six
premiers Plugin Packs gratuits pour vous aider à démarrer. Cinq Plugin Packs supplémentaires sont débloqués après
vous être inscrit et plus de 150 sont disponibles si vous souscrivez à l’offre IMP (plus d’informations sur notre site
web).

Vous pouvez continuer à configurer votre supervision en utilisant Centreon IMP en suivant ce guide.

4.5 A partir des paquets

Centreon fournit des RPM pour ses produits au travers de la solution Centreon Open Sources disponible gratuitement
sur notre dépôt.

Ces paquets ont été testés avec succès sur les environnements CentOS et Red Hat en version 7.x.

4.5.1 Étapes pré-installation

SELinux doit être désactivé. Pour cela vous devez modifier le fichier /etc/selinux/config et remplacer “enforcing” par
“disabled” comme dans l’exemple suivant :

SELINUX=disabled

Note : Après avoir sauvegardé le fichier, veuillez redémarrer votre système d’exploitation pour prendre en compte les
changements.

Une vérification rapide permet de confirmer le statut de SELinux
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$ getenforce
Disabled

4.5.2 Installation des dépôts

Dépôt Software collections de Red Hat

Afin d’installer les logiciels Centreon, le dépôt Software collections de Red Hat doit être activé.

Note : Le dépôt Software collections est nécessaire pour l’installation de PHP 7 et les librairies associées.

Exécutez la commande suivante :

# yum install centos-release-scl

Le dépôt est maintenant installé.

Dépôt Centreon

Afin d’installer les logiciels Centreon à partir des dépôts, vous devez au préalable installer le fichier lié au dépôt.
Exécutez la commande suivante.

Installation :

# wget http://yum.centreon.com/standard/18.10/el7/stable/noarch/RPMS/centreon-release-18.10-2.el7.centos.noarch.rpm -O /tmp/centreon-release-18.10-2.el7.centos.noarch.rpm
# yum install --nogpgcheck /tmp/centreon-release-18.10-2.el7.centos.noarch.rpm

Le dépôt est maintenant installé.

4.5.3 Installation du serveur central

Ce chapitre décrit l’installation d’un serveur central Centreon.

Installer un serveur Centreon central avec base de données

Exécutez la commande :

# yum install centreon
# systemctl restart mysql

Installer un serveur Centreon central sans base de données

Exécutez la commande :

# yum install centreon-base-config-centreon-engine
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Installer MySQL sur un serveur dédié

Exécutez les commandes :

# yum install centreon-database
# systemctl restart mysql

Note : le paquet centreon-database installe un serveur de base de données optimisé pour l’utilisation avec Centreon.

Système de gestion de base de données

La base de données MySQL doit être disponible pour pouvoir continuer l’installation (localement ou non). Pour
information nous recommandons MariaDB.

Pour les systèmes CentOS / RHEL en version 7, il est nécessaire de modifier la limitation LimitNOFILE. Changer
cette option dans /etc/my.cnf NE fonctionnera PAS :

# mkdir -p /etc/systemd/system/mariadb.service.d/
# echo -ne "[Service]\nLimitNOFILE=32000\n" | tee /etc/systemd/system/mariadb.service.d/limits.conf
# systemctl daemon-reload
# systemctl restart mysql

Fuseau horaire PHP

La timezone par défaut de PHP doit être configurée. Executer la commande suivante :

# echo "date.timezone = Europe/Paris" > /etc/opt/rh/rh-php71/php.d/php-timezone.ini

Note : Changez Europe/Paris par votre fuseau horaire.

Après avoir réalisé la modification, redémarrez le service Apache :

# systemctl restart httpd

Pare-feu

Paramétrer le pare-feu système ou désactiver ce dernier. Pour désactiver ce dernier exécuter les commandes suivantes :

# systemctl stop firewalld
# systemctl disable firewalld
# systemctl status firewalld

Lancer les services au démarrage

Activer le lancement automatique de services au démarrage.

Lancer les commandes suivantes sur le serveur Central :
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# systemctl enable httpd
# systemctl enable snmpd
# systemctl enable snmptrapd
# systemctl enable rh-php71-php-fpm
# systemctl enable centcore
# systemctl enable centreontrapd
# systemctl enable cbd
# systemctl enable centengine

Note : Si la base de données MySQL est sur un serveur dédié, lancer la commande d’activation mysql sur ce dernier.

Terminer l’installation

Avant de démarrer la configuration via l’interface web les commandes suivantes doivent être exécutées :

# systemctl start rh-php71-php-fpm
# systemctl start httpd
# systemctl start mysqld
# systemctl start cbd
# systemctl start snmpd
# systemctl start snmptrapd

4.5.4 Configuration

Connectez-vous à l’interface web via http://[ADRESSE_IP_DE_VOTRE_SERVEUR]/centreon. L’assistant de confi-
guration de Centreon s’affiche, cliquez sur Next.

L’assistant de configuration de Centreon contrôle la disponibilité des modules, cliquez sur Next.
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Cliquez sur Next.

Cliquez sur Next.

Définissez les informations concernant l’utilisateur admin, cliquez sur Next.
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Par défaut, le serveur ‘localhost’ est défini et le mot de passe root est vide. Si vous utilisez un serveur de base de
données déporté, il convient de modifier ces deux informations. Dans notre cas, nous avons uniquement besoin de
définir un mot de passe pour l’utilisateur accédant aux bases de données Centreon, à savoir ‘centreon’.

Cliquez sur Next.

Note : Si le message d’erreur suivant apparaît Add innodb_file_per_table=1 in my.cnf file under the [mysqld]
section and restart MySQL Server, Effectuez les opérations ci-dessous :

1. Connectez-vous avec l’utilisateur ‘root’ sur votre serveur

2. Editez le fichier suivant /etc/my.cnf
3. Ajoutez la ligne suivante au fichier :

[mysqld]
innodb_file_per_table=1

4. Redémarrez le service mysql :

# systemctl restart mysql

5. Cliquez sur Refresh

L’assistant de configuration configure les bases de données.

Cliquez sur Next.
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L’assistant de configuration propose ensuite d’installer les modules présents sur le serveur Centreon.

Cliquez sur Install.

Une fois les modules installés, cliquez sur Next.

À cette étape une publicité permet de connaître les dernières nouveautés de Centreon. Si votre plate-forme est connec-
tée à Internet vous disposez des dernières informations, sinon l’information présente dans cette version sera proposée.
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L’installation est terminée, cliquez sur Finish.

Vous pouvez maintenant vous connecter.

Dans un premier temps, il est nécessaire de passer l’interface en version française. Pour cela :

1. Cliquez sur votre profil utilisateur en haut à droite de l’interface

2. Cliquez sur le bouton Edit profile
3. Dans le champ Language, remplacez en_US par fr_FR.UTF-8
4. Cliquez sur Save
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Pour démarrer l’ordonnanceur de supervision :

1. Sur l’interface web, rendez-vous dans le menu Configuration > Collecteurs
2. Laissez les options par défaut, et cliquez sur Exporter la configuration
3. Sélectionnez le collecteur Central dans la liste de sélection

4. Décochez Générer les fichiers de configuration et Lancer le débogage du moteur de supervision (-v)
5. Cochez Déplacer les fichiers générés ainsi que Redémarrer l’ordonnanceur
6. Cliquez à nouveau sur Exporter
7. Connectez-vous avec l’utilisateur ‘root’ sur votre serveur

8. Démarrez le composant Centreon Broker

# systemctl start cbd

9. Démarrez Centreon Engine

# systemctl start centengine

10. Démarrez centcore

# systemctl start centcore

11. Démarrez centreontrapd

# systemctl start centreontrapd

La supervision est maintenant opérationnelle.

Activer le lancement automatique de services au démarrage.

Lancer les commandes suivantes sur le serveur Central :

# systemctl enable centcore
# systemctl enable centreontrapd
# systemctl enable cbd
# systemctl enable centengine

L’interface web de Centreon est composée de plusieurs menus, chaque menu a une fonction bien précise :
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— Le menu Accueil permet d’accéder au premier écran d’accueil après s’être connecté. Il résume l’état général
de la supervision.

— Le menu Supervision regroupe l’état de tous les éléments supervisés en temps réel et en différé au travers de
la visualisation des logs

— Le menu Vues permet de visualiser et de configurer les graphiques de performances pour chaque élément du
système d’informations

— Le menu Rapports permet de visualiser de manière intuitive (via des diagrammes) l’évolution de la supervision
sur une période donnée

— Le menu Configuration permet de configurer l’ensemble des éléments supervisés ainsi que l’infrastructure de
supervision

— Le menu Administration permet de configurer l’interface web Centreon ainsi que de visualiser l’état général
des serveurs

4.5.5 Configurez votre supervision facilement

En lui-même Centreon est un excellent outil de supervision et peut être configuré pour correspondre exactement à
vos besoins. Cependant vous trouverez peut-être utile d’utiliser Centreon IMP pour vous aider à configurer rapide-
ment votre supervision. Centreon IMP vous fournit des Plugin Packs qui sont des paquets contenant des modèles de
configuration qui réduisent drastiquement le temps nécessaire pour superviser la plupart des services de votre réseau.

Centreon IMP nécessite les composants techniques Centreon License Manager et Centreon Plugin Pack Manager pour
fonctionner.

Si vous n’avez pas installé les modules durant l’instalaltion de Centreon, Rendez-vous au menu Administration >
Extensions > Modules.

Clicquez sur le bouton Install/Upgrade all et validez l’action :

Une fois l’instalaltion terminée, cliquez sur Back. Les modules sont maintenant installés :
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Vous pouvez maintenant vous rendre au menu Configuration > Extensions -> Plugin Packs. Vous y trouverez vos six
premiers Plugin Packs gratuits pour vous aider à démarrer. Cinq Plugin Packs supplémentaires sont débloqués après
vous être inscrit et plus de 150 sont disponibles si vous souscrivez à l’offre IMP (plus d’informations sur notre site
web).

Vous pouvez continuer à configurer votre supervision en utilisant Centreon IMP en suivant ce guide.

4.6 A partir des VMs

Deux machines virtuelles pré-configurées sont disponibles sur le site de téléchargement de Centreon.

Ces machines virtuelles sont disponibles au format OVA (VMware) et OVF (VirtualBox).

4.6.1 Serveur Centreon central

Import

Il est dans un premier temps nécessaire d’importer le ficher OVF. Pour cela, sur le client VSphere allez dans le menu
File > Deploy OVF Template et sélectionnez le ficher précedemment téléchargé. Il est alors nécessaire de suivre les
différents menus. Les différents choix sont trés liés à l’infrastructure VMWare en place, il est difficile d’être rééllement
spécifique dans cette documentation. Il est important de noter que les bonnes pratiques sont de choisir le mode Thin
Provision qui vous permettra d’économiser de l’espace disque sur vos datastores.
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Connexion

La machine est configurée avec des comptes par défaut.

Vous pourrez donc vous connecter à l’interface web avec le compte : admin/centreon. Vous pourez aussi vous connec-
ter en SSH avec le compte root/centreon. Le mot de passe de de l’utilisateur root de la base de données n’est pas
initialisé.

Note : Pour des raisons de sécurité, il est recommandé de changer tous ces mots de passe aprés l’installation

A la première connexion, un message indique les opérations à réaliser. Suivez celles-ci, spécialement les opérations
4 et 5.

Note : Pour supprimer ce message, supprimez le fichier /etc/profile.d/centreon.sh.

4.6.2 Collecteur

Le déploiement d’un collecteur de supervision (poller) à partir de la machine virtuelle est trés similaire à celle d’un
serveur Centtreon central. Après déploiement, il est nécessaire d’ajouter à cette procédure l’échange des clefs SSH et
la configuration du collecteur via l’interface Web :

Echange des clefs SSH

La communication entre le serveur central et un collecteur se fait via SSH.

Vous devez échanger les clés SSH entre les serveurs.

Si vous n’avez pas de clé SSH privées sur le serveur central pour l’utilisateur ‘centreon’

# su - centreon
$ ssh-keygen -t rsa

Vous devez copier cette clé sur le nouveau serveur :

# su - centreon
$ ssh-copy-id -i .ssh/id_rsa.pub centreon@IP_POLLER

le mot de passe de l’utilisateur centreon sur le collecteur est configuré par défaut à centreon. Il est fortement conseillé
de la changer en utilisant la commande passwd.

Configuration de l’interface Web

4.6.3 Configurer un nouveau collecteur dans Centreon

Depuis Centreon 18.10, un assistant de configuration est disponible pour ajouter un collecteur à la plate-forme Cen-
treon.

Note : Il est possible d’ajouter un nouveau collecteur manuellement, cependant Centreon recommande d’utiliser la
procédure suivante.

Rendez-vous dans le menu Configuration > Pollers et cliquez sur Add server with wizard pour accéder à l’assistant
de configuration.

Sélectionnez Add a Centreon Poller et cliquez sur Next :
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Saisissez le nom, l’adresse IP du collecteur et celle du serveur Centreon central, cliquez sur Next :

Note : L’adresse IP du collecteur est l’adresse IP ou le FQNS pour accéder au collecteur depuis le serveur Centreon
Central.

L’adresse IP du collecteur est l’adresse IP ou le FQNS pour accéder au collecteur serveur Centreon Central vers le
collecteur.

Si vous souhaitez lier ce collecteur au serveur Centreon Central, cliquez sur Apply :
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Sinon, si vous souhaitez lier ce collecteur à un Remote Server, sélectionnez le Remote Server dans la liste et cliquez
sur Apply :

Note : Si vous souhaitez changer le sens de connexion des données entre le serveur Centreon central et le collecteur,
cochez la case Advanced : reverse Centreon Broker communication flow.

Patientez quelques secondes, l’assistant va configurer votre nouveau serveur.

Le collecteur est maintenant configuré :

Rendez-vous au chapitre Configuration simplifiée avec Centreon IMP pour mettre en place votre première supervision.

4.7 A partir des sources

4.7.1 Prérequis

CentOS

La plupart des utilisateurs de CentOS préfèreront installer Centreon Web en utilisant les paquets fournis par Centreon.

Les environnements CentOS et RHEL ne possèdent pas en standard sur dépôts l’intégralité des dépendances néces-
saires à l’installation de Centreon. Vous devez ajouter le dépôt RPM Forge

Système el7 :

$ wget http://repository.it4i.cz/mirrors/repoforge/redhat/el7/en/x86_64/rpmforge/RPMS/rpmforge-release-0.5.3-1.el7.rf.x86_64.rpm
$ wget https://repository.it4i.cz/mirrors/repoforge/RPM-GPG-KEY.dag.txt

Utilisez votre éditeur de texte favori et supprimez la première ligne du fichier RPM-GPG-KEY.dag.txt. La première
ligne doit contenir :

"-----BEGIN PGP PUBLIC KEY BLOCK-----"

Puis exécutez les commandes suivantes :

$ rpm --import RPM-GPG-KEY.dag.txt
$ rpm -Uvh rpmforge-release-0.5.3-1.el7.rf.x86_64.rpm

Vous pouvez maintenant installer les dépendances nécessaires :

$ yum update
$ yum upgrade
$ yum install httpd gd fontconfig-devel libjpeg-devel libpng-devel gd-devel perl-GD perl-DateTime \

openssl-devel perl-DBD-MySQL mysql-server mysql-devel php php-mysql php-gd php-ldap php-xml php-mbstring \
perl-Config-IniFiles perl-DBI perl-DBD-MySQL rrdtool perl-rrdtool perl-Crypt-DES perl-Digest-SHA1 \
perl-Digest-HMAC net-snmp-utils perl-Socket6 perl-IO-Socket-INET6 net-snmp net-snmp-libs php-snmp \
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dmidecode lm_sensors perl-Net-SNMP net-snmp-perl fping cpp gcc gcc-c++ libstdc++ glib2-devel \
php-pear nagios-plugins

Des commandes additionnelles sont nécessaires pour configurer correctement l’environnement :

$ usermod -U apache
$ pear channel-update pear.php.net

Si vous ne pouvez pas accéder directement à Internet directement mais passer par un proxy, exécutez la commande
suivante :

$ pear config-set http_proxy http://my_proxy.com:port

Puis exécutez :

$ pear upgrade-all

Debian / Ubuntu

Installez les dépendances nécessaires :

$ apt-get install sudo tofrodos bsd-mailx lsb-release mysql-server libmysqlclient18 libdatetime-perl \
apache2 apache2-mpm-prefork php5 php5-mysql php-pear php5-intl php5-ldap php5-snmp php5-gd php5-sqlite \
rrdtool librrds-perl libconfig-inifiles-perl libcrypt-des-perl libdigest-hmac-perl \
libdigest-sha-perl libgd-perl snmp snmpd libnet-snmp-perl libsnmp-perl nagios-plugins

Pour finir, vous devez installer des MIBs SNMP. En raison d’un problème de licence, les fichiers MIBs ne sont pas
disponibles par défaut sous Debian. Pour les ajouter, modifiez le fichier /etc/apt/sources.list et ajouter la catégorie
non-free.

Puis exécutez les commandes suivantes :

$ apt-get update
$ apt-get install snmp-mibs-downloader

Suse

Installez les dépendances nécessaires :

$ yast -i gcc gcc-c++ make automake apache2 php5 php5-mysql apache2-mod_php5 php5-pear \
php5-ldap php5-snmp php5-gd php5-soap php5-posix php5-intl php5-gettext php5-mbstring mysql \
libmysqlclient-devel perl-DBD-mysql mysql-community-server rrdtool perl-Config-IniFiles \
net-snmp perl-Net-SNMP perl-SNMP gd libjpeg-devel libpng-devel fontconfig-devel \
freetype2-devel sudo mailx fping iputils dos2unix cron dejavu nagios-plugins

Sur certaines distributions OpenSuse, le paramétrage par défaut des type mine n’est pas valide pour fonctionner avec
l’interface web Centreon. Editez le fichier /etc/mime.types et rechercher les lignes :

text/x-xsl xsl
text/x-xslt xslt xsl

Remplacez-les par :

text/xml xsl
text/xml xslt xsl

Sauvegardez le fichier et redémarrez apache :
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$ /etc/init.d/apache2 restart

4.7.2 Moteur de supervision

Centreon est testé et validé uniquement pour le moteur de supervision Centreon Engine.

Installez ce moteur avant de poursuivre l’installation. N’oubliez pas d’installer les Plugins Nagios si vous ne l’avez
pas déjà fait.

Warning : Centreon Web n’est pas compatible avec le moteur de supervision Nagios.

4.7.3 Multiplexeur de flux

Centreon est testé et validé uniquement pour le multiplexeur de flux Centreon Broker.

Installez ce multiplexeurs de flux avant de poursuivre l’installation.

4.7.4 Centreon

Téléchargez la dernière version de Centreon https://download.centreon.com/ .

Installation shell

Extraire Centreon de l’archive :

$ tar zxf centreon-2.x.x.tar.gz

Déplacez-vous dans le répertoire extrait :

$ cd centreon-2.x.x

Exécutez le script d’installation :

$ ./install.sh -i

Note : Le script d’installation permet une configuration personnalisée, cette procédure vous montrera les meilleurs
chemins à utiliser. En outre, les questions rapides Yes/No peuvent être répondues par [y] la plupart du temps.

Contrôle de prérequis

Si l’étape d’installation des prérequis s’est déroulée avec succès, vous ne devriez avoir aucun problème lors de cette
étape. Sinon, reprennez la procédure d’installation des prérequis :

###############################################################################
# #
# Centreon (www.centreon.com) #
# Thanks for using Centreon #
# #
# v2.8.0 #
# #
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# infos@centreon.com #
# #
# Make sure you have installed and configured #
# sudo - sed - php - apache - rrdtool - mysql #
# #
###############################################################################
------------------------------------------------------------------------

Checking all needed binaries
------------------------------------------------------------------------
rm OK
cp OK
mv OK
/bin/chmod OK
/bin/chown OK
echo OK
more OK
mkdir OK
find OK
/bin/grep OK
/bin/cat OK
/bin/sed OK

Acceptation de la licence

This General Public License does not permit incorporating your program into
proprietary programs. If your program is a subroutine library, you may
consider it more useful to permit linking proprietary applications with the
library. If this is what you want to do, use the GNU Library General
Public License instead of this License.

Do you accept GPLv2 license ?
[y/n], default to [n]:
> y

Composants principaux

Répondez [y] à toutes les questions

------------------------------------------------------------------------
Please choose what you want to install

------------------------------------------------------------------------

Do you want to install Centreon Nagios Plugins ?
[y/n], default to [n]:
> y

Définition des chemins d’installation

------------------------------------------------------------------------
Starting Centreon Web Installation

------------------------------------------------------------------------

Where is your Centreon directory ?
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default to [/usr/local/share/centreon]
>

Do you want me to create this directory ? [/usr/local/share/centreon]
[y/n], default to [n]:
> y
Path /usr/local/share/centreon OK

Where is your Centreon log directory ?
default to [/var/log/centreon]
>

Do you want me to create this directory ? [/var/log/centreon]
[y/n], default to [n]:
> y
Path /var/log/centreon OK

Where is your Centreon configuration directory ?
default to [/usr/local/etc/centreon]
>

Do you want me to create this directory ? [/usr/local/etc/centreon]
[y/n], default to [n]:
> y
Path /usr/local/etc/centreon OK

Where is your Centreon binaries directory ?
default to [/usr/local/bin]
>

Where is your Centreon variable state information directory ?
default to [/var/lib/centreon]
>
Path /var/lib/centreon/ OK

Do you want me to create this directory ? [/var/lib/centreon]
[y/n], default to [n]:
> y
Path /var/lib/centreon OK

/usr/bin/rrdtool OK
/usr/bin/mail OK
/usr/bin/php OK
/usr/share/php OK
/usr/bin/perl OK
Finding Apache user : apache
Finding Apache group : apache

Utilisateur et group centreon

Le groupe d’applications centreon est utilisé pour les droits d’accès entre les différents logiciels de la suite Centreon :

What is the Centreon group ? [centreon]
default to [centreon]
>
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What is the Centreon user ? [centreon]
default to [centreon]
>

Utilisateur de la supervision

Cet utilisateur exécute le moteur de supervision Centreon Engine. Si vous avez suivi la procédure d’installation offi-
cielle de Centreon Engine l’utilisateur sera vraisemblablement centreon-engine.

What is your Centreon Engine user ?
default to [centreon-engine]
>

Cet utilisateur exécute le multiplexeur de flux Centreon Broker. Si vous avez suivi la procédure d’installation officielle
de Centreon Broker l’utilisateur sera vraisemblablement centreon-broker.

What is your Centreon Broker user ?
default to [centreon-broker]
>

Répertoire des journaux d’évènements

What is your Centreon Engine log directory ?
default to [/var/log/centreon-engine]
>

Répertoire des plugins

Where is your monitoring plugins (libexec) directory ?
default to [/usr/lib/nagios/plugins]
>
Path /usr/lib/nagios/plugins OK
Add group centreon to user apache OK
Add group centreon to user centreon-engine OK
Add group centreon-engine to user apache OK
Add group centreon-engine to user centreon OK

Configuration des droits sudo

------------------------------------------------------------------------
Configure Sudo

------------------------------------------------------------------------

Where is sudo configuration file ?
default to [/etc/sudoers]
>
/etc/sudoers OK

What is your Centreon Engine startup command (init.d, service, ...) ?
default to [service centengine]
>
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Are you sure ? [service centengine]
[y/n], default to [n]:
> y

Where is your Centreon Engine binary ?
default to [/usr/sbin/centengine]
>

Where is your Centreon Engine configuration directory ?
default to [/etc/centreon-engine]
>

Where is your Centreon Broker configuration directory ?
default to [/etc/centreon-broker]
>

What is your Centreon Broker startup command (init.d, service, ...) ?
default to [service cbd]
>

Are you sure ? [service cbd]
[y/n], default to [n]:
> y

Do you want me to reconfigure your sudo ? (WARNING)
[y/n], default to [n]:
> y
Configuring Sudo OK

Configuration du serveur Apache

------------------------------------------------------------------------
Configure Apache server

------------------------------------------------------------------------

Do you want to add Centreon Apache sub configuration file ?
[y/n], default to [n]:
> y
Create ’/etc/httpd/conf.d/centreon.conf’ OK
Configuring Apache OK

Do you want to reload your Apache ?
[y/n], default to [n]:
> y
Reloading Apache service OK
Preparing Centreon temporary files
Change right on /var/log/centreon OK
Change right on /usr/local/etc/centreon OK
Change macros for insertBaseConf.sql OK
Change macros for sql update files OK
Change macros for php files OK
Change macros for php config file OK
Change macros for perl binary OK
Change right on /etc/centreon-engine OK
Change right on /etc/centreon-broker OK
Add group centreon to user apache OK
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Add group centreon to user centreon-engine OK
Add group centreon to user centreon OK
Copy CentWeb in system directory OK
Install CentWeb (web front of centreon) OK
Change right for install directory
Change right for install directory OK
Install libraries OK
Write right to Smarty Cache OK
Copying libinstall OK
Change macros for centreon.cron OK
Install Centreon cron.d file OK
Change macros for centAcl.php OK
Change macros for downtimeManager.php OK
Install cron directory OK
Change right for eventReportBuilder OK
Change right for dashboardBuilder OK
Change macros for centreon.logrotate OK
Install Centreon logrotate.d file OK
Prepare centFillTrapDB OK
Install centFillTrapDB OK
Prepare centreon_trap_send OK
Install centreon_trap_send OK
Prepare centreon_check_perfdata OK
Install centreon_check_perfdata OK
Prepare centreonSyncPlugins OK
Install centreonSyncPlugins OK
Prepare centreonSyncArchives OK
Install centreonSyncArchives OK
Prepare generateSqlLite OK
Install generateSqlLite OK
Install changeRrdDsName.pl OK
Prepare export-mysql-indexes OK
Install export-mysql-indexes OK
Prepare import-mysql-indexes OK
Install import-mysql-indexes OK
Prepare clapi binary OK
Install clapi binary OK
Centreon Web Perl lib installed OK

Installation des modules pear

------------------------------------------------------------------------
Pear Modules
------------------------------------------------------------------------
Check PEAR modules
PEAR 1.4.9 1.10.1 OK
DB 1.7.6 1.9.2 OK
DB_DataObject 1.8.4 1.11.5 OK
DB_DataObject_FormBuilder 1.0.0RC4 1.0.2 OK
MDB2 2.0.0 2.4.1 OK
Date 1.4.6 1.4.7 OK
Archive_Tar 1.1 1.3.11 OK
Auth_SASL 1.0.1 1.0.6 OK
Console_Getopt 1.2 1.3.1 OK
Validate 0.6.2 0.8.5 OK
Log 1.9.11 1.12.9 OK
Archive_Zip 0.1.2 0.1.2 OK
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All PEAR modules OK

Installation du fichier de configuration

------------------------------------------------------------------------
Centreon Post Install

------------------------------------------------------------------------
Create /usr/share/centreon/www/install/install.conf.php OK
Create /etc/centreon/instCentWeb.conf OK

Installation du composant Centstorage

------------------------------------------------------------------------
Starting CentStorage Installation

------------------------------------------------------------------------

Where is your Centreon Run Dir directory?
default to [/var/run/centreon]
>

Do you want me to create this directory ? [/var/run/centreon]
[y/n], default to [n]:
> y
Path /var/run/centreon OK

Where is your CentStorage RRD directory ?
default to [/var/lib/centreon]
>
Path /var/lib/centreon OK
Preparing Centreon temporary files
/tmp/centreon-setup exists, it will be moved...
install www/install/createTablesCentstorage.sql OK
Creating Centreon Directory ’/var/lib/centreon/status’ OK
Creating Centreon Directory ’/var/lib/centreon/metrics’ OK
Change right : /var/run/centreon OK
Install logAnalyserBroker OK
Install nagiosPerfTrace OK
Change macros for centstorage.cron OK
Install CentStorage cron OK
Change macros for centstorage.logrotate OK
Install Centreon Storage logrotate.d file OK
Create /usr/local/etc/centreon/instCentStorage.conf OK

Installation du composant Centcore

------------------------------------------------------------------------
Starting CentCore Installation

------------------------------------------------------------------------
Preparing Centreon temporary files
/tmp/centreon-setup exists, it will be moved...
Copy CentCore in binary directory OK
Change right : /var/run/centreon OK
Change right : /var/lib/centreon OK
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Change macros for centcore.logrotate OK
Install Centreon Core logrotate.d file OK
Replace CentCore init script Macro OK
Replace CentCore sysconfig script Macro OK

Do you want me to install CentCore init script ?
[y/n], default to [n]:
> y
CentCore init script installed OK
CentCore sysconfig script installed OK

Do you want me to install CentCore run level ?
[y/n], default to [n]:
> y
CentCore Perl lib installed OK
Create /usr/local/etc/centreon/instCentCore.conf OK

Installation du système de gestion des traps SNMP (CentreonTrapD)

------------------------------------------------------------------------
Starting CentreonTrapD Installation

------------------------------------------------------------------------

Where is your SNMP configuration directory ?
default to [/etc/snmp]
>
/etc/snmp OK
Finding Apache user : apache
Preparing Centreon temporary files
/tmp/centreon-setup exists, it will be moved...
Change macros for snmptrapd.conf OK
Replace CentreonTrapd init script Macro OK
Replace CentreonTrapd sysconfig script Macro OK

Do you want me to install CentreonTrapd init script ?
[y/n], default to [n]:
> y
CentreonTrapd init script installed OK
CentreonTrapd sysconfig script installed OK

Do you want me to install CentreonTrapd run level ?
[y/n], default to [n]:
> y
trapd Perl lib installed OK
Install : snmptrapd.conf OK
Install : centreontrapdforward OK
Install : centreontrapd OK
Change macros for centreontrapd.logrotate OK
Install Centreon Trapd logrotate.d file OK
Create /usr/local/etc/centreon/instCentPlugins.conf OK

Installation des plugins

------------------------------------------------------------------------
Starting Centreon Plugins Installation
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------------------------------------------------------------------------

Where is your CentPlugins lib directory
default to [/var/lib/centreon/centplugins]
>

Do you want me to create this directory ? [/var/lib/centreon/centplugins]
[y/n], default to [n]:
> y
Path /var/lib/centreon/centplugins OK
Preparing Centreon temporary files
/tmp/centreon-setup exists, it will be moved...
Change macros for CentPlugins OK
Installing the plugins OK
Change right on centreon.conf OK
CentPlugins is installed
Create /usr/local/etc/centreon/instCentPlugins.conf OK

Fin de l’installation

###############################################################################
# #
# Go to the URL : http://localhost.localdomain/centreon/ #
# to finish the setup #
# #
# Report bugs at https://github.com/centreon/centreon/issues #
# Read documentation at https://documentation.centreon.com #
# #
# Thanks for using Centreon. #
# ----------------------- #
# Contact : infos@centreon.com #
# http://www.centreon.com #
# #
###############################################################################

Installation des dépendances PHP

Tout d’abord, vous devez installer l’installeur de dépendance PHP composer. Composer peut être téléchargé ici
<https ://getcomposer.org/download/> (celui-ci est également disponible dans les dépôts EPEL).

Une fois que composer est installé, rendez-vous dans les répertoires Centreon (habituellement /usr/share/centreon/) et
exécutez la commande suivante :

composer install --no-dev --optimize-autoloader

Installation des dépendances Javascript

Tout d’abord, vous devez installer l’environnement d’exécution javscript nodejs. Les instructions d’installation sont
disponibles ici <https ://nodejs.org/en/download/package-manager/>.

Une fois que nodejs est installé, rendez vous dans les répertoire centreon (habituellement /usr/share/centreon/) et
exécutez les commandes suivantes :
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npm install
npm run build
npm prune --production

Pour tous les OS

SELinux doit être désactivé. Pour cela, vous devez modifier le fichier “/etc/sysconfig/selinux” et remplacer “enforcing”
par “disabled” comme dans l’exemple suivant :

SELINUX=disabled

Après avoir sauvegardé le fichier, veuillez redémarrer votre système d’exploitation pour prendre en compte les chan-
gements.

La timezone par défaut de PHP doit être configurée. Pour cela, allez dans le répertoire /etc/php.d et créez un fichier
nommé php-timezone.ini contenant la ligne suivante :

date.timezone = Europe/Paris

Après avoir sauvegardé le fichier, n’oubliez pas de redémarrer le service apache de votre serveur.

La base de données MySQL doit être disponible pour pouvoir continuer l’installation (localement ou non). Pour
information, nous recommandons MariaDB.

4.7.5 Configuration

Connectez-vous à l’interface web via http://[ADRESSE_IP_DE_VOTRE_SERVEUR]/centreon. L’assistant de confi-
guration de Centreon s’affiche, cliquez sur Next.

L’assistant de configuration de Centreon contrôle la disponibilité des modules, cliquez sur Next.

4.7. A partir des sources
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Cliquez sur Next.

Cliquez sur Next.

Définissez les informations concernant l’utilisateur admin, cliquez sur Next.
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Par défaut, le serveur ‘localhost’ est défini et le mot de passe root est vide. Si vous utilisez un serveur de base de
données déporté, il convient de modifier ces deux informations. Dans notre cas, nous avons uniquement besoin de
définir un mot de passe pour l’utilisateur accédant aux bases de données Centreon, à savoir ‘centreon’.

Cliquez sur Next.

Note : Si le message d’erreur suivant apparaît Add innodb_file_per_table=1 in my.cnf file under the [mysqld]
section and restart MySQL Server, Effectuez les opérations ci-dessous :

1. Connectez-vous avec l’utilisateur ‘root’ sur votre serveur

2. Editez le fichier suivant /etc/my.cnf
3. Ajoutez la ligne suivante au fichier :

[mysqld]
innodb_file_per_table=1

4. Redémarrez le service mysql :

# systemctl restart mysql

5. Cliquez sur Refresh

L’assistant de configuration configure les bases de données.

Cliquez sur Next.
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L’assistant de configuration propose ensuite d’installer les modules présents sur le serveur Centreon.

Cliquez sur Install.

Une fois les modules installés, cliquez sur Next.

À cette étape une publicité permet de connaître les dernières nouveautés de Centreon. Si votre plate-forme est connec-
tée à Internet vous disposez des dernières informations, sinon l’information présente dans cette version sera proposée.
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L’installation est terminée, cliquez sur Finish.

Vous pouvez maintenant vous connecter.

Dans un premier temps, il est nécessaire de passer l’interface en version française. Pour cela :

1. Cliquez sur votre profil utilisateur en haut à droite de l’interface

2. Cliquez sur le bouton Edit profile
3. Dans le champ Language, remplacez en_US par fr_FR.UTF-8
4. Cliquez sur Save

4.7. A partir des sources
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CHAPITRE 5

Démarrage rapide

Ce chapitre vous explique comment démarrer rapidement la configuration des principaux objets contrôlés par Cen-
treon.

5.1 Connexion à l’interface

Pour se connecter à l’interface se rendre à l’adresse : http://IP_ADDRESS/centreon

Note : Remplacer IP_ADDRESS par l’adresse IP ou FQDN du serveur web Centreon.

Renseigner l nom d’utilisateur et le mot de passe associé et cliquer sur le bouton Connect :

Vous êtes maintenant connecté à l’interface web Centreon.
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5.2 Ajouter un hôte

Votre plate-forme est maintenant prête pour superviser vos premiers serveurs et équipements réseau mais vous ne
savez pas comment faire. Pas de problème, le démarrage est très rapide !

Premièrement vous devez vous connectez à l’interface web Centreon avec un compte administrateur ou un compte
disposant des droits d’accès pour gérer les objets.

Se rendre dans le menu Configuration > Hosts > Hosts et cliquer sur le bouton Add :

Vous accédez à un formulaire permettant de décrire votre équipement mais ne soyez pas effrayé, tous les champs ne
sont pas obligatoire !

Pour démarrer renseigner les champs suivants :
— Le nom de l’objet via le champ Host Name
— La description de l’objet via le champ Alias
— Son adresse IP dans le champ IP Address / DNS
— Cliquer sur le bouton + Add a new entry et sélectionner dans la liste la valeur generic-host
— Sélectionner l’option Yes pour le champ Create Services linked to the Template too
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Sauvegarder les modifications en cliquant sur le bouton Save.

L’hôte est maintenant défini dans l’interface Centreon web mais le moteur ne le connait pas encore !

Vous devez générer la configuration, l’exporter et l’envoyer au moteur de supervision.

Le résultat est visible dans le menu Monitoring > Status Details > Hosts :

5.3 Ajouter un service

Vous venez d’ajouter un hôte et vous souhaitez ajouter des points de contrôle supplémentaires.

Note : Un point de contrôle ou indicateur est appelé service dans Centreon.

5.3. Ajouter un service
CENTREON 46-52 RUE ALBERT FR75014 PARIS

109



Se rendre dans le menu Configuration > Services > Services by host et cliquer sur le bouton Add :

Pour ajouter un service à un hôte, seuls 3 champs sont nécessaires :
— Sélectionner votre hôte via le champ Linked with Hosts
— Définir le nom du point de contrôle via le champ Description
— Sélectionner un modèle de service, par exemple Base-Ping-LAN via le champ Service Template

Note : Après avoir sélectionné un modèle de service, de nouveaux champs peuvent apparaître. Ces champs décrivent
les arguments nécessaires au contrôle du service. Le plus souvent il s’agit des seuils d’alerte pour déclencher la
notification. Vous pouvez laisser ces valeurs par défaut ou les modifier.

Sauvegarder les modifications en cliquant sur le bouton Save.
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Le service est maintenant défini dans l’interface Centreon web mais le moteur ne le connait pas encore !

Vous devez générer la configuration, l’exporter et l’envoyer au moteur de supervision.

Le résultat est visible dans le menu Monitoring > Status Details > Hosts :

5.4 Déployer un hôte à partir d’un modèle

Dans le précédent guide de démarrage rapide vous avez ajouté un hôte à partir du modèle d’hôte generic-host. Ce
modèle permet d’apporter une configuration minimale pour définir votre hôte.

Cependant les modèles d’objets dans l’interface Centreon web apporte beaucoup plus que la simple pré-
configuration de certaines valeurs. Dans Centreon web vous pouvez lier des modèles de services à des modèles
d’hôtes<hosttemplates>. Grâce à cela vous pouvez déployer facilement et en une seule fois des services pour votre
hôte.

Dans cet exemple nous utiliserons un modèle d’hôte ajouté par un Plugin Pack Centreon afin de contrôler un serveur
Linux. Ce modèle d’hôte apporte les contrôles suivants :

— CPU
— Load
— Memory
— Swap

Premièrement vous devez vous connectez à l’interface web Centreon avec un compte administrateur ou un compte
disposant des droits d’accès pour gérer les objets.

Se rendre dans le menu Configuration > Hosts > Hosts et cliquer sur le bouton Add :

5.4. Déployer un hôte à partir d’un modèle
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Vous accédez à un formulaire permettant de définir votre équipement. Pour démarrer la supervision de ce dernier,
renseignez :

— Le nom de celui-ci via le champ Host Name
— Sa description via le champ Alias
— Son adresse IP ou FQDN dans le champ IP Address / DNS
— Cliquer sur le bouton + Add a new entry et sélectionner dans la liste la valeur OS-Linux-SNMP
— Sélectionner l’option Yes pour le champ Create Services linked to the Template too
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Sauvegarder les modifications en cliquant sur le bouton Save.

L’hôte est maintenant défini dans l’interface Centreon web mais le moteur ne le connait pas encore !

Vous devez générer la configuration, l’exporter et l’envoyer au moteur de supervision.

Le résultat est visible dans le menu Monitoring > Status Details > Services :

5.5 Déployer un service à partir d’un modèle

Dans le précédent guide de démarrage rapide vous avez ajouté un hôte à partir d’un modèle à partir du modèle d’hôte
OS-Linux-SNMP. Ce modèle a permis de créer automatiquement les services suivants :

— CPU
— Load
— Memory
— Swap

Cependant certains indicateurs n’ont pu être ajouté automatiquement parce que leur configuration dépend de certains
paramètres liés à l’équipement lui-même (nom des partitions, des interfaces réseau, etc.).

Premièrement vous devez vous connectez à l’interface web Centreon avec un compte administrateur ou un compte
disposant des droits d’accès pour gérer les objets.

Se rendre dans le menu Configuration > Services > Services by host et cliquer sur le bouton Add :

5.5. Déployer un service à partir d’un modèle
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Pour ajouter un nouveau service à votre hôte vous devez définir 3 choses :
— Sélectionner l’hôte auquel lier ce service via le champ Linked with Hosts
— Définir le nom du service via le champ Description, par exemple Traffic-eth0 pour superviser la bande pas-

sante de l’interface eth0
— Sélectionner le modèle de service OS-Linux-Traffic-Generic-Name-SNMP via le champ Service Template

Note : Après avoir sélectionné un modèle de service, de nouveaux champs peuvent apparaître. Ces champs décrivent
les arguments nécessaires au contrôle du service. Le plus souvent il s’agit des seuils d’alerte pour déclencher la
notification. Vous pouvez laisser ces valeurs par défaut ou les modifier

Modifier la valeur de la macro INTERFACENAME pour saisir le nom de votre interface réseau, eth0 dans notre
exemple.
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Sauvegarder les modifications en cliquant sur le bouton Save.

Le service est maintenant défini dans l’interface Centreon web mais le moteur ne le connait pas encore !

Vous devez générer la configuration, l’exporter et l’envoyer au moteur de supervision.

Le résultat est visible dans le menu Monitoring > Status Details > Services :

5.5. Déployer un service à partir d’un modèle
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5.6 Ajouter un utilisateur

Un utilisateur Centreon est à la fois un contact qui recevra les alertes issues de la supervision et une personne qui
pourra se connecter à l’interface web Centreon.

Premièrement vous devez vous connectez à l’interface web Centreon avec un compte administrateur ou un compte
disposant des droits d’accès pour gérer les objets.

Se rendre dans le menu Configuration > Users > Contacts / Users et cliquer sur le bouton Add :

Vous accédez à un formulaire assez complet permettant de définir un utilisateur mais pas de panique tous les champs
ne sont pas nécessaires !

Le formulaire est divisé en 3 parties distinctes :
— La première partie concerne les paramètres liés à la notification
— La seconde partie, les informations pour se connecter à l’interface web Centreon
— Et la dernière pour des informations optionnelles.

5.6.1 Paramètres obligatoires

Dans le premier onglet General Information renseigner :
— votre pseudo (Alias), qui sera utilisé pour se connecter à l’interface web Centreon
— votre nom complet via le champ Full Name
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— votre adresse mail via le champ Email

5.6.2 Options de notification

Pour recevoir des notifications, définir les paramètres suivants :
— Activer la notification via le champ Enable Notifications
— Définir les types de notification d’hôte que vous souhaitez recevoir via le champ Host Notification Options,

par exemple : Down, Recovery, Flapping, Downtime Scheduled
— Définir la plage durant laquelle vous souhaitez recevoir vos notifications d’hôte via le champ Host Notification

Period, par exemple : 24x7
— Définir la manière dont vous recevrez vos notifications d’hôte via le champ Host Notification Commands, par

exemple : host-notify-by-email
— Définir les types de notification de service que vous souhaitez recevoir via le champ Service Notification

Options, par exemple : Warning, Unknown, Critical, Recovery, Flapping, Downtime Scheduled
— Définir la plage durant laquelle vous souhaitez recevoir vos notifications de service via le champ Service

Notification Period, par exemple : 24x7
— Définir la manière dont vous recevrez vos notifications de service via le champ Service Notification Com-

mands, par exemple : service-notify-by-email

5.6. Ajouter un utilisateur
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5.6.3 Accès à l’interface web Centreon

Pour se connecter à l’interface Centreon saisir les paramètres suivants :
— Autoriser l’accès via le champ Reach Centreon Front-end
— Définir son mot de passe (Password) et le confirmer (Confirm Password)
— Définir votre fuseau horaire via le champ Timezone / Location
— Définir si votre compte est administrateur de la plate-forme (Admin) ou un simple utilisateur
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Sauvegarder les modifications en cliquant sur le bouton Save.

Suivant la configuration réalisée, votre compte est prêt à recevoir des notifications et/ou se connecter à l’interface web
Centreon.

Si vous avez des idées de “quickstart” et que vous souhaitez participer à la création de ces tutoriels pour aider les
utilisateurs de la communauté, n’hésitez pas à vous faire des “pull-requests” pour que nous les intégrions facilement
depuis github.

5.6. Ajouter un utilisateur
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CHAPITRE 6

Guide de configuration

Vous trouverez dans ce chapitre toutes les informations nécessaire sà la prise en main de l’interface de configuration
de Centreon. Sachez que la configuration est une étape importante dans la prise en main de votre système.

Pensez à mettre en place une stratégie de globalisation de la configuration afin de pouvoir faire des actions globales de
configurations. Pour cela des mecanismes sont en place dans Centreon pour vous simplifier la vie tels que les modèles
d’hôtes et de services.

6.1 Actions génériques

Au sein du menu Configuration il est possible d’effectuer certaines actions “génériques” sur les différents objets.

6.1.1 Ajouter/Supprimer

L’ajout d’un nouvel objet se fait via l’instruction Ajouter à côté du menu More actions....

Pour supprimer un objet :

1. Sélectionnez le ou les objets que vous souhaitez supprimer en cochant la ou les cases près du nom de celui-ci

2. Dans le menu More actions... cliquez sur Supprimer
Attention : La suppression d’un objet est définitive. Si vous avez supprimé un objet par accident, il vous faudra le
recréer. De même, la suppression d’un objet supprime automatiquement tous les objets qui sont liés à lui et ne peuvent
vivre sans. Exemple : La suppression d’un hôte entraine la suppression de tous les services associés à cet hôte.

Pour modifier un objet, cliquez sur son nom.

6.1.2 Dupliquer

Principe

La duplication d’un objet permet de copier/cloner celui-ci afin de pouvoir réutiliser ses attributs pour la création d’un
nouvel objet. Exemple : J’ai 10 serveurs web identiques à superviser :

— J’ajoute le premier serveur web avec tous les attributs nécessaires
— Je duplique cet hôte 9 fois
— Je n’ai plus qu’à changer les noms d’hôtes et les adresses IP de chaque duplication pour les adapter aux 9

autres serveurs web à superviser
Grâce à cette méthode, il n’est plus nécessaire de créer unitairement chaque hôte.
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Pratique

Pour dupliquer un hôte :

1. Sélectionnez l’hôte que vous souhaitez dupliquer

2. Dans la colonne Options, entrez le nombre de duplication que vous souhaitez obtenir

3. Dans le menu More actions... cliquez sur Dupliquer

6.1.3 Changement massif

Principe

Les changements massifs permettent d’appliquer un changement sur plusieurs objets.

Exemple : L’ensemble des serveurs web précédemment créés changent de communauté SNMP. Un changement massif
permet de modifier cette communauté sans avoir la peine de modifier chaque fiche de chaque hôte unitairement.

Pratique

Pour effectuer un changement massif :

1. Sélectionnez les objets que vous souhaitez modifier

2. Dans le menu More actions... cliquez sur Changement massif
La fenêtre de changement s’ouvre, il existe deux types de changements :

— Incrémentale : signifie que la modification va s’ajouter aux options déjà existantes
— Remplacement : signifie que la modification va écraser les options déjà existantes

6.1.4 Activer/Désactiver

Principe

L’activation et la désactivation des objets permettent de prendre en compte ou non l’objet lors de la génération de la
configuration. Le principal intérêt est de pouvoir garder la configuration d’un objet sans pour autant l’appliquer.

Pratique

Pour activer/désactiver un objet :

1. Sélectionnez les objets que vous souhaitez modifier

2. Dans le menu More actions... cliquez sur Activer/Désactiver
Il est également possible d’activer ou de désactiver un objet via le champ “Statut” de la fiche de détails de l’objet ou
en utilisant les icônes suivantes :

— pour activer

— pour désactiver
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6.2 Les hôtes

Un hôte est toute entité possédant une adresse IP correspondant à une ressource du système d’informations. Exemples :
Un serveur, une imprimante réseau, un serveur NAS, une base de données, une sonde de température, une caméra IP...

Tous les ajouts d’hôtes se font dans le menu Configuration ==> Hôtes ==> Ajouter.

6.2.1 Configuration de l’hôte

Informations générales

— Le champ Nom de l’hôte définit le nom d’hôte qui sera utilisé par le moteur de supervision.
— Le champ Alias indique l’alias de l’hôte.
— Le champ Adresse IP/DNS : Adresse IP ou nom DNS de l’hôte. Le bouton Résoudre permet de résoudre le

nom de domaine en interrogeant le serveur DNS configuré sur le serveur central.
— Les champs Communauté SNMP & Version contiennent respectivement le nom de la communauté ainsi que

la version SNMP.
— Le champ Surveillé depuis le collecteur indique quel est le serveur de supervision chargé de superviser cet

hôte.
— Le champ Modèles d’hôte permet d’associer un ou plusieurs modèles d’hôtes à cet objet.

En cas de conflits de paramètres présents sur plusieurs modèles, le modèle d’hôte au-dessus écrase les

propriétés identiques définies dans modèles d’hôtes en dessous. Le bouton permet de déplacer
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l’ordre des modèles d’hôte. Le bouton permet de supprimer le modèle d’hôte.

— Si le champ Créer aussi les services liés au modèle est définit à Oui, Centreon génère automatiquement les
services en se basant sur les modèles de services liés aux modèles d’hôtes définis au-dessus (voir chapitre Les
modèles).

Propriétés du supervison de l’hôte

— Le champ Commande de vérification indique la commande utilisée pour vérifier la disponibilité de l’hôte.
— Le champ Arguments définit les arguments donnés à la commande de vérification (chaque argument com-

mence avec un ” !”).

La partie Macros permet d’ajouter des macros personnalisées.
— Les champs Nom de la macro et Valeur de la macro permettent respectivement de définir le nom et la valeur

de la macro.
— La case Mot de passe permet de cacher la valeur de la macro.

Pour réinitialiser la macro avec sa valeur par défaut (définie dans le templae) cliquez sur .

Pour afficher la description de la macro, cliquez sur .

Pour supprimer la macro, cliquez sur .

Pour déplacer l’ordre des macros, cliquez sur .

Propriété d’ordonancement de l’hôte

— Le champ Période de contrôle définit la période temporelle durant laquelle l’ordonnanceur vérifie le statut de
l’objet.

— Le champ Nombre de contrôles avant validation de l’état définit le nombre de contrôle à effectuer avant de
valider le statut de l’hôte : lorsque le statut est validé, le processus de notification est enclenché.

— Le champ Intervalle normal de contrôle est exprimé en minutes. Il définit l’intervalle entre chaque vérifica-
tion lorsque le statut de l’hôte est OK.

— Le champ Intervalle non-régulier de contrôle est exprimé en minutes. Il définit l’intervalle de validation du
statut non-OK de l’hôte.

— Les champs Contrôles actifs activés et Contrôles passifs activés activent/désactivent les contrôles actifs et
passifs.

Onglet Notification

— Le champ Notification activée permet d’activer ou de désactiver les notifications concernant l’objet.
— Les Options de notifications définissent les statuts pour lesquels une notification sera envoyée.
— Le champ Intervalle de notification est exprimé en minutes. Il indique la durée entre chaque envoi de notifica-

tion lorsque le statut est non-OK. Si la valeur est définie à 0 alors l’ordonnanceur envoie une seule notification
par changement de statut.

— Le champ Période de notification indique la période temporelle durant laquelle les notifications seront acti-
vées.
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— Le Délai de première notification est exprimé en minutes. Il fait référence au délai à respecter avant l’envoi
d’une première notification lorsqu’un statut non-OK est validé.

— La liste Contacts liés indique les contacts qui recevront les notifications.
— Au sein de la liste Groupe de contacts liés tous les contacts appartenant aux groupes de contacts définis

recevront les notifications.

6.2.2 Onglet Relations

— La liste Groupes d’hôtes parents définit les groupes d’hôtes auxquels l’hôte appartient.
— La liste Catégorie d’hôtes parents définit les catégories auxquelles l’hôte appartient.
— La liste Hôtes parents permet de définir les relations physiques de parenté entre objet.
— La liste Hôtes enfants permet de définir les relations physiques de parenté entre objet.

6.2.3 Traitement des données

— Si le Contrôle de vérification de l’hôte est activé, alors la commande de remontée des contrôles de l’hôte sera
activée.

— Le champ Contrôler la fraîcheur du résultat permet d’activer ou de désactiver le contrôle de fraîcheur du
résultat.

— Le champ Seuil de fraîcheur du résultat est exprimé en secondes. Si durant cette période aucune demande de
changement de statut de l’hôte (commande passive) n’a été reçue alors la commande de vérification active est
exécutée.

— Le champ Détection de bagotage des status permet d’activer ou de désactiver la détection du bagotage des
statuts (statut changeant trop fréquemment de valeur sur une période donnée).

— Les champs Seuil bas de détection de bagotage des statuts et Seuil haut de détection de bagotage des
statuts définissent les seuils hauts et bas pour la détection du bagotage en pourcentage de changement de
statuts.

— Le champ Traitement des données de performances permet d’activer ou de désactiver le traitement des
données de performances (et donc la génération des graphiques de performances). Cette option est inutile dans
le cas où Centreon Broker est utilisé.

— Les champs Rétention des informations de statut et Rétention des informations ne concernant pas le
statut indiquent si les informations concernant ou non le statut sont sauvegardées après chaque relance de la
commande de vérification.

— Le champ Options à enregistrer définit les options à enregistrer si la rétention est activée.
— Le champ Gestionnaire d’évènements activé permet d’activer ou de désactiver le gestionnaire d’évènements.
— Le champ Gestionnaire d’évènements définit la commande à exécuter si le gestionnaire d’évènements est

activé.
— Le champ Arguments définit les arguments de la commande du gestionnaire d’évènements.

6.2.4 Informations détaillées de l’hôte

Moteur de supervision

— Le champ URL définit une URL qui peut être utilisée pour donner davantage d’informations sur l’hôte.
— Le champ Notes permet d’ajouter des notes optionnelles concernant l’hôte.
— Le champ URL d’action définit une URL habituellement utilisée pour donner des informations d’actions sur

l’hôte (maintenance...).
— Le champ Icône indique l’icône à utiliser pour l’hôte.
— Le champ Icône alternative est le texte utilisé si l’icône ne peut être affichée.
— Le champ Niveau de criticité indique le niveau de criticité de l’hôte.

6.2. Les hôtes
CENTREON 46-52 RUE ALBERT FR75014 PARIS

125



Les champs présentés ci-dessous sont des champs utilisés uniquement par la CGI de l’ordonnanceur (habituellement
Nagios). Par conséquent, ils présentent peu d’intérêt lorsqu’on utilise Centreon Engine et Centreon Broker.

— Le champ Image de la carte des états définit le logo pour la CGI de l’ordonnanceur.
— Le champ Coordonnées géographique indique les coordonnées géographiques (Latitude,Longitude) de l’élé-

ment. Ces informations sont utiles dans le logiciel Centreon Map.
— Le champ Coordonnées 2D et 3D indiquent les coordonnées 2D et 3D utilisées par la CGI.

Access groups

— Le champ ACL Resource Groups (seulement visible pour les utilisateurs non administrateur), permet de lier
l’hôte à un groupe d’hôtes afin de pouvoir visualiser ce dernier (voir chapitre Les listes de contrôles d’accès).

Informations supplémentaires

— Le champ Statut permet d’activer ou de désactiver l’hôte.
— Le champ Commentaires permet d’ajouter un commentaire concernant l’hôte.

6.3 Les services

Un service est un point de contrôle lié/rattaché à un hôte. Par exemple : Pourcentage d’utilisation partition sur un
serveur, niveau d’encre sur une imprimante.

Tous les ajouts de services se font dans le menu Configuration ==> Services ==> Ajouter.
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6.3.1 Configuration du service

Informations générales

— Le champ Description définit le nom du service.
— Le champ Modèle de service indique le modèle de service auquel le service est lié.

Etat du service

— Le champ Est volatile indique si le service est volatile ou non (d’une manière générale uniquement les services
passifs sont volatiles).

— Le champ Période de contrôle définit la période temporelle durant laquelle l’ordonnanceur vérifie le statut du
service.

— Le champ Commande de vérification indique la commande utilisée pour vérifier la disponibilité du service.
— Le tableau Arguments définit les arguments donnés à la commande de vérification (le nombre d’arguments

varie en fonction de la commande de vérification choisie).
— Le champ Nombre de contrôles avant validation de l’état définit le nombre de contrôles à effectuer avant de

valider le statut du service. Lorsque le statut est validé, le processus de notification est enclenché.
— Le champ Intervalle normal de contrôle est exprimé en minutes. Il définit l’intervalle entre chaque vérifica-

tion lorsque le statut du service est OK.
— Le champ Intervalle non-régulier de contrôle est exprimé en minutes. Il définit l’intervalle de validation du

statut non-OK du service.
— Les champs Contrôle actif activé et Contrôle passif activé activent/désactivent le type de contrôle du service.

Macros

La partie Macros permet d’ajouter des macros personnalisées. Les champs Nom de la macro et Valeur de la macro
permettent respectivement de définir le nom et la valeur de la macro. La case Mot de passe permet de cacher la valeur
de la macro.

Pour réinitialiser la valeur de la macro (issue du template), cliquez sur .

Pour ajouter une description à votre macro, cliquez sur .

Pour supprimer la macro, cliquez sur .

Pour déplacer l’ordre des macros, cliquez sur .

Notification

— Le champ Notification activée permet d’activer ou de désactiver les notifications pour l’objet.
— Le champ Utiliser les contacts définis sur l’hôte : permet de faire hériter les contacts depuis la configuration

de l’hôte.
— Si la case Contacts en complément de ceux hérités est cochée, alors Centreon n’écrase pas la configuration

du modèle de service parent mais ajoute les contacts en complément des contacts définis au niveau du modèle
parent.

— La liste Contacts liés indique les contacts qui recevront les notifications.

6.3. Les services
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— Si la case Groupes de contacts en complément de ceux hérités est cochée, alors Centreon n’écrase pas la
configuration du modèle de service parent mais ajoute les groupes de contacts en complément des groupes de
contacts définis au niveau du modèle parent.

— Si la case Inherit only contacts/contacts group from host est cochée, alors lors de la génération de la confi-
guration, les contacts et/ou groupes de contacts de l’hôte (ou de ses templates suivant l’héritage) viendront
écraser ceux du service ou de ses modèles de service. Cette fonction désactive la saisie de contacts et groupes
de contacts pour ce service.

— Au sein de la liste Groupe de contacts liés tous les contacts appartenant aux groupes de contacts définis
recevront les notifications.

— Le champ Intervalle de notification est exprimé en minutes. Il indique la durée entre chaque envoi de notifica-
tion lorsque le statut est non-OK. Si la valeur est définie à 0 alors l’ordonnanceur envoie une seule notification
par changement de statut.

— Les Options de notifications définissent les statuts pour lesquels une notification sera envoyée.
— Le Délai de première notification est exprimé en minutes. Il fait référence au délai à respecter avant l’envoi

d’une première notification lorsqu’un statut non-OK est validé.

6.3.2 Onglet Relations

Relations

— La liste Lié aux hôtes permet de définir le ou les hôtes auxquels lier ce service.
— La liste Lié aux groupes de services permet de lier le service à un ou plusieurs groupes de services.

Traps SNMP

Le champ Traps SNMP reliés au service permet de définir les traps SNMP qui pourront modifier le comportement
du service.

6.3.3 Traitement des données

— Si le champ Exécuter une commande post contrôle est activé, alors la commande de remontée des contrôles
de l’hôte sera activée.

— Le champ Contrôler la fraîcheur du résultat permet d’activer ou de désactiver le contrôle de fraîcheur du
résultat.

— Le champ Seuil de fraîcheur du résultat est exprimé en secondes. Si durant cette période aucune demande
de changement de statut du service (commande passive) n’a été reçue alors la commande de vérification est
exécutée.

— Le champ Détection de bagotage des statuts permet d’activer ou de désactiver la détection du bagotage des
statuts (statut changeant trop fréquemment de valeur sur une période donnée).

— Les champs Seuil bas de détection de bagotage des statuts et Seuil haut de détection de bagotage des
statuts définissent les seuils hauts et bas pour la détection du bagotage en pourcentage de changement.

— Le champ Traitement des données de performances permet d’activer ou de désactiver le traitement des
données de performances (et donc la génération des graphiques de performances).

— Les champs Rétention des informations de statut et Rétention et des informations concernant pas le statut
indiquent si les informations concernant ou ne concernant pas le statut sont sauvegardées après chaque relance
de la commande de vérification.

— Le champ Options à enregistrer définit les options à enregistrer si la rétention est activée
— Le champ Gestionnaire d’évènements activé permet d’activer ou de désactiver le gestionnaire d’évènements.
— Le champ Gestionnaire d’évènements définit la commande à exécuter si le gestionnaire d’évènements est

activé.
— Le champ Arguments définit les arguments de la commande du gestionnaire d’évènements.
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6.3.4 Informations supplémentaires du service

Centreon

— Modèle de graphique : Définit le modèle de graphique à utiliser pour présenter les données de performances
liées au service.

— Catégories : Définit la(les) catégorie(s) à laquelle (auxquelles) le service appartient.

Moteur de supervision

— Le champ URL définit une URL qui peut être utilisée pour donner davantage d’informations sur le service.
— Le champ Notes permet d’ajouter des notes optionnelles concernant le service.
— Le champ URL d’action définit une URL habituellement utilisée pour donner des informations d’actions sur

le service (maintenance...).
— Le champ Icône indique l’icône à utiliser pour le service.
— Le champ Icône alternative est le texte utilisé si l’icône ne peut être affichée.
— Le champ Niveau de criticité indique le niveau de criticité du service.

Informations supplémentaires

— Le champ Statut permet d’activer ou de désactiver le service.
— Le champ Commentaires permet d’ajouter un commentaire concernant le service.

6.3.5 Détachement d’un service

Si un service est lié à plusieurs hôtes, alors il sera identique pour chacun d’eux. Il ne sera donc pas possible de modifier
unitairement le service d’un hôte pour modifier une propriété. C’est pourquoi il est possible de transformer ce service
lié à plusieurs hôtes en un service unique pour chaque hôte :

1. Dans la liste des services, sélectionnez le service lié à plusieurs hôtes (habituellement ce service est surligné
en orange)

2. Dans le menu More actions... cliquez sur Détacher puis validez

Il existe maintenant un service unique par hôte.

6.4 Les commandes

6.4.1 Définition

Une commande est la définition d’une ligne de commande qui utilise un script ou une application afin de réaliser une
action. Il est possible d’exécuter cette commande en précisant des arguments.

Il existe trois types de commandes :
— Les commandes de vérification sont utilisées par les ordonnanceurs afin de vérifier le statut d’un hôte ou d’un

service.
— Les commandes de notification sont utilisées par les ordonnanceurs pour alerter les contacts (via mail, SMS...).
— Des commandes diverses sont utilisées par les modules complémentaires (pour effectuer certaines actions),

par l’ordonnanceur pour le traitement des données...
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Toutes les commandes peuvent être configurées au sein du menu Configuration ==> Commandes.

6.4.2 Ajouter une commande

Avant d’ajouter une commande :

1. Sélectionnez dans le menu de gauche le type de commande que vous souhaitez ajouter (Contrôles, Notifica-
tions, Divers).

2. Cliquez sur Ajouter
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Note : Les champs de configuration d’une commande sont les mêmes qu’importe le type de commande choisi.

6.4.3 Les champs de configuration

— Le champ Nom de la commande définit le nom de la commande.
— Le champ Type de commande permet de choisir le type de commande.
— Le champ Ligne de commande indique l’application ou le script utilisé avec la commande.
— La case Activer le shell permet d’activer des fonctions propres à un shell tel que le pipe...
— Les champs Exemple d’arguments et $HOSTADDRESS$ définissent respectivement des exemples d’argu-

ments (chaque argument commence par un ” !”) et une adresse IP de test. Ces champs permettent d’exécuter la

ligne de commande définie au-dessus via l’interface web en cliquant sur la flèche bleue : .
— Le bouton Description des arguments permet d’ajouter une description aux arguments de type “$ARGn$”.

Cette description sera visible lors de l’utilisation de la commande dans un formulaire d’hôte ou de service.
— Le bouton Effacer les arguments efface la description des arguments définie
— Le bouton Description des macros permet d’ajouter une description aux macros personalisées. Ces descrip-

tions seront visibles lors de l’ajout de la commande sur un host ou un service.
— Le champ Connecteurs permet de lier un connecteur à la commande. Pour davantage d’informations sur les

connecteurs reportez-vous aux chapitres Documentation connecteurs Perl et Documentation connecteurs SSH.
— Le champ Modèle de graphique permet de lier la commande à un modèle de graphique.
— Le champ Commentaire permet de commenter la commande.

6.4.4 Arguments et macros

Au sein du champ Ligne de commande, il est possible de faire appel à des macros ainsi qu’à des arguments.

Les arguments sont utilisés afin de pouvoir passer différents paramètres aux scripts appelés par les commandes. Lors
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de l’exécution de la commande par l’ordonnanceur, chacun des arguments et macros sont remplacés par leur valeur
respective. Chaque argument se présente sous la forme $ARGn$ où n est un entier naturel supérieur à 0.

Exemple de ligne de commande utilisant les arguments : $USER1$/check-bench-process-DB -w $ARG1$ -c $ARG2$
-n $ARG3$

Note : La bonne pratique veut que nous remplacions les arguments par des macros personnalisées.

6.5 Les périodes temporelles

6.5.1 Définition

Une période temporelle est la définition d’un intervalle de temps pour chacun des jours de la semaine. Ces périodes
temporelles servent à activer les fonctionnalités de l’ordonnanceur sur une période donnée.

Les périodes temporelles s’appliquent à deux types d’actions :
— L’exécution des commandes de vérification
— L’envoi de notifications

6.5.2 Configuration

La configuration des périodes temporelles se déroule dans le menu Configuration ==> Utilisateurs ==> Périodes
temporelles.

Options basiques

— Les champs Nom de la période temporelle et Alias définissent respectivement le nom et la description de la
période temporelle.

— Les champs appartenant à la sous-catégorie Période de temps définissent les jours de la semaine pour lesquels
il est nécessaire de définir des plages horaires.

— Le tableau Exceptions permet d’inclure des jours exclus de la période de temps

Syntaxe d’une période de temps

Lors de la création d’une période temporelle, les caractères suivants permettent de définir les périodes temporelles :
— Le caractère ” :” sépare les heures des minutes. Exemple : HH :MM
— Le caractère “-” indique une continuité entre deux horaires
— Le caractère ”,” permet de séparer deux plages horaires

Quelques exemples :
— 24 heures sur 24 et 7 jours sur 7 jours : 00 :00-24 :00 (à appliquer à tous les jours de la semaine).
— De 08h00 à 12h00 et de 14h00 à 18h45 les jours de la semaine : 08 :00-12 :00,14 :00-18 :45 (à entrer au niveau

des jours de la semaine uniquement).
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Les exceptions

Les exceptions permettent d’inclure à la plage temporaire des jours exceptionnels (surcharge de la définition du fonc-
tionnement régulier de la journée).

Exemple : Un administrateur souhaite définir une période temporelle qui regroupe les heures de fermeture du bureau
c’est à dire :

— De 18h00 à 07h59 les jours de semaine
— 24 heures sur 24 les weekends
— Les jours fériés, jours de fermeture exceptionnelle

Afin de pouvoir définir les jours fériés ainsi que les jours de fermeture exceptionnelle, il est nécessaire d’utiliser les
exceptions.

Pour ajouter une exception, cliquez sur le bouton . Par journée exceptionnelle, vous devez définir une plage horaire.
Le tableau ci-dessous présente quelques exemples possibles :

Jour(s) Période de temps Explications
january 1 00 :00-24 :00 Toute la journée le premier janvier de chaque année
2014-02-10 00 :00-24 :00 Toute la journée du 10 février 2014
july 1 - august 1 00 :00-24 :00 Tous les jours de chaque année du 1 juillet au 1 août
november 30 08 :00-19 :00 De 08h00 à 19h00 tous les 30 novembre de chaque année
day 1 - 20 00 :00-24 :00 Toute la journée du premier au 20 de chaque mois
saturday -1 08 :00-12 :00,14 :00-18 :45 Tous les derniers samedi du mois les heures ouvrées
monday -2 00 :00-24 :00 Tous les avant derniers lundi du mois toute la journée

6.5. Les périodes temporelles
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Options avancées

Au sein des options avancées, il est possible d’inclure ou d’exclure des périodes à la définition de l’objet. Exemple
d’application. Prenons deux périodes temporelles :

— Une période est définie 24 heures sur 24 / 7 jours sur 7 appelée 24x7
— Une autre qui regroupe les horaires d’ouvertures du bureau appelée working_hours

Pour obtenir les horaires de fermeture du bureau, je n’ai qu’à créer une période temporelle dans laquelle j’inclus la
plage 24x7 et pour laquelle j’exclus la plage working_hours.

6.6 Les contacts

6.6.1 Définition

Les contacts au sein de Centreon sont utilisés afin de :
— Pouvoir se connecter à l’interface web de Centreon : chaque contact dispose de ses propres droits afin de se

connecter à l’interface web.
— Etre alerté en cas de nécessité (notification).

Afin d’ajouter un contact, il suffit de se rendre dans le menu Configuration ==> Utilisateurs ==> Ajouter.
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Pour afficher la matrice de notification d’un contact, cliquez sur Afficher les notifications du contact (à côté du menu
Ajouter).

6.6.2 Informations générales

— Le champ Alias/Login définit le login afin d’accéder à l’interface web.
— Le champ Nom complet contient le nom et prénom de l’utilisateur.
— Les champs Mail et Bippeur contiennent respectivement l’adresse mail et le numéro de téléphone de l’utilisa-

teur (dans le cas d’une notification par SMS ou appel par exemple).
— Le champ Modèle de contact utilisé permet de lier le contact à un modèle de contact.
— La liste Lié avec le groupe de contacts associe le contact à un ou plusieurs groupes de contacts.
— Le champ Activer les notifications permet d’activer l’envoi de notifications pour l’utilisateur.
— Le champ Options de notifications d’hôte/de service permet de définir les statuts pour lesquels il y a envoi

de notifications.
— Le champ Période de notification d’hôte/de service permet de choisir la période temporelle pour laquelle il

y a envoi de notification.
— Le champ Commande de notification d’hôte/de service permet de choisir la commande de notification pour

un hôte ou pour un service.

6.6.3 Authentification Centreon

— Le champ Autoriser l’utilisateur à se connecter à l’interface web permet d’autoriser l’utilisateur à accéder
à l’interface web de Centreon.

— Les champs Mot de passe et Confirmation du mot de passe contiennent le mot de passe utilisateur.
— Le champ Langue par défaut permet de définir la langue de l’interface Centreon pour cet utilisateur.
— Le champ Administrateur définit si cet utilisateur est administrateur de la plateforme de supervision ou non.
— Le champ Clé d’auto-connexion permet de définir une clé de connexion pour l’utilisateur. L’utilisateur n’aura

plus besoin d’entrer son login et mot de passe mais utilisera directement cette clé pour se connecter. Syntaxe
de connexion :

http://[IP_DU_SERVEUR_CENTRAL]/index.php?autologin=1&useralias=[login_utilisateur]&token=[valeur_autologin]

Note : La possibilité de connexion automatique (auto login) doit être activée dans le menu Administration ==>
Options.

— Le champ Source d’authentification spécifie si les informations de connexion proviennent d’un annuaire
LDAP ou d’informations stockées localement sur le serveur.

— Le champ Groupes de liste d’accès permet de définir un groupe d’accès pour un utilisateur, groupe utilisé
pour les contrôles d’accès (ACL).

Note : Un utilisateur Administrateur ne peut souffrir de contrôle d’accès même lié dans un groupe d’accès.

6.6.4 Informations supplémentaires

— Les champs d’adresses permettent de spécifier des informations de contacts supplémentaires (autre mail, autre
numéro de téléphone...).

— Les champs Statut et Commentaires permettent d’activer ou de désactiver le contact et de commenter celui-ci.

6.6. Les contacts
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6.7 Les groupes

Un groupe permet de regrouper un ou plusieurs objets. Il existe trois types de groupes : hôtes, services et contacts.

Les groupes d’hôtes et de services servent principalement lors de la visualisation des graphiques ou pour regrouper les
objets. Les groupes de contacts sont utilisés principalement pour la mise en place de LCAs (ou ACL).

6.7.1 Les groupes d’hôtes

Pour ajouter un groupe d’hôtes :
1. Rendez-vous dans le menu Configuration ==> Hôtes
2. Dans le menu de gauche, cliquez sur Groupes d’hôtes
3. Cliquez sur Ajouter

— Les champs Nom du groupe d’hôtes et Alias regroupent le nom et l’alias du groupe d’hôtes.
— La liste Hôtes liés permet d’ajouter des hôtes au sein du nouveau groupe d’hôtes.
— Le champ Notes permet d’ajouter des notes optionnelles concernant le groupe d’hôtes.
— Le champ URL définit une URL qui peut être utilisée pour donner davantage d’informations sur le groupe

d’hôtes.
— Le champ URL d’action définit une URL habituellement utilisée pour donner des informations d’actions sur

le groupe d’hôtes (maintenance...).
— Le champ Icône indique l’icône à utiliser pour le groupe d’hôtes.
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— Le champ Icône pour la carte est l’icône utilisée pour la cartographie.
— Le champ Rétention des fichiers RRD est exprimé en jours, il permet de définir la durée de rétention des

services appartenant à ce groupe d’hôtes au sein de la base de données RRD. Si cette valeur est vide, la valeur
sera celle par défaut définie dans le menu “Administration ==> Options ==> CentStorage” pour le champ
Durée de rétention des données dans les bases RRD.

— Les champs Statut et Commentaires permettent d’activer ou de désactiver le groupe d’hôtes et de commenter
celui-ci.

6.7.2 Les groupes de services

Pour ajouter un groupe de services :

1. Rendez-vous dans le menu Configuration ==> Services
2. Dans le menu de gauche, cliquez sur Groupes de services
3. Cliquez sur Ajouter

— Les champs Nom du groupe de services et Description regroupent le nom et la description du groupe de
services.

— La liste Services d’hôtes liés permet de choisir les différents services qui feront partie de ce groupe.
— La liste Services liés au groupe d’hôtes permet de choisir les services liés à un groupe d’hôtes qui feront

partie de ce groupe.
— Si un modèle de service appartient à la liste Modèles de service liés alors tous les services qui héritent de ce

modèle appartiennent à ce groupe.
— Les champs Statut et Commentaires permettent d’activer ou de désactiver le groupe de services et de com-

menter celui-ci.

6.7. Les groupes
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6.7.3 Les groupes de contacts

Pour ajouter un groupe de contacts :

1. Rendez-vous dans le menu Configuration ==> Utilisateurs
2. Dans le menu de gauche, cliquez sur Groupes de contacts
3. Cliquez sur Ajouter

— Les champs Nom du groupe de contacts et Alias définissent le nom et la description du groupe de contacts.
— La liste Contacts liés permet d’ajouter les contacts au groupe de contacts.
— Les champs Statut et Commentaires permettent d’activer ou de désactiver le groupe de contacts et de com-

menter celui-ci.

Note : Pour plus d’information se référer au chapitre associé sur les groupes.

6.8 Les catégories

Les catégories sont utilisées afin de pouvoir définir des ACLs sur les hôtes et les services. Le but est de pouvoir classer
les hôtes ou les services au sein d’une même catégorie.

Centreon 2.4 avait intégré une nouvelle fonctionnalité appelée “Criticité”. A partir de la version 2.5, les niveaux
de criticité sont liés à une catégorie, ils sont devenus un type de catégorie. Un niveau de criticité est un indicateur
permettant de définir la criticité d’un hôte ou d’un service. Le but est de pouvoir traiter les problèmes des hôtes ou des
services par ordre de priorité. Grâce à ce système, il est ainsi possible de filtrer les objets dans les vues “Supervision”
par criticité.

6.8.1 Les catégories d’hôtes

Pour ajouter une catégorie d’hôtes :

1. Rendez-vous dans le menu Configuration ==> Hôtes
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2. Dans le menu de gauche, cliquez sur Catégories
3. Cliquez sur Ajouter

— Les champs Nom de la catégorie d’hôtes et Alias contiennent respectivement le nom et l’alias de la catégorie
d’hôte.

— La liste Hôtes liés permet d’ajouter des hôtes à la catégorie.
— Si un modèle d’hôte est ajouté à Lié au modèle d’hôte alors tous les hôtes qui héritent de ce modèle appar-

tiennent à cette catégorie.
— La case Est de type criticité signifie que la catégorie d’hôtes à un niveau de criticité.
— Les champs Niveau et Icônes définissent respectivement un niveau de criticité et une icône associée.
— Les champs Statut et Commentaires permettent d’activer ou de désactiver la catégorie d’hôte et de commenter

celle-ci.

6.8.2 Les catégories de services

Pour ajouter une catégorie de services :

1. Rendez-vous dans le menu Configuration ==> Services
2. Dans le menu de gauche, cliquez sur Catégories
3. Cliquez sur Ajouter

6.8. Les catégories
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— Les champs Nom et Description définissent le nom et la description de la catégorie de service.
— Si un modèle de service appartient à Liée aux modèles de services alors tous les services appartenant à ce

modèle de services font partie de cette catégorie.
— La case Est de type criticité signifie que la catégorie de service à un niveau de criticité.
— Les champs Niveau et Icônes définissent respectivement un niveau de criticité et une icône associée.
— Le champ Statut permet d’activer ou de désactiver la catégorie de services.

Note : Pour plus d’information se référer au chapitre associé sur les catégories.

6.9 Les modèles

6.9.1 Définition

Un modèle est une pré-configuration de paramètres d’un objet qui pourra être utilisé pour configurer ce dernier. Le
principal avantage est de pouvoir définir des valeurs par défaut pour certains objets afin d’accélérer la création d’objets
similaires.

Lors de la création d’un modèle, seul le nom du modèle est obligatoire. Les autres attributs sont optionnels.

Il existe trois types de modèles :
— Les modèles d’hôtes
— Les modèles de services
— Les modèles de contacts

Les avantages sont :
— Définition simplifiée des éléments
— Pas de redondance d’information
— Facilité d’ajout de nouvelles ressources
— Configurations prédéfinies assimilées à un « catalogue d’indicateurs»
— Les modèles peuvent hériter d’autres modèles

6.9.2 Les modèles d’hôtes

Héritage

Un hôte ou un modèle d’hôte peut hériter d’un ou plusieurs modèles d’hôtes. Cet héritage peut être :
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— de type associatif (addition de plusieurs modèles d’hôte)
— de type père-fils

Héritage de type Père-Fils

Il s’agit d’une prédéfinition de paramètres à “n” niveaux. L’objet hérite de son modèle qui peut lui même hériter de son
modèle. Si le fils redéfini un paramètre, ce dernier écrase celui défini dans les modèles de niveaux supérieurs. Sinon il
vient compléter le paramétrage.

Héritage de type associatif

Il s’agit d’additionner plusieurs modèles au sein d’un même objet afin d’additionner l’ensemble des paramètres dispo-
nibles. Si un hôte hérite de plusieurs modèles d’hôtes et si un même paramètre est défini sur plusieurs modèles, alors
le modèle d’hôte situé au-dessus des autres modèles est prioritaire par rapport à ses ascendants.

Le schéma ci-dessous présente un hôte héritant de plusieurs modèles d’hôtes.

6.9. Les modèles
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Configuration

Pour ajouter un modèle d’hôtes :

1. Rendez-vous dans le menu Configuration ==> Hôtes
2. Dans le menu de gauche, cliquez sur Modèles
3. Cliquez sur Ajouter

Note : Se rapporter au chapitre de configuration des hôtes pour configurer un modèle car le formulaire est identique.

6.9.3 Les modèles de services

Héritage

Un service ou un modèle de service ne peut hériter que d’un seul modèle de service (héritage de type Père-Fils).

Configuration

Pour ajouter un modèle de services :

1. Rendez-vous dans le menu Configuration ==> Services
2. Dans le menu de gauche, cliquez sur Modèles
3. Cliquez sur Ajouter

Note : Se rapporter au chapitre de configuration des services pour configurer un modèle car le formulaire est identique.

6.9.4 Les bonnes pratiques

Explications

La bonne pratique veut que des modèles de services soient associés à des modèles d’hôtes : lors de la création d’un
hôte, les services sont générés automatiquement à partir des modèles d’hôtes. Il y a deux intérêts à lier les modèles de
services aux modèles d’hôtes :

— Les services générés automatiquement conservent leur granularité : il est donc possible de modifier les attributs
d’un service sans impacter les autres services issus de ce modèle
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— La création de nouveaux hôtes est grandement accélérée : vous n’avez qu’à définir l’hôte et les modèles d’hôtes
associés à celui-ci

Exemple : Je créé l’hôte srvi-web-01 selon le modèle ci-dessous :

L’hôte srvi-web-01 possèdera automatiquement les services suivants :
— Load, CPU, Memoiry, disk-/ à partir des modèles de services issus du modèle d’hôte “Linux-Server-RedHat-5”
— broken-jobs, hit-ratio, tablespaces, listener à partir des modèles de services issus du modèle d’hôte “DB-

MySQL”
— processus et connection à partir des modèles de services issus du modèle d’hôte “Web-Server-Apache”

Lorsque les services d’un hôte sont générés à partir des modèles d’hôtes, il est possible que certains services générés ne
soient plus ou pas vérifiés par l’outil de supervision. Dans ce cas, il est nécessaire de désactiver les services inutilisés
(et non de les supprimer). En cas de suppression des services, la régénération des services de l’hôte à partir des modèles
d’hôtes va recréer les services supprimés.

6.9. Les modèles
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Configuration

La liaison des modèles de services avec les modèles d’hôtes a lieu dans l’onglet Relations des modèles de services ou
des modèles d’hôtes.

6.9.5 Les modèles de contacts

Un contact ou un modèle de contact peut hériter d’un seul modèle de contact.

Configuration

Pour ajouter un modèle de contacts :

1. Rendez-vous dans le menu Configuration ==> Utilisateurs
2. Dans le menu de gauche, cliquez sur Modèles de contacts
3. Cliquez sur Ajouter
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Note : Se rapporter au chapitre de configuration des contacts. De plus, les modèles de contacts sont utilisés pour
l’import automatique de profils via un annuaire LDAP.

6.10 Configuration simplifiée de Centreon IMP

6.10.1 Qu’est-ce que IMP ?

Centreon IMP pour Instant Monitoring Platform, est une solution basée sur l’association de Centreon 3.4 et de la
nouvelle génération de Plugin Packs accessible en ligne (acquisition et installation).

L’objectif de Centreon IMP est de vous faire gagner beaucoup de temps lors de la mise en place de votre supervision, de
simplifier la mise en place de vos points de contrôle et de réduire le temps de maintenance de votre plate-forme. Grâce
à ses Plugin Packs, plugins packagés avec des modèles prêts à l’emploi couplés à une documentation de déploiement
(monitoring procedure), Centreon IMP doit vous permettre de démarrer votre supervision au maximum 30 minutes
après l’installation du système Centreon 3.4. Tous les Plugin Packs sont maintenus par nos équipes et font l’objet de
mises à jour ou ajouts réguliers, vous permettant d’améliorer de façon continue vos contrôles.

Les Plugin Packs (pack de configuration), développés par Centreon, reposent sur les Centreon Plugins (sondes de
supervision) dont l’éventail fonctionnel est un des plus riches du marché : plus de 170 domaines IT sont déjà couverts
en 2017, représentant plus de 2000 indicateurs de supervision. Ils vous permettent de déployer votre supervision
rapidement et simplement.

Vous souhaitez utiliser Centreon IMP ? Rien de plus simple. Suivez les instructions ci-dessous.

6.10.2 Prérequis

1. Avoir installé Centreon 3.4

Pour pouvoir utiliser Centreon IMP, vous devez absolument installer la dernière version de Centreon open source, la
version 3.4. Cette version intègre la dernière version de Centreon Web c’est à dire la version 2.8.x.

Centreon 3.4 est installable soit en “fresh install” avec l’ISO d’installation de Centreon soit en mettant à jour votre
plateforme Centreon déjà installée. Pour ces deux étapes, rendez-vous dans les rubriques appropriées de la documen-
tation

2. Avoir une connexion internet

Pour accéder à Centreon IMP, votre serveur de supervision Centreon central, doit absolument avoir une connexion à
internet. Cette dernière permettra de procéder à la récupération des Plugin Packs de Centreon IMP via internet puis
leur installation.

Note : Si votre serveur Centreon n’a pas accès directement à internet, pensez à configurer un proxy.

6.10.3 Accédez aux Plugin Packs de Centreon IMP

Premiers Plugin Packs gratuits : avec Centreon 3.4, vous pouvez déjà récupérer les 6 Plugin Packs délivrés gratuite-
ment.

Pour récupérer les Plugin Packs de Centreon IMP, votre plate-forme Centreon open source a besoin d’être connectée
à votre compte Centreon IMP créé sur le site web Centreon.

En créant votre compte Centreon IMP sur le site web de Centreon, vous pouvez :
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— soit accéder à 5 Plugin Packs additionnels gratuitement (essai gratuit de Centreon IMP)
— soit souscrire à l’offre Centreon IMP et accéder à son catalogue de Plugin Packs prêts à l’emploi couvrant à ce

jour plus de 170 domaines IT.
Centreon open
source (verison 3.4)

Centreon IMP Free Trial
with online account

Centreon IMP 1/6/12 month
online subscription

6 Free Plugin
Pack(*)

x x x

5 additional Free
Plugin Packs

x x

+160 Plugin Packs x
total 6 Free Plugin Packs(*) 11 Free Plugin Packs +170 Plugin Packs

Quels Plugin Packs sont disponibles à chaque niveau ?
— Centreon open source 3.4 - 6 Plugins packs gratuits :

— Cisco standard (SNMP)
— Linux (SNMP)
— MySQL
— Printer standard (SNMP)
— UPS Standard (SNMP)
— Windows (SNMP)
— Centreon (central)
— Centreon DB
— Centreon Poller
— Centreon Map
— Centreon MBI

— Essai gratuit de Centreon IMP avec un compte en ligne - 5 Plugin Packs additionnals :
— DHCP
— DNS
— FTP
— HTTP
— LDAP

— Centreon IMP avec une souscription de 1, 6, 12 mois : Accès au catalogue de Plugin Packs.

Note : (*) Nous savons tous que 6 != 11 Aux 6 Plugin Packs livrés gratuitement avec Centreon 3.4, s’ajoutent 5 Plugin
Packs Centreon (Central, DB, Poller, MAP et MBI). Comme ils servent à superviser la plateforme de supervision, nous
préférons ne pas les compter, ces packs servant à superviser votre plateforme de supervision.

6.11 Guide d’accès via l’exemple de l’essai gratuit à Centreon IMP

Nous allons maintenant vous guider dans l’accès aux 5 Plugin Packs de l’essai gratuit à Centreon IMP.

Pour cela il vous suffit de créer votre compte Centreon IMP sur le site web de Centreon.

Suivez les étapes décrites ci-dessous :

6.11.1 1. Créez votre compte Centreon IMP sur le site web de Centreon

La création de ce compte est gratuite et ne prend que quelques minutes.

Allez sur le site web de Centreon et rendez-vous sur la page de souscription à Centreon IMP. Cliquez sur “Try it” dans
la première colonne du tableau comparatif des offres.
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Créez maintenant votre compte Centreon IMP (rubrique New customer) et conservez précieusement votre login et
password. Ils vous seront nécessaire pour activer votre compte Centreon IMP dans Centreon et ainsi avoir accès aux 5
Plugin Packs additionnels gratuits.

Après avoir complété tous les champs, validez en cliquant sur le bouton subscribe. Votre compte est créé. Vous allez
maintenant activer votre compte Centreon IMP dans Centreon.

Note : Veillez à indiquer une adresse email valide car la création d’un compte puis l’accès à l’essai gratuit de Centreon
IMP intègre l’envoi automatisé de mails de confirmations/informations.
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6.11.2 2. Activer son compte Centreon IMP dans Centreon

Sur votre plate-forme Centreon, allez dans le menu Administration -> Extensions -> Subscription et connectez-vous
avec votre login et password de votre compte Centreon IMP.

Note : Il s’agit du compte que vous avez créé sur le site web de Centreon (étape précédente).

Note : Si le menu Administration -> Extensions -> Subscription n’est pas disponible sur votre Centreon, rendez-
vous dans le menu Administration -> Extensions -> Modules et installez les modules suivants en cliquant sur l’icône
d’installation situé à droite :

— centreon-pp-manager
— centreon-license-manager

En cliquant sur la flèche à côté du champ “Password”, vous allez activer votre compte Centreon IMP.
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Vous êtes maintenant connecté ! En cliquant sur le bouton Setup vous allez maintenant accéder à l’installation de vos
5 Plugin Packs additionnels gratuits.

Note : Avec ce compte vous pouvez connecter gratuitement plusieurs plate-forme à la fois pour faire vos tests.

6.11.3 3. Installez vos 5 Plugin Packs additionnels gratuits

Pour installer vos 5 Plugin Packs et bénéficier de l’essai gratuit Centreon IMP, cliquez sur le bouton Setup. Vous
accédez alors au Plugin Pack Manager.

Le Plugin Pack Manager vous permet de visualiser les Plugins Packs et de les installer très facilement.
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Dans l’essai gratuit de Centreon IMP (notre exemple présent), seule une partie du catalogue des Plugin Packs est
accessible. Les Plugin Packs non disponibles au téléchargement s’affichent en grisé et les boutons d’installation ou de
mise à jour seront alors indisponibles au passage de la souris (les 3 Plugin Packs en bas à droite de notre capture).

Pour installer un Plugin Pack, il suffit de passer votre souris dessus puis de cliquer sur l’icône d’installation (symbole
+ en vert).

avant installation après installation

N’oubliez pas que chaque pack nécessite également le déploiement de plugins. Dans chaque monitoring procédure
mise à disposition avec votre pack, vous avez la liste des dépendances sous forme de rpm à installer pour que votre
supervision puisse démarrer.

Note : Pensez à déployer tous les rpms sur chaque poller qui le nécessitent. Sinon votre supervision ne pourra pas
fonctionner. En effet, seuls les Plugins Centreon des 11 premiers Plugin Packs ont été installés par défaut sur vos
serveurs Centreon. Il est indispensable de suivre la procédure de déploiement de chaque Plugin Pack en cliquant sur
l’icône ” ?”.

Le Plugin Pack Manager dispose de filtres pour faciliter votre recherche d’un Plugin Pack. Vous pouvez effectuer des
recherches en fonction de :
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— Mot clé (Keyword)
— Catégorie (Category)
— Statut (Status)
— Date de mise à jour du pack (Last update)

Pour accéder à la description d’un Plugin Pack il vous suffit de cliquer sur son icône.

6.11.4 4. L’essayer c’est l’adopter !

Pour accéder à l’ensemble des Plugin Packs de Centreon IMP, vous pouvez souscrire à l’Offre suivant différentes
durées : 1 mois, 6 mois ou 1 an. Bien sûr, le tarif est plus attractif pour les durées d’engagements les plus longues.

Pour souscrire, rendez-vous sur notre site et sélectionnez une souscription

Après l’achat de votre souscription Centreon IMP, vous allez activer votre compte Centreon IMP dans Centreon. Pour
cela, cliquez sur le bouton Link.
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Confirmez que c’est réellement ce que vous souhaitez faire.

Vous avez maintenant accès à tous les Plugin Packs de Centreon IMP. Cliquez sur le bouton install pour accédez au
Plugin Pack Manager et procéder à l’installation des Plugin Packs de votre choix.
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Votre abonnement Centreon IMP intègre l’accès aux Plugin Packs, à leur installation, à leur mise à jour, l’accès aux
nouveaux Plugin Packs développés par Centreon et une assistance en ligne.

Si vous décidez d’arrêter votre abonnement Centreon IMP, vous ne perdrez pas le bénéfice des Plugin Packs installés.
Les hôtes et les points de contrôles déployés grâce aux Plugin Packs resteront inchangés.

En revanche, vous perdrez l’accès aux mises à jour des Plugin Packs installés, l’accès aux nouveaux Plugin Packs ainsi
que l’accès à tous les Plugin Packs non installés et vous n’aurez plus aucune assistance en ligne.

Note : Si vous décidez de changer de serveur et donc de migrer votre souscription sur un nouveau serveur, vous serez
obligé de passer par le service client. Nous n’avons pas encore intégré à nos outils en ligne la possibilité de le faire.
Pour cela, contactez imp at centreon dot com.

Note : Si vous avez des questions ou des problèmes relatifs à l’installation de IMP, vous pouvez contacter nos équipes
techniques via l’adresse email suivant : imp at centreon dot com.

Si vous avez des questions n’hésitez pas à consulter notre FAQ Centreon IMP

6.12 Configuration avancée

Voici toutes les fonctions de configuration avancées.

6.12.1 Les macros

Une macro est une variable permettant de récupérer certaines valeurs. Une macro commence et se termine toujours
par le signe “$”.

Les macros standards

Les macros standards sont des macros prédéfinies dans le code source des moteurs de supervision. Ces différentes
macros permettent de récupérer la valeur de différents objets au sein des commandes.

Exemple :
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— La macro $HOSTADDRESS$ permet de récupérer l’adresse IP d’un hôte
— La macro $CONTACTEMAIL$ permet de récupérer l’adresse mail du contact

Note : La liste complète des macros est disponible à l’adresse suivante : Liste des macros

Les macros personnalisées

Définition

Les macros personnalisées sont des macros définies par l’utilisateur lors de la création d’un hôte ou d’un service.
Elles sont utilisées dans les commandes de vérifications. Les macros personnalisées commencent par $_HOST pour
les macros personnalisées d’hôtes et par $_SERVICE pour les macros personnalisées de services. Il y a plusieurs
avantages à utiliser les macros personnalisées à la place des arguments :

— La fonction de la macro est définie dans le nom de celle-ci. La macro $_HOSTMOTDEPASSEINTRANET$
est plus facilement lisible que $ARG1$

— Les macros héritent des modèles d’hôtes et de services, la modification d’une seule macro est donc possible
pour un hôte ou un service. En revanche, les arguments doivent être tous redéfinis en cas de modification d’un
seul argument

— Le nombre d’arguments est limité à 32 contrairement aux macros personnalisées qui sont infinies
Une macro d’hôte est utilisée pour définir une variable qui est propre à l’hôte et qui ne changera pas qu’importe
le service interrogé : des identifiants de connexion à l’hôte, un port de connexion pour un service particulier, une
communauté SNMP.

Une macro de service est plutôt utilisée pour définir des paramètres propres à un service : un seuil WAR-
NING/CRITICAL, une partition à interroger...

Exemple

Lors de la définition d’un hôte, les macros suivantes sont créées :

Pour faire appel à ces macros dans une commande de vérification, il faudra les invoquer en utilisant les variables
suivantes : $_HOSTUSERLOGIN$, $_HOSTUSERPASSWORD$.

Lors de la définition d’un service, les macros suivantes sont créées :

Pour faire appel à ces macros dans une commande de vérification, il faudra les invoquer en utilisant les variables
suivantes : $_SERVICEPARTITION$, $_SERVICEWARNING$, $_SERVICECRITICAL$.
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Cas particulier

Le champ Communauté SNMP & Version présent au sein d’une fiche d’hôte génèrent automatiquement les macros
personnalisées suivantes : $_HOSTSNMPCOMMUNITY$ et $_HOSTSNMPVERSION$.

Les macros de ressources

Les macros de ressources sont des macros globales qui sont utilisées par le moteur de supervision. Ces macros peuvent
être invoquées par n’importe quel type de commande. Elles se présentent sous la forme $USERn$ où ‘n’ est compris
entre 1 et 256.

D’une manière générale, ces macros sont utilisées pour faire référence aux chemins contenant les sondes de supervi-
sion. Par défaut, la macro $USER1$ est créée et sa valeur est la suivante : /usr/lib/nagios/plugins.

Pour ajouter une macro de ressources :
— Rendez-vous dans le menu Configuration ==> Moteurs de supervision
— Cliquez sur Ajouter

— Le champ Nom de la ressource définit le nom de la macro de ressources. Exemple : $USER3$
— Le champ Valeur de la ressource définit la valeur de la macro.
— La liste Lié au collecteur permet de définir quels seront les moteurs de supervision qui pourront accéder à

cette macro.
— Les champs Statut et Commentaire permettent d’activer/désactiver la macro ou de la commenter.

Les macros d’environnements

Les macros d’environnement (aussi appelées macros “à la demande” ou “on demand” en anglais) permettent de récu-
pérer des informations à partir de tous les objets issus de la supervision. Elles sont utilisées afin de pouvoir récupérer
à un instant “t” la valeur d’un objet.

Elles sont complémentaires aux macros standards. Exemple :
— La macro standard $CONTACTEMAIL$ fait référence à l’adresse email du contact qui utilisera la commande

de notification
— La macro d’environnement $CONTACTEMAIL :centreon$ retournera l’adresse email de l’utilisateur “cen-

treon”
La documentation complète des macros à la demande est disponible à cette adresse Liste des macros.

Note : L’utilisation de ces macros n’est pas recommandée car la recherche d’une valeur d’un paramètre d’un objet
depuis un autre objet est consommateur en termes de ressources.
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Warning : L’activation du paramètre Activation des optimisations pour les installations de grandes tailles rend
impossible l’utilisation des macros d’environnements.

6.12.2 Les méta-services

Définition

Un méta-service est un service virtuel permettant l’agrégation de métriques issues de différents services au travers
d’une opération mathématique. Les méta-services sont gérés de la même manière qu’un service c’est à dire qu’ils
possèdent des seuils, un processus de notification, génèrent un graphique de performance...

Exemple : Il est possible de déterminer la consommation totale de trafic WAN en additionnant au sein d’un méta-
service l’ensemble des services supervisant le trafic WAN unitairement.

Les types de calcul

Plusieurs types de calculs sont possibles sur les métriques récupérées :
— Moyenne : réalise la moyenne des données de performances
— Somme : réalise la somme des données de performances
— Minimum : récupère le minimum de l’ensemble des données de performances
— Maximum : récupère le maximum de l’ensemble des données de performances

Les types de sources de données

Le résultat du calcul est une donnée de performance (métrique) qui génèrera un graphique de performance. Afin de
tracer au mieux le résultat, il faut sélectionner le type de source de données (par défaut GAUGE). Les types de sources
de données disponibles sont :

— Le type GAUGE enregistre une valeur instantanée (température, humidité, CPU, ...)
— Le type COUNTER enregistre une valeur incrémentale par rapport au résultat précédent
— Le type DERIVE stockera la dérivée de la ligne allant de la dernière à la valeur courante de la source de

données. Cela peut être utile pour des jauges, par exemple, de mesurer le taux de personnes entrant ou quittant
une pièce.

— Le type ABSOLUTE est pour les compteurs qui se réinitialisent à la lecture. Il est utilisé pour les compteurs
rapides qui ont tendance à déborder.

Note : Plus d’informations sur le site de RRDTools

Configuration

Pour ajouter un méta-service :

1. Rendez-vous dans le menu Configuration ==> Services
2. Dans le menu de gauche, cliquez sur Méta-services
3. Cliquez sur Ajouter
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Informations générales

— Le champ Nom du Méta-Service correspond au nom du méta-service affiché dans l’interface.
— Le champ Format de la chaîne de sortie (Formatage printf) correspond au message de sortie (‘output’)

visible dans Centreon. La valeur “%d” correspond à la valeur calculée par le méta-service
— Les champs Niveau d’alerte et Niveau critique correspondent respectivement aux seuils “WARNING” et

“CRITICAL” du méta-service.
— Les champs Type de calcul et Type de source de données correspondent respectivement aux calculs et à la

description de la source de données
— Le champ Mode de sélection permet de sélectionner les services contenant les métriques qui entreront dans le

calcul du méta-service.

Si l’option Sélectionner les services manuellement est sélectionnée alors les métriques choisies seront issues de
services sélectionnés manuellement.

Si l’option Recherche SQL est sélectionnée alors les services utilisés seront sélectionnés automatiquement par Cen-
treon via une recherche à partir du champ Expression SQL à rechercher de type LIKE. La métrique à utiliser sera
dans ce cas à sélectionner dans la liste déroulante Métrique.

Note : Plus d’informations sur le formatage PRINTF
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Etat du Meta Service

— Le champ Période de contrôle définit la période temporelle durant laquelle l’ordonnanceur vérifie le statut du
méta-service.

— Le champ Nombre de contrôles avant validation de l’état définit le nombre de contrôles à effectuer avant de
valider le statut du méta-service : lorsque le statut est validé, une notification est envoyée.

— Le champ Intervalle normal de contrôle est exprimé en minutes. Il définit l’intervalle entre chaque vérifica-
tion lorsque le statut du méta-service est OK.

— Le champ Intervalle non-régulier de contrôle est exprimé en minutes. Il définit l’intervalle de validation du
statut non-OK du méta-service.

Notification

— Le champ Notification activée permet d’activer les notifications.
— La liste Groupes de contacts liés permet de définir les groupes de contacts qui seront alertés.
— Le champ Intervalle de notification est exprimé en minutes et permet de définir l’intervalle de temps entre

l’envoi de deux notifications.
— Le champ Période de notification permet de définir la période de notification.
— Le champ Type de notification définit les types de notifications envoyées.

Informations supplémentaires

— La liste Modèle de graphique définit le modèle de graphique utilisé par ce méta-service.
— Les champs Statut et Commentaires permettent d’activer/désactiver ou de commenter le méta-service.

Sélectionner manuellement des services

Si vous avez choisi l’option Sélectionner les services manuellement, au sein de l’écran regroupant l’ensemble des
méta-services :

1. Cliquez sur pour sélectionner les métriques entrant en jeu dans le calcul du méta-service. Ces mé-
triques sont appelées indicateurs.

2. Cliquez sur Ajouter

— Le champ Hôte permet de sélectionner l’hôte auquel le service à sélectionner appartient.
— Le champ Service permet de choisir le service (première liste) ainsi que la métrique au sein de ce service

(seconde liste).
— Les champs Statut et Commentaires permettent d’activer/désactiver ou de commenter l’indicateur.

3. Répétez l’opération jusqu’à avoir ajouté tous les indicateurs nécessaires au calcul du méta-service.
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Note : Un méta-service est à considérer comme service régulier. Il est nécessaire de générer la configuration de
l’ordonnanceur central, d’exporter cette dernière puis de redémarrer l’ordonnanceur.

6.12.3 Les dépendances

Principe

Les dépendances sont utilisées afin de répondre à deux principaux besoins :
— Limiter l’envoi de notifications
— Cibler les alertes

Les dépendances d’objets sont de deux types :
— Dépendance physique entre objet : un switch de répartition est situé en amont d’un ensemble de serveurs et en

aval d’un routeur
— Dépendance logique entre objet : l’accès à un site web avec authentification LDAP dépend de l’état de l’an-

nuaire LDAP lui-même

Les dépendances physiques

Les dépendances physiques consistent à prendre en compte les liens physiques entre les équipements. Ce lien ne peut
être défini que pour les objets de type “Hôte”.

La configuration d’une dépendance physique se déroule au sein de l’onglet Relations d’une fiche de configuration
d’un hôte (Configuration ==> Hôtes ==> Ajouter).

Il est possible de définir deux paramètres :
— Les hôtes parents : signifie que les hôtes sélectionnés sont parents de cet hôte (situé en amont). Si tous les hôtes

parents sélectionnés deviennent indisponibles ou injoignables alors l’hôte sera considéré par l’ordonnanceur
comme injoignable lui-même.

— Les hôtes enfants : signifie que l’hôte devient parent de tous les hôtes enfants sélectionnés.

Note : Tous les parents d’un hôte doivent être dans un état non-OK pour que l’hôte lui-même soit considéré comme in-
joignable. A partir du moment où au moins un chemin d’accès (liaison de dépendance physique) est toujours joignable
alors l’ordonnanceur continuera de surveiller cet hôte.

Dans le cas où des relations de parentés ont été définies entre hôtes supervisés par des ordonnanceurs différents, il est
possible :

— D’empêcher l’établissement d’une relation de parenté, lors de la modification du formulaire d’hôte, entre deux
hôtes supervisés par deux collecteurs différents.

— D’autoriser l’établissement de cette relation de parenté. Dans ce cas la dépendance ne sera pas gérée par les
moteurs de supervision mais par Centreon Broker qui prendra en compte cette relation au sein de son moteur
de corrélation.

Pour empêcher l’établissement de cette relation de parenté, il est nécessaire de cocher la case Activer le mode strict
de gestion des relations de parentés au sein du menu Administration ==> Options.

A l’inverse si cette case n’est pas cochée alors les liens de parenté entre hôtes appartenant à deux collecteurs différents
peuvent être établis.

Note : Ne cochez pas le filtre de notification “Injoignable” sur les hôtes ainsi que sur les contacts pour ne pas recevoir
ce type de notification.
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Les dépendances logiques

Les dépendances logiques consistent à mettre en place des liens logiques entre plusieurs objets de différents types ou
non. Par exemple : Un service est chargé de superviser l’accès à une page web requérant une authentification basée
sur un annuaire LDAP. Il est logique que si le serveur LDAP est en panne, l’accès à la page web sera limité voire
impossible. Dans cette situation, la notification émise ne doit l’être que pour l’annuaire LDAP et non le site web.

Les hôtes

Pour configurer une dépendance logique :

1. Rendez-vous dans le menu Configuration ==> Notifications
2. Dans le menu de gauche, sous le titre Dépendances, cliquez sur Hôtes
3. Cliquez sur Ajouter

Dans ce cas, nous avons deux types d’hôtes qui entrent en jeu : un ou des hôtes (appelé hôtes maîtres) dont le statut
contrôle l’exécution et les notifications d’autres hôtes (appelés hôtes dépendants). Si vous utilisez Centreon Broker,
il est également possible à partir des hôtes maîtres de contrôler l’exécution et les notifications de services (appelés
services dépendants).

— Les champs Nom et Description indiquent le nom et la description de la dépendance
— Le champ Relation de parenté est à ignorer si vous utilisez Centreon Engine. S’il est activé, alors si les liens

de dépendances de l’hôte maître deviennent indisponibles, la dépendance en cours de création n’est plus prise
en compte.

— Le champ Critères d’échec d’exécution indique quels sont les statuts du ou des hôtes maîtres qui empêcheront
la vérification des hôtes ou des services dépendants

— Le champ Critères d’échec de notification indique quels sont les statuts du ou des hôtes maîtres qui empê-
cheront l’envoi de notifications pour les hôtes ou les services dépendants

— La liste Nom d’hôtes défini le ou les hôtes maîtres
— La liste Nom d’hôtes liés défini les hôtes dépendants
— La liste Services dépendants défini les services dépendants
— Le champ Commentaire permet de commenter la dépendance

Les services

Pour ajouter une dépendance au niveau des services :

1. Rendez-vous dans le menu Configuration ==> Notifications
2. Dans le menu de gauche, sous le titre Dépendances, cliquez sur Services
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3. Cliquez sur Ajouter

Dans ce cas, nous avons deux entités qui entrent en jeu : les services (dits maîtres) qui contrôlent l’exécution et les
notifications d’autres services (dits dépendants). Si vous utilisez Centreon Broker, il est également possible de contrôler
l’exécution et les notifications d’autres hôtes.

— Les champs Nom et Description indiquent le nom et la description de la dépendance
— Le champ Relation de parenté est à ignorer si vous utilisez Centreon Engine. S’il est activé, alors si les liens

de dépendances du service maître deviennent indisponibles la dépendance en cours de création n’est plus prise
en compte.

— Le champ Critères d’échec d’exécution indique quels sont les statuts du (ou des) service(s) maître(s) qui
empêchera(ront) la vérification des hôtes ou des services dépendants

— Le champ Critères d’échec de notification indique quels sont les statuts du (ou des) service(s) maître(s) qui
empêchera(ront) l’envoi de notifications pour les hôtes ou les services dépendants

— La liste Services définie le ou les services maîtres
— La liste Services dépendants définie les services dépendants
— La liste Hôtes dépendants définie les hôtes dépendants
— Le champ Commentaire permet de commenter la dépendance

Les groupes d’hôtes

Pour ajouter une dépendance au niveau des groupes d’hôtes :

1. Rendez-vous dans le menu Configuration ==> Notifications
2. Dans le menu de gauche, sous le titre Dépendances, cliquez sur Groupes d’hôtes
3. Cliquez sur Ajouter
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Deux types de groupes d’hôtes : Un groupe d’hôtes est dit maître s’il contrôle l’exécution et la notification d’autres
groupes d’hôtes (dit dépendants).

— Les champs Nom et Description indiquent le nom et la description de la dépendance
— Le champ Relation de parenté est à ignorer si vous utilisez Centreon Engine. S’il est activé, alors si les liens

de dépendances du groupe d’hôte maître deviennent indisponibles la dépendance en cours de création n’est
plus prise en compte.

— Le champ Critères d’échec d’exécution indique quels sont les statuts du ou des groupes d’hôtes maîtres qui
empêcheront la vérification des groupes d’hôtes dépendants

— Le champ Critères d’échec de notification indique quels sont les statuts du ou des hôtes maîtres qui empê-
cheront l’envoi de notifications pour des groupes d’hôtes dépendants

— La liste Nom du groupe d’hôte définie le ou les groupes d’hôtes maîtres
— La liste Nom des groupes d’hôtes liés définie le ou les groupes d’hôtes dépendants
— Le champ Commentaire permet de commenter la dépendance

Les groupes de services

Pour ajouter une dépendance au niveau des groupes de services :

1. Rendez-vous dans le menu Configuration ==> Notifications
2. Dans le menu de gauche, sous le titre Dépendances, cliquez sur Groupes de services
3. Cliquez sur Ajouter

Deux types de groupes de services : Un groupe de services est dit maître s’il contrôle l’exécution et la notification
d’autres groupes de services (dit dépendants).

— Les champs Nom et Description indiquent le nom et la description de la dépendance
— Le champ Relation de parenté est à ignorer si vous utilisez Centreon Engine. S’il est activé, alors si les liens

de dépendances du groupe de service maître deviennent indisponibles la dépendance en cours de création n’est
plus prise en compte.

— Le champ Critères d’échec d’exécution indique quels sont les statuts du ou des groupes de services maîtres
qui empêcheront la vérification des groupes de services dépendants

— Le champ Critères d’échec de notification indique quels sont les statuts du ou des hôtes maîtres qui empê-
cheront l’envoi de notifications pour des groupes de services dépendants

— La liste Nom des groupes de services définie le ou les groupes de services maîtres
— La liste Nom des groupes de services liés définie le ou les groupes de services dépendants
— Le champ Commentaire permet de commenter la dépendance

Les méta-services

Pour ajouter une dépendance au niveau des méta-services :

1. Rendez-vous dans le menu Configuration ==> Notifications
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2. Dans le menu de gauche, sous le titre Dépendances, cliquez sur Méta-services
3. Cliquez sur Ajouter

Deux types de méta-services : Un méta-service est dit maître s’il contrôle l’exécution et la notification d’autres méta-
services (dit dépendants).

— Les champs Nom et Description indiquent le nom et la description de la dépendance
— Le champ Relation de parenté est à ignorer si vous utilisez Centreon Engine. S’il est activé, alors si les liens

de dépendances du méta-service maître deviennent indisponibles la dépendance en cours de création n’est plus
prise en compte.

— Le champ Critères d’échec d’exécution indique quels sont les statuts du ou des méta-services maîtres qui
empêcheront la vérification des méta-services dépendants

— Le champ Critères d’échec de notification indique quels sont les statuts du ou des méta-services qui empê-
cheront l’envoi de notifications pour des méta-services dépendants

— La liste Nom du méta-service définie le (ou les) méta-service(s) maître(s)
— La liste Nom des méta-services liés définie le (ou les) méta-service(s) dépendant(s)
— Le champ Commentaire permet de commenter la dépendance

6.12.4 Les escalades de notifications

Définition

D’une manière générale, en cas de déclenchement d’une alerte, une notification permet de contacter un ou plusieurs
contacts (ou groupes de contacts). De même, il est possible d’envoyer plusieurs notifications suivant un intervalle de
temps régulier.

Une escalade de notifications permet de contacter différents groupes de contacts au fil des notifications envoyées ou de
changer le moyen de notification (remplacer les mails par un SMS). La définition d’une escalade de notification pour
un hôte, un groupe d’hôte, un service, un groupe de services ou un méta-service écrase la configuration classique des
notifications pour cet objet.

Exemple : Un service A est paramétré pour envoyer des notifications à un groupe de contacts “A” en cas de statut
non-OK. Ces notifications sont envoyées toutes les 5 minutes. Si pendant un certain nombre de notifications envoyées
le statut du service est toujours en non-OK, il est possible de contacter les individus du groupe de contacts “B” etc...

Les escalades de notifications sont pratiques dans les cas où il existe dans une société une équipe de support de niveau
1, niveau 2, niveau 3... Lorsqu’un problème survient l’équipe de support niveau 1 est contactée. Si pendant un certain
temps l’équipe niveau 1 n’a pas réussi à résoudre le problème, l’équipe niveau 2 est avertie etc...

Configuration

Pour ajouter une escalade de notification :

1. Rendez-vous dans le menu Configuration ==> Notifications ==> Escalades
2. Cliquez sur Ajouter
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— Les champs Nom d’escalade et Alias permettent de définir un nom et un alias à l’escalade de notifications.
— Le champ Première notification permet de choisir le numéro de la notification à partir de laquelle le groupe

de contacts sera averti.
— Le champ Dernière notification permet de choisir le dernier numéro de la notification pour lequel ce groupe

de contacts sera averti. Si le groupe de contacts est le dernier niveau de l’escalade. La valeur de ce champ est
0.

— Le champ Intervalle de notification définit l’intervalle de notifications entre chaque alerte.
— Le champ Période d’escalade définit la période temporelle de notifications.
— Les champs Options d’escalade des hôtes et Options d’escalade des services définissent les statuts d’hôtes

et de services pour lesquels l’escalade est utilisée.
— La liste Groupes de contacts liés définit le groupe de contacts à contacter lors du déclenchement de l’escalade.
— Le champ Commentaire permet de commenter l’escalade.

Application de l’escalade

Pour sélectionner les différents objets qui seront concernés par cette escalade, les onglets Escalade des hôtes, Esca-
lade des services, Escalade des groupes d’hôtes, Escalade des méta-services, Escalade des groupes de services
permettent de choisir les objets sur lesquels les escalades sont appliquées.

6.12.5 Les temps d’arrêts récurrents

Définition

Un temps d’arrêt est une période de temps durant laquelle les notifications sont désactivées pour un hôte ou un service.
Les temps d’arrêts sont pratiques lors d’opérations de maintenance sur un hôte ou un service : ils permettent d’éviter
de recevoir des alertes de type faux-positif.

Les temps d’arrêts récurrents sont des temps d’arrêts qui reviennent de manière répétitive.

Exemple : Une sauvegarde des machines virtuelles est effectuée tous les jours de 20h00 à minuit. Ce type de sauvegarde
a tendance à saturer l’utilisation CPU de toutes les machines virtuelles. Il est nécessaire de programmer des temps
d’arrêts récurrents sur les services concernés afin d’éviter de recevoir des notifications de 20h00 à minuit.

Note : Les temps d’arrêts sont pris en comptes dans le calcul du taux de disponibilité de la ressource dans le menu
“Tableau de bord”.
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Les types de temps d’arrêts

Il existe deux types de temps d’arrêts :
— Les temps d’arrêts fixe : C’est à dire que le temps d’arrêt a lieu exactement pendant la période de temps définie.
— Les temps d’arrêts flexible : C’est à dire que si pendant la période de temps définie, le service ou l’hôte retourne

un statut non-OK alors le temps d’arrêt démare et dure le nombre de secondes défini dans le formulaire.

Configuration

Pour ajouter un temps d’arrêt récurrent :

1. Rendez-vous dans le menu Supervision ==> Temps d’arrêt
2. Dans le menu de gauche, cliquez sur Temps d’arrêt récurrent
3. Cliquez sur Ajouter

Configuration des temps d’arrêts

— Les champs Nom et Description permettent de donner un nom et de décrire le temps d’arrêt récurrent.
— Le champ Activer permet d’activer ou de désactiver le temps d’arrêt.
— Le champ Période permet de définir une ou plusieurs périodes de temps d’arrêt récurrent. Pour ajouter une

période, cliquez sur le symbole .

Il est possible de choisir trois types de périodes :
— Hebdomadaire : Permet de choisir les jours de semaine
— Mensuel : Permet de choisir les jours dans un mois
— Date spécifique : Permet de choisir des dates spécifiques
— Le champ Jours définit le (ou les) jour(s) concerné(s).
— Le champ Période de temps contient la période de temps concernée (exprimée en HH :MM - HH :MM).
— Le champ Type de temps d’arrêt définit le type de temps d’arrêt souhaité.
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Note : Il est possible de combiner plusieurs types de périodes au sein d’un seul temps d’arrêt.

Relations

— La liste Lié aux hôtes permet de choisir le ou les hôtes concernés par le temps d’arrêt récurrent.
— Si un groupe d’hôte est choisi avec la liste Lié avec le groupe d’hôtes tous les hôtes appartenant à ce groupe

sont concernés par le temps d’arrêt récurrent.
— La liste Lié avec les services permet de choisir le ou les services concernés par le temps d’arrêt récurrent.
— Si un groupe de services est choisi avec la liste Linked with Service Groups tous les services appartenant à

ce groupe sont concernés par le temps d’arrêt récurrent.

6.12.6 Les traps SNMP

Définition

Les traps SNMP sont des informations envoyées en utilisant le protocole SNMP depuis un équipement supervisé vers
un serveur de supervision (satellite). Ces informations contiennent plusieurs attributs dont :

— Adresse de l’équipement qui a envoyé l’information.
— L’OID racine (Object Identifier) correspond à l’identifiant du message reçu.
— Le message envoyé au travers du trap SNMP qui correspond à un ensemble de paramètres (1 à N).

Afin de pouvoir interpréter l’évènement reçu, le serveur de supervision doit posséder dans sa configuration le néces-
saire pour traduire l’évènement. Pour cela, il doit disposer d’une base de données contenant les OID ainsi que leurs
descriptions, c’est ce qu’on appelle les fichiers MIB. Il existe deux types de MIB :

— Les MIB standards qui utilisent des OID standardisés et qui sont implémentés par de nombreux constructeurs
sur leurs équipements.

— Les MIB constructeurs qui sont propres à chacun et souvent à chaque modèle d’équipement.
Les MIB constructeurs sont à récupérer auprès des constructeurs de matériels. Centreon permet de stocker la définition
des traps SNMP dans sa base de données MySQL. Les traps peuvent ensuite être reliés à des services passifs via
l’onglet Relations de la définition d’un service.

Architecture

Avec Centreon 2.5.x, la gestion des traps SNMP a été revue en profondeur par rapport aux versions précédentes :
— les processus ‘snmptt’ et ‘centtraphandler’ ont été fusionnés au sein d’un unique processus ‘centreontrapd’.
— le processus ‘snmptthandler’ est remplacé par le processus ‘centreontrapdforward’.
— les satellites peuvent disposer de leur propre définition de Trap SNMP au sein d’une base dédiée SQLite

supprimant ainsi l’accès au serveur MySQL Centreon.

Traitement d’un trap par le serveur central

Voici le processus de traitement d’un trap SNMP avec Centreon 2.5.x :

1. snmptrapd est le service permettant de récupérer les traps SNMP envoyés par les équipements (par défaut il
écoute sur le port UDP 162).

2. Une fois le trap SNMP reçu, il est envoyé au script ‘centreontrapdforward’ qui va écrire les informations reçues
dans un dossier tampon (par défaut : /var/spool/centreontrapd/).

3. Le service ‘centreontrapd’ lit les informations reçues dans le dossier tampon et interprète les différents traps
reçus en vérifiant dans la base de données Centreon les actions à entreprendre pour traiter ces évènements.
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4. Le service ‘centreontrapd’ transmet les informations à l’ordonnanceur ou au service ‘centcore’ (pour trans-
mettre les informations à un ordonnanceur distant) qui se charge de modifier le statut et les informations
associées au service auquel est lié le trap SNMP.

Traitement d’un trap par un serveur satellite

Afin de garder une copie de la configuration des traps SNMP sur chaque serveur satellite, une base de données SQLite
est chargée de garder en cache les informations de traps contenues dans la base de données MySQL. Cette base de
données SQLite est automatiquement générée par le serveur Central. Voici le processus de traitement d’un trap SNMP
avec Centreon 2.5.x :

1. snmptrapd est le service permettant de récupérer les traps SNMP envoyées par les équipements (par défaut il
écoute sur le port UDP 162).

2. Une fois le trap SNMP reçu, il est envoyé au script ‘centreontrapdforward’ qui va écrire les informations reçues
dans un dossier tampon (par défaut : /var/spool/centreontrapd/).

3. Le service ‘centreontrapd’ lit les informations reçues dans le dossier tampon et interprète les différentes traps
reçus en vérifiant dans la base de données SQLite les actions à entreprendre pour traiter les traps reçus.

4. Le service ‘centreontrapd’ transmet les informations à l’ordonnanceur qui se charge de modifier le statut et les
informations associées au service dont est lié le trap SNMP.
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Note : Le processus Centcore à la charge, comme pour l’export de configuration de la supervision, de copier la base
SQLite sur le collecteur distant.

Configuration des services

Snmptrapd

Afin d’appeler le script ‘centreontrapdfoward’, le fichier /etc/snmp/snmptrapd.conf doit contenir les lignes suivantes :

disableAuthorization yes
traphandle default su -l centreon -c "/usr/share/centreon/bin/centreontrapdforward"

Vous pouvez optimiser les performances de snmptrapd en utilisant les options suivantes :
— -On n’essaye pas de transformer les OIDs
— -t ne log pas les traps au serveur syslog
— -n n’essaye pas de transformer les adresses IP en nom d’hôtes

Ces options peuvent être modifiées dans le fichier /etc/sysconfig/snmptrapd

OPTIONS="-On -d -t -n -p /var/run/snmptrapd.pid"

Il est également possible de placer le dossier tampon snmptrapd en mémoire vive. Pour cela, ajoutez la ligne suivante
dans le fichier /etc/fstab :

tmpfs /var/run/snmpd tmpfs defaults,size=128m 0 0
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Centreontrapdforward

Pour modifier le dossier tampon vers lequel les informations seront écrites, modifiez le fichier de configuration
/etc/centreon/centreontrapd.pm :

our %centreontrapd_config = (
spool_directory => ’/var/spool/centreontrapd/’,

);

1;

Vous pouvez également mapper le dossier dans le cache en mémoire vive, en ajoutant la ligne suivante dans le fichier
/etc/fstab :

tmpfs /var/spool/centreontrapd tmpfs defaults,size=512m 0 0

Centreontrapd

Deux fichiers de configuration existent pour Centreontrapd :
— /etc/centreon/conf.pm contient les informations de connexion à la base de données MySQL
— /etc/centreon/centreontrapd.pm contient la configuration du service centreontrapd

Configuration du service Au sein du fichier /etc/centreon/centreontrapd.pm il est conseillé de modifier unique-
ment trois paramètres (si nécessaire) :

— Si l’option mode est définie à 1 alors centreontrapd fonctionne sur un serveur satellite, sinon il fonctionne sur
un serveur central (Centreon).

— L’option centreon_user permet de modifier l’utilisateur qui exécute les actions.
— L’option spool_directory permet de modifier le dossier tampon à lire (si vous l’avez modifié dans le fichier de

configuration de ‘centreontrapdforward’).
Voici un exemple de configuration possible du fichier /etc/centreon/centreontrapd.pm (le fichier de configuration
peut être modifiée avec ‘-config-extra = xxx’) :

our %centreontrapd_config = (
# Temps en secondes avant d’arrêter brutalement les sous processus
timeout_end => 30,
spool_directory => "/var/spool/centreontrapd/",
# Délai entre deux contrôles du répertoire de "spool" pour détecter de nouveaux fichiers à traiter
sleep => 2,
# 1 = utiliser la date et heure du traitement e l’évènement par centreontrapdforward
use_trap_time => 1,
net_snmp_perl_enable => 1,
mibs_environment => ’’,
remove_backslash_from_quotes => 1,
dns_enable => 0,
# Séparateur à appliquer lors de la substitution des arguments
separator => ’ ’,
strip_domain => 0,
strip_domain_list => [],
duplicate_trap_window => 1,
date_format => "",
time_format => "",
date_time_format => "",
# Utiliser le cache d’OID interne de la base de données
cache_unknown_traps_enable => 1,
# Temps en secondes avant de recharger le cache
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cache_unknown_traps_retention => 600,
# 0 = central, 1 = poller
mode => 0,
cmd_timeout => 10,
centreon_user => "centreon",
# 0 => continuer en cas d’erreur MySQL | 1 => ne pas continuer le traitement (blocage) en cas d’erreur MySQL
policy_trap => 1,
# Enregistrement des journaux en base de données
log_trap_db => 0,
log_transaction_request_max => 500,
log_transaction_timeout => 10,
log_purge_time => 600

);

1;

Configuration de la connexion à la base de données
Note : Sur un collecteur distant (satellite), la configuration de l’accès à la base de données est à réaliser dans le fichier
/etc/centreon/centreontrapd.pm.

Il est possible de configurer le fichier /etc/centreon/conf.pm de deux manières :
— Conserver la connexion au serveur de base de données MySQL (nécessaire pour le serveur central et possible

pour les serveurs satellites). Contenu du fichier :
$centreon_config = {
VarLib => "/var/lib/centreon",
CentreonDir => "/usr/share/centreon/",
"centreon_db" => "centreon",
"centstorage_db" => "centreon_storage",
"db_host" => "localhost:3306",
"db_user" => "centreon",
"db_passwd" => "centreon"
};

1;

— Connecter centreontrapd à la base de données SQLite locale. Contenu du fichier :

$centreon_config = {
VarLib => "/var/lib/centreon",
CentreonDir => "/usr/share/centreon/",
"centreon_db" => "dbname=/etc/snmp/centreon_traps/centreontrapd.sdb",
"centstorage_db" => "dbname=/etc/snmp/centreon_traps/centreontrapd.sdb",
"db_host" => "",
"db_user" => "",
"db_passwd" => "",
"db_type" => ’SQLite’,
};

1;

Configuration Centreon

Ajouter un constructeur

Au sein de Centreon, les OIDs racines des traps SNMP sont classés par constructeur. Pour ajouter un constructeur :
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1. Rendez-vous dans le menu Configuration ==> Traps SNMP
2. Dans le menu de gauche, cliquez sur Constructeur
3. Cliquez sur Ajouter

— Les champs Nom du constructeur et Alias définissent le nom et l’alias du constructeur
— Le champ Description fournit une indication sur le constructeur

Importation des MIB

Il est également possible d’importer des OIDs à partir des MIBs fournies par les constructeurs. Pour cela :

1. Rendez-vous dans le menu Configuration ==> Traps SNMP
2. Dans le menu de gauche, cliquez sur MIBs

— La liste Constructeur permet de choisir le constructeur auquel appartient la MIB que vous importez
— Le champ Fichier (mib) permet de charger la MIB

3. Cliquez sur Importer

Note : Les dépendances des MIBS que vous importez doivent être présentes dans le dossier /usr/share/snmp/mibs.
Une fois l’import terminé, supprimez les dépendances préalablement copiées.
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Note : Une fois les traps SNMP importés, il est nécessaire de vérifier le statut “Supervision” associé aux évènements.
Par défaut celui-ci sera “OK”.

Configuration manuelle des traps

Configuration basique Il est également possible de créer manuellement des définitions de trap SNMP :

1. Rendez-vous dans le menu Configuration ==> Traps SNMP
2. Cliquez sur Ajouter

— Le champ Nom du Trap définit le nom du trap.
— Le champ OID définit l’OID racine à recevoir pour que ce trap soit considéré comme reçu.
— Le champ Nom du constructeur définit le nom du constructeur auquel appartient le trap à sélectionner dans

la liste déroulante.
— Le champ Message de sortie contient le message à afficher en cas de réception d’un trap contenant l’OID

configuré au-dessus.

Note : Par défaut, la MIB contient la définition de cette variable (Exemple : “Link up on interface $2. State : $4.”, ici
$2 sera remplacé par le 2ème argument reçu dans l’évènement.). Dans le cas contraire, la variable $* permet d’afficher
l’ensemble des arguments contenu dans le trap.

Note : Il est possible de construire soit même le message de sortie. Pour cela, utilisez la MIB afin de connaitre les
arguments qui seront présents dans le corps de l’évènement et récupérer les arguments avec les variables $n. Chaque
argument étant identifié par un OID, il est possible d’utiliser directement cet OID afin de le placer dans le message de
sortie sans connaitre sa position via la variable @{OID}.

— Le champ Statut par défaut définit le statut “supervision” par défaut du service en cas de réception du trap.
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— Le Si la case Envoyer le résultat est cochée alors le résultat est soumis au moteur de supervision.
— Le champ Commentaires (dernier champ) contient par défaut le commentaire constructeur du trap SNMP. La

plupart du temps, ce commentaire indique la liste des variables contenues dans le trap SNMP (voir chapitre
suivant sur la configuration avancée).

Configuration avancée des traps Il est possible de détermine le statut d’un service à partir de la valeur d’un para-
mètre du trap SNMP plutôt qu’à partir de l’OID racine. Anciennement les constructeurs définissaient un trap SNMP
(OID racine) par type d’évènement à envoyer (linkUp / linkDown). Aujourd’hui, la tendance est de définir un OID
racine par catégorie d’évènements puis de définir l’évènement via un ensemble de paramètres.

Pour cela, il est possible de définir des Règles de correspondance avancées en cliquant sur le bouton et de créer
autant de règles que nécessaire. Pour chaque règle, définir les paramètres :

— Chaine définit l’élément sur lequel sera appliqué la recherche (@OUTPUT@ défini l’ensemble du Message
de sortie traduit).

— Expression régulière définit la recherche de type REGEXP à appliquer.
— Statut définit le statut du service en cas de concordance.

Note : L’ordre est important dans les règles de correspondance car le processus s’arrêtera à la première règle dont la
correspondance est assurée.

— Le champ Ne pas envoyer le résultat si pas de correspondance avérée désactive l’envoi des informations au
moteur d’ordonnancement si aucune correspondance avec une règle n’est validée.

— Si la case Reprogrammer les services associés est cochée alors le prochain contrôle du service, qui doit être
‘actif’, sera reprogrammé au plus tôt après la réception du trap.

— Si la case Exécuter une commande spéciale est cochée alors la commande définie dans Commande spéciale
est exécutée.

Configuration très avancée des traps L’onglet Avancé permet de configurer le comportement d’exécution du pro-
cessus de traitement des traps SNMP lors de la réception de ce dernier.

— Activer le routage permet d’activer le routage des informations.
— Commande de routage permet de définir la commande à utiliser pour le routage.

Avant d’exécuter le traitement de l’évènement (traduction du Message de sortie), il est possible d’exécuter une com-
mande appelée PREEXEC. Pour cela, il est possible de définir des Commande PREEXEC (de type SNMPTT) en
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cliquant sur le bouton et de créer autant de règles que nécessaire.
— Définition de la commande PREEXEC définit la commande à exécuter.

Voici un exemple d’utilisation avec le trap linkUP : Pour un équipement Cisco, $2 == ifDescr contient le numéro
de port de l’interface (GigabitEthernet0/1 par exemple). La meilleure description de l’interface est contenue dans le
champ SNMP ifAlias.

La commande suivante permet de récupérer cette valeur

snmpget -v 2c -Ovq -c <community> <cisco switch> ifAlias.$1

Pour utiliser le résultat de la commande PREEXEC dans le Message de sortie, il faut utiliser la variable $p{n} où ‘n’
correspond à l’ordre de définition de la commande. Exemple

"Interface $2 ( $p1 ) linkUP. State: $4." "$CA"

Le résultat sera de la forme : Interface GigabitEthernet0/1 ( SERVEUR NAS ) linkUP. State : up
— Le champ Enregistrer les informations des traps SNMP en base de données permet de journaliser ou non

les traps en base de données.
— Le champ Temps d’exécution maximum exprimé en secondes, permet de définir le temps maximum de

traitement de l’évènement y compris les commandes de prétraitement (PREEXEC) ainsi que celles de post-
traitement (commande spéciale).

— Le champ Intervalle d’exécution exprimé en secondes, permet de définir le temps minimum d’attente entre
deux traitements d’un évènement.

— Le champ Type d’exécution permet d’activer l’Intervalle d’exécution en définissant les conditions Par OID
racine, Par la combinaison OID racine et hôte ou de désactiver cette restriction Aucune.

— Le champ Méthode d’exécution permet de définir si lors de la réception de plusieurs mêmes évènements (OID
racine). L’exécution est soit Séquentielle, soit Parallèle.

Les variables

Lors de l’ajout d’une règle de correspondance ou de l’exécution d’une commande spéciale il est possible de passer des
arguments aux champs Chaine ou Commande spéciale. Ces arguments sont listés dans le tableau ci-dessous :
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Nom de la variable Description
@{NUMERIC_OID} Récupération de la valeur d’un argument via son OID, exemple

@{.1.3.6.1.4.1.9.9.43.1.1.1}
$1, $2... Récupération de la valeur d’un argument via son ordre d’apparition
$p1, $p2,... Valeur de la commande PREEXEC ($p1 = pour la première commande, $p2 pour la

seconde, ...)
$* Tous les arguments séparés par un espace
@HOSTNAME@ Nom d’hôte (dans Centreon) auquel le service est rattaché
@HOSTADDRESS@ Adresse IP de l’hôte ayant envoyé le trap
@HOSTADDRESS2@ Nom DNS de l’hôte ayant envoyé le trap (si le serveur n’arrive pas à effectuer une

résolution DNS inversée alors on récupère l’adresse IP
@SERVICEDESC@ Nom du service
@TRAPOUTPUT@ ou
@OUTPUT@

Message envoyé par l’expéditeur du trap

@STATUS@ Statut du service
@SEVERITYNAME@ Nom du niveau de criticité de l’évènement
@SEVERITYLEVEL@ Niveau de criticité de l’évènement
@TIME@ Heure de réception du trap
@POLLERID@ ID du collecteur ayant reçu le trap
@POLLERAD-
DRESS@

Adresse IP du collecteur ayant reçu le trap

@CMDFILE@ Chemin vers le fichier de commande de CentCore (central) ou de Centreon Engine
(collecteur)

De plus, il existe des variables spéciales pouvant être utilisées dans la section Paramètres de routage au niveau de la
Commande de routage si l’option Activer le routage est sélectionnée :

Nom de la variable Description
@GETHOST-
BYADDR($1)@

Résolution DNS inverse permettant de connaitre le nom DNS à partir de l’adresse IP
(127.0.0.1 -> localhost)

@GETHOSTBY-
NAME($1)@

Résolution DNS permettant de connaitre l’adresse IP à partir du nom DNS (localhost
-> 127.0.0.1)

Appliquer les changements

Pour pouvoir exporter les OID présents en base de données en fichier de configuration pour centreontrapd, suivez la
procédure suivante :

1. Rendez-vous dans le menu Configuration ==> Traps SNMP
2. Dans le menu de gauche, cliquez sur Générer
3. Sélectionnez le collecteur vers lequel vous souhaitez exporter les fichiers de configuration

4. Cochez Générer la base de données des traps et Appliquer la configuration
5. Dans la liste déroulante Envoyer le signal (préférez l’option Recharger)

6. Cliquez sur le bouton Générer
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6.13 Description des processus principaux

6.13.1 Le processus de notifications dans Centreon

Notifier un contact dans Centreon

Avant qu’un contact soit notifié au sein de Centreon, il est nécessaire de respecter plusieurs étapes. Si aucune escalade
de notification n’est définie, le processus de gestion des notifications est standard. Celui-ci est décrit ci-dessous :

1. Un service (ou un hôte) est vérifié à intervalle régulier en fonction de la période temporelle de vérifications
définie pour lui (Dans le cas d’un service passif, on attend que le statut du service change d’état)

2. Lorsqu’une anomalie survient (statut non-OK), le service (ou l’hôte) passe en état SOFT

3. Après que le nombre maximum de vérifications avant validation de l’état ait eu lieu et si le service (ou l’hôte)
persiste en conservant son statut non-OK son état passe de SOFT à HARD. Le moteur de supervision met en
cache le numéro de la notification pour le service (ou l’hôte) : c’est à dire 0.

A chaque intervalle d’envoi de notification pour le service (ou l’hôte) et jusqu’à la fin du statut non-OK, le moteur de
supervision réalise les opérations suivantes :

4. Le moteur de supervision vérifie que la période temporelle de notifications définie pour le service (ou l’hôte)
permet la notification à l’instant où le service (ou l’hôte) est passé en état HARD. Si oui, alors on passe à l’étape
suivante sinon, on attend que la période temporelle définie pour le service (ou l’hôte) permette la notification.

5. Le moteur de supervision vérifie que la notification est activée pour le statut actuel du service (ou de l’hôte)

Pour chaque contact associé au service (ou à l’hôte) :

6. Le moteur de supervision vérifie plusieurs paramètres :

— Est-ce que les notifications sont activées pour ce contact ?
— Est-ce que la période temporelle de notifications définie pour le contact permet la notification ?
— Est-ce que le contact est configuré pour être notifié pour le statut actuel du service (ou l’hôte) ?

7. Si ces trois conditions sont validées, alors le moteur de supervision alerte le contact en utilisant le script de
notifications définit pour le service ou l’hôte.

8. Le moteur de supervision incrémente le numéro de notification de 1

Le schéma ci-dessous résume la gestion des notifications au sein de Centreon :
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Les escalades de notifications au sein de Centreon

Les escalades de notifications permettent deux choses :
— Notifier des contacts différents en fonction du nombre de notifications envoyées
— Changer de moyens de notifications au cours du temps

En cas d’utilisation des escalades de notifications, la récupération de la liste de contact est quelque peu différente :

1. Un service (ou un hôte) est vérifié à intervalle régulier en fonction de la période temporelle de vérification
définie pour lui

2. Lorsqu’une anomalie survient (statut non-OK), le service (ou l’hôte) passe en état SOFT

3. Après que le nombre maximum de vérifications avant validation de l’état ait eu lieu, si le service (ou l’hôte)
persiste en conservant son statut non-OK son état passe de SOFT à HARD. Le moteur de supervision met en
cache le numéro de la notification pour le service (ou l’hôte) : c’est à dire 0.

A chaque intervalle d’envoi de notification pour le service (ou l’hôte) et jusqu’à la fin du statut non-OK le moteur de
supervision réalise les opérations suivantes :

1. Si aucune escalade de notification n’est définie pour le service (ou l’hôte) et le numéro actuel de notification,
alors le traitement de la notification est fait de la même manière que pour une notification classique : le moteur
de supervision utilise la configuration de notifications définie pour le service (ou l’hôte).

2. Si une escalade de notification est définie pour le service (ou l’hôte) et le numéro actuel de notification, alors
le moteur de supervision se base sur la configuration de l’escalade afin de sélectionner les contacts à notifier et
les moyens à utiliser.

3. Le mécanisme de traitement d’une notification est le même que pour l’envoi d’une notification normale

Pour rappel, la configuration des escalades de notifications est définie dans le chapitre Les escalades de notifications.

6.13.2 Gérer les dépendances logiques

Vous avez vu dans le chapitre sur la configuration des dépendances comment configurer des dépendances entre objets
(hôtes, services, groupes d’hôtes, ...). Ce sous-chapitre permet d’illustrer l’utilisation de ces dépendances au travers de
quelques cas concrets.

Note : Les dépendances reposent sur des critères d’échec à savoir “ne pas faire si”. Ne pas notifier si le service est
dans un état Critique. Ne pas exécuter le contrôle si le service est dans un état Critique, d’Alerte, Inconnu, ...

Dépendance d’un service

Un service est vérifié en utilisant un scénario Sélénium. Ce scénario se connecte à une interface web avec un identifiant
et un mot de passe. Ces informations de connexions sont stockées dans une base de données MySQL.

Par conséquent, si jamais le serveur de base de données ne répond plus, alors le scénario Sélénium ne peut aboutir.
Il parait évident qu’il est nécessaire de créer un lien de dépendance logique entre le service qui utilise le scénario
Sélénium et le service qui est chargé de vérifier le statut du serveur MySQL.

De plus, étant donné que le scénario Sélénium ne peut pas s’exécuter correctement, aucune donnée de performances
ne peut être stockée en base de données. Il faut donc arrêter non seulement la notification pour le service utilisant le
scénario Sélénium mais aussi la vérification.

Afin de créer cette dépendance :

1. Rendez-vous dans le menu Configuration ==> Notifications
2. Dans le menu de gauche en dessous de Dépendances, cliquez sur Services
3. Cliquez sur Ajouter
4. Entrez le nom et la description de la dépendance
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5. Pour les champs Critères d’échec d’exécution et Critères d’échec de notification, cochez Alerte, Critique,
Inconnu et En attente

6. Dans la liste Service, sélectionnez le service qui est chargé de vérifier le statut du serveur MySQL
7. Dans la liste Services dépendants, sélectionnez le service qui utilise le scénario Sélénium
8. Sauvegardez

A partir de ce moment, si le service chargé de vérifier le statut du serveur MySQL a un statut “Alerte”, “Critique”,
“Inconnu” ou “En attente”, alors le service chargé d’exécuter le scénario Sélénium ne sera plus exécuté jusqu’à ce que
le service maître redevienne OK.

Dépendance d’un hôte

Prenons le cas de deux hôtes qui fonctionnent en cluster. Trois hôtes sont créés afin de pouvoir superviser ce cluster :
un hôte A, un hôte B (tous les deux membres du cluster) et un hôte C (qui centralise les informations du cluster).

Si jamais, l’hôte A ou l’hôte B a un statut non-OK, alors les services de l’hôte C sera automatiquement considéré
comme non-OK. Il est donc nécessaire d’ajouter une dépendance qui empêche l’envoi de notifications si jamais l’hôte
A ou l’hôte B devient défaillant. Cependant, la remontée des données de performances doit toujours être fonctionnelle,
c’est pourquoi il est nécessaire de continuer la supervision de l’hôte C.

Afin de créer cette dépendance :
1. Rendez-vous dans le menu Configuration ==> Notifications
2. Dans le menu de gauche en dessous de Dépendances, cliquez sur Hôtes
3. Cliquez sur Ajouter
4. Entrez le nom et la description de la dépendance
5. Pour le champ Critères d’échec de notification, cochez Alerte, Critique, Inconnu et En attente
6. Dans la liste Nom d’hôtes, sélectionnez l’hôte A
7. Dans la liste Nom d’hôte liés, sélectionnez l’hôte C
8. Sauvegardez

Répétez cette opération pour l’hôte B.

Dépendance d’un groupe de service

Prenons l’exemple d’un ensemble de services Oracle sur lequel se base l’application ERP. Il faut deux groupes de
services :

— Le groupe Application Oracle
— Le groupe Application ERP

Si les services Oracle deviennent critiques, alors les services de l’application ERP sont automatiquement critiques.
Il est nécessaire de créer un lien de dépendance afin d’empêcher la vérification et la notification des services de
l’application ERP si l’application Oracle est non-OK.

Afin de créer cette dépendance :
1. Rendez-vous dans le menu Configuration ==> Notifications
2. Dans le menu de gauche en dessous de Dépendances, cliquez sur Groupes de services
3. Cliquez sur Ajouter
4. Entrez le nom et la description de la dépendance
5. Pour le champ Critères d’échec d’exécution et Critères d’échec de notification, cochez Critique et En attente
6. Dans la liste Noms des groupes de services, sélectionnez le groupe de services Application Oracle
7. Dans la liste Noms des groupes de services liés, sélectionnez le groupe de services Application ERP
8. Sauvegardez
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6.13.3 Gérer les groupes et les catégories

Au sein de Centreon, il est possible de regrouper un ou plusieurs objets au sein de différents groupes :
— Les groupes d’hôtes
— Les groupes de services
— Les groupes de contacts

Il est également possible de créer des catégories d’hôtes ou de services.

Les groupes

D’une manière générale, les groupes sont des containeurs permettant de regrouper un ensemble d’objet possédant une
propriété commune :

— Même identité matérielle (serveurs Dell, HP, IBM, ...), identité logique (équipements réseau) ou identité géo-
graphique (Europe, Asie, Afrique, Amérique du nord, ...)

— Appartenance à une même application (application CMS, ...) ou à un même secteur d’activité (Gestion de la
paie, ...)

— ...

Les groupes d’hôtes et de services

Les groupes d’hôtes et de services permettent de regrouper des objets par entités logiques. Ils sont utilisés pour :
— La configuration des ACLs afin de lier un ensemble de ressources à un type de profil
— Permettre de visualiser les rapports de disponibilité par groupe. Générer un rapport de disponibilité des res-

sources “Agence Paris”.
— Permettre de visualiser le statut d’un ensemble d’objets en sélectionnant dans les filtres de recherche un groupe

d’objets
— Rechercher rapidement un à plusieurs graphiques de performances en parcourant l’arbre des objets par groupes

puis par ressource
D’une manière générale, on cherche à regrouper les hôtes par niveau fonctionnel. Exemple : Hôtes DELL, HP ou
encore Hôtes Linux, Windows... On cherche également à regrouper les services par applications métiers. Exemple :
Application de gestion de la paie, Application ERP, ...

Note : Pour les hôtes appartenant à un groupe d’hôtes, la rétention des fichiers RRD peut être définie au sein du
groupe d’hôtes auquel il appartient. Cette définition vient surcharger la définition globale. Dans le cas où un même hôte
appartient à plusieurs groupes possédant chacun une définition de rétention, la valeur la plus élevée sera sélectionnée
pour l’hôte.

Les groupes de contacts

Les groupes de contacts sont utilisés pour pouvoir notifier des contacts :
— Lors de la définition d’un hôte ou d’un service
— Lors de la définition d’une escalade de notifications

De plus, les groupes de contacts sont également utilisés lors de la définition d’un groupe d’accès.

Par conséquent, il est nécessaire de regrouper les contacts d’une manière logique. La plupart du temps, ils sont regrou-
pés suivant leurs rôles au sein du système d’informations. Exemple : DSI, Administrateurs Windows, Administrateurs
Linux, Responsable de l’application de Gestion de la paie, ...
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Les catégories

D’une manière générale, les catégories servent soit à définir un niveau de criticité pour un hôte ou un service, soit à
regrouper techniquement un ensemble d’objets (services liés à une exécution de requête sur un SGBD MariaDB, ...).
La bonne pratique demande à ce qu’on regroupe des hôtes ou des services au sein de catégories pour pouvoir faciliter
le filtrage de ces objets au sein d’ACL. Les catégories sont également utilisées pour définir des types d’objets au sein
du module Centreon MAP ou pour classer les objets au sein de sous-groupes dans le module Centreon BI.

6.13.4 Gestion des traps SNMP avec Centreon

Recevoir des traps SNMP avec Centreon

Ce sous-chapitre présente les différentes étapes afin de pouvoir superviser un équipement en utilisant les traps SNMP.

Importation des traps SNMP

Afin d’importer les traps SNMP, vous devez respecter les étapes suivantes :

1. Créez un constructeur lié à le trap SNMP que vous avez créé, voir le sous-chapitre associé

2. Importez la MIB au sein de l’interface web de Centreon, voir le sous-chapitre associé

Lors de l’importation d’un fichier MIB, il est possible que des dépendances soient nécessaires durant l’import au
niveau de votre serveur. Afin de pouvoir trouver les dépendances de vos MIB, il faut ouvrir votre fichier de MIB via
un éditeur de texte standard, puis :

1. Repérez la ligne qui commence par IMPORTS

2. Toutes les dépendances nécessaires à l’importation de votre fichier de MIB se situent après le mot clé FROM
Exemple :

Dans le fichier de MIB montré ci-dessus, il existe 4 dépendances nécessaires à l’importation de la MIB : SNMPv2-
SMI, SNMPv2-TC, SNMPv2-CONF, SNMP-FRAMEWORK-MIB. Une fois l’importation terminée, il est nécessaire
de modifier la définition du trap afin de modifier le statut par défaut du trap :

1. Rendez-vous dans le menu Configuration ==> Traps SNMP
2. Cliquez sur le trap que vous souhaitez modifier.

En fonction du message associé au trap, modifiez le statut par défaut du service. Dans le cas où le statut du service
dépend du message reçu, utilisez le mode de correspondance avancé.
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Créer un modèle de service passif

Afin de faciliter la configuration des services utilisant les traps SNMP, il est plus pratique de créer un modèle de service
passif. De cette manière, lors de la création d’un service il ne restera plus qu’à faire hériter le service à partir de ce
modèle et de lier le trap ou les traps SNMP associés à ce service.

1. Rendez-vous dans le menu Configuration ==> Services
2. Dans le menu de gauche, cliquez sur Modèles
3. Cliquez sur Ajouter

Le tableau ci-dessous résume l’ensemble des attributs d’un modèle de service passif :

Attributs Description
Onglet Configuration du service
Alias TRAP
Nom du service generic-service-passif
Période de contrôle 24x7
Commande de vérification check_centreon_dummy
Arguments Status : 0 Output : “Aucun trap reçu depuis 24 heures
Nombre maximum de contrôle 1
Contrôles actifs activées Non
Contrôles passifs activées Oui
Onglet Traitement des données
Contrôler la fraîcheur du résultat TRAP
Seuil de fraicheur du résultat 86400 (24 heures)

Note : La sonde check_centreon_dummy sera appelée si aucun trap n’est reçu sous 24 heures.

Création du service

Puis, créez le service et associez ce dernier au modèle de service passif. Il ne vous reste plus qu’à vous rendre dans
l’onglet Relations et de renseigner, au sein du champ Traps SNMP, les traps SNMP qui pourront modifier le statut
du service.

Maintenant, régénérez les fichiers de configuration pour prendre en compte ces changements.

Simuler l’envoi d’un trap

Afin de tester que la réception des traps SNMP fonctionne correctement sur votre équipement. Vous pouvez envoyer
un évènement SNMP fictif à votre serveur de supervision en utilisant l’utilitaire en ligne de commandes snmptrap.

Syntaxe :

snmptrap -v SNMP-VERSION -c COMMUNITY IP-DESTINATION UPTIME TRAP-OID PARAMETER-OID PARAMETER-TYPE PARAMETER-VALUE

Avec :
— SNMP-VERSION : version du protocole SNMP. Pour la syntaxe ci-dessus, c’est obligatoirement 2c
— COMMUNITY : communauté SNMP
— DESTINATION-IP : IP de destination du trap SNMP. Cela peut être un poller ou le serveur Centreon
— TRAP-OID : OID contenant ENTERPRISE-OID plus l’OID du trap SNMP afin de former l’OID complet
— UPTIME : temps en secondes depuis le dernier redémarrage de l’équipement. Lorsque l’on précise une chaîne

vide, cet argument est automatiquement rempli par le binaire « snmptrap »
Tout paramètre supplémentaire au trap SNMP doit contenir les 3 variables suivantes. Elles doivent être répétées pour
chaque paramètre supplémentaire :
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— PARAMETER-OID : OID contenant ENTERPRISE-OID plus l’OID du trap SNMP afin de former l’OID du
paramètre

— PARAMETER-TYPE : type de paramétré, ‘i’ pour « Integer », ‘s’ pour « String », etc.
— PARAMETER-VALUE : valeur liée au paramètre. Mettre entre guillemets une chaîne de caractères contenant

des espaces
Exemple de trap pour simuler un évènement “linkUp” sur l’interface ‘eth0’ :

snmptrap -v2c -c public 192.168.1.1 ’’ .1.3.6.1.6.3.1.1.5.4 ifIndex i 2 ifDescr s eth0 ifAdminStatus i 1 ifOperStatus i 1

Modifier le message de sortie

Utiliser l’ensemble des arguments

Pour un trap SNMP, lors de la configuration du message de sortie, l’argument $* permet d’afficher l’ensemble des
informations (valeur des arguments) contenu au sein du trap SNMP. Cependant, il est possible d’afficher uniquement
certaines informations contenues au sein du trap SNMP en appelant unitairement les arguments.

Exemple :

Le message de sortie “Link down on interface $2. State : $4.” permet d’afficher uniquement le nom de l’interface et
l’état de celle-ci (argument $2 et $4).

Où trouver les arguments ?

Les arguments se trouvent au sein de la documentation de la MIB de votre constructeur ou bien au sein du champ
Commentaires de votre trap SNMP.

Par exemple :

Pour afficher :
— L’index du lien tombé, utilisez l’argument $1
— Le nom de l’interface tombée, utilisez l’argument $2
— L’état administratif de l’interface, utilisez l’argument $3
— L’état de l’interface, utilisez l’argument $4
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Par exemple, le message de sortie suivant permet d’afficher l’ensemble des arguments :

Link down on interface: $2 (index: $1). Operational state: $4, Administration state: $3

Effectuer un contrôle actif suite à la reception d’un trap

Il est possible par l’utilisation de l’option Reprogrammer les services associés de réaliser un contrôle actif sur le
service suite à la réception du trap SNMP.

Le contrôle actif défini au niveau du service est alors effectué.

Executer une commande spciale

Centreontrapd peut éxecuter une commande spéciale suite à la réception d’un trap SNMP. Pour utiliser cela, il suffit
de cocher l’option Executer une commande spécial et d’écrire la commande voulue.

Utiliser l’ensemble des arguments (via les OID)

Il est également possible de récupérer directement la valeur d’un argument sans connaître son ordre d’arrivée ($1, $2,
$3, ...). Pour cela, utilisez l’OID complet de l’argument.

Voici un exemple :

Link down on interface: @{.1.3.6.1.2.1.2.2.1.2} (index: @{.1.3.6.1.2.1.2.2.1.1}). Operational state: @{.1.3.6.1.2.1.2.2.1.8}, Administration state: @{.1.3.6.1.2.1.2.2.1.7}

Utiliser une variable externe

Il est également possible de modifier le message de sortie en récupérant des informations via des scripts ou commandes
externes et de récupérer le résultat pour l’insérer au sein du message. Pour cela, au sein de la définition de votre trap
SNMP, rendez-vous dans l’onglet Avancé et ajoutez une (ou plusieurs) commande(s) PREEXEC.

Exemple :

La première commande est “snmpget -v 2c -Ovq -c public @HOSTADDRESS@ ifAlias.$1” et permet de récupérer
l’alias de l’interface. La variable “$1” correspond ici à la valeur associée à l’argument 1 des traps linkUp/linkDown,
soit l’index.

La seconde commande contient “snmpget -v 2c -Ovq -c public @HOSTADDRESS@ ifSpeed.$1” et permet de ré-
cupérer la vitesse de l’interface. La variable “$1” correspond ici à la valeur associée à l’argument 1 des traps lin-
kUp/linkDown, soit l’index.

Pour utiliser le résultat de la première commande dans le message de sortie, utilisez l’argument $p1 et pour utiliser le
résultat de la seconde commande dans le message de sortie, utilisez l’argument $p2.

Par conséquent, nous pouvons déduire le message de sortie suivant :

Link down on interface: $2 (index: $1). Operational state: $4, Administration state: $3, Alias : $p1, Speed : $p2
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Utiliser une expression régulière

Il est également possible de modifier le message de sortie en utilisant une expression régulière par l’intermédiaire de
l’option Output Transform. Il suffit de renseigner une expression régulière et elle sera éxécutée à la réception d’un
trap SNMP.

Par exemple :

s/\|/-/g

Remplacera les occurences | dans le message de sortie du trap SNMP par -.

Router/transférer les traps SNMP

Parfois, il existe un concentrateur de traps SNMP au sein d’une société. Exemple : Oracle GRID. Oracle GRID est
chargé de fédérer les informations de tous les serveurs Oracle en cas de nécessité, c’est le serveur Oracle GRID qui
envoie un trap SNMP au serveur de supervision.

Or, à partir d’un trap SNMP reçu par Oracle GRID, on souhaite pouvoir extraire l’adresse IP de l’hôte concerné et
afficher le message du trap dans un service appartenant non pas à Oracle Grid mais à l’hôte concerné par le trap (le
véritable émetteur).

Pour cela, exécutez la procédure suivante :

1. Créez un trap générique, ayant les paramètres suivants :

Attributs Description
Onglet Configuration du trap
Nom Nom du trap
OID OID du trap
Statut Statut par défaut du trap
Message de sortie Message de sortie personnalisé
Onglet Avancé
Activé le routage Cochez la case
Commande de
routage

$2 (ici on part du principe que l’argument numéro 2 du trap contient l’adresse IP de l’hôte
concerné par le trap)

2. Créer une deuxième définition du trap avec :

Attributs Description
Onglet Configuration du trap
Nom Nom du trap (autre que celui de la première définition)
OID OID du trap (même que celui de la première définition)
Statut Statut par défaut du trap
Message de sortie Message de sortie personnalisé

3. Associer la première définition à un service (par exemple PING) du serveur Oracle GRID

4. Associer la deuxième définition à un service passif de l’hôte concerné

5. Générer les définitions de traps SNMP et redémarrer centreontrapd

Au sein du champ Commande de routage vous pouvez utiliser les arguments suivants :

Nom de la variable Description
@GETHOST-
BYADDR($2)@

Résolution DNS inverse permettant de connaitre le nom DNS à partir de l’adresse IP
(127.0.0.1 -> localhost)

@GETHOSTBY-
NAME($2)@

Résolution DNS permettant de connaitre l’adresse IP à partir du nom DNS (localhost
-> 127.0.0.1)
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Ne pas soumettre le trap SNMP durant un downtime

L’option Check Downtime permet à centreontrapd de contrôler si le service n’est pas dans un statut de downtime lors
de la réception du trap SNMP. Il est possible alors d’annuler la soumission du trap.

Note : Ce mode de focntionnement n’est compatible qu’avec Centreon Broker et des services supervisés depuis le
central.

Il est possible d’adapter le comportement selon ces trois méthodes :
— Aucun : Rien de spécial, le trap SNMP est envoyé normalement
— Real-Time : Si un downtime est actif sur le service, il n’est pas mis à jour.
— History : Ooption utilisée pour ne pas prendre en compte un trap SNMP qui concerne un événement passé lors

d’un temps d’arrêt.

FAQ

Comme vu dans le chapitre sur les traps SNMP, plusieurs éléments entrent en jeu dans la gestion des traps SNMP.
En cas de problèmes, il est nécessaire de vérifier le bon fonctionnement de son architecture, plusieurs points sont à
vérifier.

Source : Gestion des traps SNMP sous Centreon par Laurent Pinsivy, GNU/Linux Magazine N°160 - Mai 2013, licence
CC BY-NC-ND

Configuration de l’émetteur

Le premier point à contrôler est la configuration de l’équipement ou application qui a émis l’interruption que vous
auriez dû recevoir. Vérifiez l’adresse IP ou nom DNS de destination, la communauté SNMP ainsi que la version du
protocole.

Pare-feux réseau et logiciels, routage

Le second point à contrôler sont les autorisations des pare-feux réseau et logiciels ou la mise en place d’un routage
spécifique. Si un ou plusieurs pare-feux réseau sont présent ou si une translation de port et/ou d’adresse IP est en
place, vérifiez que le flux est possible entre l’émetteur et le collecteur. L’utilisation de sondes réseau, de débogage des
équipements réseau (pare-feux et routeurs) ou des logiciels tcpdump/wireshark sur le collecteur peut vous permettre
de valider la réception du flux de données sur le port UDP 162.

Snmptrapd

Une fois la réception du flux validé, vérifiez l’état de fonctionnement du processus snmptrapd, qui doit être en cours
d’exécution, ainsi que ses options de configuration. Il est possible d’activer la journalisation du processus. Pour cela
modifiez le fichier « /etc/sysconfig/snmptrapd.options » et remplacez la ligne « OPTIONS » pour avoir :

# snmptrapd command line options
# OPTIONS="-On -d -t -n -p /var/run/snmptrapd.pid"
OPTIONS="-On -Lf /var/log/snmptrapd.log -p /var/run/snmptrapd.pid"

Redémarrez le processus pour prendre en compte les modifications. Ainsi, pour toute réception de traps SNMP, ces
évènements seront inscrit dans le journal « /var/log/snmptrapd.log ». Si les évènements sont inscrit dans le journal,
supprimez la journalisation et passez à l’étape suivante.
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Dans le cas où vous filtrez par communauté SNMP, vérifiez les communautés autorisées dans le fichier de configuration
« /etc/snmp/snmptrapd.conf ». Si après toutes ces vérifications les traps SNMP ne sont pas inscrites dans le journal,
vérifiez que le processus écoute sur le port UDP 162 pour les équipements distants en utilisant la commande :

# netstat -ano | grep 162
udp 0 0 0.0.0.0:162 0.0.0.0:* off (0.00/0/0)

Si tel n’est pas le cas, modifiez le port d’écoute du processus.

Note : On ne le répète jamais assez mais désactivez le débogage du processus après validation du fonctionnement.
Dans le cas contraire, la volumétrie des journaux peut être très importante.

Centreontrapdforward

Une fois la validation du processus snmptrapd réalisée, contrôlez le processus centreontrapdforward. La première
étape consiste à vérifier l’appel de ce processus par snmptrapd dans le fichier « /etc/snmp/snmptrapd.conf » :

— Vérifier que le service snmptrapd appelle bien centreontrapdforward. Pour cela, éditez le fichier
/etc/snmp/snmptrapd.conf et vérifiez que le fichier contient :

traphandle default su -l centreon -c "/usr/share/centreon/bin/centreontrapdforward"

Si l’accès au fichier est incorrect, modifiez le et redémarrez le processus snmptrapd. Vous pouvez contrôler le bon
fonctionnement du binaire centreontrapdforward en vous rendant au chapitre de configuration de centreontrapdfor-
ward.

Centreontrapd

Le prochain binaire est celui de Centreon qui permet de sélectionner l’hôte possédant l’adresse IP ou le nom DNS de
l’émetteur ainsi que le service lié à cet hôte et auquel est reliée la définition de l’interruption SNMP. Pour vérifier son
fonctionnement, il convient de vérifier les paramètres de configuration de centreontrapd.

Vous pouvez vérifier la bonne configuration de centreontrapd au sein du chapitre de configuration de centreontrapd.

CentCore

Dans le cas d’un serveur central, le processus Centcore doit être démarré pour transférer la commande externe à
l’ordonnanceur supervisant l’émetteur, vérifiez son état de fonctionnement. Activez le débogage du processus via le
menu Administration ==> Options ==> Débogage et redémarrez le processus.

Note : Vous pouvez modifier le niveau de débogage du processus via le fichier /etc/sysconfig/centcore en modifiant
la sévérité.

En cas de non réception de la commande externe, vérifiez le chemin d’accès au fichier de commande du processus
défini dans la variable « $cmdFile » du fichier de configuration « /etc/centreon/conf.pm .». Le chemin doit être «
/var/lib/centreon/centcore.cmd » dans le cas d’un serveur central ou le chemin vers le fichier de commande de l’or-
donnanceur.

Ordonnanceur

Que vous ayez configuré un serveur central ou un collecteur distant pour la réception de trap SNMP, l’ordonnanceur
doit recevoir la commande externe de changement de statut et/ou de message de sortie («output»). Vérifiez le journal
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de l’ordonnanceur. Dans le cas de Centreon Engine le fichier est /var/log/centreon-engine/centengine.log. Les lignes
suivantes doivent apparaître :

[1352838428] EXTERNAL COMMAND: PROCESS_SERVICE_CHECK_RESULT;Centreon-Server;Traps-SNMP;2;Probleme critique
[1352838433] PASSIVE SERVICE CHECK: Centreon-Server;Traps-SNMP;2;Probleme critique

Si seule la commande externe apparaît mais pas la prise en compte de celle-ci par l’ordonnanceur (« PASSIVE SER-
VICE CHECK »), il se peut qu’un problème de synchronisation de l’horloge système soit en cause. Le serveur est soit
en retard et la commande sera traitée ultérieurement, soit en avance et la commande ne sera pas prise en compte.

Centreon

Afin d’être visible dans Centreon, l’ordonnanceur doit transmettre les informations, via son module NEB, à la partie
serveur du broker pour que ce dernier l’insère en base de données. Centreon affichera ensuite le résultat à partir de la
base de données « centreon_storage ». S’il vous est possible de visualiser les informations des derniers contrôles de
votre collecteur dans l’interface web, alors vous devriez voir le statut et le message de sortie (« output ») de modifiés.
Si tel n’est pas le cas, alors votre ordonnanceur n’est pas connecté à la partie serveur de votre broker. Les problèmes
peuvent être les suivants :

— L’ordonnanceur n’a pas chargé le module NEB à son démarrage car celui-ci est introuvable ou non défini dans
les options de l’ordonnanceur

— Le module NEB n’a pu se connecter à la partie serveur à cause d’un problème de paramétrage.
— Un pare-feu bloque la connexion entre le collecteur et le serveur Centreon qui héberge la base de données -La

partie serveur du broker n’est pas fonctionnelle ou n’est pas en cours d’exécution

Schéma détaillé

Vous trouverez ci-dessous un schéma détaillé de tous les processus utilisés et/ou présents lors de la réception d’une
interruption SNMP :
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6.14 Déployer une configuration

6.14.1 Procédure

Lors de la création/suppression/modification des objets via l’interface de configuration, les changements effectués ne
sont pas appliqués de manière automatique aux serveurs de supervision. Afin de pouvoir appliquer les modifications
effectuées, il est nécessaire de suivre la procédure suivante ci-dessous.

Première étape

1. Rendez-vous dans le menu Configuration ==> Collecteurs
2. Choisissez les collecteurs sur lesquels exporter la configuration

3. Cliquez sur Appliquez la configuration

1. Cochez les cases Générer les fichiers de configuration et Lancer le débogage du moteur de supervision
(-v)

2. Cliquez sur Exporter

6.14. Déployer une configuration
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Vérifier qu’aucune erreur n’apparait lors de la génération.

Note : Si cela est le cas, corriger les erreurs et refaire la première étape.

Deuxième étape

1. Décochez les cases Générer les fichiers de configuration et Lancer le débogage du moteur de supervision
(-v)

2. Puis cochez les cases Déplacer les fichiers générés ainsi que Redémarrer l’ordonnanceur
3. Cliquez sur Exporter

Note : L’option Commande exécutée post-génération permet de demander l’exécution de la commande post-
génération paramétrée au niveau de la configuration de l’ordonnanceur.
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6.14.2 Explications

Au sein de la page de génération de la configuration, plusieurs options sont disponibles :

1. Générer les fichiers de configuration : Génère les fichiers de configuration de l’ordonnanceur dans un réper-
toire temporaire. Cette configuration est générée à partir des objets configurés via l’interface web

2. Lancer le débogage du moteur de supervision (-v) : Permet à l’ordonnanceur de vérifier la configuration
générée

3. Déplacer les fichiers générés : Déplace les fichiers de configuration du répertoire temporaire vers le répertoire
de l’ordonnanceur

4. Redémarrer l’ordonnanceur : Redémarre l’ordonnanceur afin d’appliquer les nouveaux fichiers de configu-
ration

5. Commande exécutée post-génération : Exécute la commande post-génération paramétrée au niveau de la
configuration de l’ordonnanceur

Une fois configurée, la supervision vous permettra de remonter des informations relatives à l’état de santé de votre
Système d’informations. Pour connaître le fonctionnement de l’interface d’exploitation de ces résultats, référez vous
au guide d’exploitation.

6.14. Déployer une configuration
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CHAPITRE 7

Guide d’exploitation

7.1 Présentation du bandeau principal

Centreon 18.10 introduit un nouveau bandeau principal. Ce dernier est divisé en quatre sections :
— État de la plate-forme de supervision
— Résumé du statut des hôtes
— Résumé du statut des services
— Profil utilisateur

7.1.1 État de la plate-forme de supervision

Cette partie résume l’état des différents serveurs de la plate-forme Centreon. Deux icônes présentent :
— Si tous les serveurs sont connectés au serveur Centreon Central.
— Si la remontée des données présente de la latence.

Note : En cliquant sur l’icône pollers vous pourrez visualiser les différents problèmes et accéder directement au menu
de configuration des serveurs.

7.1.2 Résumé du statut des hôtes

Cette partie présente la synthèse du statut des hôtes supervisés par la plate-forme.

En cliquant sur chaque cercle de couleur représentant un statut (Down, Unreachable, Up), il est possible d’accéder
directement au menu Monitoring > Status Details > Hosts filtré :

Note : Seuls les statuts non acquittés et non en temps d’arrêts sont affichés.
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En cas d’hôte(s) en état Pending, une pastille de couleur est présente sur l’icône hosts :

Pour accéder au détail, il suffit de cliquer sur l’icône hosts ou sur la flèche :

Vous pourrez visualiser le nombre total d’hôtes supervisés et leurs répartitions par statut. En cliquant sur chaque statut
(Down, Unreachable, Up, Pending), il est possible d’accéder directement au menu Monitoring > Status Details >
Hosts filtré.

7.1.3 Résumé du statut des services

Cette partie présente la synthèse du statut des services supervisés par la plate-forme.

En cliquant sur chaque cercle de couleur représentant un statut (Critical, Warning, Unknown, OK), il est possible
d’accéder directement au menu Monitoring > Status Details > Services filtré :

Note : Seuls les statuts non acquittés et non en temps d’arrêts sont affichés.

En cas de service(s) en état Pending, une pastille de couleur est présente sur l’icône services :
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Pour accéder au détail, il suffit de cliquer sur l’icône services ou sur la flèche :

Vous pourrez visualiser le nombre total de services supervisés et leurs répartitions par statut. En cliquant sur chaque
statut (Critical, Warning, Unknown, OK, Pending), il est possible d’accéder directement au menu Monitoring > Status
Details > Services filtré.

7.1.4 Profil utilisateur

Cette dernière partie affiche l’heure suivant le fuseau horaire sélectionné dans votre profil et vous permet d’accéder,
en cliquant sur l’icône à l’édition de ce dernier.

Vous pourrez également copier l’url de connexion directe (autologin), et vous déconnecter de l’interface Centreon.

7.1. Présentation du bandeau principal
CENTREON 46-52 RUE ALBERT FR75014 PARIS

195



7.2 General

7.2.1 Comment utiliser les boîtes de sélection

Sélection multiple

Il y a plusieurs moyens de réaliser des sélections multiple dans Centreon

Avec la touche “Shift”

Il est possible de sélectionner rangée d’éléments en maintenant la touche “Shift” lors du click sur un premier élément
puis sur un second élément.

Avec la touche “Control”

Vous pouvez selectionner plusieurs éléments en maintenant la touche “Ctrl” quand vous sélectionnez un élément. Cette
fonctionnalité ne fonctionne que sur Linux et Windows.

L’action sélectionner tout

Vous pouvez sélectionner tout les éléments d’un champs en appuyant sur le bouton “Sélectionner tout” dans la liste
déroulante.

Cette action ajoute à la sélection tout les éléments même ceux qui ne sont pas visible dans la liste déroulante. Cette
sélection utilise le champs de recherche.
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Afficher le nom complet

En survolant l’élément sélectionné ou à sélectionner, le nom apparait en complet dans un popover.

7.3 Les vues personnalisées

7.3.1 Présentation

Les vues personnalisées permettent à chaque utilisateur d’avoir sa propre vue de la supervision. Une vue peut contenir
de 1 à 3 colonnes. Chaque colonne peut contenir des widgets.

Un widget est un module permettant de visualiser certaines informations sur certains objets. Il est possible d’insérer
au sein d’une même vue plusieurs widgets de différents types. Par défaut, Centreon propose des widgets permettant
d’obtenir des informations sur : les hôtes, les groupes d’hôtes, les services, les groupes de services. Enfin, un dernier
widget permet de visualiser les graphiques de performances en temps réel.

7.3.2 Gestion des vues

Toutes les manipulations ci-dessous se déroulent au sein de la page Accueil ==> Vues personnalisées. Cette page est
également la première page affichée lors de la connexion d’un utilisateur au sein de Centreon.

Ajouter une vue

Pour ajouter une vue, cliquez sur Ajouter une vue.

7.3. Les vues personnalisées
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— Le champ Nom de la vue indique le nom de la vue qui sera visible par l’utilisateur
— Le champ Mise en page permet de choisir le nombre de colonne de la vue

Pour modifier une vue existante, cliquez sur Editer une vue.

Note : La diminution du nombre de colonnes enlève les widgets associées à la colonne.

Partager une vue

Il est possible de partager une vue existante avec un ou plusieurs utilisateurs. Pour cela, cliquez sur Partager la vue.
— Si le champ Verrouillée est définit à Oui, alors les autres utilisateurs ne pourront pas modifier la vue
— Le champ Liste des utilisateurs permet de définir les utilisateurs avec lesquels est partagée la vue
— Le champ Liste des groupes utilisateur permet de définir les groupes d’utilisateurs avec lesquels est partagée

la vue

Insérer un widget

Pour ajouter un widget, cliquez sur Ajouter un widget.
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— Le champ Titre du widget permet de définir un nom pour son widget
— Choisissez dans le tableau en dessous le type de widget que vous souhaitez ajouter

Personnaliser son widget

Il est possible de déplacer un widget en faisant un drag-and-drop depuis la barre de titre. Pour réduire un widget,
cliquez sur . Par défaut, les informations contenues au sein du widget sont rafraîchis de manière régulière. Pour les

rafraîchir manuellement, cliquez sur .

Pour personnaliser son widget, cliquez sur .

Supprimer un widget

Il est possible de supprimer le widget en cliquant sur .

7.3.3 Détail des widgets

Les paragraphes ci-dessous détaillent les attributs de chaque widget après avoir cliqué sur .

7.3. Les vues personnalisées
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Le widget d’hôtes

Filters

— Le champ Host Name Search permet de faire une recherche sur un nom d’hôte
— Si la case Display Up est cochée, les hôtes en statut UP seront affichés
— Si la case Display Down est cochée, les hôtes en statut DOWN seront affichés
— Si la case Display Unreachable est cochée, les hôtes en statut UNREACHABLE seront affichés
— La liste Acknowledgement Filter permet d’afficher les hôtes acquittés ou non acquittés (si la liste est vide, les

deux types d’hôtes seront affichés)
— La liste Downtime Filter permet d’afficher les hôtes qui subissent un temps d’arrêt ou non (si la liste est vide,

les deux types d’hôtes seront affichés)
— La liste State Type permet d’afficher les hôtes en état SOFT ou HARD (si la liste est vide, les deux types

d’hôtes seront affichés)
— La liste Hostgroup permet d’afficher les hôtes appartenant à un certain groupe d’hôtes (si la liste est vide, tous

les hôtes seront affichés)
— La liste Results limite le nombre de résultats

Columns

— Si la case Display Host Name est cochée, alors le nom d’hôte sera affiché
— Si la case Display Output est cochée, alors le message associé au statut de l’hôte sera affiché
— La liste Output Length permet de limiter la longueur du message affiché
— Si la case Display Status est cochée, alors le statut de l’hôte est affiché
— Si la case Display IP est cochée, alors l’adresse IP de l’hôte est affichée
— Si la case Display Last Check est cochée, alors la date et l’horaire de la dernière vérification sont affichés
— Si la case Display Duration est cochée, alors la durée durant laquelle l’hôte a conservé son statut est affichée
— Si la case Display Hard State Duration est cochée, alors la durée durant laquelle l’hôte a conservé son état

HARD est affichée
— Si la case Display Tries est cochée, alors le nombre d’essais avant la validation de l’état est affiché
— La liste Order By permet de classer les hôtes par ordre alphabétique suivant plusieurs paramètres

Misc

— Le champ Refresh Interval (seconds) permet de définir la durée avant le rafraîchissement des données

Le widget de services

Filters

— Le champ Host Name permet de faire une recherche sur un nom d’hôte
— Le champ Service Description permet de faire une recherche sur un nom de service
— Si la case Display Ok est cochée, les services en statut OK seront affichés
— Si la case Display Warning est cochée, les services en statut WARNING seront affichés
— Si la case Display Critical est cochée, les services en statut CRITICAL seront affichés
— Si la case Display Unknown est cochée, les services en statut UNKNOWN seront affichés
— Si la case Display Pending est cochée, les services en statut PENDING seront affichés
— La liste Acknowledgement Filter permet d’afficher les services acquittés ou non acquittés (si la liste est vide,

les deux types d’hôtes seront affichés)
— La liste Downtime Filter permet d’afficher les services qui subissent un temps d’arrêt ou non (si la liste est

vide, les deux types d’hôtes seront affichés)
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— La liste State Type permet d’afficher les services en état SOFT ou HARD (si la liste est vide, les deux types
d’hôtes seront affichés)

— La liste Hostgroup permet d’afficher les services appartenant à des hôtes faisant partie d’un certain groupe
d’hôtes (si la liste est vide, tous les services seront affichés)

— La liste Servicegroup permet d’afficher les services appartenant à un certain groupe de services (si la liste est
vide, tous les services seront affichés)

— La liste Results limite le nombre de résultats

Columns

— Si la case Display Host Name est cochée, alors le nom d’hôte sera affiché
— Si la case Display Service Description est cochée, alors le nom du service sera affiché
— Si la case Display Output est cochée, alors le message associé au statut du service sera affiché
— La liste Output Length permet de limiter la longueur du message affiché
— Si la case Display Status est cochée, alors le statut du service est affiché
— Si la case Display Last Check est cochée, alors la date et l’horaire de la dernière vérification sont affichés
— Si la case Display Duration est cochée, alors la durée durant laquelle le service a conservé son statut est

affichée
— Si la case Display Hard State Duration est cochée, alors la durée durant laquelle le service a conservé son

état HARD est affichée
— Si la case Display Tries est cochée, alors le nombre d’essais avant la validation de l’état est affiché
— La liste Order By permet de classer les services par ordre alphabétique suivant plusieurs paramètres

Misc

— Le champ Refresh Interval (seconds) permet de définir la durée avant le rafraichissement des données

Le widget de graphique de performance

— Le champ Service permet de choisir le service pour lequel le graphe sera affiché
— La liste Graph period permet de choisir la période de temps que le graphe doit afficher
— Le champ Refresh Interval (seconds) permet de définir la durée avant le rafraichissement des données

Le widget de groupe d’hôtes

— Le champ Hostgroup Name Search permet de choisir les groupes d’hôtes affichés
— Si la case Enable Detailed Mode est cochée, alors tous les noms d’hôtes ainsi que les services associés à ces

hôtes seront affichés pour les groupes d’hôtes sélectionnés
— La liste Results permet de limiter le nombre de résultats
— La liste Order By permet de classer les groupes d’hôtes par ordre alphabétique suivant plusieurs paramètres
— Le champ Refresh Interval (seconds) permet de définir la durée avant le rafraichissement des données

Le widget de groupes de services

— Le champ Servicegroup Name Search permet de choisir les groupes de services affichés
— Si la case Enable Detailed Mode est cochée, alors tous les noms d’hôtes ainsi que les services associés à ces

hôtes seront affichés pour les groupes de services sélectionnés
— La liste Results permet de limiter le nombre de résultats
— La liste Order By permet de classer les groupes de services par ordre alphabétique suivant plusieurs paramètres
— Le champ Refresh Interval (seconds) permet de définir la durée avant le rafraichissement des données

7.3. Les vues personnalisées
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7.4 Supervision Temps-réel

Le menu Supervision permet de visualiser en temps-réel l’évolution de la supervision de son système d’information.

7.4.1 Statut des objets

Les statuts sont des indicateurs pour les hôtes ou les services. Chaque statut a une signification bien précise pour
l’objet. A chaque statut correspond un code généré par la sonde de supervision en fonction des seuils définis par
l’utilisateur.

Statut des hôtes

Le tableau ci-dessous résume l’ensemble des statuts possibles pour un hôte.

Statut Code de retour Description
UP 0 L’hôte est disponible et joignable
DOWN 1 L’hôte est indisponible
UNREACHABLE 2 L’hôte est injoignable

Statut des services

Le tableau ci-dessous résume l’ensemble des statuts possibles pour un service.

Statut Code de retour Description
OK 0 Le service ne présente aucun problème
WARNING 1 Le service a dépassé le seuil d’alerte
CRITICAL 2 Le service a dépassé le seuil critique
UNKNOWN 3 Le statut du service ne peut être vérifié (exemple : agent SNMP DOWN...)

Statuts avancés

En plus des statuts standards, de nouveaux statuts permettent d’ajouter des informations complémentaires :
— Le statut PENDING est un statut affiché pour un service ou un hôte fraîchement configuré mais qui n’a pas

encore été contrôlé par l’ordonnanceur.
— Le statut UNREACHABLE est un statut indiquant que l’hôte est situé (relation de parenté) en aval d’un hôte

dans un statut DOWN.
— Le statut FLAPPING (bagotant) est un statut indiquant que le pourcentage de changement de statut de l’objet

est très élevé. Ce pourcentage est obtenu à partir de calculs effectués par le moteur de supervision.
— Le statut ACKNOWLEDGED est un statut indiquant que l’incident du service ou de l’hôte est pris en compte

par un utilisateur.
— Le statut DOWNTIME est un statut indiquant que l’incident du service ou de l’hôte est survenu durant une

période de temps d’arrêt programmé.

Etats SOFT et HARD

Un hôte ou un service peut avoir deux états :
— SOFT : Signifie qu’un incident vient d’être détecté et que ce dernier doit être confirmé.
— HARD : Signifie que le statut de l’incident est confirmé. Lorsque le statut est confirmé, le processus de notifi-

cation est enclenché (envoi d’un mail, SMS, ...).
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Confirmation d’un statut

Un incident (statut non-OK) est confirmé à partir du moment où le nombre d’essai de validation est arrivé à son terme.
La configuration d’un objet (hôte ou service) implique un intervalle de contrôle régulier, un nombre d’essai pour
valider un état non-OK ainsi qu’un intervalle non-régulier de contrôle. Dès la détection du premier incident, le statut
est dans un état “SOFT” jusqu’à sa validation en état “HARD” déclenchant le processus de notification.

Exemple :

Un service a les paramètres de vérifications suivants :
— Nombre de contrôles avant validation de l’état : 3
— Intervalle normal de contrôle : 5 minutes
— Intervalle non-régulier de contrôle : 1 minute

Imaginons le scénario suivant :
— Instant t + 0 : Le service est vérifié, il a le statut OK.
— Instant t + 5 : La seconde vérification montre que le service a le statut CRITICAL. Le service passe en état

SOFT (essai 1/3).
— Instant t + 6 : La troisième vérification à lieu, le service a toujours le statut CRITICAL en état SOFT (essai

2/3).
— Instant t + 7 : La quatrième vérification montre que le service a toujours le statut CRITICAL (essai 3/3). Le

nombre d’essais a été atteint, le statut est configuré (état HARD). Le processus de notification est enclenché.
— Instant t + 8 : Le service retrouve le statut OK. Il passe directement en état HARD. Le processus de notification

est enclenché.
— Instant t + 13 : Le service a le statut WARNING. Il passe en état SOFT (essai 1/3).
— Instant t + 14 : Le service a toujours le statut WARNING (essai 2/3).
— Instant t + 15 : Le service a le statut CRITICAL. Il reste en état SOFT car il a changé de statut.

7.4.2 Actions génériques

Par défaut, lors de la visualisation des statuts des hôtes ou des services, les données de supervision sont rafraîchies
automatiquement (15 secondes par défaut). Cependant, plusieurs icônes permettent de contrôler le rafraichissement
des données. Le tableau ci-dessous résume les différentes fonctions de ces icônes :

Icône Description

Permet de rafraîchir manuellement les résultats

Permet de mettre en pause le rafraîchissement automatique des données

Permet de reprendre le rafraîchissement automatique des données

7.4.3 Hôtes

Visualisation

Pour visualiser le statut des hôtes, rendez-vous dans le menu Supervision > Détails des statuts > Hôtes.

7.4. Supervision Temps-réel
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La barre de recherche grise permet de filtrer les résultats affichés.
— Pour visualiser les hôtes rencontrant un problème mais étant non acquittés, sélectionnez le filtre Problèmes

non acquittés
— Pour visualiser tous les hôtes rencontrant un problème, sélectionnez le filtre Problèmes en cours
— Pour visualiser tous les hôtes, sélectionnez le filtre All
— Pour visualiser les hôtes classés par groupes d’hôtes, cliquez sur le menu Résumé des statuts par groupes

d’hôtes

Tableaux d’hôtes

Le tableau ci-dessous donne une description de toutes les colonnes du tableau affiché lors de la visualisation des hôtes :
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Nom de la
colonne

Description

S Affiche le niveau de criticité de l’hôte

Hôtes Affiche le nom de l’hôte. L’icône indique que les notifications pour cet hôte sont

désactivées. L’icône permet de visualiser l’ensemble des graphiques de performances pour
cet hôte

Statut Permet de visualiser le statut de l’hôte
Adresse IP Indique l’adresse IP de l’hôte
Dernier
contrôle

Affiche la date et l’heure du dernier contrôle

Durée Affiche la durée depuis laquelle l’hôte a conservé son statut actuel
Validé
depuis

Affiche la durée depuis laquelle l’hôte a conservé son statut actuel (n’apparait pas lors de la
visualisation de tous les hôtes)

Tentatives Affiche le nombre de tentatives effectuées avant de valider l’état
Statut
détaillé

Affiche le message expliquant le statut de l’hôte

Note : La colonne criticité ainsi que le filtre associé apparaissent si au moins un objet affiché possède un niveau de
criticité.

Filtres disponibles

Vous pouvez filtrer le résultat présenté via les filtres suivants :
— Hôte : permet de filtrer par nom d’hôte via une recherche de type SQL LIKE.
— Statut : permet de filtrer sur le statut des hôtes.
— Criticité : permet de filtrer par criticité.
— Collecteur : permet de filtrer les hôtes par collecteur. Seuls les hôtes du collecteur sélectionné seront affichés.
— Groupe d’hôte : permet de filtrer par groupe d’hôte. Seuls les hôtes du groupe d’hôtes sélectionné seront

affichés.

Note : La recherche sur les champs texte ne commence qu’à partir de la saisie d’au moins 3 caractères.

Tableau de groupes d’hôtes

Le tableau ci-dessous donne une description de toutes les colonnes du tableau affiché lors de la visualisation des
groupes d’hôtes :

Nom de la
colonne

Description

Groupes d’hôtes Liste l’ensemble des groupes d’hôtes
Etat des hôtes Permet de visualiser le nombre d’hôtes ayant le statut disponible, indisponible, injoignable

ou en attente
Etat des services Permet de visualiser le nombre de services ayant le statut OK, WARNING, CRITICAL ou

PENDING

Filtres disponibles

Vous pouvez filtrer le résultat présenté en sélectionnant dans la liste déroulante un collecteur. Seuls les hôtes du
collecteur sélectionné seront affichés.
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Détails d’un hôte

Lorsque vous cliquez sur un hôte, la page suivante s’affiche :

Détails du statut

Le tableau ci-dessous résume l’ensemble des attributs de cette partie :
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Attributs Description
Statut de l’hôte Affiche le statut de l’hôte
Statut détaillé Affiche le message associé au statut de l’hôte
Données de performance Affiche les données de performances renvoyées par la sonde
Tentative Affiche le nombre de tentative avant validation de l’état
Type d’état Affiche le type d’état (‘SOFT’ ou ‘HARD’)
Dernier contrôle Affiche la date et l’heure du dernier contrôle effectué sur l’hôte
Prochain contrôle Affiche la date et l’heure du prochain contrôle effectué sur l’hôte
Latence Affiche le temps de latence entre la programmation de l’exécution et l’exécution

réelle de la sonde
Temps d’exécution Affiche le temps d’exécution de la sonde
Changement du dernier état Affiche la date et l’heure depuis laquelle l’hôte est dans l’état actuel
Durée de l’état actuel Affiche la durée depuis laquelle l’hôte est dans l’état actuel
Dernier notification Affiche la date et l’heure d’envoi de la dernière notification
Prochaine notification Affiche la date et l’heure d’envoi de la prochaine notification
Numéro de notification actuel Affiche le nombre de notifications déjà envoyées
Est-ce que le statut de l’hôte
bagote ?

Indique si l’hôte bagotte (a le statut FLAPPING)

Pourcentage de changement
de statut

Affiche le pourcentage de changement d’état

Planification d’arrêt en cours ? Indique si l’hôte est concerné par un temps d’arrêt
Dernière mise à jour Affiche la date et l’heure de la dernière mise à jour

Options et Commandes disponibles

Les options ainsi que les commandes permettent d’effectuer un certain nombre d’actions sur l’hôte. Ces différentes
options sont traitées au sein du guide d’exploitation.

Liens

Le conteneur Liens permet de visualiser les groupes d’hôtes auxquels l’hôte appartient.

Notifications

Le conteneur Notifications permet de visualiser quels sont les contacts et les groupes de contacts qui seront alertés en
cas d’envoi d’une notification.

7.4.4 Services

Visualisation

Pour visualiser le statut des services, rendez-vous dans le menu Supervision > Détails des statuts > Services.
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La barre de recherche grise permet de filtrer les résultats affichés.
— Pour visualiser les services rencontrant un problème validé (état “HARD”) mais étant non acquittés, sélection-

nez le filtre Problèmes non acquittés
— Pour visualiser tous les services rencontrant un problème (validé ou non, acquittés ou non), sélectionnez le

filtre Problèmes en cours
— Pour visualiser tous les services, sélectionnez le filtre Tous les services
— Pour visualiser tous les services (classés par hôtes), quel que soit le statut, cliquez sur le menu Regroupement

par hôte

— Pour visualiser le nombre de services (classés par hôtes et statuts), cliquez sur le menu Regroupement par
hôte, puis sélectionnez le filtre Résumé
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— Pour visualiser tous les services (classés par groupes d’hôtes), cliquez sur le menu Regroupement par groupes
d’hôtes

— Pour visualiser le nombre de services (classés par groupes d’hôtes et statuts), cliquez sur le menu Regroupe-
ment par groupes d’hôtes, puis sélectionnez le filtre Résumé
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— Pour visualiser tous les services (classés par groupes de services), cliquez sur le menu Regroupement par
groupes de services

— Pour visualiser le nombre de services (classés par groupes de services et statuts), cliquez sur le menu Regrou-
pement par groupes de services, puis sélectionnez le filtre Résumé
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— Pour visualiser les méta-services, rendez-vous dans le menu Supervision > Détails des statuts > Services et
filtrez sur l’hôte meta

Tableaux de services

Le tableau ci-dessous décrit les colonnes affichées lors de la visualisation des services.

Nom de la
colonne

Description

S Affiche le niveau de criticité du service

Hôtes Affiche le nom de l’hôte. L’icône permet d’accéder à une page web décrivant l’hôte

Services Affiche le nom du service. L’icône indique que les notifications pour ce service sont

désactivées. L’icône permet de visualiser le graphique de performance lié à ce service.

L’icône permet d’accéder à une page web décrivant le service
Validé
depuis

Affiche la durée depuis laquelle le service a conservé son statut actuel

Dernier
contrôle

Affiche la date et l’heure du dernier contrôle effectué

Tentatives Affiche le nombre de tentatives effectuées pour valider l’état
Statut
détaillé

Affiche le message expliquant le statut du service

Note : La colonne criticité ainsi que le filtre associé apparaissent si au moins un objet affiché possède un niveau de
criticité.

Note : La colonne Validé depuis n’apparait pas lors de la sélection du menu contextuel Tous les services.

Tableaux des groupes

Le tableau ci-dessous décrit les colonnes affichées lors de la visualisation des services classés par groupes.
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Nom de la colonne Description
Hôtes ou Groupes d’hôtes
Hôtes ou Groupes de services
Hôtes

Liste l’ensemble des hôtes ou hôtes séparés par des groupes d’hôtes ou hôtes
séparées par des groupes de services L’icône permet de visualiser l’ensemble

des services liés à l’hôte L’icône permet de visualiser l’ensemble des
graphiques de performances liés aux services appartenant à l’hôte

Statut Affiche le statut de l’hôte
Informations sur les services Affiche le statut des services (Mode détaillé) ou le nombre de services classés

par statut (Mode résumé)

Détails d’un service

Lorsque vous cliquez sur un service, la page suivante s’affiche :

Détails du statut

Le tableau ci-dessous résume l’ensemble des attributs de cette partie :
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Attributs Description
Statut du service Affiche le statut du service
Statut détaillé Affiche le message associé au statut du service
Informations d’état étendues Affiche le message long (“long output”) associé au statut du service
Données de performance Affiche les données de performances renvoyées par la sonde
Tentative Affiche le nombre de tentative en cours pour valider l’état
Type d’état Affiche le type d’état (‘SOFT’ ou ‘HARD’)
Dernier contrôle Affiche la date et l’heure du dernier contrôle effectué sur le service
Prochain contrôle Affiche la date et l’heure du prochain contrôle effectué sur le service
Latence Affiche le temps de latence entre la programmation de l’exécution et son

exécution réelle
Temps d’exécution Affiche le temps d’éxécution de la sonde
Changement du dernier état Affiche la date et l’heure depuis laquelle le service est dans l’état actuel
Durée de l’état actuel Affiche la durée depuis laquelle le service est dans l’état actuel
Dernier notification Affiche la date et l’heure d’envoi de la dernière notification
Numéro de notification actuel Affiche le nombre de notifications déjà envoyées
Est-ce que le statut du service
bagote ?

Indique si le service bagotte (statut FLAPPING)

Pourcentage de changement de
statut

Affiche le pourcentage de changement d’état

Planification d’arrêt en cours ? Indique si le service est concerné par un temps d’arrêt
Dernière mise à jour Affiche la date et l’heure de la dernière mise à jour

Options et commandes du service

Les options ainsi que les commandes du service permettent d’effectuer un certain nombre d’actions sur le service. Ces
différentes options sont traitées au sein du guide d’exploitation.

Graphique détaillé et graphiques des statuts

Les parties Graphique détaillé et Graphique des statuts permettent respectivement de visualiser le graphique de
performance ainsi que le graphique d’historique de statuts pour ce service.

Raccourcis d’hôte et de service

Ces différentes options sont traitées au sein du guide d’exploitation.

Liens

Le conteneur Liens permet de visualiser :
— Les groupes d’hôtes auxquels l’hôte contenant le service appartient
— Les groupes de services auxquels le service appartient
— Les catégories de services auxquels le service appartient

Notifications

Le conteneur Notifications permet de visualiser quels sont les contacts et les groupes de contacts qui seront alertés en
cas d’envoi d’une notification.

7.4. Supervision Temps-réel
CENTREON 46-52 RUE ALBERT FR75014 PARIS

213



7.4.5 Les temps d’arrêts

Pour visualiser les temps d’arrêts en cours sur les ressources, rendez-vous dans le menu Supervision > Temps d’arrêt

Le tableau ci-dessous décrit les colonnes de cette page.

Nom de la colonne Description
Nom de l’hôte Indique le nom de l’hôte
Service (si on utilise la page Services) Affiche le service concerné par le temps d’arrêt
Date et heure de début et Date et heure de fin Affiche la date et l’heure de début et de fin
Durée Affiche la durée du temps d’arrêt
Auteur Affiche la personne ayant ajouté ce temps d’arrêt
Commentaires Affiche le raison du temps d’arrêt
Démarré Indique si le temps d’arrêt est en cours ou non
Fixe Indique si le temps d’arrêt est fixe ou non

Filtres disponibles

Vous pouvez filtrer le résultat présenté via les filtres suivants :
— Nom de l’hôte : permet de filtrer par nom d’hôte via une recherche de type SQL LIKE.
— Service : permet de filtrer par le nom du service.
— Statut détaillé : permet de filtrer par le statut détaillé des services.
— Auteur : permet de filtrer par utilisateur ayant créé des commentaires.
— Afficher les temps d’arrêt terminés : permet d’afficher en plus les temps d’arrêt terminés.
— Afficher les temps d’arrêt récurrents : permet d’afficher les temps d’arrêts récurrents.

Note : La recherche sur les champs texte ne commence qu’à partir de la saisie du troisième caractère.

7.4.6 Les commentaires

Pour visualiser les commentaires définis sur les ressources, rendez-vous dans le menu Supervision > Temps d’arrêt
> Commentaires

Le tableau ci-dessous décrit les colonnes de cette page.
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Nom de la colonne Description
Nom de l’hôte Indique le nom de l’hôte
Service (si on utilise la page Services) Affiche le service concerné par le commentaire
Date de saisie Affiche la date et l’heure où le commentaire a été saisi
Auteur Affiche la personne ayant ajouté ce commentaire
Commentaires Affiche le contenu du commentaire
Acquittement persistant en cas de redémarrage de
l’ordonnanceur

Indique si le commentaire reste après le redémarrage de
l’ordonnanceur

Filtres disponibles

Vous pouvez filtrer le résultat présenté via les filtres suivants :
— Nom de l’hôte : permet de filtrer par nom d’hôte via une recherche de type SQL LIKE.
— Service : permet de filtrer par le nom du service.
— Statut détaillé : permet de filtrer par le statut détaillé des services.

Note : La recherche sur les champs texte ne commence qu’à partir de la saisie du troisième caractère.

7.5 Graphiques de performances

Ce chapitre va vous permettre de comprendre comment fonctionne la gestion de la performance avec Centreon.

Le fonctionnement de graphiques de performance est en lien avec les plugins d’interrogation que vous utilisez car ce
sont ces derniers qui vous remonter toutes les données de performance à Centreon pour générer les graphiques. Si vous
manquez de données à ce sujet ou si vous souhaitez faire évoluer le format des métriques remontées, veuillez vous
reporter sur les plugins utilisés. Le choix des plugins est donc une étape importante pour avoir des graphiques utiles
à l’exploitation des résultats de la supervision. Les Centreon-Plugins, plugins officiels de Centreon, sont développés
pour apporter le plus de données possibles et pour s’intégrer au mieux avec le module de métrologie de Centreon.
N’hésitez pas à feuilleter le catalogue pour voir les possibilités.

7.5.1 Les graphes

Définition

Centreon permet de générer des graphiques à partir des informations de supervision. Il existe deux types de gra-
phiques :

— Les graphiques de performances permettent de visualiser l’évolution des services de manière intuitive.
Exemples : niveau de remplissage d’un disque dur, trafic réseau...

— Les graphiques d’historique (ou graphiques des statuts) permettent de visualiser l’évolution des statuts d’un
service.

Les graphiques de performances ont toujours comme abscisse une période de temps et comme ordonnée une unité
(Volts, Octets...). Les graphiques d’historique ont toujours comme abscisse une période de temps, leurs ordonnées ne
varient pas. Uniquement la couleur du graphique permet de visualiser le statut de l’objet :

— Vert pour le statut OK
— Orange pour le statut WARNING
— Rouge pour le statut CRITICAL
— Gris pour le statut UNKNOWN

Exemple de graphique de performances :
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Visualisation

Les graphiques de performances

Il existe plusieurs manières de visualiser les graphiques de performances :
— Visualiser le graphique dans la liste des services (Menu Supervision > Détails des statuts > Services) en

survolant l’icône

— Visualiser le graphique depuis la page de détails d’un objet en cliquant sur l’icône
— Se rendre dans le menu Supervision > Informations de performance pour visualiser un à plusieurs graphiques

Les graphiques d’historique

Comme pour les graphiques de performances, il existe différentes façons d’accéder au graphique d’historique :
— A partir de la page de détail d’un objet (voir le chapitre supervision temps-réelle)
— A partir du menu Supervision > Informations de performance, en sélectionnant au préalable un service

spécifique puis, en cochant la case Affichage de l’état.

Visualiser plusieurs graphiques

Pour visualiser l’ensemble des graphiques, rendez-vous dans le menu Monitoring > Informations de performance.
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Tous les filtres en haut de la page permettent de sélectionner le graphique que l’on désire afficher sur la période voulue.

L’option Hôtes permet d’afficher l’ensemble des graphiques liés aux hôtes sélectionnés

L’option Services permet d’affciher uniqument les graphiques des services sélectionnés

L’option Période de Visualisation peut être utilisé pour sélectionner la période voulue. Cela peut être une période
prédéfinie ou spécifique.

— Séparer les courbes : sépare plusieurs courbes d’un graphique en plusieurs graphiques contenant chacun une
courbe

— Affichage de l’état : affiche les graphiques d’historique liés aux graphiques de performances affichés
Pour exploiter les données des graphiques, il est possible de :

— Visualiser le graphique de performance sur un jour, une semaine, un mois et une année en cliquant sur le
graphique de performances de votre choix

— De sauvegarder le graphique en cliquant sur l’icône
— De télécharger l’ensemble des données qui composent le graphique au format .csv en cliquant sur l’icône

Filtres Il est possible de filtrer la sélection des ressources via :
— La barre de recherche rapide en recherchant par hôte ou service
— En parcourant l’arbre de sélection (menu de gauche) par groupe d’hôtes, puis par hôte, puis par service dont

afficher le graphique
— En parcourant l’arbre de sélection (menu de gauche) par groupe de services puis par service dont afficher le

graphique

Note : Les hôtes non liés à un groupe d’hôte sont ajoutés au conteneur Hôtes orphelins.

7.5. Graphiques de performances
CENTREON 46-52 RUE ALBERT FR75014 PARIS

217



7.5.2 Personnaliser les graphiques

Les modèles de graphiques

Définition

Les modèles de graphiques sont des modèles qui permettent de mettre en forme les graphiques. Les modèles de
graphiques permettent de configurer plusieurs paramètres de présentation dont la mesure de l’axe des ordonnées, la
largeur et la hauteur du graphique ou encore les différentes couleurs...

Configuration

Pour ajouter un nouveau modèle de graphique :

1. Rendez-vous dans le menu Supervision > Informations de performance
2. Dans le menu de gauche cliquez sur Modèles
3. Cliquez sur Ajouter

Informations générales
— Le champ Nom du Modèle permet de définir un nom pour le modèle de graphe
— Le champ Label Vertical contient la légende pour l’axe des ordonnées (type de données mesurées)
— Les champs Largeur et Hauteur sont exprimées en pixels et expriment respectivement la largeur et la hauteur

du modèle
— Le champ Limite inférieure définit la limite minimale de l’axe des ordonnées
— Le champ Limite supérieure définit la limite maximale de l’axe des ordonnées
— La liste Base définit la base de calcul pour les données lors de la mise à l’échelle des ordonnées du graphique.

Utilisez 1024 pour des mesures comme l’octet (1 Ko = 1024 octets) et 1000 pour des mesures comme le volt
(1 kV = 1000 Volts).

Note : Si la case “Taille max” est cochée, le graphique sera automatiquement mis à l’échelle de la valeur maximale
des ordonnées présentées sur la période donnée.
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Utiliser un modèle de graphe

Vous pouvez ajouter ce modèle de présentation lors de l’édition de l’objet à :
— Un service (ou un modèle de service) en se rendant dans l’onglet Informations supplémentaires du service.
— Une commande.

Les courbes

Définition

Une courbe est la représentation de l’évolution des données de performances (métriques issues de la collecte) visible
via les graphiques de performance. Un graphique peut contenir plusieurs courbes. Il est possible de personnaliser les
courbes en modifiant certains paramètres : l’allure des courbes, la position des courbes sur le graphique, la légende
ainsi que les informations complémentaires (moyenne, valeur totale...).

Configuration

Pour ajouter un nouveau modèle de courbes :

1. Rendez-vous dans le menu Supervision > Informations de performance
2. Dans le menu de gauche cliquez sur Courbes
3. Cliquez sur Ajouter
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— Le champ Nom du modèle définit le nom du modèle.
— Le champ Source de données Hôtes/Service définit le service pour lequel sera utilisée cette courbe. Si ces

informations ne sont pas renseignées, cette définition de courbe s’appliquera à l’ensemble des services dans
lesquels cette métrique apparait.

— Le champ Nom de la source de données permet de sélectionner la métrique qui utilisera cette définition. La
liste Liste des métriques connues permet de choisir les métriques déjà existantes utilisées par les services.

— Si la case Empiler est cochée, cette courbe s’empilera (‘stacking’) sur les autres (utile pour voir la proportion
d’une métrique par rapport à une autre).

— Si la case Empiler est cochée, la liste Ordre permet de définir l’ordre d’affichage/empilage de la courbe (plus
le nombre est petit, plus il sera proche de l’abscisse).

— Si la case Inverser est cochée, la courbe est inversée (opposée de la valeur absolue) par rapport à l’axe des
ordonnées (utile pour voir la proportion du trafic entrant par rapport au trafic sortant).

— La liste Epaisseur exprime l’épaisseur de la ligne du trait de la courbe (exprimée en pixels).
— Le champ Couleur de la courbe définit la couleur de la courbe.
— Le champ Couleur de l’aire concerne la couleur de remplissage de la courbe si l’option Remplissage est

cochée, (voir ci-dessous). Elle contient 3 champs qui correspondent respectivement aux couleurs du statut OK,
WARNING et CRITICAL.

— Le champ Transparence définit le niveau de transparence de la couleur du contour.
— Si la case Remplissage est cochée, alors toute la courbe est remplie avec la couleur de l’aire définie en fonction

du statut.
Les attributs ci-dessous concernent les informations situées en dessous du graphique.

— Le champ Légende définit la légende de la courbe.
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— Si la case Afficher uniquement la légende est cochée, la courbe sera masquée tandis que la légende sera
visible.

— La liste Ligne vide après cette légende permet de définir un certain nombre de lignes vides après la légende.
— Si la case Afficher la valeur maximale est cochée, alors la valeur maximale atteinte par la courbe sera affichée.
— Si la case Afficher la valeur minimale est cochée, alors la valeur minimale atteinte par la courbe sera affichée.
— Si la case Arrondir les valeurs minimales et maximales est cochée, alors les valeurs minimales et maximales

seront arrondies.
— Si la case Afficher la moyenne est cochée, alors la moyenne des points de la courbe sera affichée.
— Si la case Afficher la dernière valeur est cochée, alors la dernière valeur collectée de la courbe sera affichée.
— Si la case Afficher la valeur totale est cochée, s’affiche alors la valeur totale (somme de toutes les valeurs de

la courbe sur la période sélectionnée).
— Le champ Commentaires permet de commenter la courbe.

Quelques exemples de courbes

Les courbes empilées :

Les courbes inversées :

Les courbes avec remplissage :
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Les métriques virtuelles

Définition

Les métriques virtuelles sont l’affichage de courbes résultant du traitement / agrégation de données issues d’un jeu de
données. Le jeu de données correspond aux différentes valeurs des courbes sur la période de présentation du graphique.
La création de métriques virtuelles repose sur le langage RPN (Reverse Polish Notation).

Deux types de jeu de données sont disponibles :
— CDEF : Cette commande crée un nouvel ensemble de points à partir d’une ou plusieurs séries de données.

L’agrégation est réalisée sur chaque point (données).
— VDEF : Le résultat de chaque agrégation est une valeur et une composante temporelle. Ce résultant peut

également être utilisé dans les divers éléments de graphique et d’impression.

CDEF vs VDEF Le type CDEF travaille sur un ensemble de points (tableau de données). Le résultat du traitement
(exemple : multiplication par 8 pour convertir des bits en octets) sera un ensemble de point. Le type VDEF permet
d’extraire le maximum d’un ensemble de point.

Note : Pour plus d’informations sur la notation de type RPN, référencez-vous à la documentation officielle RRD

Configuration

Pour ajouter une métrique virtuelle :

1. Rendez-vous dans le menu Supervision > Informations de performance
2. Dans le menu de gauche, cliquez sur Métriques (en dessous de Virtuals)

3. Cliquez sur Ajouter

222
CENTREON 46-52 RUE ALBERT FR75014 PARIS

Chapitre 7. Guide d’exploitation

http://oss.oetiker.ch/rrdtool/tut/rpntutorial.en.html


— Le champ Nom de la Métrique définit le nom de la métrique.
— La liste Source de données Hôte / Service permet de définir le service depuis lequel exploiter les métriques.
— Le champ Type DEF définit le type de jeu de données utilisé pour calculer la courbe virtuelle.
— Le champ Fonction RPN (Notation Polonaise Inversée) définit la formule permettant de calculer la métrique

virtuelle.

Note : Il n’est pas possible d’ajouter ensemble les métriques de différents services. Cependant, il est possible d’ajouter
des métriques virtuelles pour le calcul d’une nouvelle métrique.

— Le champ Unité de la Métrique définit l’unité de la métrique.
— Le champ Niveau d’alerte définit le seuil d’alerte à afficher dans le graphique.
— Le champ Niveau critique définit le seuil critique à afficher dans le graphique.
— Si la case Masquer le graphique et la légende est cochée, alors la courbe et la légende sont cachées.
— Le champ Commentaires permet de commenter la métrique.

7.6 Gestion de la supervision

7.6.1 Acquitter un problème

Principe

Lorsqu’un hôte ou un service présente un incident et que ce dernier est validé, le processus de notification est enclen-
ché, pouvant générer une notification envoyée à un contact. Si le problème persiste et suivant la configuration réalisée
(relancer une notification à intervalle de temps régulier, escalade de notification) il est possible que d’autres alertes
soient émises.

L’acquittement d’un incident permet de stopper le processus de notification (envoi de notifications), jusqu’à ce que
l’hôte ou le service retrouve un statut nominal.

Exemple d’utilisation :

Un service est chargé de vérifier la santé des disques durs d’une baie de disque. Un disque dur physique tombe en
panne sur une baie de disque, une notification est envoyée. L’opérateur de supervision acquitte le service en précisant
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qu’une équipe est en train de régler le problème. Les notifications ne sont plus envoyées. Le service reprendra son état
nominal après changement du disque.

Note : L’acquittement d’un incident signifie la prise en compte du problème par un utilisateur de la supervision (et
non la résolution de ce dernier qui ne pourra être effective que lorsque le contrôle sera revenu dans son état nominal).

Pratique

Pour acquitter un incident, deux solutions sont possibles :

Depuis la supervision temps réelle

1. Rendez-vous dans le menu Supervision ==> Détail du statut ==> Hôtes (ou Services)

2. Sélectionnez le ou les objets que vous souhaitez acquitter

3. Dans le menu Plus d’actions cliquez sur Hôtes : Acquitter ou sur Services : Acquitter

La fenêtre suivante s’affiche :

— Si la case Acquittement persistant en cas de changement de statut non-OK est cochée, alors l’acquitte-
ment sera conservé en cas de changement de statut non-OK (Exemple DOWN à UNREACHABLE ou bien
WARNING à CRITICAL). Sinon, l’acquittement disparait et le processus de notification est réactivé.

— Si la case Notifier est cochée, alors une notification est envoyée aux contacts liés à l’objet pour les avertir que
l’incident sur la ressource a été acquitté (dans le cas où le contact possède le filtre de notification d’acquittement
d’activé).

— Si la case Persistant en cas de redémarrage de l’ordonnanceur est cochée, alors l’acquittement sera conservé
en cas de redémarrage de l’ordonnanceur. Sinon, l’acquittement disparait et le processus de notification est
réactivé.

— Le champ Commentaire est généralement utilisé pour fournir la raison de l’acquittement et est obligatoire.
— Si la case Acquitter les services liés à l’hôte est cochée, alors tous les services liés à l’hôte seront acquittés

(option visible uniquement si vous acquittez un hôte).
— Si la case Forcer les contrôles actifs est cochée, alors une commande sera envoyée à l’ordonnanceur pour

recontrôler dans les plus brefs délais la ressource.
Pour supprimer l’acquittement d’un incident sur un objet :

1. Rendez-vous dans le menu Supervision ==> Détail du statut ==> Hôtes (ou Services)

2. Sélectionnez les objets auxquels vous souhaitez supprimer l’acquittement

3. Dans le menu Plus d’actions, cliquez sur Hôtes : Dés-acquitter ou sur Services : Dés-acquitter
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Depuis la fiche détaillée d’un objet

A partir de la page de détail d’un objet, cliquez sur l’icône associé au champ Acquittés dans le cadre Options

Vous accèderez à une page dédiée permettant d’acquitter l’incident.

Note : Les champs sont identiques à la fenêtre obtenue à partir du menu de supervision temps réel.

7.6.2 Ajouter un commentaire

Principe

Centreon permet d’ajouter des commentaires à un objet. Ce commentaire est visible par toute personne ayant accès à
la ressource (hôte ou service). Un commentaire possède les propriétés suivantes :

— Nom de l’hôte
— Nom du service si le commentaire est associé à un service
— Date de saisie du commentaire
— Auteur du commentaire
— Le contenu du commentaire
— La validité du commentaire face à un redémarrage de l’ordonnanceur

Pratique

Pour ajouter un commentaire, deux solutions sont possibles :

Depuis la fiche détaillée d’un objet

1. Accédez à la page de détails de l’objet

2. Dans la catégorie Commandes disponibles, cliquez sur Ajouter un commentaire pour cet hôte/ce service

Depuis le menu Commentaires

1. Rendez-vous dans le menu Supervision ==> Temps d’arrêt ==> Commentaire
2. Cliquez sur Ajouter un commentaire

Attributs

La fenêtre suivante s’affiche :

— Le champ Nom de l’hôte définit l’hôte concerné par le commentaire
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— Si vous avez choisi d’ajouter un commentaire pour un service, le champ Service vous permet de sélectionner
le service concerné par le commentaire.

— Si la case Persistant en cas de redémarrage de l’ordonnanceur est cochée, alors le commentaire sera
conservé en cas de redémarrage de l’ordonnanceur.

— Le champ Commentaire contient le commentaire lui-même.

7.6.3 Programmer un temps d’arrêt

Principe

Un temps d’arrêt est une période de temps durant laquelle les notifications sont désactivées pour une ressource. Les
temps d’arrêts sont utilisés lors d’opération d’une maintenance programmée ; ils permettent d’éviter de recevoir des
alertes de type faux-positif.

Note : Il est important de sélectionner l’ensemble des ressources nécessaires afin d’éviter les faux-positifs comme les
faux-négatifs. De plus, le temps passé dans cet état est pris en compte lors de la génération des données de disponibilité.

Il existe deux types de temps d’arrêts :
— Le temps d’arrêt fixe : démarre et s’arrête aux heures prévues de début et de fin.
— Le temps d’arrêt flexible : démarre pendant la fenêtre de temps prévue, dès la détection d’un incident. Il prend

fin lorsque la durée prévue en secondes est écoulée.

Pratique

Il y a trois possibilités différentes de définir un temps d’arrêt :
— Depuis la fiche de détails d’un hôte ou du service
— Depuis l’interface de supervision temps réelle
— Depuis le menu Temps d’arrêt

Depuis la fiche détaillée d’un objet

1. Accédez à la page de détails d’un objet

2. Dans la catégorie Commandes, cliquez sur Planifier un arrêt pour cet hôte/ce service

Depuis la supervision temps réelle

1. Rendez-vous dans le menu Supervision ==> Détails du statut ==> Hôtes (ou Services)

2. Sélectionnez le(s) objet(s) sur lesquels vous souhaitez planifier un temps d’arrêt

3. Dans le menu Plus d’actions..., cliquez sur Hôtes : Ajouter un temps d’arrêt ou Services : Ajouter un
temps d’arrêt

Depuis le menu Temps d’arrêt

1. Rendez-vous dans le menu Supervision ==> Temps d’arrêt
2. Dans le menu de gauche, cliquez sur Temps d’arrêt
3. Cliquez sur Ajouter un temps d’arrêt
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Attributs

— Le champ Nom de l’hôte définit l’hôte concerné par le temps d’arrêt
— Le champ Service définit le service concerné par le temps d’arrêt
— Si la case Fixe est cochée alors le temps d’arrêt est fixe. Sinon, il est flexible
— Si le temps d’arrêt est flexible, le champ Durée définit la durée du temps d’arrêt
— Les champs Date et heure de début et Date et heure de fin définissent les dates de début et de fin du temps

d’arrêt
— Le champ Commentaires sert à indiquer pourquoi le temps d’arrêt est programmé

7.6.4 Gestion des vérifications

Principe

Il est possible d’activer ou de désactiver momentanément la vérification d’un hôte ou d’un service.

Warning : La modification des paramètres de vérifications n’impacte pas la configuration de l’objet en base de
données. Ces modifications sont réalisées sur la supervision en temps-réel ; elles seront annulées lors du redémar-
rage de l’ordonnacneur.

Pratique

Pour modifier la gestion de la vérification sur un objet, deux solutions sont possibles :

Depuis la fiche détaillée d’un objet

1. Accédez à la page de détails de l’objet

2. Dans la catégorie Options, rendez-vous à la ligne Contrôles actifs pour vérifier l’état des contrôles.

Pour :

— Activer la vérification, cliquez sur

— Désactiver la vérification, cliquez sur

Depuis la supervision temps réelle

1. Rendez-vous dans le menu Supervision ==> Détails du statut ==> Hôtes (ou Services)

2. Sélectionnez le(s) objet(s) sur lesquels vous souhaitez activer ou de désactiver la vérification

3. Dans le menu Plus d’actions... cliquez sur :

— Hôtes : Désactiver la vérification ou Services : Désactiver la vérification pour arrêter la vérification d’un
hôte ou d’un service

— Hôtes : Activer la vérification ou Services : Activer la vérification pour activer la vérification d’un hôte ou
d’un service
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7.6.5 Soumettre un résultat

Principe

Pour les services ayant la propriété de contrôle passif, il est possible d’envoyer manuellement un résultat à l’ordon-
nanceur afin que celui-ci soit pris en compte par l’ordonnanceur.

Pratique

Pour soumettre un résultat, accédez à la page de détails de l’objet. Dans la catégorie Commandes du service cliquez
sur Soumettre un résultat pour ce service

Attributs

— Les champs Nom de l’hôte et Service définissent l’hôte et le service pour lequel le résultat sera soumis
— Le champ Résultat du contrôle définit le statut du service
— Le champ Sortie du contrôle définit le message à afficher pour le service
— Le champ Données de performance permet de définir des données de performances pour la génération des

graphiques

7.6.6 Gestion des notifications

Principe

Il est possible d’activer ou de désactiver momentanément la notification d’un hôte ou d’un service.

Warning : La modification des paramètres de notifications n’impacte pas la configuration de l’objet en base de
données. Ces modifications sont réalisées sur la supervision en temps-réel ; elles seront annulées lors du redémar-
rage de l’ordonnacneur.

Pratique

Il y a deux moyens de gérer les notifications :

Depuis la fiche détaillée d’un objet

1. Accédez à la page de détails de l’objet

2. Dans la catégorie Options, rendez-vous à la ligne Notifications pour l’envoi des notifications.

Pour :

— Activer la notification, cliquez sur

— Désactiver la notification, cliquez sur
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Depuis la supervision temps réelle

1. Rendez-vous dans le menu Supervision ==> Détail du statut ==> Hôtes (ou Services)

2. Sélectionnez le ou les hôtes/services pour lesquels vous souhaitez activer ou de désactiver la notification

3. Dans le menu Plus d’actions... cliquez sur :

— Hôtes : Désactiver la notification ou Services : Désactiver la notification pour arrêter la notification d’un
hôte ou d’un service

— Hôtes : Activer la notification ou Services : Activer la notification pour activer la notification d’un hôte ou
d’un service

7.6.7 Reprogrammation des contrôles

Principe

Par défaut, les contrôles (vérifications d’un service) sont exécutés à intervalle régulier suivant la configuration définie
par l’utilisateur. Il est possible d’interagir sur la pile d’ordonnancement des contrôles afin de modifier la programma-
tion de ces derniers.

Il existe deux types de programmation :
— La programmation classique : la vérification du service est mise en priorité dans la file d’attente de l’ordon-

nanceur (dès que possible).
— La programmation forcée : la vérification du service est mise en priorité dans la file d’attente de l’ordonnacneur

(dès que possible) et cela même si l’heure de la demande d’exécution est en dehors de la période contrôle ou
si le service n’est pas de type actif.

Pratique

Il y a deux moyens de forcer la vérification d’un service :

Depuis la fiche détaillée de l’objet

1. Accédez à la page de détail de l’objet

2. Dans la catégorie Commandes de l’hôte (ou Commandes du service), cliquez sur Re-planifier le prochain
contrôle pour cet hôte / service ou Re-planifier le prochain contrôle pour cet hôte / ce service (Forcé)

Depuis la supervision temps réelle

1. Rendez-vous dans le menu Supervision ==> Détails du statut ==> Hôtes (ou Services)

2. Sélectionnez le ou les objets pour lesquels vous souhaitez forcer la vérification

3. Dans le menu Plus d’actions... cliquez sur Planifier un contrôle immédiat ou Planifier un contrôle immé-
diat (Forcé)
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7.7 Tableaux de bord

7.7.1 Les rapports

Définition

Les rapports de disponibilités des objets accessibles via l’interface web Centreon permettent de visualiser de manière
intuitive le taux de disponibilité d’un hôte, d’un groupe d’hôtes ou d’un groupe de services sur une période de temps
donnée.

Visualisation

Pour visualiser le rapport de disponibilité d’un ‘hôte :

1. Rendez-vous dans le menu Rapports ==> Tableau de bord
2. Dans le menu de gauche, sélectionnez Hôte
3. Sélectionnez l’hôte désiré dans la liste déroulante Hôte

— La liste Période de génération permet de choisir la période de temps sur laquelle on souhaite visualiser le taux
de disponibilité. Il est possible de sélectionner une période prédéfinie via la liste déroulante ou de sélectionner
manuellement sa période en définissant les champs Du et Au

— Le tableau Etat de l’hôte permet de visualiser le taux et la durée de disponibilité associé par état de l’objet
— Le tableau Statuts des éléments du rapport permettent de visualiser la disponibilité des services associés à

l’hôte suivant leurs statuts
— La frise chronologique permet de visualiser de manière intuitive le statut de l’objet au court du temps
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De plus, en cliquant sur une journée de la frise chronologique, vous obtenez le rapport de la journée :

Il est également possible de visualiser des rapports web pour :
— Les groupes d’hôtes : Cliquez sur Groupes d’hôtes dans le menu de gauche
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— Les groupes de services : Cliquez sur Groupes de services dans le menu de gauche
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L’icône permet d’exporter les données du rapport au format CSV.

Note : Cliquez sur le service d’un hôte dans le rapport de disponibilité de l’hôte pour obtenir un rapport détaillé du
service.
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7.8 Les journaux d’évènements

7.8.1 Définition

Les journaux d’évènements (aussi appelés “Event logs”) permettent de :
— Visualiser les différents changements de statuts et états des objets supervisés
— Voir les notifications envoyées ainsi que leurs destinataires

Ces journaux peuvent être visualisés sur une période donnée.

7.8.2 Visualisation

Pour visualiser les journaux d’évènements, rendez-vous dans le menu Supervision ==> Journaux d’évènements.
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Le menu supérieur permet de selectionner la liste des hôtes et services desquels on désire afficher les journaux d’éve-
nements. Il est possible de sélectionner une liste de hôtes ou de services contenue dans un groupe d’hôtes ou dans un
groupe de services.

Les champs Type de message et Statut permettent de filtrer les éléments recherchés selon leur état et leur statut.

Le champs Période de visualisation permet de sélectionner une période temporelle sur laquelle afficher les évene-
ments voulus. Il est possible d’utiliser une période temporelle prédefinie ou alors de sélectionner une période manuel-
lement, en utilisant les champs Du et Au.

Le tableau permet de visualiser les résultats.

7.8.3 Filtrer les messages

Type de message

Il est possible d’afficher plusieurs types de messages sur la période donnée :
— Les services ayant le statut WARNING en cochant Alerte
— Les erreurs (hôtes non disponibles ou services ayant le statut CRITICAL) en cochant Erreur
— Les incidents d’hôtes ou de service validés (“HARD”) en cliquant sur Etat Hard seulement
— Les notifications envoyées en cliquant sur Notifications

Statut de l’hôte ou du service

Note : Les choix effectués ici influencent les cases cochées dans Type de message. Il est également possible de
visualiser les différents messages en sélectionnant manuellement les statuts désirés pour les hôtes ou les services.

7.8.4 Les résultats

Le tableau ci-dessous décrit les différentes colonnes du tableau de résultats.

Nom de la
colonne

Description

Jour Affiche la date de l’évènement
Heure Affiche l’heure de l’évènement
Nom de l’objet Affiche le nom de l’objet (hôte et/ou service)
Statut Affiche le statut de l’objet
Type Affiche l’état de l’objet (‘SOFT’ ou ‘HARD’)
Nombre d’essais Affiche le nombre de vérification depuis le statut actuel de l’objet
Statut détaillé Affiche le message expliquant le statut de l’hôte ou du service
Contact Affiche le contact ayant été contacté (n’est renseigné que s’il s’agit d’une notification)
Commande Affiche la commande utilisée pour alerter le contact (n’est renseigné que s’il s’agit d’une

notification)
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CHAPITRE 8

Guide d’administration

8.1 Les listes de contrôles d’accès

Les listes de contrôles d’accès (LCA ou Access Control List en Anglais) permettent de limiter l’accès à l’interface
web aux utilisateurs de Centreon à travers diverses règles. Les ACL permettent également de créer plusieurs profils
utilisateur permettant de focaliser sur un ensemble précis de ressources.

Note : La gestion des contrôles d’accès est une fonction propre à Centreon, l’exportation de la configuration vers les
moteurs de supervision n’est pas nécessaire pour les activer.

Les groupes d’accès sont des groupes contenant les utilisateurs de Centreon. Pour chaque groupe d’accès, il est possible
de définir trois types de contrôles d’accès :

— Les filtres d’accès aux ressources permettent de limiter l’accès aux objets de Centreon (hôtes, services...)
— Les filtres d’accès aux menus permettent de limiter l’accès aux menus de Centreon
— Les filtres d’accès sur les actions permettent de limiter l’accès aux actions que l’utilisateur peut entreprendre

sur un moteur de supervision ou sur les ressources elles-mêmes (planifier temps d’arrêt, arrêter moteur de
supervision...)

Note : Un utilisateur peut appartenir à plusieurs groupes d’accès permettant ainsi d’additionner l’ensemble des auto-
risations d’accès.

Les ACLs respectent des règles très strictes :
— Les administrateurs de Centreon ne sont pas soumis aux ACLs (propriété du contact).
— Un utilisateur (non administrateur) n’appartenant à aucun groupe d’accès n’a aucun droit sur la plateforme de

supervision (écran vide après connexion).
— Les ACLs sont recalculées toutes les minutes, c’est pourquoi il est parfois nécessaire de patienter quelques

instants avant de voir appliquer la modification sur le profil.

Note : L’ajout de modules complémentaires à Centreon permet parfois d’ajouter des filtres supplémentaires pour les
groupes d’accès. Exemple : les modules Centreon BI, BAM et MAP peuvent être soumis à des filtres

8.1.1 Groupes d’accès

Pour ajouter un groupe d’accès :

1. Rendez-vous dans le menu Administration ==> ACL
2. Cliquez sur Ajouter
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Informations générales

— Les champs Nom du groupe et Alias définissent le nom et l’alias du groupe
— La liste Contacts liés permet de lier des contacts au groupe d’accès
— La liste Groupes de contacts liés permet de lier des groupes de contacts au groupe d’accès
— Le champ Statut permet d’activer ou de désactiver le groupe d’accès

Note : Les groupes de contacts peuvent être des groupes provenant de l’annuaire LDAP connecté à l’interface Cen-
treon.

Les groupes créés sur Centreon ne doivent pas avoir le même nom que les groupes LDAP. Si c’est le cas, les groupes
dans Centreon devront être renommés.

Autorisations

Les listes présentes au sein de cet onglet permettent de lier les différents types de contrôles d’accès déjà créés au
groupe d’accès.

8.1.2 Filtre d’accès aux ressources

Les filtres d’accès aux ressources permettent de limiter la visualisation des objets (hôtes, groupes d’hôtes, services,
groupes de services) à un profil utilisateur.

Pour ajouter un filtre d’accès aux ressources :

1. Rendez-vous dans le menu Administration ==> ACL
2. Dans le menu de gauche, cliquez sur Gestion des accès aux ressources
3. Cliquez sur Ajouter
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Note : Une fois les filtres sur les ressources paramétrez, vous pouvez visualiser le résultat via le menu Vérifier la vue
de l’utilisateur à côté de l’option pour ajouter un nouveau filtre.

Informations générales

— Les champs Nom du groupe et Description définissent le nom et la description du filtre
— La liste Groupes liés permet de lier des groupes d’accès à ce filtre de ressources
— Le champ Statut et Commentaires permet d’activer/désactiver le filtre ainsi que de le commenter

Gestion des hôtes

L’onglet Gestion des hôtes permet d’ajouter :
— Des hôtes
— Des groupes d’hôtes

Si la case Inclure tous les hôtes ou Inclure tous les groupes d’hôtes est cochée, alors tout objet nouvellement créé
sera automatiquement ajouté au filtre.

Note : Il est possible d’exclure explicitement des hôtes du filtre (pratique dans le cas où 1 ou 2 hôtes uniquement ne
doivent pas faire partie du filtre) dans le cas où les options Inclure tous les hôtes ou Inclure tous les groupes d’hôtes
sont cochées.

Gestion des services

L’onglet Gestion des services permet d’ajouter des groupes de services au filtre.
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Méta-Services

L’onglet Méta-Services permet d’ajouter des méta-services au filtre.

Filtres

— La liste Filtrer par collecteur permet de sélectionner les hôtes en fonction des collecteurs de supervision (si
aucun n’est sélectionné alors tous les collecteurs sont pris en compte)

— La liste Filtrer par catégorie d’hôte permet de filtrer les hôtes par catégorie
— La liste Filtrer par catégorie de service permet de filtrer les services par catégorie

Warning : Les filtres par collecteur ou par catégorie d’objet sont des filtres d’inclusion (UNION). Seuls les objets
appartenant à ces filtres en plus des groupes d’objets (hôtes et services) seront visibles.

8.1.3 Filtre d’accès aux menus

Les filtres d’accès au menu permettent de limiter l’accès aux différents menus de l’interface Centreon. Les menus sont
hiérarchisés de la manière suivante :

— Les menus de niveau 1 (Accueil, Supervision, Vues, ...)
— Les menus de niveau 2 (Supervision ==> Hôtes, Supervision ==> Services, ...)
— Les menus contextuels de niveau 3 (Supervision ==> Services ==> Par hôtes / détails)
— Les menus contextuels de niveau 4 (Supervision ==> Services ==> Par hôtes / détails ==> Problems)

Note : Pour accéder à un niveau de menu ‘n-1’, l’utilisateur doit avoir accès au menu de niveau ‘n’ sinon ce dernier
ne pourra pas visualiser le menu au travers de l’interface. Dans le cas contraire, l’utilisateur devra accéder directement
à la page concernée via un lien direct (autologin, ...).

Pour ajouter un filtre d’accès aux menus :

1. Rendez-vous dans le menu Administration ==> ACL
2. Dans le menu de gauche, cliquez sur Gestion des accès aux menus
3. Cliquez sur Ajouter
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— Les champs Nom du groupe et Alias définissent le nom et l’alias du filtre d’accès
— Le champ Statut permet d’activer ou de désactiver le filtre
— La liste Groupes liés permet d’associer un groupe d’accès au filtre
— La catégorie Pages disponibles permet d’associer des menus au filtre (Le menu parent doit être coché pour

pouvoir accéder au menu enfant)
— Le champ Commentaires donne des indications sur le filtre

Warning : Lors de la définition de l’accès aux menus Configuration ==> Hôtes et Configuration ==> Service,
il est possible de donner accès en lecture seule aux différents objets ou en lecture/écriture.

Note : A chaque ajout de nouveau module Centreon possédant une interface web accessible au travers d’un nouveau
menu, ce dernier devra être ajouté dans les groupes d’accès au menu afin que les utilisateurs puissent y accéder le cas
échéant.

8.1.4 Filtre d’accès sur les actions

Les filtres sur les actions permettent de limiter l’accès aux actions réalisables sur les ressources (hôtes et services)
ainsi que sur les ordonnanceurs de supervision (arrêt des notifications, redémarrage d l’ordonnanceur, ...).

Pour ajouter un filtre d’accès aux actions :

1. Rendez-vous dans le menu Administration ==> ACL
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2. Dans le menu de gauche, cliquez sur Gestion des accès sur les actions
3. Cliquez sur Ajouter

— Les champs Nom de l’action et Description contiennent le nom du filtre ainsi que sa description
— La liste Groupes liés permet d’associer un groupe d’accès au filtre

Le tableau ci-dessous décrit les fonctionnalités générales d’accès :

Champ Actions associées
Afficher les statistiques des hôtes et
services dans le bandeau

Affiche les statistiques de supervision sous forme de tableau présent
dans le bandeau de Centreon

Afficher les statistiques des collecteurs
dans le bandeau

Affiche les statistiques des collecteurs en haut à droite (voir la case
Etat des collecteurs)

Afficher la liste des collecteurs Affiche la liste des collecteurs dans Supervision ==> Hôtes ou
Supervision ==> Services

Le tableau ci-dessous décrit les fonctionnalités de génération de la configuration :

Champ Actions associées
Générer les fichiers de
configuration

Permet de générer, tester et exporter la configuration des collecteurs et de redémarrer
les moteurs de supervision

Générer la configuration
des traps SNMP

Permet de générer et exporter la configuration des traps SNMP pour le processus
Centreontrapd sur les collecteurs et de redémarrer ce dernier

Le tableau ci-dessous décrit l’ensemble des actions qui peuvent être autorisées sur l’ordonnanceur :
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Champ Actions associées
Afficher les statistiques des hôtes et
services dans le bandeau

Affiche les statistiques de supervision sous forme de tableau présent
dans le bandeau de Centreon

Afficher les statistiques des collecteurs
dans le bandeau

Affiche les statistiques des collecteurs en haut à droite (voir la case
Etat des collecteurs)

Afficher la liste des collecteurs Affiche la liste des collecteurs dans Supervision ==> Hôtes ou
Supervision ==> Services

Arrêter l’ordonnanceur Autoriser l’arrêt de l’ordonnanceur
Redémarrer l’ordonnanceur Autoriser le redémarrage de l’ordonnanceur
Activer/Désactiver les notifications Activer/Désactiver l’envoi de notifications
Activer/Désactiver les contrôles des
services

Activer/Désactiver les contrôles des services

Activer/Désactiver les contrôles passifs
des services

Activer/Désactiver les contrôles passifs pour les services

Activer/Désactiver les contrôles des hôtes Activer/Désactiver les contrôles sur les hôtes
Activer/Désactiver les contrôles des
passifs d’hôtes

Activer/Désactiver les contrôles passifs pour les hôtes

Activer/Désactiver le gestionnaire
d’évènements

Activer/Désactiver le gestionnaire d’évènement

Activer/Désactiver la détection de
bagotage

Activer/Désactiver la détection du statut FLAPPING (ou bagotage)

Activer/Désactiver la commande post
contrôle des services

Activer/Désactiver la commande post-contrôle des services

Activer/Désactiver la commande post
contrôle des hôtes

Activer/Désactiver la commande post-contrôle des hôtes

Activer/Désactiver les données de
performance

Activer/Désactiver les données de performances

Le tableau ci-dessous décrit l’ensemble des actions qui peuvent être autorisées sur les services :

Champ Actions associées
Activer/Désactiver les vérifications pour un
service

Activer/Désactiver les vérifications pour un service

Activer/Désactiver les notifications pour un
service

Activer/Désactiver les notifications pour un service

Prendre en compte un incident d’un service Permettre aux utilisateurs d’acquitter un service
Supprimer la prise en compte d’un service Permettre aux utilisateurs de supprimer un acquittement de

service
Re-planifier la prochaine vérification d’un
service

Re-planifier la prochaine vérification d’un service

Re-planifier la prochaine vérification d’un
service (Forcé)

Re-planifier la prochaine vérification d’un service (Forcé)

Planifier un temps d’arrêt pour un service Planifier un temps d’arrêt pour un service
Ajouter/Supprimer un commentaire pour un
service

Autoriser l’ajout de commentaires pour un service

Activer/Désactiver le gestionnaire d’évènement
pour un service

Activer/Désactiver le gestionnaire d’évènement pour un
service

Activer/Désactiver la détection de bagotage
d’un service

Activer/Désactiver la détection du statut FLAPPING (ou
bagotage) pour un service

Activer/Désactiver le contrôle passif d’un
service

Activer/Désactiver le contrôle passif pour les services

Soumettre un résultat pour un service Autoriser la soumission d’un résultat pour un service
Afficher la commande exécutée par le moteur
de collecte

Autoriser l’affichage de la commande exécutée pour un service
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Le tableau ci-dessous décrit l’ensemble des actions qui peuvent être autorisées sur les hôtes :

Champ Actions associées
Activer/Désactiver les vérifications pour un
hôte

Activer/Désactiver les vérifications pour un hôte

Activer/Désactiver les notifications pour un
hôte

Activer/Désactiver les notifications pour un hôte

Prendre en compte un incident d’un hôte Permettre aux utilisateurs d’acquitter un hôte
Supprimer la prise en compte d’un hôte Permettre aux utilisateurs de supprimer un acquittement d’un

hôte
Re-planifier la prochaine vérification d’un hôte Re-planifier la prochaine vérification d’un hôte
Re-planifier la prochaine vérification d’un hôte
(Forcé)

Re-planifier la prochaine vérification d’un hôte (Forcé)

Planifier un temps d’arrêt pour un hôte Planifier un temps d’arrêt pour un hôte
Ajouter/Supprimer un commentaire pour un
hôte

Autoriser l’ajout de commentaires pour un hôte

Activer/Désactiver le gestionnaire d’évènement
pour un hôte

Activer/Désactiver le gestionnaire d’évènement pour un hôte

Activer/Désactiver la détection de bagotage
d’un hôte

Activer/Désactiver la détection du statut FLAPPING (ou
bagotage) pour un hôte

Activer/Désactiver les contrôles des services de
l’hôte

Activer/Désactiver les contrôles des services d’un hôte

Soumettre un résultat pour un hôte Autoriser la soumission d’un résultat pour un hôte

— Le champ Statut permet d’activer ou de désactiver le filtre

8.1.5 Recalculer les ACLs

Il est possible de recalculer manuellement les ACLs :
1. Rendez-vous dans le menu Administration ==> ACL
2. Dans le menu de gauche, cliquez sur Recharger les ACL
3. Sélectionnez le ou les utilisateurs pour lesquels vous souhaitez recharger les ACL
4. Dans le menu Plus d’actions, cliquez sur Recharger les ACL

8.2 Architecture distribuée

Les architectures distribuées Centreon sont décrites dans le chapitre architecture :
— Architecture distribuée
— Architecture distribuée avec Remote server

8.2.1 Installer un collecteur

Selectionnez votre méthode d’installation :

A partir de l’ISO Centreon el7

Installation

Le processus d’installation est identique à celui d’un serveur Centreon Central réalisé à partir du fichier ISO de Cen-
treon.
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Note : Référez-vous à la documentation installation.

A la question Which server type would you like to install ? il faut choisir l’option Poller server.

Echange de clés SSH

La communication entre le serveur central et un collecteur se fait via SSH.

Vous devez échanger les clés SSH entre les serveurs.

Si vous n’avez pas de clé SSH privée sur le serveur central pour l’utilisateur centreon :

# su - centreon
$ ssh-keygen -t rsa

Générez un mot de passe sur le nouveau serveur pour l’utilisateur centreon :

# passwd centreon

Vous devez copier cette clé sur le nouveau serveur :

# su - centreon
$ ssh-copy-id -i .ssh/id_rsa.pub centreon@IP_POLLER
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Configurer un nouveau collecteur dans Centreon

Depuis Centreon 18.10, un assistant de configuration est disponible pour ajouter un collecteur à la plate-forme Cen-
treon.

Note : Il est possible d’ajouter un nouveau collecteur manuellement, cependant Centreon recommande d’utiliser la
procédure suivante.

Rendez-vous dans le menu Configuration > Pollers et cliquez sur Add server with wizard pour accéder à l’assistant
de configuration.

Sélectionnez Add a Centreon Poller et cliquez sur Next :

Saisissez le nom, l’adresse IP du collecteur et celle du serveur Centreon central, cliquez sur Next :

Note : L’adresse IP du collecteur est l’adresse IP ou le FQNS pour accéder au collecteur depuis le serveur Centreon
Central.

L’adresse IP du collecteur est l’adresse IP ou le FQNS pour accéder au collecteur serveur Centreon Central vers le
collecteur.

Si vous souhaitez lier ce collecteur au serveur Centreon Central, cliquez sur Apply :
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Sinon, si vous souhaitez lier ce collecteur à un Remote Server, sélectionnez le Remote Server dans la liste et cliquez
sur Apply :

Note : Si vous souhaitez changer le sens de connexion des données entre le serveur Centreon central et le collecteur,
cochez la case Advanced : reverse Centreon Broker communication flow.

Patientez quelques secondes, l’assistant va configurer votre nouveau serveur.

Le collecteur est maintenant configuré :

Rendez-vous au chapitre Configuration simplifiée avec Centreon IMP pour mettre en place votre première supervision.

A partir des paquets Centreon

Installation

SELinux doit être désactivé. Pour cela vous devez modifier le fichier /etc/selinux/config et remplacer “enforcing” par
“disabled” comme dans l’exemple suivant

SELINUX=disabled

Note : Après avoir sauvegardé le fichier, veuillez redémarrer votre système d’exploitation pour prendre en compte les
changements.

Une vérification rapide permet de confirmer le statut de SELinux

$ getenforce
Disabled

Paramétrer le pare-feu système ou désactiver ce dernier. Pour désactiver ce dernier exécuter les commandes suivantes
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# systemctl stop firewalld
# systemctl disable firewalld
# systemctl status firewalld

Afin d’installer les logiciels Centreon à partir des dépôts, vous devez au préalable installer le fichier lié au dépôt.
Exécutez la commande suivante à partir d’un utilisateur possédant les droits suffisants.

Installation du dépôt Centreon :

# wget http://yum.centreon.com/standard/18.10/el7/stable/noarch/RPMS/centreon-release-18.10-2.el7.centos.noarch.rpm -O /tmp/centreon-release-18.10-2.el7.centos.noarch.rpm
# yum install --nogpgcheck /tmp/centreon-release-18.10-2.el7.centos.noarch.rpm

Le dépôt est maintenant installé.

Exécutez la commande :

# yum install centreon-poller-centreon-engine

Echange de clés SSH

La communication entre le serveur central et un collecteur se fait via SSH.

Vous devez échanger les clés SSH entre les serveurs.

Si vous n’avez pas de clé SSH privée sur le serveur central pour l’utilisateur centreon :

# su - centreon
$ ssh-keygen -t rsa

Générez un mot de passe sur le nouveau serveur pour l’utilisateur centreon :

# passwd centreon

Vous devez copier cette clé sur le nouveau serveur :

# su - centreon
$ ssh-copy-id -i .ssh/id_rsa.pub centreon@IP_POLLER

Configurer un nouveau collecteur dans Centreon

Depuis Centreon 18.10, un assistant de configuration est disponible pour ajouter un collecteur à la plate-forme Cen-
treon.

Note : Il est possible d’ajouter un nouveau collecteur manuellement, cependant Centreon recommande d’utiliser la
procédure suivante.

Rendez-vous dans le menu Configuration > Pollers et cliquez sur Add server with wizard pour accéder à l’assistant
de configuration.

Sélectionnez Add a Centreon Poller et cliquez sur Next :
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Saisissez le nom, l’adresse IP du collecteur et celle du serveur Centreon central, cliquez sur Next :

Note : L’adresse IP du collecteur est l’adresse IP ou le FQNS pour accéder au collecteur depuis le serveur Centreon
Central.

L’adresse IP du collecteur est l’adresse IP ou le FQNS pour accéder au collecteur serveur Centreon Central vers le
collecteur.

Si vous souhaitez lier ce collecteur au serveur Centreon Central, cliquez sur Apply :
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Sinon, si vous souhaitez lier ce collecteur à un Remote Server, sélectionnez le Remote Server dans la liste et cliquez
sur Apply :

Note : Si vous souhaitez changer le sens de connexion des données entre le serveur Centreon central et le collecteur,
cochez la case Advanced : reverse Centreon Broker communication flow.

Patientez quelques secondes, l’assistant va configurer votre nouveau serveur.

Le collecteur est maintenant configuré :

Rendez-vous au chapitre Configuration simplifiée avec Centreon IMP pour mettre en place votre première supervision.

8.2.2 Installer un Remote Server

L’installation d’un Remote Server est très similaire à celle d’un Centreon Central Server. Selectionnez votre méthode
d’installation :

A partir de l’ISO Centreon el7

Installation

Etape 1 : Démarrage Afin d’installer Centreon, démarrez votre serveur sur l’image ISO de Centreon en version el7.
Démarrez avec l’option Install CentOS 7 :
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Etape 2 : Choix de la langue Choisissez la langue du processus d’installation puis cliquez sur Done :

Etape 3 : Sélection des composants Cliquez sur le menu Installation Type :

Il est possible de choisir différentes options :
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— Central with database : Installe Centreon (interface web + base de données) ainsi que l’ordonnanceur et le
broker

— Central without database : Installe Centreon (interface web uniquement) ainsi que l’ordonnanceur et le broker
— Poller : Installe le serveur satellite (ordonnanceur et broker uniquement)
— Database only : Installe le serveur de base de données (utilisé en complément avec l’option Central server

without database)

Etape 4 : Configuration système

Partitionnement des disques Cliquez sur le menu Installation Destination :
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Sélectionnez le disque dur et l’option I will configure partitioning puis cliquez sur “Done :

A l’aide du bouton + créez votre partitionnement suivant les prérequis de la documentation puis cliquez sur Done :
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Une fenêtre de confirmation apparaît, cliquez sur Accept Changes pour valider le partitionnement :

Configuration réseau Cliquez sur le menu Network & Hostname :
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Activez toutes les cartes réseaux, saisissez le nom de votre serveur puis cliquez sur Done :

Configuration du fuseau horaire Cliquez sur le menu Date & Time :
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Sélectionnez votre fuseau horaire et cliquez sur le bouton de configuration :

Activez ou ajouter des serveurs NTP, cliquez sur OK puis Done :
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Démarrage de l’installation Une fois toutes les options configurées, cliquez sur Begin Installation :

Cliquez sur Root Password :
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Saisissez et confirmez le mot de passe de l’utilisateur root. Cliquez sur Done :

Patientez pendant le processus d’installation :
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Lorsque l’installation est terminée, cliquez sur Reboot.

Mise à jour du système d’exploitation
Connectez-vous via un terminal et exécutez la commande :

# yum update
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Acceptez toutes les clés GPG proposées :

Redémarrez votre système avec la commande :

# reboot

Configuration

Connectez-vous à l’interface web via http://[ADRESSE_IP_DE_VOTRE_SERVEUR]/centreon. L’assistant de confi-
guration de Centreon s’affiche, cliquez sur Next.

L’assistant de configuration de Centreon contrôle la disponibilité des modules, cliquez sur Next.
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Cliquez sur Next.

Cliquez sur Next.

Définissez les informations concernant l’utilisateur admin, cliquez sur Next.

8.2. Architecture distribuée
CENTREON 46-52 RUE ALBERT FR75014 PARIS

261



Par défaut, le serveur ‘localhost’ est défini et le mot de passe root est vide. Si vous utilisez un serveur de base de
données déporté, il convient de modifier ces deux informations. Dans notre cas, nous avons uniquement besoin de
définir un mot de passe pour l’utilisateur accédant aux bases de données Centreon, à savoir ‘centreon’.

Cliquez sur Next.

Note : Si le message d’erreur suivant apparaît Add innodb_file_per_table=1 in my.cnf file under the [mysqld]
section and restart MySQL Server, Effectuez les opérations ci-dessous :

1. Connectez-vous avec l’utilisateur ‘root’ sur votre serveur

2. Editez le fichier suivant /etc/my.cnf
3. Ajoutez la ligne suivante au fichier :

[mysqld]
innodb_file_per_table=1

4. Redémarrez le service mysql :

# systemctl restart mysql

5. Cliquez sur Refresh

L’assistant de configuration configure les bases de données.

Cliquez sur Next.
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L’assistant de configuration propose ensuite d’installer les modules présents sur le serveur Centreon.

Cliquez sur Install.

Une fois les modules installés, cliquez sur Next.

À cette étape une publicité permet de connaître les dernières nouveautés de Centreon. Si votre plate-forme est connec-
tée à Internet vous disposez des dernières informations, sinon l’information présente dans cette version sera proposée.

8.2. Architecture distribuée
CENTREON 46-52 RUE ALBERT FR75014 PARIS

263



L’installation est terminée, cliquez sur Finish.

Vous pouvez maintenant vous connecter.

Dans un premier temps, il est nécessaire de passer l’interface en version française. Pour cela :

1. Cliquez sur votre profil utilisateur en haut à droite de l’interface

2. Cliquez sur le bouton Edit profile
3. Dans le champ Language, remplacez en_US par fr_FR.UTF-8
4. Cliquez sur Save
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Activer l’option Remote Server

Connectez-vous à votre serveur ayant la fonction Remote Server et exécutez la commande suivante

# /usr/share/centreon/bin/centreon -u admin -p centreon -a enableRemote -o CentreonRemoteServer -v @IP_CENTREON_CENTRAL

Note : Remplacez @IP_CENTREON_CENTRAL par l’IP du serveur Centreon vu par le collecteur.

Cette commande va activer le mode Remote Server

Starting Centreon Remote enable process:

Limiting Menu Access...Success
Limiting Actions...Done

Notifying Master...Success

Set ’remote’ instance type...Done

Centreon Remote enabling finished.

Echange de clés SSH

La communication entre le serveur central et un collecteur se fait via SSH.

Vous devez échanger les clés SSH entre les serveurs.

Si vous n’avez pas de clé SSH privée sur le serveur central pour l’utilisateur centreon :

# su - centreon
$ ssh-keygen -t rsa

Générez un mot de passe sur le nouveau serveur pour l’utilisateur centreon :

# passwd centreon

Vous devez copier cette clé sur le nouveau serveur :

# su - centreon
$ ssh-copy-id -i .ssh/id_rsa.pub centreon@IP_POLLER
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Configurer un nouveau Remote Server dans Centreon

Depuis Centreon 18.10, un assistant de configuration est disponible pour ajouter un Remote Server à la plate-forme
Centreon.

Note : Il est possible d’ajouter un nouveau collecteur manuellement, cependant Centreon recommande d’utiliser la
procédure suivante.

Rendez-vous au menu Configuration > Pollers et cliquez sur Add server with wizard pour accéder à l’assistant de
configuration.

Sélectionnez Add a Centreon Remote Server et cliquez sur Next :

Si vous souhaitez ajouter un nouveau serveur, sélectionnez l’option Manual input et saisissez les informations de-
mandées.
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Si vous avez déjà activé l’option Remote Server durant l’installation de votre serveur, sélectionnez l’option Select a
Remote Server et sélectionnez votre serveur dans la liste puis complétez les informations demandées.
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Note : Les champs Database user et Database password sont les accès aux bases de données Centreon définis durant
l’installation de votre Remote Server.

Cliquez sur Next :

Sélectionnez le(s) collecteur(s) à lier à ce Remote Server. Puis cliquez sur Apply :

L’assistant va configurer votre nouveau serveur :
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Le Remote Server est maintenant configuré :

Rendez-vous au chapitre Configuration simplifiée avec Centreon IMP pour mettre en place votre première supervision.

A partir des paquets Centreon

Étapes pré-installation

SELinux doit être désactivé. Pour cela vous devez modifier le fichier /etc/selinux/config et remplacer “enforcing” par
“disabled” comme dans l’exemple suivant :

SELINUX=disabled

Note : Après avoir sauvegardé le fichier, veuillez redémarrer votre système d’exploitation pour prendre en compte les
changements.

Une vérification rapide permet de confirmer le statut de SELinux

$ getenforce
Disabled

Installation des dépôts

Dépôt Software collections de Red Hat Afin d’installer les logiciels Centreon, le dépôt Software collections de Red
Hat doit être activé.

Note : Le dépôt Software collections est nécessaire pour l’installation de PHP 7 et les librairies associées.

Exécutez la commande suivante :
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# yum install centos-release-scl

Le dépôt est maintenant installé.

Dépôt Centreon Afin d’installer les logiciels Centreon à partir des dépôts, vous devez au préalable installer le fichier
lié au dépôt. Exécutez la commande suivante.

Installation :

# wget http://yum.centreon.com/standard/18.10/el7/stable/noarch/RPMS/centreon-release-18.10-2.el7.centos.noarch.rpm -O /tmp/centreon-release-18.10-2.el7.centos.noarch.rpm
# yum install --nogpgcheck /tmp/centreon-release-18.10-2.el7.centos.noarch.rpm

Le dépôt est maintenant installé.

Installation du serveur central

Ce chapitre décrit l’installation d’un serveur central Centreon.

Installer un serveur Centreon central avec base de données Exécutez la commande :

# yum install centreon
# systemctl restart mysql

Installer un serveur Centreon central sans base de données Exécutez la commande :

# yum install centreon-base-config-centreon-engine

Installer MySQL sur un serveur dédié Exécutez les commandes :

# yum install centreon-database
# systemctl restart mysql

Note : le paquet centreon-database installe un serveur de base de données optimisé pour l’utilisation avec Centreon.

Système de gestion de base de données La base de données MySQL doit être disponible pour pouvoir continuer
l’installation (localement ou non). Pour information nous recommandons MariaDB.

Pour les systèmes CentOS / RHEL en version 7, il est nécessaire de modifier la limitation LimitNOFILE. Changer
cette option dans /etc/my.cnf NE fonctionnera PAS :

# mkdir -p /etc/systemd/system/mariadb.service.d/
# echo -ne "[Service]\nLimitNOFILE=32000\n" | tee /etc/systemd/system/mariadb.service.d/limits.conf
# systemctl daemon-reload
# systemctl restart mysql

270
CENTREON 46-52 RUE ALBERT FR75014 PARIS

Chapitre 8. Guide d’administration



Fuseau horaire PHP La timezone par défaut de PHP doit être configurée. Executer la commande suivante :

# echo "date.timezone = Europe/Paris" > /etc/opt/rh/rh-php71/php.d/php-timezone.ini

Note : Changez Europe/Paris par votre fuseau horaire.

Après avoir réalisé la modification, redémarrez le service Apache :

# systemctl restart httpd

Pare-feu Paramétrer le pare-feu système ou désactiver ce dernier. Pour désactiver ce dernier exécuter les commandes
suivantes :

# systemctl stop firewalld
# systemctl disable firewalld
# systemctl status firewalld

Lancer les services au démarrage Activer le lancement automatique de services au démarrage.

Lancer les commandes suivantes sur le serveur Central :

# systemctl enable httpd
# systemctl enable snmpd
# systemctl enable snmptrapd
# systemctl enable rh-php71-php-fpm
# systemctl enable centcore
# systemctl enable centreontrapd
# systemctl enable cbd
# systemctl enable centengine

Note : Si la base de données MySQL est sur un serveur dédié, lancer la commande d’activation mysql sur ce dernier.

Terminer l’installation Avant de démarrer la configuration via l’interface web les commandes suivantes doivent
être exécutées :

# systemctl start rh-php71-php-fpm
# systemctl start httpd
# systemctl start mysqld
# systemctl start cbd
# systemctl start snmpd
# systemctl start snmptrapd

Configuration

Connectez-vous à l’interface web via http://[ADRESSE_IP_DE_VOTRE_SERVEUR]/centreon. L’assistant de confi-
guration de Centreon s’affiche, cliquez sur Next.
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L’assistant de configuration de Centreon contrôle la disponibilité des modules, cliquez sur Next.

Cliquez sur Next.

Cliquez sur Next.
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Définissez les informations concernant l’utilisateur admin, cliquez sur Next.

Par défaut, le serveur ‘localhost’ est défini et le mot de passe root est vide. Si vous utilisez un serveur de base de
données déporté, il convient de modifier ces deux informations. Dans notre cas, nous avons uniquement besoin de
définir un mot de passe pour l’utilisateur accédant aux bases de données Centreon, à savoir ‘centreon’.

Cliquez sur Next.

Note : Si le message d’erreur suivant apparaît Add innodb_file_per_table=1 in my.cnf file under the [mysqld]
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section and restart MySQL Server, Effectuez les opérations ci-dessous :

1. Connectez-vous avec l’utilisateur ‘root’ sur votre serveur

2. Editez le fichier suivant /etc/my.cnf
3. Ajoutez la ligne suivante au fichier :

[mysqld]
innodb_file_per_table=1

4. Redémarrez le service mysql :

# systemctl restart mysql

5. Cliquez sur Refresh

L’assistant de configuration configure les bases de données.

Cliquez sur Next.

L’assistant de configuration propose ensuite d’installer les modules présents sur le serveur Centreon.

Cliquez sur Install.

Une fois les modules installés, cliquez sur Next.
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À cette étape une publicité permet de connaître les dernières nouveautés de Centreon. Si votre plate-forme est connec-
tée à Internet vous disposez des dernières informations, sinon l’information présente dans cette version sera proposée.

L’installation est terminée, cliquez sur Finish.

Vous pouvez maintenant vous connecter.
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Dans un premier temps, il est nécessaire de passer l’interface en version française. Pour cela :

1. Cliquez sur votre profil utilisateur en haut à droite de l’interface

2. Cliquez sur le bouton Edit profile
3. Dans le champ Language, remplacez en_US par fr_FR.UTF-8
4. Cliquez sur Save

Activer l’option Remote Server

Connectez-vous à votre serveur ayant la fonction Remote Server et exécutez la commande suivante

# /usr/share/centreon/bin/centreon -u admin -p centreon -a enableRemote -o CentreonRemoteServer -v @IP_CENTREON_CENTRAL

Note : Remplacez @IP_CENTREON_CENTRAL par l’IP du serveur Centreon vu par le collecteur.

Cette commande va activer le mode Remote Server

Starting Centreon Remote enable process:

Limiting Menu Access...Success
Limiting Actions...Done

Notifying Master...Success

Set ’remote’ instance type...Done

Centreon Remote enabling finished.

Echange de clés SSH

La communication entre le serveur central et un collecteur se fait via SSH.

Vous devez échanger les clés SSH entre les serveurs.

Si vous n’avez pas de clé SSH privée sur le serveur central pour l’utilisateur centreon :

# su - centreon
$ ssh-keygen -t rsa

Générez un mot de passe sur le nouveau serveur pour l’utilisateur centreon :
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# passwd centreon

Vous devez copier cette clé sur le nouveau serveur :

# su - centreon
$ ssh-copy-id -i .ssh/id_rsa.pub centreon@IP_POLLER

Configurer un nouveau Remote Server dans Centreon

Depuis Centreon 18.10, un assistant de configuration est disponible pour ajouter un Remote Server à la plate-forme
Centreon.

Note : Il est possible d’ajouter un nouveau collecteur manuellement, cependant Centreon recommande d’utiliser la
procédure suivante.

Rendez-vous au menu Configuration > Pollers et cliquez sur Add server with wizard pour accéder à l’assistant de
configuration.

Sélectionnez Add a Centreon Remote Server et cliquez sur Next :

Si vous souhaitez ajouter un nouveau serveur, sélectionnez l’option Manual input et saisissez les informations de-
mandées.

8.2. Architecture distribuée
CENTREON 46-52 RUE ALBERT FR75014 PARIS

277



Si vous avez déjà activé l’option Remote Server durant l’installation de votre serveur, sélectionnez l’option Select a
Remote Server et sélectionnez votre serveur dans la liste puis complétez les informations demandées.
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Note : Les champs Database user et Database password sont les accès aux bases de données Centreon définis durant
l’installation de votre Remote Server.

Cliquez sur Next :

Sélectionnez le(s) collecteur(s) à lier à ce Remote Server. Puis cliquez sur Apply :

L’assistant va configurer votre nouveau serveur :
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Le Remote Server est maintenant configuré :

Rendez-vous au chapitre Configuration simplifiée avec Centreon IMP pour mettre en place votre première supervision.

8.2.3 Etat des collecteurs et Remote Servers

Le statut de la plate-forme Centreon est disponible via le menu Administration > Platform Status

Broker Statistics

Pour visualiser les statistiques de fonctionnement de Centreon Broker, rendez-vous dans le menu Administration >
Platform Status > Broker Statistics, puis sélectionnez votre serveur :
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Engine Statistics

Il est également possible de visualiser les performance des moteurs de colllecte via le menu Administration > Plat-
form Status > Engine Statistics en sélectionnant le serveur désiré :
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8.2.4 Configuration avancée d’un collecteur

Centreon Broker et pare-feu

Certaines fois, il n’est pas possible d’initialiser le flux Centreon Broker depuis le collecteur (ou Remote Server) vers
le serveur Centreon Central ou le Remote Server.

Centreon a développé la possibilité d’initialiser le flux depuis le serveur Centreon Central vers le collecteur ou du
Remote Server vers le collecteur.

Rendez-vous dans le menu Configuration > Pollers > Broker configuration et cliquez sur la configuration Centreon
Broker SQL du serveur Centreon Central ou du Remote Server.

Rendez-vous dans l’onglet Input et ajouter une nouvelle entrée de type TCP - IPv4.

Saisissez le nom de cette configuration, le port TCP pour le champ Connection port afin de se connecter au collecteur
et l’adresse IP du collecteur pour le champ Host to connect to, puis cliquez sur Save :

Rendez-vous dans le menu Configuration > Pollers > Broker configuration et cliquez sur la configuration Broker
module de votre collecteur.
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Rendez-vous dans l’onglet Output et modifiez l’entrée Output 1 - IPv4 :

1. Supprimer la valeur pour le champ Host to connect to
2. Contrôlez le port TCP Connection port
3. Activer l’option One peer retention

Cliquez sur Save, générer et exporter la configuration des serveurs impactés.

Authentification avec Centreon Broker

Si vous souhaitez authentifier les pollers envoyant des données dans votre système de monitoring vous pouvez utiliser
le mécanisme d’authentification intégré à Centreon Broker. Celui-ci est basé sur l’utilisation de certificats X.509.

La première étape est de générer un certificat pour l’autorité de certification (Certificate Authority, CA) avec OpenSSL.
ca.key sera la clé privée (à stocker de manière sécurisée), tandis que ca.crt sera la clé publique servant à authentifier
les connexions entrantes :
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$ openssl req -x509 -newkey rsa:2048 -nodes -keyout ca.key -out ca.crt -days 365

Nous pouvons maintenant générer les certificats en utilisant la clé de la CA :

$ openssl req -new -newkey rsa:2048 -nodes -keyout central.key -out central.csr -days 365
$ openssl req -new -newkey rsa:2048 -nodes -keyout poller.key -out poller.csr -days 365
$ openssl x509 -req -in central.csr -CA ca.crt -CAkey ca.key -CAcreateserial -out central.crt -days 365 -sha256
$ openssl x509 -req -in poller.csr -CA ca.crt -CAkey ca.key -CAcreateserial -out poller.crt -days 365 -sha256

Placez central.key, central.crt et ca.crt sur le serveur Centreon central (dans /etc/centreon-broker par exemple) et
poller.key, poller.crt et ca.crt sur votre poller.

Nous devons maintenant configurer Centreon Broker pour utiliser ces fichiers. Allez dans Configuration > Pollers
> Broker configuration. Pour central-broker-master, dans l’onglet Input, vous devez remplir les paramètres suivants
pour central-broker-master-input.

— Enable TLS encryption = Yes
— Private key file = /etc/centreon-broker/central.key
— Public certificate = /etc/centreon-broker/central.crt
— Trusted CA’s certificate = /etc/centreon-broker/ca.crt

De manière similaire pour le poller, vous devez modifier les paramètres de la connexion TCP dans l’onglet Output.
— Enable TLS encryption = Yes
— Private key file = /etc/centreon-broker/poller.key
— Public certificate = /etc/centreon-broker/poller.crt
— Trusted CA’s certificate = /etc/centreon-broker/ca.crt

Régénérez la configuration des pollers affectés par ces changements (Configuration ==> Pollers) et la mise en place
de l’authentification est terminée.

Centreontrapd Configuration

Collecteur

Il est nécessaire de modifier la configuration du processus Centreontrapd afin d’utiliser la base de données locale
SQLite. Référez-vous au chapitre Les traps SNMP.

Remote Server

La configuration du processus Centreontrapd est identique à celle d’un serveur Centreon Central.

Pour aller plus loin avec Centreon Broker

Note : Cette section est uniquement disponible en langue anglaise.
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This section aims to help user understand how Centreon Broker works and how it should be configured. It references
Centreon’s best practices and describe the various options used by Centreon Broker.

General Overview

Centreon Broker is at is core a simple multiplexing engine. It takes events from Inputs and send them to various
Outputs. Inputs are typically other instances of Centreon Broker over TCP/IP, while Outputs can be a SQL database,
other brokers, a BI/BAM engine, Centreon Map, etc.

Each Input or Output has a type that describe what it does and several parameters, some of them mandatory and other
optional. Additionally, an Output can have a Failover that will start when the Output is in an error state to allow
retention of data.

An important distinction to make is the standalone Centreon Broker versus a Centreon Broker installed as Centreon
Engine’s module. Both have the exact same capabilities and support the same Inputs and Outputs. The difference is that
Centreon Broker configured as a module will be automatically started when Centreon Engine starts and automatically
generates the events associated to this Centreon Engine. Often, those modules only have one Output to an instance of
Centreon Broker acting as a concentrator.

Main Configuration Page

This section lists all the instances of Centreon Broker configured in your park, either in standalone or module mode.
Each instance has a name, is associated with a poller, has a number of Inputs, Outputs, and Loggers, and can be
‘enabled’ or ‘disabled’.

A poller of type ‘Central’ will have three instances of Centreon Broker by default. One Centreon Broker installed
as a module for Centreon Engine (here called central-module-master), one Centreon Broker acting as a stand-alone
concentrator (here called central-broker-master) and one Centreon Broker specialized in generating the RRD data
used by the graphs (here called central-rrd-master). A best practice is to always use a separate instance of Centreon
Broker to generate RRD data. This way, an issue in the RRD stack will not cause any issue in your main monitoring.

As expected, central-module-master has only one Output and zero Input. Configured as a module to Centreon Engine,
it generates events on its own and forward them to the standalone instance of Centreon Broker.

A poller generally only have an instance of Centreon Broker, configured as a module for Centreon Engine.

Broker General Configuration Page

This section lists all the general options associated with an instance of Centreon Broker.

Main options :

Poller The poller where this instance lives.

Name The name of this instance.

Config file name The name of the configuration file used by this instance.

Retention path When an Output is in an error state, a Failover is launched. Failovers save data in files called retention
files. Those in turn are saved in the directory specified here. Best practice is ‘/var/lib/centreon-broker/’

Status This is used to enable or disable this instance.

Log options :

Write timestamp If activated, each log entry is preceded by the timestamp of the time it was written down. This is
useful to know when an error occured. Best practice is ‘Yes’.

Write thread id If activated, each log entry is preceded by the ID of the thread being executed at this instant. This is
only useful for advanced debugging purpose. Best practice is ‘No’.
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Advanced Options :

Statistics Centreon Broker has a mechanism of on-demand status reporting that can be enabled here. This is used by
Centreon Web to check the status of this instance at any time, to know which Inputs and Outputs are in an error
state, and to generate various statistics on event processing. Best practice is ‘Yes’.

Correlation Centreon Broker has a mechanism of top-level correlation. This should only be actived if top-level cor-
relation has been properly configured in Centreon Web. In all other cases, default to ‘No’.

Event queue max size The max size of the in-memory queue, in events. If the number of events in memory exceeds
this number, Centreon Broker will start to use ‘temporary files’ to prevent Broker from using too much memory
at the cost of additional disk I/O. The exact number can be tweaked to use more or less memory. A good default
is ‘50000’.

If ‘Statistics’ is enabled, on-demand status can be queried manually through a file placed in /var/lib/centreon-
broker/name.stats.

Broker Input Configuration Page

This section lists all the Inputs activated for this instance of Centreon Broker. Centreon Broker can have as many
Inputs as needed.

Inputs read events from a TCP connection. All Inputs have the following parameters :

Name The name of the input. Must be unique.

Serialization protocol The protocol that was used to serialize the data. Can be either ‘BBDO’ or ‘NDO’. NDO is an
old textual protocol that suffers from very poor performance, poor density of data, and poor security. BBDO is
a next-gen binary protocol that is performant and secure. NDO is deprecated. It should never be used in new
installation. Best practice is ‘BBDO’.

Compression If compression was used to serialize the data. Can be ‘auto’, ‘yes’, or ‘no’. If left on ‘auto’ Centreon
Broker will detect if compression was used while doing a TCP handshake (or assume no compression was used
for files). Default to ‘auto’ for TCP, ‘no’ for files.

Filter category The categories of events accepted by this Input. If empty, no restriction on events accepted. If filled,
only events of the given type will be processed. Input that accept data from Centreon Engines’ Broker module
should be set to accept only ‘Neb’ events.

Connection Port Which port will be used for the connection. Mandatory.

Host to connect to This important parameter will decide if this input will listen or attempt to initiate a connection.
Left empty, this input will listen on its given port. If filled, this input will attempt to initiate a connection to the
given host/port.

Enable TLS encryption Enable the encryption of the flux. For the encryption to work, the private key file, the public
certificate and the trusted CA’s certificate need to be set on both end. Default to ‘auto’, i.e ‘no’ unless TCP
negociation has been activated and the remote endpoint has activated encryption.

Private Key File The private key file used for the encryption.

Public certificate The public certificate used for the encryption.

Trusted CA’s certificate The trused CA certificate used for the encryption.

Enable negociation Enable negociation. If ‘yes’, this Intput will try to negociate encryption and compression with
the remote endpoint.

One peer retention mode By default, a listening input will accept any number of incoming connections. In ‘one peer
retention’ mode only one connection is accepted at the same time, on a first-come first-serve basis. Default to
‘no’.

To reiterate, TCP Input can either listen on a given port or can attempt to initiate a connection if a host is given. This
allow flexible network topology.
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Broker Logger Configuration Page

This section lists all the loggers activated for this instance of Centreon Broker. Centreon Broker can have as many
loggers as needed.

For each logger, the parameters are :

Type 4 types of loggers are managed by Centreon Broker.

1. ‘File’ : This logger will write its log into the file specified into its ‘name’ parameter.

2. ‘Standard’ : This logger will write into the standard output if named ‘stdout’ or ‘cout’ or into the standard
error output if named ‘stderr’ or ‘cerr’.

3. ‘Syslog’ : This logger will write into the syslog as provided by the system, prefixed by ‘centreonbroker’.

4. ‘Monitoring’ : This logger will write into the log of Centreon Engine. It can only be activated if this instance
of Centreon Broker is a module.

Name The name of this logger. This name must be the path of a file if the logger has the type ‘File’ or ‘stdout’, ‘cout’,
‘stderr’ or ‘cerr’ if the logger has the type ‘Standard’. This option is mandatory.

Configuration messages Should configuration messages be logged ? Configuration messages are one-time messages
that pop-up when Centreon Broker is started. Default is ‘Yes’.

Debug messages Should debug messages be logged ? Debug messages are messages used to debug Broker’s behavior.
They are extremely verbose and should not be used in a production environment. Default is ‘No’.

Error messages Should error messages be logged ? Error messages are messages logged when a runtime error occurs.
They are generally important. Default is ‘Yes’.

Informational messages Should informational messages be logged ? Informational messages are messages that are
used to provide an information on a specific subject. They are somewhat verbose. Default is ‘No’.

Logging level The level of the verbosity accepted by this logger. The higher the verbosity, the more messages will be
logged. Default to ‘Base’.

Additionally, the type ‘File’ has the following parameter :

Max file size The maximum size of log file in bytes. When the file has reached its limit, old data will be overwritten
in a round robin fashion.

A Broker will usually have at least one ‘File’ logger which will log Configuration and Error messages. Others can be
configured freely. A maximal logger (every category to ‘Yes’ and logging level to ‘Very detailed’) is valuable to debug
some issues, but be warned that it will generate a very large amount of data quickly.

Broker Output Configuration Page

This section lists all the Outputs activated for this instance of Centreon Broker. Centreon Broker can have as many
Outputs as needed.

For each Outputs, the parameters are :

Type There is a several types for Outputs managed by Centreon Broker.

1. ‘TCP - IPV4’ and ‘TCP - IPV6’ : This Output forwards data to another server, either another Centreon
Broker or Centreon Map.

2. File : This Output write data into a file.

3. RRD : This Output will generate RRD data from performance data.

4. Storage : This Output will write metrics into the database and generate performance data.

5. SQL : This Output will write real time status into Centreon’s database.

6. Dumper Reader : This Output will read from a database when Broker is asked to synchronize databases.

7. Dumper Writer : This Output will write into a database when Broker is asked to synchronize databases.
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8. BAM Monitoring : This Output will generate BAM data from raw events and update real time BAM status.
9. BAM Reporting : This Output will write long term BAM logs that can then be used by BI.

Failover A Failover is an Output that will be started when this Output is in error state. Example are TCP connections
gone haywire, MySQL server suddenly disconnecting, etc. By default, each Output has an automatic Failover
that will automatically store data in retention files and replay it when the primary Output recover from its error
state. This is what you want in 99% of the case. Otherwhise, you can specify here another Output that will act
as a Failover if this is what you need.

Retry interval When this Output is in error state, this parameter control how much time the Output will wait before
retrying. Default is one attempt every 30 seconds.

Buffering timeout When this Output is in error state, Centreon Broker will wait this much time before launching the
Failover. This is mainly useful if you want to make Centreon Broker wait for another software to initialize
before activating its Failover. In all other cases, this should not be used. Default is 0 seconds.

Filter category The categories of events accepted by this Output. If empty, no restriction on events accepted. If filled,
only events of the given type will be processed. The exact best practices are Output specific.
1. ‘BAM Reporting’ should only accept ‘Bam’ events.
2. ‘Dump Writer’ should only accept ‘Dumper’ events.
3. ‘RRD’ should only accept ‘Storage’ events.

In all other cases, no restriction should be configured.
Events generated by an Output are reinjected into Centreon Broker’s event queue.

Some Outputs only works when consuming data generated by another Output. A ‘RRD’ Output consumes data from a
Storage Output, a ‘Dumper Writer’ consumes data from a ‘Dumper Reader’, and a ‘BAM Reporting’ Output consumes
data from a ‘BAM Monitoring’ Output.

Centreon Web needs at least an active Output ‘SQL’ to activate its real time monitoring capabilities. The Outputs
‘Storage’ and ‘RRD’ are needed to activate Centreon Web metric plotting. The Output ‘BAM Monitoring’ is needed
for real time BAM data and the Output ‘BAM Reporting’ for BI report.

Due to the fully distributed nature of Centreon Broker, producer and consumer Outputs can be located on logically or
physically different instances, as long as they are connected to each other.

Important : Centreon Web 2.x features two databases, the configuration database and the real time database. Those
are respectively called ‘centreon’ and ‘centreon-storage’. Different Outputs expect different database in their configu-
ration.

Output Type Expected database
SQL centreon-storage
Storage centreon-storage
Dumper Reader centreon
Dumper Writer centreon
BAM Monitoring centreon
BAM Reporting centreon-storage

TCP Outputs TCP Outputs forward events to a a remote endpoint. As with TCP Inputs, TCP Output can either
listen on a given port or can attempt to initiate a connection if a host parameter is given. This allow flexible network
topology.

Outputs of type ‘TCP’ have the following parameters :
Serialization protocol The protocol that will be used to serialize the data. Can be either ‘BBDO’ or ‘NDO’. NDO is

an old textual protocol that suffers from very poor performance, poor density of data, and poor security. BBDO
is a next-gen binary protocol that is performant and secure. NDO is deprecated. It should never be used in new
installation. Best practice is ‘BBDO’.

Enable negociation Enable negociation. If ‘yes’, this Output will try to negociate encryption and compression with
the remote endpoint.
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Connection Port Which port will be used for the connection. Mandatory.

Host to connect to This important parameter will decide if this Output will listen or attempt to initiate a connection.
Left empty, this Output will listen on its given port. If filled, this Output will attempt to initiate a connection to
the given host/port.

Enable TLS encryption Enable the encryption of the flux. For the encryption to work, the private key file, the public
certificate and the trusted CA’s certificate need to be set on both end. Default to ‘auto’, i.e ‘no’ unless TCP
negociation has been activated and the remote endpoint has activated encryption.

Private Key File The private key file used for the encryption.

Public certificate The public certificate used for the encryption.

Trusted CA’s certificate The trused CA certificate used for the encryption.

One peer retention mode By default, a listening Output will accept any number of incoming connections. In ‘one
peer retention’ mode only one connection is accepted at the same time, on a first-come first-serve basis. Default
to ‘no’.

Compression If compression should be used to serialize the data. Can be ‘auto’, ‘yes’, or ‘no’. If left on ‘auto’
Centreon Broker will detect if compression is supported by the endpoint during a TCP negociation. Default to
‘auto’ for TCP.

Compression Level The level of compression that should be used, from 1 to 9. Default (or if not filled) is 6. The
higher the compression level is, the higher the compression will be at the cost of processing power.

Compression Buffer The size of the compression buffer that should be used. Best practice is ‘0’ or nothing.

File Outputs File Outputs send events into a file on the disk. Additionally, they have the capability of replaying the
data of this file if used as a Failover Output. Most ‘File’ Outputs will be used as Failovers.

Outputs of type ‘File’ have the following parameters :

Serialization protocol The protocol that will be used to serialize the data. Can be either ‘BBDO’ or ‘NDO’. NDO is
an old textual protocol that suffers from very poor performance, poor density of data, and poor security. BBDO
is a next-gen binary protocol that is performant and secure. NDO is deprecated. It should never be used in new
installation. Best practice is ‘BBDO’.

File path The path of the file being written to.

Compression If compression should be used to serialize the data. Can be ‘auto’, ‘yes’, or ‘no’. ‘auto’ is equal to ‘no’
for files.

Compression Level The level of compression that should be used, from 1 to 9. Default (or if not filled) is 6. The
higher the compression level is, the higher the compression will be at the cost of processing power.

Compression Buffer The size of the compression buffer that should be used. Best practice is ‘0’ or nothing.

RRD Outputs RRD Outputs generate RRD data (used by Centreon Web to generate graphs) from metrics data
generated by a ‘Storage’ Output. Best practice is to isolate this Output on its own instance of Centreon Broker to
ensure that an issue in the RRD stack will not have any effect on the main instance of Centreon Broker.

Outputs of type ‘RRD’ have the following parameters :

RRD file directory for metrics The directory where the RRD files of the metrics will be written. A good default is
/var/lib/centreon/metrics/.

RRD file directory for statuses The directory where the RRD files of the statuses will be written. A good default is
/var/lib/centreon/statuse/

TCP port The port used by RRDCached, if RRDCached has been configured on this server. If not, nothing.

Unix socket The unix socket used by RRDCached, if RRDCached has been configured on this server. If not, nothing.

Write metrics Should RRD metric files be written ? Default ‘yes’.

Write status Should RRD status files be written ? Default ‘yes’.

8.2. Architecture distribuée
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Storage Outputs Perfdata storage Outputs save metric data into a database and generate RRD data used by the
‘RRD’ Output. This Output usually generates a lot of queries and is very performance intensive. If Centreon Broker is
slow, tweaking the Maximum Queries Per Transaction parameter of this Output is the first optimization to attempt.

This Output can be tasked to rebuild ‘RRD’ data from a database of stored metric data. This is usually a costly, slow
process, during which it is still able to process new metric data, though not as quickly.

Outputs of type ‘Storage’ have the following parameters :

DB Type The type of the database being accessed. MariaDB is a state-of-the-art database that has been extensively
tested with Centreon. We advice the use of MariaDB.

DB Port The port of the database being accessed.

DB User The user used by this Output to connect to this database.

DB Name The name of this database. In Centreon term, this is the database containing the real-time monitoring data,
generally called ‘centreon-storage’.

DB Password The password used by this Output to connect to this database.

Maximum queries per transaction This parameter is used to batch several queries in large transaction. This allow
fine performance tuning but can generate latency if not enough queries are generated to fill those batches. The
Default is 20000 queries per transaction. If you have very low load and unexpectedly high latency, try lowering
this number. If you have a very high load and high latency, try raising this number.

Transaction commit timeout How many seconds are allowed to pass before a forced commit is made. Default is
infinite. If you have very low load and unexpectedly high latency, try 5 seconds.

Replication enabled Should Centreon Broker check that the replication status of this database is complete before
trying to insert data in it ? Only useful if replication is enabled for this database.

Rebuild check interval in seconds The amount of seconds between each rebuild check. Default 300 seconds.

Store in performance data in data_bin Should this Output saves the metric data in the database ? Default ‘yes’. If
‘no’, this Output will generate RRD data without saving them into the database, making a rebuild impossible.

Insert in index data Insert new ids into the database. Default ‘no’. This should never be modified unless prompted
by Centreon Support or explicitely written down into a documentation.

SQL Outputs SQL Outputs save real time status data into the real time database used by Centreon Web. This is the
most important Output for the operation of Centreon Web.

Moreover, this Output has a garbage collector that will clean old data from the database occasionally. This is an
optional process, as old data is marked ‘disabled’, and can actually be useful to keep around for debugging purpose.

Outputs of type ‘SQL’ have the following parameters :

DB Type The type of the database being accessed. MariaDB is a state-of-the-art database that has been extensively
tested with Centreon. We advice the use of MariaDB.

DB Port The port of the database being accessed.

DB User The user used by this Output to connect to this database.

DB Name The name of this database. In Centreon term, this is the database containing the real-time monitoring data,
generally called ‘centreon-storage’.

DB Password The password used by this Output to connect to this database.

Maximum queries per transaction This parameter is used to batch several queries in large transaction. This allow
fine performance tuning but can generate latency if not enough queries are generated to fill those batches. The
Default is 20000 queries per transaction. If you have very low load and unexpectedly high latency, try lowering
this number. If you have a very high load and high latency, try raising this number.

Transaction commit timeout How many seconds are allowed to pass before a forced commit is made. Default is
infinite. If you have very low load and unexpectedly high latency, try 5 seconds.

290
CENTREON 46-52 RUE ALBERT FR75014 PARIS

Chapitre 8. Guide d’administration



Replication enabled Should Centreon Broker check that the replication status of this database is complete before
trying to insert data in it ? Only useful if replication is enabled for this database.

Cleanup check interval How many seconds between each run of the garbage collector cleaning old data in the data-
base ? Default is never.

Instance timeout How many seconds before an instance is marked as ‘unresponding’ and all of its hosts and services
marked as ‘unknown’. Default is 300 seconds.

Lua Outputs Lua Outputs send metrics information into a script by a key-value system. The Lua script should be
on your server.
Path The path of the Lua script in your server.
Filter category The categories of events accepted by this Output. If empty, no restriction on events accepted. If filled,

only events of the given type will be processed. Outputs that accept data from Centreon Engine’s Broker
module should be set to accept only ‘Neb’ events.

Lua parameter
Type Type of the metric value.
Name/Key Name of the metric value.
Value Value of the metric.

Dumper Reader/Writer A Dumper Reader/Writer pair is used to synchronize part of a database between two ins-
tances of Centreon Broker. In the future there will be an extensive synchronization mechanism, but today it is mainly
used to synchronize BA for the BAM Poller Display mechanism.

The BAM Poller Display configuration documentation explains how to properly configure those Outputs.

Outputs of type ‘Dumper Reader’ and ‘Dumper Writer’ have the following parameters :
DB Type The type of the database being accessed. MariaDB is a state-of-the-art database that has been extensively

tested with Centreon. We advice the use of MariaDB.
DB Port The port of the database being accessed.
DB User The user used by this Output to connect to this database.
DB Name The name of this database. In Centreon term, this is the database containing the configuration data, gene-

rally called ‘centreon’.
DB Password The password used by this Output to connect to this database.

8.3 Base de connaissance

Intégré nativement depuis la version 2.8.0 de Centreon Web, Centreon Knowledge Base permet d’interfacer une base
de connaissances techniques de procédures (wiki).

Pour cela, elle crée des liens entre un hôte/service et une procédure spécifique vers un wiki.

Pour plus de flexibilité, les procédures peuvent être liées directement sur les modèles.

Centreon Knowledge Base est la solution idéale pour lier aisément une base de connaissance avec Centreon Web.

8.3.1 Pré-requis

Centreon & Moteur de supervision

Centreon Knowledge Base est nativement intégré à Centreon depuis la version 2.8.0 de Centreon Web.

Le module dispose donc des même pré-requis.

8.3. Base de connaissance
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Mediawiki

Centreon Knowledge Base requiert que MediaWiki (version = 1.31) soit installé sur un serveur. Un paquet RPM de
Mediawiki est disponible sur les dépôts Centreon.

Alternativement vous pouvez télécharger MediaWiki ici et accéder à la documentation ici.

8.3.2 Configuration de l’accès au wiki

Afin d’utiliser Centreon Knowledge Base, vous devez le configurer pour qu’il accède à la base de données du wiki.

Pour cela rendez-vous dans Administration > Parameters > Knowledge Base et renseignez le formulaire.

8.3.3 Guide d’utilisateur

Définition

Une procédure est une documentation technique et/ou fonctionnelle qui met à la disposition des exploitants un mode
opératoire dans le cadre du traitement d’une alerte.

Le contenu d’une procédure peut être d’ordre général ou spécifique :
— Décrire les actions nécessaires à la résolution d’un problème.
— Informer de l’existence d’une consigne particulière (temporaire ou permanente).
— ...

Une procédure peut être associée à un hôte ou un service.
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Algorithme d’affichage : Héritage et surcharge

Pour éviter une trop grande charge de travail sur les procédures de déploiement, cette fonctionnalité permet à l’admi-
nistrateur de configurer une procédure simple pour les hôtes/services.

Ainsi une procédure peut être spécifiée pour un hôte/service donné mais aussi pour un modèle d’hôte et de service.

Si une procédure est définie au niveau d’un modèle, tous les enfants du modèle parent bénéficieront de cette procédure
sauf en cas de surcharge. Ce système est identique au système de modèle par héritage présent dans Centreon Web.

La fonctionnalité Centreon Knowledge Base est conçu pour éviter d’ajouter ou de mettre à jour manuellement plu-
sieurs fois la même procédure dans la base de connaissances.

Quand un utilisateur clique sur la procédure d’un hôte :
— si une procédure spécifique est définie pour cet hôte, la page wiki de l’hôte s’affichera
— si aucune procédure spécifique n’est définie mais que le modèle d’hôte a une procédure alors c’est la page wiki

de cette dernière qui s’affichera
— si le modèle d’hôte n’a pas de procédure de définie, alors les modèles d’hôte parents seront parcourus pour

vérifier la présence d’une procédure
— finalement si aucune procédure n’est définie dans l’arbre des modèles, aucune procédure ne sera accessible.

Il en est de même pour les services.

Création / Mise à jour / Suppression d’une base de connaissances

Naviguer dans l’interface Web de Centreon vers Configuration -> Knowledge Base.

L’extension permet de :
— Lister les hôtes / services / modèles d’hôtes / modèles de services avec leurs bases de connaissances liées
— Créer / Visualiser / Editer / Visualiser l’historique pour un hôte / service / modèle d’hôte / modèle de service
— Lister les hôtes / services / modèles d’hôtes / modèles de services sans base de connaissances définie.

Centreon Knowledge Base utilise un wiki pour stocker sa base de connaissance. Toutes les créations / modifications
sont donc réalisées à travers celui-ci.

Lien avec l’interface web de supervision

La base de connaissance est accessible depuis l’interface Centreon Web à travers un icône cliquable (voir ci dessous)
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En cliquant sur l’icône, l’utilisateur est redirigé vers la base de connaissance correspondante.

Si l’icône est situé à gauche du nom de l’hôte, la base de connaissance concernera l’hôte.

Si l’icône est situé à droite du nom du service, la base de connaissance concernera le service.

Synchronisation

Un cron se charge de réaliser les mises à jour de la configuration des hôtes, des services ainsi que des modèles.

Par exemple, si vous créez une page dans le wiki en utilisant le motif habituel (ex : Host:Centreon-Server ou
Service:Centreon-Server Disk-/), le ajoutera automatiquement le lien vers la page du wiki correspondante
dans le champ URL de la table Informations étendues.

Bonnes pratiques de déploiement

Pour déployer Centreon KnowledgeBase de la meilleure manière, nous vous recommandons fortement d’utiliser les
différents niveaux du système d’héritage.

La bonne pratique est donc de définir les bases de connaissances au niveau des modèles.

Voici un exemple d’une configuration pour un modèle d’hôte :
— Linux > Generic-hosts
— Windows > Generic-hosts
— RedHat > Linux
— Debian > Linux
— Active-Directory > Windows
— LDAP > Linux

Pour configurer Centreon KnowledgeBase pour le modèle d’hôte RedHat, vous pouvez suivre la démarche décrite
dans Lien avec l’interface web de supervision.

Dans l’arbre des modèles, il apparaît que le modèle RedHat hérite de deux autres modèles : Linux et Generic-hosts.

Dans cet exemple tous les hôtes utilisant le modèle d’hôte RedHat auront une nouvelle base de connaissances dispo-
nible.

Vous pouvez configurer une procédure dans un niveau plus élevé dans l’arbre des modèles.

Par exemple si vous définissez une procédure pour le modèle d’hôte Linux, tous les hôtes utilisant les modèles d’hôtes
RedHat, Debian et LDAP hériteront de cette procédure par héritage.

Le comportement est le même pour les modèles de services.

Warning : Pour suprimmer le lien d’une base de connaissance pour un hôte / service / modèle spéci-
fique, editer l’objet et supprimer le contenu du champ URL dans l’onglet Informations détaillées.
Si l’objet hérite d’une base de connaissance d’un modèle, la suppression du contenu du champ sur-
chargera la valeur du modèle et supprimera le lien de la base de connaissance.
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8.4 Les extensions

8.4.1 Les modules

Les modules permettent d’ajouter des fonctionnalités supplémentaires à Centreon. Il est possible d’installer des mo-
dules en utilisant l’utilitaire YUM ou à partir des fichiers sources (*.tar.gz).

Les modules sont regroupés en 3 types :
— Les modules communautaires, sous licence GPL v2, développés par la communauté Centreon
— Les modules core, sous licence GPL v2, développés par l’équipe Centreon
— Les modules propriétaires, soumis à licence, développés par la société Centreon

Pour installer un module :

1. Installez le module à partir de la documentation associée (le plus souvent dans le répertoire
/usr/share/centreon/www/modules sur le serveur Central)

2. Rendez-vous dans le menu Administration > Extensions > Modules

Vous avez alors deux choix :

— Installer un module en cliquant sur le bouton ,
— Ou cliquez sur le bouton Install/Upgrade all pour installer tous les modules en même temps.

Le tableau ci-dessous résume les différentes colonnes de la page :

Colonne Description
Nom Contient le nom du module
Nom réel Contient le nom complet du module
Informa-
tions

Contient des informations à propos du module

Version Indique la version du module
Auteur Indique l’auteur du module
Date de fin
de licence

Indique la date d’expiration de la licence

Installé Indique si le module est installé ou non
Statut Indique le statut du module : installé, installé mais sans licence, inconnu etc...
Actions Permet d’effectuer certaines actions sur un module :

Pour installer un module, cliquez sur l’icône :
Pour configurer un module, cliquez sur l’icône

Pour supprimer un module, cliquez sur l’icône , puis confirmez la suppression

Pour mettre à jour un module, cliquer sur l’icône puis suivre le processus

8.4.2 Les widgets

Les widgets permettent de construire de véritables vues personnalisées, abordées au chapitre les vues personnalisées.
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Pour installer un widget :

1. Installez le widget à partir de la documentation associée (le plus souvent dans le répertoire
/usr/share/centreon/www/widgets sur le serveur Central)

2. Rendez-vous dans le menu Administration > Extensions > Widgets

Vous avez alors deux choix :

— Installer un widget en cliquant sur le bouton ,
— Ou cliquez sur le bouton Install/Upgrade all pour installer tous les widgets en même temps.

Le tableau ci-dessous résume les différentes colonnes de la page :

Co-
lonne

Description

Titre Contient le nom du widget
Des-
crip-
tion

Contient des informations à propos du widget

Ver-
sion

Indique la version du widget

Auteur Indique l’auteur du widget
Ac-
tions

Permet d’effectuer certaines actions sur un widget :

Pour installer un widget, cliquez sur l’icône

Pour supprimer un widget, cliquez sur l’icône , puis confirmez la suppression

Pour mettre à jour un widget, cliquer sur l’icône puis suivre le processus

8.5 Les médias

Les médias sont des images utilisées par l’interface web de Centreon. Ces images sont utilisées afin de pouvoir re-
présenter de manière plus intuitive les ressources supervisées, proposer des fonds de cartes pour des modules de
cartographie, ...

8.5.1 Gestion des images

L’ensemble des images est stocké dans le dossier /usr/share/centreon/www/img/media du serveur Centreon.
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Il existe deux méthodes pour ajouter des images dans ce dossier :
— Le faire manuellement
— Utiliser la synchronisation automatique : cette méthode a l’avantage de pouvoir importer plusieurs images à la

fois.

Ajout manuel

Pour ajouter une image dans Centreon :

1. Rendez-vous dans le menu Administration ==> Paramétres
2. Dans le menu de gauche, cliquez sur Images
3. Cliquez sur Ajouter

La fenêtre suivante s’affiche :

— Le champ Nouveau dossier ou dossier existant permet d’ajouter un nouveau dossier au sein du dossier
d’images ou de choisir un dossier déjà existant dans lequel pourra être copié l’image

— Le champ Image ou archive permet de sélectionner l’image ou l’ensemble d’images contenu dans une archive
qui sera importée

— Le champ Commentaires permet de décrire l’image

Synchroniser les images

Pour synchroniser une ou plusieurs images dans les médias Centreon :

1. Copiez vos images au sein du dossier d’image (les images peuvent être situées dans des dossiers)

2. Assurez-vous que l’utilisateur qui exécute votre serveur web a les droits en lecture sur ces images

3. Rendez-vous dans le menu Administration ==> Paramétres
4. Dans le menu de gauche, cliquez sur Médias
5. Cliquez sur Synchroniser le répertoire des images

La fenêtre suivante importe les nouvelles images :

8.6 Options d’administration de la plate-forme Centreon

Les options suivantes permettent de modifier les paramètres de l’architecture Centreon.
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8.6.1 Centreon

Cette partie traite de la configuration des options générales de l’interface web Centreon.

1. Rendez-vous dans le menu Administration > Paramétres
2. Dans le menu de gauche, cliquez sur Centreon UI
3. Cliquez sur Centreon

La fenêtre suivante s’affiche :

— Le champ Répertoire désigne le répertoire dans lequel Centreon est installé
— Le champ Répertoire Web de Centreon indique le répertoire web sur lequel est installé Centreon
— Le champ Limite par page (par défaut) définit le nombre d’objet affiché par page de Configuration
— Le champ Limite par page pour les pages de supervision définit le nombre d’objet affiché par page au sein

du menu Supervision
— Le champ Graphique de performance par page définit le nombre maximum de graphiques affichés sur la

page de Performances*
— Le champ Nombre d’éléments présent définit le nombre maximum d’éléments affichés dans chaque boîte de

sélection
— Le champ Durée d’expiration de la session, exprimé en minutes, indique la durée maximale d’une session
— Le champ Intervalle de rafraîchissement pour la page des statistiques, exprimé en secondes, indique l’in-

tervalle de rafraîchissement pour les objets de la page des statistiques
— Le champ Intervalle de rafraîchissement pour la page de supervision, exprimé en secondes, indique l’in-

tervalle de rafraîchissement pour les objets de la page supervision
— Le champ Trier par indique le tri par défaut pour les pages de supervision des hôtes et des services.
— Le champ Choix de tri indique l’ordre par défaut de tri pour les pages de supervision des services et des hôtes.
— Le champ Trier les problèmes par permet de choisir comment trier les différents incidents dans le menu

Supervision
— La champ Ordre de tri des problèmes indique l’ordre d’affichage des incidents par ordre de gravité croissant

ou décroissant
— Le champ Afficher les temps d’arrêts et les acquittements sur les graphiques permet d’afficher ou non ces

éléments
— Le champ Afficher les comentaires sur les graphiques permet d’afficher ou non ces éléments
— La case Activer la connexion automatique autorise les utilisateurs à se connecter à l’interface web via le

mécanisme de connexion automatique
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— La case Afficher le raccourci de connexion automatique permet d’afficher le raccourci de connexion en haut
à droite

— La case Activer l’authentification SSO active l’authentification SSO
— Le champ Mode SSO indique si l’authentification doit avoir lieu uniquement par SSO ou bien en utilisant

l’authentification locale également (Mixte). Le mode mixte nécessite l’adresse des clients de confiance.
— Le champ Adresses des clients SSO de confiance indique quelles sont les adresses IP/DNS des clients de

confiance pour le SSO (correspond à l’adresse du reverse proxy). Chaque client de confiance est séparé par une
virgule.

— Le champ Adresses des clients de bloqués indique quelles sont les adresses IP/DNS des clients qui seront
refusés.

— Le champ Entête HTTP SSO indique la variable de l’en-tête qui sera utilisée comme login/pseudo.
— Le champ Chaine de recherche (pattern) pour l’authentification (login) indique l’expression rationnelle

(pattern) de recherche pour l’utilisateur.
— Le champ Chaine de remplacement (pattern) pour l’authentification (login) indique la chaine de rempla-

cement.
— Le champ Timezone par défaut de l’hôte permet de définit un timezone par défaut pour application du déca-

lage horaire
— Le champ Adresse mail de contact du support (de la plate-forme de supervision) indique l’adresse email

de support Centre des services du client pour la plate-forme Centreon. Cette adresse mail sera affichée en bas
de page sur le lien Centre des services

Warning : La fonctionnalité SSO doit être activée seulement dans un environnement dédié et sécurisé pour le
SSO. Les accès direct des utilisateurs à Centreon Web doivent être désactivés.

Configuration du proxy

La configuraiton du proxy est nécessaire pour bénéficier de l’offre Centreon IMP.

Renseigner les différents champs :
— URL du proxy web
— Port d’accès au proxy internet
— Proxy user
— Proxy password

Une fois vos paramètres saisi, testez votre configuration en cliquant sur le bouton Text Proxy Configuration. Si votre
configuration est correcte, un message indiquera la réussite :
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8.6.2 Supervision

Cette partie traite des options générales de l’interface de supervision temps réel.

1. Rendez-vous dans le menu Administration > Paramétres
2. Dans le menu de gauche, cliquez sur Supervision

— Le champ Unité de temps de référence indique l’intervalle de temps en seconde utilisé pour planifier les
contrôles et les notifications

— Le champ Répertoire des images définit le répertoire d’image dans lequel sont stockés les médias
— Le champ Répertoire des sondes définit le répertoire où se situent les sondes de supervision
— Le champ Script de démarrage du broker contient le chemin vers le script de démarrage du broker
— Le champ Chemin complet de l’exécutable contient le chemin vers l’exécutable permettant d’envoyer des

mails
— Les listes Nombre maximum d’hôtes à afficher et Nombre maximum de services à afficher contiennent le

nombre maximal d’hôte ou de services à afficher dans la vue d’ensemble (menu Accueil > Accueil)
— Le champ Intervalle de rafraîchissement de la page définit l’intervalle de rafraîchissement des données dans

la vue d’ensemble
— Les cases contenues dans les catégories Options d’acquittement par défaut et Options de temps d’arrêt

par défaut définissent les options par défaut qui seront cochées ou non lors de la définition d’un acquittement
ou d’un temps d’arrêt

— Le champ Durée permet de définir la durée par défaut d’un temps d’arrêt

8.6.3 CentCore

Cette partie permet de paramétrer le fonctionnement du processus CentCore.

1. Rendez-vous dans le menu Administration > Paramétres
2. Dans le menu de gauche, cliquez sur Centcore
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— Le champ Activer la récupération des statistiques de Centreon Broker active la récupération des statistiques
de Centreon Broker par CentCore. Cette option peut être bloquante car la lecture du tuyau (pipe) peut être une
action bloquante

— Le champ Temps maximum d’exécution des commandes Centcore permet de définir un temps de d’exécu-
tion maximal des commandes locales et via SSH du processus

8.6.4 LDAP

Cette partie permet de configurer la connexion au(x) annuaire(s) LDAP.

Pour ajouter un nouvel annuaire :

1. Rendez-vous dans le menu Administration > Paramétres
2. Dans le menu de gauche, cliquez sur LDAP
3. Cliquez sur Ajouter

— Les champs Nom de la configuration et Description définissent le nom et la description du serveur LDAP
— Le champ Activer l’authentification LDAP permet d’activer l’authentification à travers le serveur LDAP
— Le champ Sauvegarde du mot de passe LDAP permet de stocker le mot de passe des utilisateurs en base de

données, utile en cas de perte de connexion avec l’annuaire pour authentifier les utilisateurs
— Le champ Import automatiques des utilisateurs permet d’importer automatiquement les utilisateurs de l’an-

nuaire LDAP dans Centreon. En cliquant sur Importer les utilisateurs manuellement, vous pouvez choisir
les utilisateurs que vous souhaitez importer

Note : Si l’option Import automatiques des utilisateurs est cochée, alors pour toute nouvelle personne qui se
connecte à l’interface Centreon, ses paramètres LDAP seront automatiquement importés dans Centreon (nom, prénom,
adresse mail, ...). Les profils ACL seront appliqués lors de l’accès (Lien vers Les ACLs). Par contre, si cette option
n’est pas cochée, seuls les utilisateurs importés manuellement pourront s’authentifier.

8.6. Options d’administration de la plate-forme Centreon
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— Le champ Taille limite de la recherche LDAP permet de limiter la taille de la recherche des utilisateurs
— Le champ Temps maximum d’exécution de la recherche LDAP permet de définir le temps maximum de la

recherche LDAP
— Le champ Modèle de contact définit le modèle de contact qui sera lié pour tous les utilisateurs importés depuis

cet annuaire LDAP
— Le champ Utiliser le service DNS indique s’il faut utiliser le serveur DNS pour résoudre l’adresse IP de

l’annuaire LDAP
— Le champ LDAP servers permet d’ajouter un ou plusieurs annuaires LDAP vers lequel Centreon va se connec-

ter.

Le tableau ci-dessous résume les différents paramètres à insérer pour ajouter un serveur LDAP :

Colonne Description
Adresse du serveur Contient l’adresse IP ou nom DNS du serveur LDAP
Port Indique le port de connexion pour accéder à l’annuaire LDAP
SSL Indique si le protocole SSL est utilisé pour la connexion au serveur
TLS Indique si le protocole TLS est utilisé pour la connexion au serveur

— Les champs Utilisateur du domaine et Mot de passe définissent le nom d’utilisateur et le mot de passe pour
se connecter au serveur LDAP

— Le champ Version du protocole indique la version du protocole à utiliser pour se connecter
— La liste Modèle permet de préconfigurer les filtres de recherches des utilisateurs sur l’annuaire LDAP. Ces

filtres permettant de proposer par défaut une recherche sur un annuaire de type MS AD ou de type Posix.

Note : Avant tout import, vérifiez les paramètres par défaut proposés. Si vous n’avez sélectionné aucun modèle, vous
devez définir manuellement les filtres de recherches en complétant les champs.

Sous CentOS 7, on peut définir de ne pas vérifier le certificat serveur avec la procédure suivante :

Ajouter la ligne suivante dans le fichier “/etc/openldap/ldap.conf” :

TLS_REQCERT never

Puis redémarrez le serveur Apache :

service httpd restart

8.6.5 RRDTool

Cette partie permet de configurer le moteur de génération des graphiques RRDTool ainsi que les tailles des polices
utilisées pour la présentation de ces derniers.

1. Rendez-vous dans le menu Administration > Paramétres
2. Dans le menu de gauche, cliquez sur RRDTool
3. Cliquez sur RRDTool
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— Le champ Chemin complet de l’exécutable RRDTOOL définit le chemin vers l’exécutable RRDTool
— Les champs appartenant aux catégories Propriétés du titre, Propriétés de l’unité, Propriétés des axes, Pro-

priétés de la légende, Propriété du filigrane permettent de définir la police ainsi que la taille de la police pour
la propriété sélectionnée

— Le champ Activer RRDCached permet d’activer le processus RRDcached (Ne fonctionne qu’avec le broker
Centreon Broker)

— Le champ Port TCP définit le port sur lequel écoute RRDcached (ne pas activer la connexion TCP)
— Le champ Chemin d’accès au socket Unix définit le chemin vers le socket Unix

Warning : N’activez RRDCacheD que si votre plate-forme de supervision rencontre de trop nombreux accès
disques concernant l’écriture des données dans les fichiers RRD.

8.6.6 Debogage

Cette partie permet de configurer l’activation de la journalisation de l’activité des processus Centreon.
1. Rendez-vous dans le menu Administration > Paramétres
2. Dans le menu de gauche, cliquez sur Débogage
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— Le champ Répertoire d’enregistrement des journaux définir le chemin où seront enregistrés les journaux
d’évènements

— La case Enregistrer les authentifications permet de journaliser les authentifications à l’interface Centreon
— La case Débogage du moteur de supervision active la journalisation du débogage de l’ordonnanceur
— La case Débogage RRDTool active la journalisation du débogage du moteur de graphique RRDTool
— La case Débogage de l’import d’utilisateurs LDAP active la journalisation du débogage de l’import des

utilisateurs LDAP
— La case Enregistrer les requêtes SQL active la journalisation des requêtes SQL exécutées par l’interface

Centreon
— La case Débogage processus Centcore active la journalisation du débogage du processus Centcore
— La case Débogage du processus Centstorage active la journalisation du débogage du processus Centstorage
— La case Débogage du moteur de traitement des traps SNMP (centreontrapd) active la journalisation du

débogage du processus Centreontrapd

8.7 Journalisation des modifications de configuration

8.7.1 Principe

Par défaut, Centreon conserve dans un journal toutes les actions utilisateurs concernant la modification de la confi-
guration de la supervision. Pour accéder à ces informations, rendez-vous dans le menu Administration ==> Journal
d’évènements.

La barre de recherche grise vous permet de filtrer les informations présentées via les filtres :
— Objet permettant de filtrer sur le nom de l’objet (hôte, service, contact, définition de trap SNMP, groupe, ...)
— Utilisateur permettant de filtrer par auteur de modification
— Type d’objet permettant de filtrer par type d’objet modifié.

304
CENTREON 46-52 RUE ALBERT FR75014 PARIS

Chapitre 8. Guide d’administration



8.7.2 Pratique

Exemple : Pour voir toutes les actions faites par l’utilisateur admin, renseignez “admin” dans le champ Utilisateur
puis cliquez sur Rechercher.

Le tableau ci-dessous définit les colonnes du tableau de résultats :

Colonne Description
Heures Indique la date et l’heure de l’évènement
Type de modification Contient le type d’action effectuée. Il existe plusieurs

types d’actions possibles :
— Added : Indique que l’objet a été ajouté
— Changed : Indique que l’objet a été modifié
— Deleted : Indique que l’objet a été supprimé
— Massive Change : Indique un changement massif

de configuration sur des objets
— Enabled : Indique que l’objet a été activé
— Disabled : Indique que l’objet a été désactivé

Type Indique le type d’objet concerné
Objet Indique le nom de l’objet concerné
Auteur Indique l’utilisateur ayant effectué cette modification

En cliquant sur le nom d’un objet, vous pouvez visualiser l’historique des modifications réalisées sur ce dernier.

Le tableau ci-dessous définit les colonnes du tableau des modifications :

Colonne Description
Date Date et heure de la modification
Nom de l’utilisateur Nom de la personne ayant réalisé la modification
Type Type de modification

La dernière colonne décrit la modification en elle-
même :

— Nom du champ : Décrit le champ du formulaire
modifié

— Avant : Indique l’ancienne valeur
— Après : Indique la nouvelle valeur

8.8 Sauvegarde de la plate-forme

8.8.1 Fonctionnement

Exécution journalière

Le script de sauvegarde est exécuté de manière journalière par une tâche planifiée située dans /etc/cron.d/centreon :
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##########################
# Cron for Centreon-Backup
30 3 * * * root /usr/share/centreon/cron/centreon-backup.pl >> /var/log/centreon/centreon-backup.log 2&>1

Chaque jour à 3H30, Le script de sauvegarde vérifie sur une sauvegarde doit être réalisée ce jour.

Types de sauvegarde

Il y a deux types de sauvegarde : base de données et fichiers de configuration.

Sauvegarde de la base de données

La sauvegarde de la base de données peut être réalisée sur deux bases : centreon et centreon_storage

Il y a deux types de sauvegarde :
— MySQLdump : la commande mysqldump est utilisée pour sauvegarder la base de données. Attention, cette

commande peut prendre un certain temps si la base est volumineuse.
— LVM Snapshot : Copie binaire des fichiers MySQL. Vous devez avoir un volume logique dédiée à MySQL

(ex : /var/lib/mysql) et 1Go d’espace disponible dans son groupe de volumes.
Format de la sauvegarde :

— yyyy-mm-dd-centreon.sql.gz
— yyyy-mm-dd-centreon_storage.sql.gz

Sauvegarde des fichiers de configuration

Tous les fichiers de configuration du serveur central sont sauvegardés : MySQL, Apache, PHP, SNMP, centreon,
centreon-broker

Format de la sauvegarde :
— yyyy-mm-dd-Monitoring-Engine.tar.gz (fichiers de configuration centreon-engine)
— yyyy-mm-dd-Central.tar.gz (autres fichiers de configuration)

8.8.2 Configuration

Ce chapitre décrit la configuration de centreon-backup.

1. Se rendre dans le menu : Administration ==> Paramètres ==> Backup
La fenêtre suivante est affichée :
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— Backup enabled Activer/Désactiver la sauvegarde
— Backup directory Répertoire de stockage des sauvegardes
— Temporary directory Répertoire utilisé durant le processus de sauvegarde
— Backup database centreon Activer la sauvegarde de la base de données centreon
— Backup database centreon_storage Activer la sauvegarde de la base de données centreon_storage
— Backup type Type de sauvegarde (MySQLdump or LVM snapshot)
— Full backup Période pour la sauvegarde complète
— Partial backup Période pour la sauvegarde partielle (seulement disponible pour la sauvegarde par LVM snap-

shot)
— Backup retention Durée de rétention des sauvegardes (en jours)
— Backup configuration files Activer la sauvegarde des fichiers de configuration
— MySQL configuration file path Chemin d’accès au fichier de configuration MySQL
— SCP export enabled Activer l’export des sauvegardes par SCP
— Remote user Utilisateur distant pour l’export SCP
— Remote host Hôte distant pour l’export SCP
— Remote directory Répertoire distant pour l’export SCP

Warning : Temporary directory ne peut pas être un sous répertoire de Backup directory.

8.8.3 Restauration d’un serveur central Centreon

Le processus de restauration consiste en deux étapes :
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— Réinstaller la plate-forme suivant le documentation d’installation de Centreon. Ne pas oublier de faire la mise
à jour du système.

— Restaurer les différents fichiers de configuration, puis les bases de données Centreon.

Restauration des fichiers de configuration de Centreon

Avant de restaurer les bases de données, il faudra restaurer certains fichiers de configuration dans un premier temps :

# cd /var/backup
# tar -xvf AAAA-MM-JJ-central.tar.gz
# cd backup/central/etc/centreon
# cp * /etc/centreon/

Restauration des bases de données

Une fois le serveur Centreon réinstallé (même version de Centreon), il suffit de décompresser les sauvegardes des
bases de données centreon et centreon_storage :

# mysql
mysql> drop database centreon;
mysql> drop database centreon_storage;
mysql> CREATE database centreon;
mysql> CREATE database centreon_storage;
mysql> GRANT ALL ON centreon.* TO ’centreon’@’<adresse_ip_centreon>’ IDENTIFIED BY ’password’ ;
mysql> GRANT ALL ON centreon_storage.* TO ’centreon’@’<adresse_ip_centreon>’ IDENTIFIED BY ’password’ ;
mysql> exit;
# gzip -d AAAA-MM-JJ-centreon.sql.gz
# mysql centreon < AAAA-MM-JJ-centreon.sql
# gzip -d AAAA-MM-JJ-centreon_storage.sql.gz
# mysql centreon_storage < AAAA-MM-JJ-centreon_storage.sql

Ces opérations peuvent prendre un certain temps du fait de la taille de la base “centreon_storage”.

Note : Le mot de passe (password ci-dessus), est stocké dans les fichiers de configuration restaurés précédemment.
Par exemple le champ $mysql_passwd dans le fichier “/etc/centreon/conf.pm”.

Note : Par défaut, il n’y a pas de mot de passe pour le compte root de mysql lors de l’installation d’un serveur via
Centreon ISO.

La manipulation ci-dessus est valide pour des versions identiques de Centreon.

Restauration des clés SSH

Cette étape consiste à restaurer les clés SSH de l’utilisateur centreon, voir centreon-engine dans le cadre d’un en-
vironnement distribué. Leur restauration doit être manuelle. Il faut donc dans un premier temps extraire cette archive
dans un répertoire temporaire puis déplacer un à un les fichiers suivant leur emplacement.

Sur le serveur central :

# cd /var/backup
# tar -xvf AAAA-MM-JJ-centreon-engine.tar.gz
# cd backup/ssh
# mkdir -p /var/spool/centreon/.ssh/
# chmod 700 /var/spool/centreon/.ssh/
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# cp -p id_rsa /var/spool/centreon/.ssh/
# cp -p id_rsa.pub /var/spool/centreon/.ssh/

Test de connexion du central central vers les satellites :

# su - centreon
# ssh <adresse_ip_poller>

Répondre “Oui” à la question.

Note : Cette opération est à effectuer si et seulement si votre plate-forme est en mode distribuée.

Restauration des plugins

Les plugins ont été sauvegardés dans l’archive : “AAAA-MM-JJ-centreon-engine.tar.gz”. Leur restauration doit être
manuelle. Il faut donc dans un premier temps extraire cette archive dans un répertoire temporaire puis déplacer un à
un les fichiers suivant leur emplacement.

Sur chaque collecteur, il faudra réaliser l’action suivante :

# cd /var/backup
# tar -xvf AAAA-MM-JJ-centreon-engine.tar.gz
# cd backup/plugins
# cp -pRf * /usr/lib/nagios/plugins

Restauration des scripts d’initialisation

Certains points de contrôles concernant Oracle ou SAP entraînent la modification du script d’initialisation de l’or-
donnanceur afin d’y ajouter des variables d’environnements. Si vous avez modifié le script d’initialisation de votre
ordonnanceur, il faudra le restaurer.

Dans un premier temps extraire cette archive dans un répertoire temporaire puis déplacer un à un les fichiers suivant
leurs emplacements :

# cd /var/backup
# tar -xvf AAAA-MM-JJ-centreon-engine.tar.gz
# cd backup
# cp init_d_centengine /etc/init.d/centengine

Restauration des agents de supervision

Si vous utilisez les agents NRPE, ou NSCA il faudra les réinstaller puis restaurer leur configuration :

# cd /var/backup
# tar -xvf YYYY-MM-DD-centreon-engine.tar.gz
# cd backup/etc
# cp nrpe.cfg /etc/centreon-engine/
# cp nsca.cfg /etc/centreon-engine/

Note : Cette manipulation est à utiliser si et seulement si vous utilisez les agents NRPE ou NSCA. Si vous utiliser
NSCA le fichier de configuration à copier n’est pas nrpe.cfg mais nsca.cfg.
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Génération de la configuration du central

Une fois toutes les étapes (nécessaires) effectuées, il faudra générer la configuration de chaque collecteur.

Reconstruction des graphiques

Une fois que vous avez restauré votre plate-forme de supervision et que tout est en ordre, il faudra reconstruire les
fichiers RRD afin de retrouver tous vos “anciens” graphiques de performance.

Pour reconstruire les graphiques de performance, il faudra vous rendre dans le menu Administration -> Options ->
Centstorage -> Manage. Sur cette page, il faudra sélectionner tous les services et cliquer sur Rebuild RRD Database.

Le serveur central est maintenant restauré.

8.9 Partitionnement des bases de données

8.9.1 Présentation

Le module Centreon Partitioning est maintenant intégré de base avec Centreon Web, il offre différentes fonctionnalités
et avantages.

— Il permet de partitionner les tables MySQL en fonction de la date des lignes. Ce qui offre une optimisation du
temps d’exécution de nombreuses requêtes.

— La purge des données est améliorée, il est maintenant juste nécessaire de supprimer les partitions trop an-
ciennes.

— L’étendue d’un crash MySQL est limitée par la reconstruction des partitions en erreur.
— Les tables existantes peuvent être partitionnées

Note : Ce partionnement comporte des limitations : - Le nombre maximal de partitions (pour une table) est 1024 -
Les clés étrangères ne sont pas supportées

Depuis la version 2.8.0 de Centreon Web, les tables logs, data_bin, log_archive_host et log_archive_service sont
partionnées automatiquement lors de l’installation.

Plus de détails sur le partitionnement MySQL ici.

8.9.2 Pré-requis

Les pré-requis nécessaires pour l’utilisation de ce module sont les suivants :
— php-mysql
— Pear-DB
— MySQL (>= 5.1.x)

Le paramètre MySQL open_files_limit doit être fixé à 32000 dans la section [server] :

[server]
open_files_limit = 32000

Note : En installant via l’ISO de Centreon, ce paramètre est déjà convenablement configuré. Si vous installez les rpm
sur votre propre install RedHat ou CentOS, vous serez obligé de le faire vous même. N’oubliez pas de redémarrer le
service mysql / mariadb si vous avez besoin de configurer ce paramètre dans le fichier my.cnf.

Si vous utilisez systemd, il est nécessaire de créer le fichier “/etc/systemd/system/mariadb.service.d/mariadb.conf” :
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[Service]
LimitNOFILE=32000

Puis recharger systemd et MySQL :

$ systemctl daemon-reload
$ systemctl restart mysql

Afin d’exploiter le module, vous pouvez suivre la documentation suivante :

Guide utilisateur

Configuration

Centreon Partitioning utilise des fichiers de configuration XML. Les fichiers des tables Centreon sont fournis.

Exemple avec partitioning-data_bin.xml

<?xml version="1.0" encoding="UTF-8"?>
<centreon-partitioning>
<table name="data_bin" schema="centreon_storage">

<activate>1</activate>
<column>ctime</column>
<type>date</type>
<duration>daily</duration>
<retention>365</retention>
<retentionforward>10</retentionforward>
<backup>

<folder>/var/backups/</folder>
<format>%Y-%m-%d</format>

</backup>
<createstmt>

CREATE TABLE IF NOT EXISTS ‘data_bin‘ (
‘id_metric‘ int(11) DEFAULT NULL,
‘ctime‘ int(11) DEFAULT NULL,
‘value‘ float DEFAULT NULL,
‘status‘ enum(’0’,’1’,’2’,’3’,’4’) DEFAULT NULL,
KEY ‘index_metric‘ (‘id_metric‘)

) ENGINE=MyISAM DEFAULT CHARSET=utf8;
</createstmt>

</table>
</centreon-partitioning>

Explication Centreon Partitioning permet de créer des partitions journalières. Pour cela, votre table doit avoir un
champ dont la valeur est un timestamp (temps en secondes depuis le 1er janvier 1970).

Le sens des attributs/valeurs des fichiers XML :
— Attributs ‘name’ et ‘schema’ : Respectivement nom de la table et nom de la base
— tag ‘column’ : nom du champ ayant pour valeur un timestamp unix
— tag ‘type’ : seulement la valeur “date” est supportée
— tag ‘duration’ : seulement la valeur “daily” est supportée (les futures versions supporteront : “weekly”, “month-

ly”)
— tag ‘timezone’ : la timezone du serveur (la timezone est présente dans ‘/etc/sysconfig/clock’ pour un OS Cen-

tOS)
— tag ‘retention’ : nombre de jours de retention
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— tag ‘retentionforward’ : nombre de partition créées par avance (utile pour la durée de partitionnement)

Exploitation

Migration des tables La ligne de commande exécute la procédure suivante :
— Renomme la table existante (‘xxx’ devient ‘xxx_old’)
— Crée une table partitionnée vide
— Migre les données dans la table partitionnée (instructions ‘SELECT INSERT’)

Warning : Des vérifications doivent être faites avant :

— L’espace disponible sur le volume sur lequel se trouvent les bases MySQL doit être suffisant pour contenir
deux fois la taille des tables traitées (Indexes + données).

— Les tables ne doivent pas contenir de données dans le futur (le temps est un facteur clé pour la mise en place
du partitionnement).

— La mémoire sur le serveur MySQL doit être suffisante.

Warning : Les requêtes/instructions ‘SELECT INSERT’ vont verrouiller la table et probablement certains traite-
ments.

La migration de la table est effectuée en utilisant l’option ‘-m’ :

# php /usr/share/centreon/bin/centreon-partitioning.php -m data_bin

Si la migration de la table est ok l’ancienne table peut être supprimée avec la commande suivante :

# mysql centreon_storage
mysql> DROP TABLE data_bin_old;

Mise à jour des tables Une fois le partitionnement effectué un script cron sera exécuté tous les jours :

0 4 * * * centreon /usr/bin/php /usr/share/centreon/cron/centreon-partitioning.php >> /var/log/centreon/centreon-partitioning.log 2>&1

Supervision

Plugins Packs Il est possible de superviser le bon fonctionnement du partitioning en utilisant les Plugins Packs. Pour
cela, il est nécessaire d’installer le pack “Centreon DB”.

L’indicateur Partitioning remontera alors les alertes utiles.

Sur l’interface Le menu Administration => Etat du Serveur remonte toutes les informations nécessaires concer-
nant le système de partition. Ce menu contient la liste compléte des partitions sur les différentes tables.
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Des informations plus globales sur l’état de santé des bases de données sont également présentes.

8.10 URI personnalisée

Il est possible de modifier l’URI de Centreon. Par exemple, /centreon peut être remplacé par /monitoring.

Pour mettre à jour l’URI Centreon, vous devez suivre les étapes suivantes :
— Supprimer ce dossier sur le serveur central : centreon/www/static
— Remplacer les occurences /centreon par /votre_uri_personnalise dans centreon/www/index.html
— Remplacer les occurences /centreon par /votre_uri_personnalise dans centreon/www/.htaccess
— Naviguer vers l’URL Centreon

8.10. URI personnalisée
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CHAPITRE 9

Mise à jour

Ce chapitre décrit le processus de mise à jour d’une plate-forme Centreon.

La procédure dépend de la méthode d’installation de votre plate-forme Centreon. Sélectionner Mise à jour RPM si
vous avez installé Centreon à partir de l’ISO ou des RPMS, sinon sélectionner A partir des sources. Avant de mettre
à jour réaliser une sauvegarde.

Warning : En cas de migration d’une plate-forme disposant du module Centreon Poller Display 1.6.x, référez-
vous à la procédure de migration suivante.

9.1 Mise à jour vers Centreon 18.10

Ce chapitre décrit la procédure de mise à jour de votre plate-forme vers Centreon 18.10.

Warning : A la fin de cette procédure, les utilisateurs de Centreon EMS devront demander de nouvelles licenses
au Support Centreon.

Warning : Cette procédure ne s’applique que pour une plate-forme Centreon installée à partir des dépôts Centreon
3.4 sur des distributions Red Hat / CentOS en version 7.
Si cela n’est pas le cas, se référer à la procédure de migration.

Pour mettre à jour votre serveur Centreon Map, référez-vous à la documentation associée.

Pour mettre à jour votre serveur Centreon MBI, référez-vous à la documentation associée.

9.1.1 Sauvegarde

Avant toute chose, il est préférable de s’assurer de l’état et de la consistance des sauvegardes de l’ensemble des serveurs
centraux de votre plate-forme :

— Serveur(s) Centreon central(aux) ;
— Serveur(s) de gestion de base de données ;
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9.1.2 Mise à jour du serveur Centreon Central

Mise à jour des dépôts

Afin d’installer les logiciels Centreon, le dépôt Software collections de Red Hat doit être activé.

Note : Le dépôt Software collections est nécessaire pour l’installation de PHP 7 et les librairies associées.

Exécutez la commande suivante :

# yum install centos-release-scl

Il est maintenant nécessaire de mettre à jour le dépôt Centreon.

Exécutez la commande suivante :

# wget http://yum.centreon.com/standard/18.10/el7/stable/noarch/RPMS/centreon-release-18.10-2.el7.centos.noarch.rpm -O /tmp/centreon-release-18.10-2.el7.centos.noarch.rpm
# yum install --nogpgcheck /tmp/centreon-release-18.10-2.el7.centos.noarch.rpm

Mise à jour de la solution Centreon

Mettez à jour le cache de yum :

# yum clean all

Mettez à jour l’ensemble des composants :

# yum update centreon\*

Note : Acceptez les nouvelles clés GPG des dépôts si nécessaire.

Actions complémentaires

Le fuseau horaire par défaut de PHP 7 doit être configurée. Executer la commande suivante :

# echo "date.timezone = Europe/Paris" > /etc/opt/rh/rh-php71/php.d/php-timezone.ini

Note : Changez Europe/Paris par votre fuseau horaire.

Redémarrez les services en Executer les commandes suivantes :

# systemctl enable rh-php71-php-fpm
# systemctl start rh-php71-php-fpm
# systemctl restart httpd
# systemctl restart cbd
# systemctl restart centengine
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Finalisation de la mise à jour

Connectez-vous à l’interface web Centreon pour démarrer le processus de mise à jour :

Cliquez sur Next :

Cliquez sur Next :

La note de version présente les principaux changements, cliquez sur Next :

9.1. Mise à jour vers Centreon 18.10
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Le processus réalise les différentes mises à jour, cliquez sur Next :
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Votre serveur Centreon est maintenant à jour, cliquez sur Finish pour accéder à la page de connexion :

Pour mettre à jour votre module Centreon BAM, référez-vous à la documentation associée.

9.1.3 Mise à jour des collecteurs

Installation des dépôts

Exécutez la commande suivante :

# wget http://yum.centreon.com/standard/18.10/el7/stable/noarch/RPMS/centreon-release-18.10-2.el7.centos.noarch.rpm -O /tmp/centreon-release-18.10-2.el7.centos.noarch.rpm
# yum install --nogpgcheck /tmp/centreon-release-18.10-2.el7.centos.noarch.rpm

9.1. Mise à jour vers Centreon 18.10
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Mise à jour de la solution Centreon

Mettez à jour l’ensemble des composants :

# yum update centreon*

Note : Acceptez les nouvelles clés GPG des dépôts si nécessaire.

Actions complémentaires

Redémarrez le service centengine en exécutant la commande suivante :

# systemctl restart centengine

9.1.4 Mise à jour des serveurs Poller Display

Référez-vous à la documentation de migration d’un serveur Poller Display vers Remote Server 18.10.

9.2 A partir des sources

Pour mettre à jour Centreon depuis les sources, télécharger la dernière version de Centreon.

9.2.1 Installation shell

Extraire le paquet :

$ tar xvfz centreon-2.x.x.tar.gz

Se déplacer de répertoire :

$ cd centreon-2.x.x

Exécuter le script :

$ ./install -u /etc/centreon

Où /etc/centreon correspond au répertoire de configuration de centreon à rempalcer le cas échéant.

Contrôle des prérequis

Si l’étape [Step 01] est réussie, vous devriez avoir aucun problème ici. Sinon revenir à l’étape [Step 01] et installer les
prérequis :

###############################################################################
# #
# Centreon (www.centreon.com) #
# Thanks for using Centreon #
# #
# v2.8.1 #
# #

320
CENTREON 46-52 RUE ALBERT FR75014 PARIS

Chapitre 9. Mise à jour



# infos@centreon.com #
# #
# Make sure you have installed and configured #
# sudo - sed - php - apache - rrdtool - mysql #
# #
###############################################################################
------------------------------------------------------------------------

Checking all needed binaries
------------------------------------------------------------------------
rm OK
cp OK
mv OK
/bin/chmod OK
/bin/chown OK
echo OK
more OK
mkdir OK
find OK
/bin/grep OK
/bin/cat OK
/bin/sed OK
------------------------------------------------------------------------

Detecting old installation
------------------------------------------------------------------------
Finding configuration file in: /etc/centreon OK
You seem to have an existing Centreon.

Choix des composants principaux

Chargement des paramètres d’installation précédents :

Do you want to use the last Centreon install parameters ?
[y/n], default to [y]:
> y

Using: /etc/centreon/instCentCore.conf
/etc/centreon/instCentPlugins.conf
/etc/centreon/instCentStorage.conf
/etc/centreon/instCentWeb.conf

Sélectionner les composants à mettre à jour :

Do you want to install : Centreon Web Front
[y/n], default to [n]:
> y

Do you want to install : Centreon CentCore
[y/n], default to [n]:
> y

Do you want to install : Centreon Nagios Plugins
[y/n], default to [n]:
> y

Do you want to install : Centreon Snmp Traps process
[y/n], default to [n]:

9.2. A partir des sources
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> y
Convert variables for upgrade:

Mise à jour de l’interface web

De nouvelle informaitons sont nécessaires.

Le chemin vers les binaires de centreon :

------------------------------------------------------------------------
Start CentWeb Installation

------------------------------------------------------------------------

Where is your Centreon binaries directory
default to [/usr/local/centreon/bin]
>
Path /usr/local/centreon/bin OK

Le chemin de données supplémentaires pour Centreon Web :

Where is your Centreon data information directory
default to [/usr/local/centreon/data]
>

Do you want me to create this directory ? [/usr/local/centreon/data]
[y/n], default to [n]:
> y
Path /usr/local/centreon/data
/usr/bin/perl OK
Finding Apache user : www-data
Finding Apache group : www-data

Le groupe applicatif Centreon. Ce groupe est utilisé pour les droits d’accès entre les applications Centreon :

What is the Centreon group ? [centreon]
default to [centreon]
>

Do you want me to create this group ? [centreon]
[y/n], default to [n]:
> y

L’utilisateur applicatif Centreon :

What is the Centreon user ? [centreon]
default to [centreon]
>

Do you want me to create this user ? [centreon]
[y/n], default to [n]:
> y

L’utilisateur du module broker. Cet utilisateur est utilisé pour ajouter des droits à Centreon sur les répertoires de
configuration et journaux. Si vide, l’utilisateur du moteur de supervision sera utilisé.

Par exemple :
— Centreon Broker : centreon-broker
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What is the Broker user ? (optional)
>

Le chemin vers les journaux. Par exmeple :
— Centreon Engine : /var/log/centreon-engine

Le chemin vers les sondes de supervision :

Where is your monitoring plugins (libexec) directory ?
default to [/usr/lib/nagios/plugins]
>

Path /usr/lib/nagios/plugins OK
Add group centreon to user www-data OK
Add group centreon to user nagios OK
Add group nagios to user www-data OK
Add group nagios to user centreon OK

------------------------------------------------------------------------
Configure Sudo

------------------------------------------------------------------------

Le chemin vers le script de démarrage de l’ordonnanceur. Par exemple :
— Centreon Engine : /etc/init.d/centengine

Le chemin vers le répertoire de configuratino du broker. Par exemple :
— Centreon Broker : /etc/centreon-broker

Le chemin vers e script de démarrage du broker. Par exemple :
— Centreon Broker : /etc/init.d/cbd

Remplacement ou non du fichier de droits utilisateurs. Pour plus de sécurité, sauvegarder le fichier /etc/sudoers.

Do you want me to reconfigure your sudo ? (WARNING)
[y/n], default to [n]:
> y
Configuring Sudo OK

------------------------------------------------------------------------
Configure Apache server

------------------------------------------------------------------------
Create ’/etc/apache2/conf.d/centreon.conf’ OK
Configuring Apache OK

Do you want to reload your Apache ?
[y/n], default to [n]:
> y
Reloading Apache service OK
Preparing Centreon temporary files
Change right on /usr/local/centreon/log OK
Change right on /etc/centreon OK
Change macros for insertBaseConf.sql OK
Change macros for sql update files OK
Change macros for php files OK
Disconnect users from WebUI
All users are disconnected OK
Copy CentWeb in system directory
Install CentWeb (web front of centreon) OK
Change right for install directory
Change right for install directory OK
Install libraries OK
Write right to Smarty Cache OK

9.2. A partir des sources
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Copying libinstall OK
Change macros for centreon.cron OK
Install Centreon cron.d file OK
Change macros for centAcl.php OK
Change macros for downtimeManager.php OK
Change macros for eventReportBuilder.pl OK
Change macros for dashboardBuilder.pl OK
Install cron directory OK
Change right for eventReportBuilder.pl OK
Change right for dashboardBuilder.pl OK
Change macros for centreon.logrotate OK
Install Centreon logrotate.d file OK
Prepare export-mysql-indexes OK
Install export-mysql-indexes OK
Prepare import-mysql-indexes OK
Install import-mysql-indexes OK
Prepare indexes schema OK
Install indexes schema OK

------------------------------------------------------------------------
Pear Modules
------------------------------------------------------------------------
Check PEAR modules
PEAR 1.4.9 1.9.4 OK
DB 1.7.6 1.7.14 OK
DB_DataObject 1.8.4 1.10.0 OK
DB_DataObject_FormBuilder 1.0.0RC4 1.0.2 OK
MDB2 2.0.0 2.4.1 OK
Date 1.4.6 1.4.7 OK
HTML_Common 1.2.2 1.2.5 OK
HTML_QuickForm 3.2.5 3.2.13 OK
HTML_QuickForm_advmultiselect 1.1.0 1.5.1 OK
HTML_Table 1.6.1 1.8.3 OK
Archive_Tar 1.1 1.3.7 OK
Auth_SASL 1.0.1 1.0.6 OK
Console_Getopt 1.2 1.2.3 OK
Net_SMTP 1.2.8 1.6.1 OK
Net_Socket 1.0.1 1.0.10 OK
Net_Traceroute 0.21 0.21.3 OK
Net_Ping 2.4.1 2.4.5 OK
Validate 0.6.2 0.8.5 OK
XML_RPC 1.4.5 1.5.5 OK
SOAP 0.10.1 0.13.0 OK
Log 1.9.11 1.12.7 OK
Archive_Zip 0.1.2 0.1.2 OK
All PEAR modules OK

------------------------------------------------------------------------
Centreon Post Install

------------------------------------------------------------------------
Create /usr/local/centreon/www/install/install.conf.php OK
Create /etc/centreon/instCentWeb.conf OK
Convert variables for upgrade:

Mise à jour de Centreon Storage

De nouvelle informaitons sont nécessaires.
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------------------------------------------------------------------------
Start CentStorage Installation

------------------------------------------------------------------------
Preparing Centreon temporary files
/tmp/centreon-setup exists, it will be moved...
install www/install/createTablesCentstorage.sql OK
CentStorage status Directory already exists PASSED
CentStorage metrics Directory already exists PASSED
Change macros for centstorage binary OK
Install CentStorage binary OK
Install library for centstorage OK
Change right : /var/run/centreon OK
Change macros for centstorage init script OK
Replace CentCore default script Macro OK

Do you want me to install CentStorage init script ?
[y/n], default to [n]:
> y
CentStorage init script installed OK
CentStorage default script installed OK

Do you want me to install CentStorage run level ?
[y/n], default to [n]:
> y
update-rc.d: using dependency based boot sequencing
insserv: warning: current start runlevel(s) (3 5) of script ’centstorage’ overwrites defaults (2 3 4 5).
Change macros for logAnalyser OK
Install logAnalyser OK
Change macros for logAnalyser-cbroker OK
Install logAnalyser-cbroker OK
Change macros for nagiosPerfTrace OK
Install nagiosPerfTrace OK
Change macros for purgeLogs OK
Install purgeLogs OK
Change macros for purgeCentstorage OK
Install purgeCentstorage OK
Change macros for centreonPurge.sh OK
Install centreonPurge.sh OK
Change macros for centstorage.cron OK
Install CentStorage cron OK
Change macros for centstorage.logrotate OK
Install Centreon Storage logrotate.d file OK
Create /etc/centreon/instCentStorage.conf OK
Convert variables for upgrade:

Mise à jour Centreon Core

De nouvelle informations sont nécessaires.

------------------------------------------------------------------------
Start CentCore Installation

------------------------------------------------------------------------
Preparing Centreon temporary files
/tmp/centreon-setup exists, it will be moved...
Change CentCore Macro OK
Copy CentCore in binary directory OK
Change right : /var/run/centreon OK
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Change right : /var/lib/centreon OK
Change macros for centcore.logrotate OK
Install Centreon Core logrotate.d file OK
Replace CentCore init script Macro OK
Replace CentCore default script Macro OK

Do you want me to install CentCore init script ?
[y/n], default to [n]:
> y
CentCore init script installed OK
CentCore default script installed OK

Do you want me to install CentCore run level ?
[y/n], default to [n]:
> y
update-rc.d: using dependency based boot sequencing
insserv: warning: current start runlevel(s) (3 5) of script ’centcore’ overwrites defaults (2 3 4 5).
Create /etc/centreon/instCentCore.conf OK
Convert variables for upgrade:

Mise à jour des sondes Centreon

De nouvelle informations sont nécessaires.

------------------------------------------------------------------------
Start CentPlugins Traps Installation

------------------------------------------------------------------------
Finding Apache user : www-data
Preparing Centreon temporary files
/tmp/centreon-setup exists, it will be moved...
Change macros for CentPluginsTraps OK
Change macros for init scripts OK
Installing the plugins Trap binaries OK
Backup all your snmp files OK
Change macros for snmptrapd.conf OK
Change macros for snmptt.ini OK
SNMPTT init script installed OK
SNMPTT default script installed OK
update-rc.d: using dependency based boot sequencing
Install : snmptrapd.conf OK
Install : snmp.conf OK
Install : snmptt.ini OK
Install : snmptt OK
Install : snmptthandler OK
Install : snmpttconvertmib OK
Generate SNMPTT configuration OK
Create /etc/centreon/instCentPlugins.conf OK

Fin de la mise à jour :

###############################################################################
# #
# Go to the URL : http://localhost/centreon/ #
# to finish the setup #
# #
# Report bugs at https://github.com/centreon/centreon/issues #
# #
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# Thanks for using Centreon. #
# ----------------------- #
# Contact : infos@centreon.com #
# http://www.centreon.com #
# #
###############################################################################

9.2.2 Installation Web

Durant la mise à jour web suivre les instructions suivantes :

Présentation

Contrôle des dépendances

Cette étape contrôle la liste des dépendances PHP.

9.2. A partir des sources
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Notes de version

Mise à jour des bases de données

Cette étape met à jour le modèle des bases de données ainsi que les données, version par version.

9.2. A partir des sources
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Finalisation
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CHAPITRE 10

Migration vers Centreon 18.10

Ce chapitre présente les procédure de migration d’une plate-forme de supervision vers Centreon 18.10 :

10.1 Migration depuis une plate-forme Centreon 3.4

10.1.1 Prérequis

Cette procédure ne s’applique que pour une plate-forme Centreon 3.4, installé sur une distribution GNU/Linux 64
bits et disposant des prérequis suivants :

Composants Version
Centreon Web 2.8.x
Centreon Broker 3.0.x
Centreon Engine 1.8.x

Note : Si votre plate-forme a été installé à partir de l’ISO Centreon ou des dépôts Centreon 3.4 sur CentOS ou Red
Hat en version 7, référez-vous à la documentation de mise à jour.

10.1.2 Migration

Warning : En cas de migration d’une plate-forme disposant du système de redondance Centreon, il est nécessaire
de contacter votre support Centreon.

Warning : En cas de migration d’une plate-forme disposant du module Centreon Poller Display 1.6.x, référez-
vous à la procédure de migration suivante.

Installation du nouveau serveur

Installez un nouveau serveur Centreon à partir de l’ISO ou des paquets et terminez le processus d’installation en vous
connectant à l’interface web.

Note : Il est préférable de saisir le même mot de passe pour l’utilisateur ‘centreon’ lors du processus d’installation
web.
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Synchronisation des données

Connectez-vous à votre ancien serveur Centreon et synchronisez les répertoires suivants :

# rsync -avz /etc/centreon root@IP_New_Centreon:/etc
# rsync -avz /etc/centreon-broker root@IP_New_Centreon:/etc
# rsync -avz /var/log/centreon-engine/archives/ root@IP_New_Centreon:/var/log/centreon-engine
# rsync -avz --exclude centcore/ --exclude log/ /var/lib/centreon root@IP_New_Centreon:/var/lib
# rsync -avz /var/spool/centreon/.ssh root@IP_New_Centreon:/var/spool/centreon

Note : Remplacez IP_New_Centreon par l’adresse IP de votre nouveau serveur Centreon.

Si le SGBD MySQL/MariaDB est installé sur même serveur que le serveur Centreon, exécutez les commandes sui-
vantes :

1. Arrêtez le processus mysqld sur les deux serveurs (ancien et nouveau) :

# systemctl stop mysqld

2. Sur le nouveau serveur, supprimer le contenu du répertoire /var/lib/mysql/ :

# rm -Rf /var/lib/mysql/*

3. Sur l’ancien serveur, lancer la synchronisation des données :

# rsync -avz /var/lib/mysql/ root@IP_New_Centreon:/var/lib/mysql/

4. En cas de migration d’un SGBD MySQL/MariaDB 5.x vers 10.x, il est nécessaire de lancer la commande
suivante sur le nouveau serveur :

# mysql_upgrade

5. Redémarrage du processus mysqld sur nouveau serveur :

# systemctl start mysqld

Synchronisation des plugins

La synchronisation des sondes de supervision (plugins) est plus délicate et dépend de votre installation. Les principaux
répertoires à synchroniser sont :

1. /usr/lib/nagios/plugins/

2. /usr/lib/centreon/plugins/

Note : Il est important d’installer les dépendances nécessaires au fonctionnement des sondes de supervision.

Mise à jour de la suite Centreon

Forcez la mise à jour du nouveau serveur en déplacant le contenu du répertoire /usr/share/centreon/installDir/install-
18.10.0-YYYYMMDD_HHMMSS dans le repértoire /usr/share/centreon/www/install :

# cd /usr/share/centreon/installDir/
# mv install-18.10.0-YYYYMMDD_HHMMSS/ ../www/install/
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Se connecter à l’url http://[ADRESSE_IP_DE_VOTRE_SERVEUR]/centreon et suivre les étapes de mise à jour.

Note : Si vous avez modifié le mot de passe de l’utilisateur ‘centreon’ lors de l’installation de votre nouveau serveur
Centreon pour accéder aux bases de données, il sera nécessaire de réaliser les actions suivantes sur le nouveau serveur
Centreon :

1. Modifiez le fichier /etc/centreon/centreon.conf.php

2. Modifiez le fichier /etc/centreon/conf.pm

3. Éditer la configuration du Centreon Broker central, via l’interface web Centreon et modifier le mot de passe
pour les deux output broker Perfdata generator et Broker SQL database.

Si l’adresse IP de votre serveur Centreon a changé, éditez la configuration de l’ensemble des modules broker de vos
collecteurs et modifiez l’adresse IP de connexion au serveur Centreon central (output IPv4).

Puis générez la configuration de l’ensemble de la plate-forme et exportez là.

Mise à jour des modules

Référez-vous à la documentation des modules installés afin de connaître leur compatibilité avec Centreon 18.10, et
pour mettre à jour ces derniers.

10.2 Migration d’une plate-forme avec Poller Display

10.2.1 Mise à jour du serveur Centreon Central

Si le module centreon-poller-display-central-1.6.x est installé :

1. Rendez-vous dans le menu Administration > Extensions > Modules et désinstallez le module centreon-
poller-display-central

2. Supprimez le paquet associé :

# yum remove centreon-poller-display-central

Puis suivez la procédure de mise à jour si vous avez une plate-forme CentOS v7 avec paquets Centreon, sinon la
procédure de migration d’un serveur Centreon central vers 18.10.

Note : Si vous possédez des modules Centreon EMS, il est nécessaire de mettre à jour ces dépôts. Contactez votre
support Centreon pour obtenir ces derniers. Demandez également les nouvelles licences associées.

10.2.2 Migration d’un server Poller Display vers Remote Serve

1. Rendez-vous dans le menu Administration > Extensions > Modules et supprimez le module Centreon Poller
Display

2. Si vous avez installé le module à partir du paquet RPM, supprimez le paquet en exécutant la commande
suivante :

# yum remove centreon-poller-display

Note : Si vous possédez des modules Centreon EMS, il est nécessaire de mettre à jour ces dépôts. Contactez votre
support Centreon pour obtenir ces derniers.

10.2. Migration d’une plate-forme avec Poller Display
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3. Si votre serveur est basé sur la distribution CentOS ou Red Hat en version 7, réalisez la mise à jour en suivant
la procédure de mise à jour ; sinon exécutez la procédure de migration.

4. Rendez-vous dans le menu Administration > Extensions > Modules et installez le module centreon-license-
manager.

Note : Si vous possédez des modules Centreon EMS, demandez les nouvelles licences de vos modules.

5. Exécutez la commande suivante :

# /usr/share/centreon/bin/centreon -u admin -p centreon -a enableRemote -o CentreonRemoteServer -v @IP_CENTREON_CENTRAL

Note : Remplacez @IP_CENTREON_CENTRAL par l’IP du serveur Centreon vu par le collecteur.

Cette commande va activer le mode Remote Server

Starting Centreon Remote enable process:

Limiting Menu Access...Success
Limiting Actions...Done

Notifying Master...Success

Set ’remote’ instance type...Done

Centreon Remote enabling finished.

6. Echange de clé SSH :

Si vous n’avez pas de clé SSH privée sur le serveur central pour l’utilisateur ‘centreon’

# su - centreon
$ ssh-keygen -t rsa

Vous devez copier cette clé sur le Remote Server :

# su - centreon
$ ssh-copy-id -i .ssh/id_rsa.pub centreon@IP_POLLER

7. Sur le serveur Centreon Central, dans l’interface web Centreon, éditez tous les collecteurs rattachés au Re-
mote Server et liez ceux-ci au nouveau Remote Server via la liste de sélection.

Note : N’oubliez pas de générer la configuration de votre Remote Server.

Note : Un serveur Centreon Remote Server est un serveur dont l’administration est autonome. Ainsi, la configuration
de l’annuaire LDAP, celle des utilisateurs ainsi que celle des ACL sont propres à ce serveur et doivent être configurées
via les menus Configuration (pour les utilisateurs) et Administration (pour l’annuaire LDAP et les ACL).

10.3 Nagios Reader vers Centreon CLAPI

Nagios Reader to Centreon CLAPI est un projet libre et open source qui permet d’analyser une configuration Nagios
contenue dans les fichiers CFG et de transformer celle-ci en commandes compatibles Centreon CALPI afin de pouvoir
importer les objets dans l’interface Centreon web.
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10.3.1 Prérequis

Avant toute chose vous devez avoir une plate-forme Centreon installée et prête à l’emploi. Se référer à la documentation
d’installation de Centreon.

10.3.2 Installation

Le script nécessite le module Perl-Nagios-Object pour lire les fichiers CFG. Pour installer ce dernier, exécutez les
commandes suivantes sur votre serveur Nagios(R) :

$ yum install perl-Module-Build
$ cd /tmp
$ wget http://search.cpan.org/CPAN/authors/id/D/DU/DUNCS/Nagios-Object-0.21.20.tar.gz
$ tar xzf Nagios-Object-0.21.20.tar.gz
$ cd Nagios-Object-0.21.20
$ perl Build.PL
$ ./Build
$ ./Build test
$ ./Build install

Puis télécharger le script depuis github sur votre serveur Nagios(R) :

$ cd /tmp
$ git clone https://github.com/centreon/nagiosToCentreon.git
$ cd nagiosToCentreon

10.3.3 Utilisation

Sur une nouvelle installation de Centreon, le collecteur par défaut est appelé “Central”. Si le nom de ce dernier est
différent, vous devez modifier le script pour modifier le nom par défaut à la ligne 65 :

my $default_poller = "Central";

Pour afficher l’aide, exécutez la commande :

$ perl nagios_reader_to_centreon_clapi.pl --help
######################################################
# Copyright (c) 2005-2015 Centreon #
# Bugs to http://github.com/nagiosToCentreon #
######################################################

Usage: nagios_reader_to_centreon_clapi.pl
-V (--version) Show script version
-h (--help) Usage help
-C (--config) Path to nagios.cfg file

Pour exécuter le script lancer la commande :

$ perl nagios_reader_to_centreon_clapi.pl --config /usr/local/nagios/etc/nagios.cfg > /tmp/centreon_clapi_import_commands.txt

Exportez le fichier /tmp/centreon_clapi_import_commands.txt sur votre serveur Centreon.

Enfin exécutez la commande suivante pour importer les objets dans Centreon web :

$ /usr/share/centreon/www/modules/centreon-clapi/core/centreon -u admin -p @PASSWORD -i /tmp/centreon_clapi_import_commands.txt

10.3. Nagios Reader vers Centreon CLAPI
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Note : Remplacez @PASSWORD par le mot de passe de l’utilisateur admin de Centreon web.
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CHAPITRE 11

Programme CEIP

Rejoignez le programme CEIP d’amélioration de l’expérience utilisateur Centreon.

11.1 Programme CEIP d’amélioration de l’expérience utilisateur Cen-
treon

Centreon s’efforce en permanence de comprendre et d’anticiper les besoins de ses clients afin de fournir des produits
et des solutions de qualité. Le programme d’amélioration de l’expérience client, appelé Centreon Customer Expe-
rience Improvement Program en anglais ou CEIP, bénéficiera aux clients en nous permettant de comprendre comment
vous utilisez notre logiciel ; ceci afin que nous puissions vous fournir une amélioration continue de votre expérience
logicielle Centreon. Le programme est volontaire et anonyme. Les clients qui choisissent de participer acceptent de
partager :

— Informations telles que la version du système d’exploitation du serveur principal Centreon de la plate-forme,
ainsi que le nom et la version du SGBD

— Informations sur les produits Centreon, telles que le nombre de serveurs et le numéro de version des composants
installés sur le serveur principal de Centreon (modules et widgets)

— Informations sur la configuration Centreon tels que le nombre d’hôtes, de services, de groupes d’hôtes et les
services

— Le fuseau horaire du serveur Centreon
Au cours du processus d’installation ou de mise à jour, il vous sera demandé de participer au programme d’améliora-
tion. Gardez la case cochée pour rejoindre le programme d’amélioration.

11.2 Questions fréquemment posées (FAQ)

11.2.1 Quels sont les paramètres de configuration possibles du programme CEIP ?

La participation au programme est activée par défaut. Cependant cette option peut être modifiée dans l’interface Web.
Les options sont :

— Activée
— Désactivé

Les utilisateurs peuvent modifier l’option du menu Administration > Paramètres > Centreon UI > Envoyer des
statistiques anonymes à tout moment.
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11.2.2 Que fera Centreon avec les informations collectées ?

Les informations collectées seront utilisées pour mieux comprendre comment les clients utilisent les produits Centreon
et comment les améliorer, en résolvant les problèmes et en fournissant les nouvelles fonctionnalités les plus utiles de
manière beaucoup plus rationnelle.

11.2.3 Les informations collectées sont-elles anonymes ?

OUI ! De plus, Centreon prend de nombreuses précautions pour protéger la sécurité des informations collectées, trans-
mises et stockées. Nous collectons uniquement les données des produits Centreon. Le programme n’effectue que
les actions décrites sur cette page, et uniquement si vous décidez de participer. Ce programme ne peut pas collecter
d’informations à votre insu ou sans votre consentement.

11.2.4 Comment fonctionne le programme d’amélioration de l’expérience Cen-
treon ?

Il s’agit d’un processus automatisé qui ne nécessite aucun effort de participation et est transparent pour les utilisateurs.
Les utilisateurs choisissent simplement de participer, en accordant à Centreon l’autorisation de recevoir des données
anonymes de manière sécurisée.

11.2.5 Vais-je recevoir du spam si je participe au programme ?

Vous ne recevrez pas de courrier électronique de la part de Centreon concernant ce programme, que vous y participiez
ou non. Nous ne collectons pas d’informations personnelles identifiables dans le cadre de ce programme qui seraient
utilisées pour vous identifier ou vous contacter.

11.2.6 Ai-je besoin d’une connexion Internet ?

Une connexion Internet est requise pour participer à ce programme. Cependant, vous n’avez pas besoin d’être connecté
tout le temps. Lorsqu’une connexion Internet devient disponible, les informations sont automatiquement transmises
avec un impact minimal sur votre connexion.

11.2.7 Puis-je voir les données collectées avant leur envoi à Centreon ?

Non, les informations ne peuvent pas être affichées. Ce programme est conçu pour fonctionner avec des milliers
d’utilisateurs sans affecter leur utilisation du produit. Les données sont donc envoyées automatiquement. Les données
sont également codées et compressées pour pouvoir être traitées efficacement.

11.2.8 Combien de temps dure le programme ?

Les informations sont collectées tant que vous utilisez la version du produit pour laquelle vous avez accepté de parti-
ciper ou jusqu’à ce que vous décidiez de ne plus participer au programme.

11.2.9 A quoi sert l’ID d’installation anonyme ?

Lors du premier démarrage du serveur Centreon, un numéro aléatoire est généré, l’ID d’installation anonyme. Cet ID
est unique au serveur. Il permet d’agréger toutes les informations en provenance d’un même serveur tout en garantissant
l’anonymat du serveur.
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11.2.10 Quels produits prennent en charge le programme d’amélioration de Cen-
treon Experience ?

Le programme CEIP concerne le serveur Centreon central.

11.2. Questions fréquemment posées (FAQ)
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CHAPITRE 12

Foire Aux Questions

12.1 A propos du nouveau nommage des solutions

Pourquoi cette version s’appelle-t-elle 18.10 plutôt que 2.9 ?

Il y a deux raisons. Pour faciliter la maintenance d’une plateforme Centreon, tous ses composants logiciels et modules
possèdent maintenant le même numéro de version que la solution elle-même. Et parce que nous produirons désormais
une nouvelle solution tous les six mois, ce numéro de version prend la forme AA.MM où AA désigne l’année de sortie
et MM le mois. Vous trouverez plus de détails dans cet article de blog.

Pendant combien de temps Centreon 3.4.6 / Centreon Web 2.8 sera-t-elle supportée ?

Nous corrigerons les problèmes critiques de Centreon 3.4.6 et tous ses composants logiciels, comme Centreon Web
2.8, jusqu’en octobre 2019.

Pendant combien de temps Centreon 18.10 sera-t-elle supportée ?

Nous corrigerons les problèmes logiciels de Centreon 18.10 jusqu’en avril 2020.

Quand sera disponible la version suivante de Centreon ?

La version suivante sera disponible en avril 2019 et s’appellera Centreon 19.04.

Quel est le plan prévisionnel de disponibilité des versions Centreon ?

Centreon produira une nouvelle version tous les six mois. Référez-vous au chapitre.

12.2 Mettre à niveau en Centreon 18.10

Quelles versions de Centreon puis-je mettre à niveau en Centreon 18.10 ?

Les plateformes Centreon 2.6, 2.7 ou 2.8 peuvent être facilement mises à niveau vers 18.10. Pour les plateformes plus
anciennes, il est recommandé de mettre à jour en 2.6 dans un premier temps, puis en 18.10.

J’utilise Centreon open source version 2.x, puis-je mettre à niveau gratuitement vers 18.10 ?

Oui, vous pouvez mettre à niveau vers Centreon open source 18.10, qui est gratuit.

J’utilise Centreon EPP, MAP, BAM ou MBI, puis-je mettre à niveau en 18.10 ?

Si votre contrat de support est à jour, vous avez le droit de mettre à niveau votre plateforme en Centreon 18.10. Vous
devez contacter l’équipe support pour obtenir l’accès aux nouveaux dépôts. Vous aurez aussi besoin de nouvelles clés
de licence.
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J’utilise Centreon EPP, MAP, BAM ou MBI, la version courante de ces modules est-elle compatible avec Cen-
treon 18.10 ?

Non, vous devez mettre à niveau la plateforme complète, et donc mettre à niveau ces modules dans leur version 18.10.

J’ai souscrit en ligne à un abonnement IMP, puis-je mettre à niveau ma plateforme en 18.10 ?

Oui, si votre souscription IMP est valide, vous avez le droit de mettre à niveau votre plateforme en 18.10.

Sur quel système d’exploitation s’appuie Centreon 18.10 ?

Centreon 18.10 s’appuie sur CentOS 7 est n’est pas compatible avec les versions précédentes de CentOS.

Ma plateforme Centreon s’appuie sur CentOS 6, puis-je mettre à niveau vers 18.10 ?

Oui, vous pouvez mettre en oeuvre la procédure de migration d’une plateforme Centreon depuis CentOS 6 vers CentOS
7. Référez-vous au chapitre.

Quelle est la différence entre une migration et une mise à jour ?

Si votre plateforme s’appuie déjà sur CentOS 7, une simple mise à jour logicielle suffit à mettre à niveau en 18.10.
Si votre plateforme s’appuie encore sur CentOS 6, une procédure de migration est nécessaire pour mettre à niveau en
18.10.

Référez-vous au chapitre.

Où puis-je trouver la procédure de mise à jour d’un serveur Centreon ?

Référez-vous au chapitre.

Où puis-je trouver la procédure de migration d’un serveur Centreon ?

Référez-vous au chapitre.

Lors de la migration de CentOS 6 vers CentOS 7, dois-je migrer les Pollers en même temps que le serveur
Central ?

Il est possible de migrer les Pollers un par un, après le serveur Central. Le serveur Central 18.10 est compatible avec
la version précédente de Poller.

J’utilise le module optionnel Poller Display sur l’un de mes Pollers. Lors de la mise à niveau en 18.10, ce Poller
doit-il être transformé en Remote Server ?

Oui, car le module Poller Display n’est pas compatible avec Centreon 18.10. Ceci est détaillé plus bas dans cette FAQ.

12.3 Clés de licence logicielle pour Centreon EPP, MAP, BAM, MBI

J’utilise Centreon EPP, MAP, BAM et/ou MBI, pourquoi dois-je changer les clés de licence logicielle lors de la
mise à niveau en 18.10 ?

Nous avons changé de technologie et le format des clés de licence a été modifié avec Centreon 18.10. Les anciennes
clés de licence ne sont pas compatible avec Centreon 18.10.

Comment puis-je obtenir mes nouvelles clés de licence ?

Veuillez contacter l’équipe support. Vous devrez vous munir du fingerprint de votre serveur.

Comment puis-je trouver le fingerprint de mon serveur Centreon ?

Celui-ci est accessible depuis l’IHM Centreon, menu Administration > Extensions > Subscription
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12.4 Centreon Remote Server

La fonctionnalité Remote Server est-elle incluse dans la solution open source de Centreon ?

Oui, la nouvelle fonctionnalité Centreon Remote Server est incluse dans la solution gratuite Centreon 18.10 open
source.

Est-ce que Remote Server est un complément à Poller Display, ou bien un remplacement ?

La fonctionnalité Centreon Remote Server remplace le module Poller Display. Le module Poller Display n’est pas
compatible avec Centreon 18.10. La fonctionnalité Centreon Remote Server est intégrée à Centreon 18.10 est ne
nécessite pas de module additionnel.

Quel est la différence entre Poller Display et Remote Server ?

Poller Display est une module additionnel de Centreon, alors que Remote Server est une fonctionnalité intégrée à
la solution. L’ajout et la configuration d’un Remote Server se fait en quatre étapes simples depuis l’IHM Centreon.
Centreon Remote Server combine des fonctionnalités disponibles dans les versions 1.5 et 1.6 de Poller Display, le tout
de façon robuste et intégrée à Centreon.

Le module Poller Display est-il compatible avec Centreon 18.10 ?

Non, le module Poller Display n’est pas compatible avec Centreon 18.10.

Comment puis-je mettre à niveau un Poller Display en Remote Server ?

Référez-vous au chapitre.

12.5 Customer Experience Improvement Program (CEIP)

Où puis-je trouver de l’information sur le programme CEIP d’amélioration de l’expérience utilisateur Centreon ?

Une FAQ dédiée au programme CEIP est disponible dans la documentation.

12.6 Conformité RGPD

12.6.1 Information pour les utilisateurs Centreon afin de préparer leur conformité
RGPD

Dans un contexte de fournisseur de services d’infogérance (MSP), la plate-forme Centreon délivre un service de
supervision aux clients du fournisseur.

Stockage des informations d’identification de l’utilisateur

Pour chaque client du fournisseur, le serveur Centreon central stocke en base de données les informations d’identifi-
cation de l’utilisateur afin d’accéder au serveur de supervision :

— nom (name)
— pseudo (alias/login), mot de passe
— adresse mail
— numéro de téléphone (optionnel, pour notification associée)

Le serveur central enregistre également des paramètres additionnels pour chaque utilisateur :
— langue, fuseau horaire
— paramétrage de la notification
— groupes de contrôle d’accès (ACL)

12.4. Centreon Remote Server
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Gestion de l’information :
— Chaque utilisateur peut accéder à ses informations via le menu Administration > Paramètres > Mon compte
— Les utilisateur peuvent être créés, modifiés et supprimés depuis le menu Configuration > Utilisateurs par un

utilisateur possédant les droits nécessaires.

Journalisation des actions utilisateur

Si un utilisateur possède les droits de configuration de la supervision (défini dans les accès utilisateur), une entrée dans
le journal stockée en base de données et liée à son compte utilisateur sera présente pour chaque modification réalisée :

— L’accès aux journaux est disponible via le menu Administration > Logs avec possibilité de filtrer par utilisa-
teur.

— Ces journaux ne peuvent être supprimés qu’en accédant à la base de données SQL et en supprimant tout
enregistrement pertinent.

Transactions HTTP

Centreon recommande de sécuriser l’accès à la plate-forme de surveillance en activant le mode HTTPS sur le serveur
Apache. Un certificat officiel signé est requis pour assurer un niveau de sécurité minimum.

Authentification

Afin de rester cohérent avec votre politique de sécurité et de mieux gérer le cycle de vie et les approbations des utili-
sateurs, Centreon dispose d’une option pour activer la liaison vers un annuaire Active Directory ou LDAP. Centreon
recommande d’activer cette option et de ne pas utiliser un compte local.

Sauvegarde

Centreon fournit un module d’extraction de données Centreon pour permettre la mise en place d’une politique de
sauvegarde des données de supervision. Centreon recommande fortement d’activer ce module et surtout d’exporter la
sauvegarde sur un serveur tiers.

12.7 Administration de la plate-forme Centreon

12.7.1 Comment la fonction Supprimer des graphiques fonctionne ?

Afin de préserver les performances globales, cette action ne supprime pas toutes les données de la base de données
juste après son lancement. Les entrées seront retirées des tables index_data et metrics mais pas de la table data_bin.

La principale raison est que la table data_bin stocke rapidement une énorme quantité de données et utilise le moteur
MyISAM qui ne prend pas en charge le verrouillage par ligne Si vous essayez de supprimer trop d’entrées simultané-
ment, vous pourriez bloquer toute votre base de données pendant plusieurs heures.

Quoi qu’il en soit, cela ne signifie pas que les données resteront dans votre base de données indéfiniment. Elles seront
supprimées plus tard, en fonction de votre politique de rétention des données programmée.
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12.7.2 Mon dashboard sur plusieurs jours est indetermminé, que dois-je contrôler ?

Il s’agit d’un bug du à certaines versions mysql avec les tables partitionées
(https://bugs.mysql.com/bug.php?id=70588). Remplacer les ‘=’ par des LIKE dans les requêtes corrige le pro-
blème mais réduit les performances.

Nous vous recommandons de mettre à jour votre SGBD MySQL 5.5.36, 5.6.16, 5.7.4, MariaDB 10.0.33, 10.1.29,
10.2.10.

12.7.3 Aucun graphique ne semble être généré, que dois-je contrôler ?

Il ya plusieurs choses à vérifier lorsque les RRDs ne semblent pas être générés.

Espace disque

Par défaut, les fichiers contenant les graphiques (.rrd) sont stockés dans le répertoire /var/lib/centreon/metrics. Il est
évidemment nécessaire de disposer d’assez d’espace sur votre système de fichiers.

Permissions

Est-ce que les fichiers contenant les graphiques (.rrd) peuvent être écrit dans le répertoire /var/lib/centreon/metrics ?
Le processus qui écrit dans ce répertoire est soit cdb soit centstorage.

Plugins

Est-ce que vos plugins génèrent correctement les données de performance ? Se référer à la documentation officielle
pour plus d’informations.

Centreon Broker

Centreon Broker doit être correctement configuré. Se référer à la documentation de configuration pour plus d’infor-
mations.

Le démon cbd rrd doit être en cours d’exécution :

# systemctl status cbd
cbd.service - Centreon Broker watchdog
Loaded: loaded (/etc/systemd/system/cbd.service; enabled; vendor preset: disabled)
Active: active (running) since mer. 2018-07-18 17:46:03 CEST; 2 months 9 days ago
Process: 21410 ExecReload=/bin/kill -HUP $MAINPID (code=exited, status=0/SUCCESS)

Main PID: 9537 (cbwd)
CGroup: /system.slice/cbd.service

-9537 /usr/sbin/cbwd /etc/centreon-broker/watchdog.xml
-9539 /usr/sbin/cbd /etc/centreon-broker/central-rrd.xml
-9540 /usr/sbin/cbd /etc/centreon-broker/central-broker.xml

12.8 Performance de la plate-forme Centreon

Ce chapitre est un guide pour optimiser Centreon

12.8. Performance de la plate-forme Centreon
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12.8.1 Bases de données

Le serveur de base de données est l’un des éléments centraux de Centreon. Sa performance a un impact direct sur
l’utilisateur de l’interface web. Centreon utilise deux ou trois bases de données en fonction de votre broker :

— centreon – Stockage de la configuration
— centreon_storage – Données temps réelle et historique

Index

Les bases de données utilisent des index pour accélérer les requêtes. Dans le cas où des index sont manquants les
requêtes sont plus longues à être exécutées.

Synchronisation des index

Des fichiers d’index sont générées pour chaque version de Centreon depuis la version 2.4.0‘. Ils sont situés dans le
répertoire data normalement situé dans les répertoires bin ou www. Il y a un fichier JSON pour chaque base de
données :

— centreonIndexes.json – Index pour la base centreon
— centreonStorageIndexes.json – Index pour la base centreon_storage
— centreonStatusIndexes.json – Index pour la base centreon_status

Vérifiez si votre base de données est désynchronisée :

$ cd CENTREONBINDIR
$ ./import-mysql-indexes -d centreon -i ../data/centreonIndexes.json

Si des différences sont détectées, vous pouvez synchroniser votre base de données. Le processus prend quelques
minutes mais si votre base de données contient un fort volume de données sans index, cela peut prendre plus de
2 heures. Soyez sûre d’avoir assez de place disponible sur la partition pour reconstruire les index :

$./import-mysql-indexes -d centreon -i ../data/centreonIndexes.json -s

Note : Les index utilisés par les clés étrangères (‘foreign keys ‘) ne peuvent être synchronisés.

L’option -s ou --sync doit être utilisée pour mettre à jour la base de données. Si vous avez besoin de définir
l’utilisateur et le mot de passe, utiliser respectivement les options -u et -p.

Optimisations InnoDB

Cette section n’est pas encore documentée.

Schema des Bases de données

Le schema de la base de données Centreon peut être consulté ici :
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Le schéma de la base de données Centreon_storage ici :

12.8.2 RRDCacheD

RRDCacheD est un processus qui permet de limiter les E/S disque lors de la mise à jour des graphiques de performance
et/ou des graphiques de statut (fichiers RRDs). Pour cela, le processus RRDCacheD est appelé par le module Centreon
Broker et mutualise les écritures sur disque plutôt que d’enregistrer une à une les données issues de la collecte.
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Installation

Le processus RRDCacheD est disponible dnas le paquet rrdtool déjà installé sur votre serveur Centreon.

Configuration

Options générales

Éditer le fichier /etc/sysconfig/rrdcached et modifier les informations suivantes

# Settings for rrdcached
OPTIONS="-m 664 -l unix:/var/rrdtool/rrdcached/rrdcached.sock -s rrdcached -b /var/rrdtool/rrdcached -w 3600 -z 3600 -f 7200"
RRDC_USER=rrdcached

Note : L’ordre des options est très important, si l’option ** -m 664** est placée après l’option -l
unix :/var/rrdtool/rrdcached/rrdcached.sock alors la socket sera créée avec les mauvais droits.

Concernant les autres options importantes :

Op-
tion

Description

-w Les données sont écrites sur le disques toutes les x secondes (ici 3600s donc 1h)
-z Doit être inférieur ou égale à l’option -w. RRDCacheD utilise une valeur aléatoire dans l’intervalle [0 :-z]

pour décaler l’écriture d’un fichier afin d’éviter que trop d’écritures soient mises en attente simultanément.
-f Correspond à un temps maximum de mise à jour (timeout). Si dans le cache des valeurs sont supérieures

ou égales au nombre de secondes définies, alors celle-ci sont automatiquement écrite sur le disque.

Note : Ces valeurs doivent être adaptées en fonction du besoin/des contraintes de la plate-forme concernée !

Configuration des groupes

Créer les groupes en exécutant les commandes suivantes

# usermod -a -g rrdcached centreon-broker
# usermod -a -g rrdcached apache
# usermod -a -g centreon rrdcached
# usermod -a -g centreon-broker rrdcached

Redémarrer le processus Apache pour prendre en compte les modifications

# /etc/init.d/httpd restart

Démarrer le processus RRDCacheD

# /etc/init.d/rrdcached start

Configurer le processus dans l’interface web Centreon

Se rendre dans le menu Administration -> Options -> RRDTool, activer l’utilisation du processus et renseigner
l’accès au socket /var/rrdtool/rrdcached/rrdcached.sock :

12.8. Performance de la plate-forme Centreon
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Warning : Attention, même si la modification a été réalisé dans le menu Administration, il est nécessaire d’ex-
porter la configuration et de redémarrer le processus centreon-broker via un export de la configuration du serveur
central et un redémarrage du processus cbd.

Interface web Centreon

La mise en place de rrdcached fait que les graphiques ne sont plus mis à jours en temps réel. Il est donc possible de
voir un petit blanc sur la droite de certains graphiques. Cela veut dire que les données sont encore dans le cache du
processus, cela est normal !

Warning : Attention, si le processus crash pour une raison quelconque (aucune en théorie c’est plutôt stable), les
données sont perdues, donc aucun moyen de les rejouer sauf en reconstruisant les graphiques via centreon-broker.
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CHAPITRE 13

Comment déployer la supervision ?

Avec Centreon vous avez la possibilité de superviser des environnements relativement variés. Serveurs, application,
UPS, sites web, équipements réseau : tous ces environnements ont leur spécificités. C’est pour cette raison que Cen-
treon met à disposition de ses utilisateurs des “Plugins Packs” basés sur les centreon plugins. Pour vous aider à
implémenter facilement ces derniers au sein de votre Centreon, cette documentation a pour vocation de vous aider à
configurer la supervision de ces environnements dans Centreon.

13.1 Implementation du SSO

13.1.1 Comment fonctionne le SSO avec Centreon ?

Voici un exemple d’architecture SSO avec LemonLDAP :
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1. L’utilisateur s’authentifie sur le portail SSO

2. Le portail d’authentification vérifie les droits d’accès auprès du serveur LDAP

3. Le serveur LDAP renvoie les données de l’utilisateur

4. Le portail d’authentification crée une session pour stocker les données de l’utilisateur et renvoie un cookie SSO
à l’utilisateur

5. L’utilisateur est redirigé vers Centreon Web and intercepté par le handler SSO wui vérifie les droits d’accès de
l’utilisateur

6. Le handler envoie une requête à Centreon Web avec l’en-tête d’authentification (ex : HTTP_AUTH_USER)

7. Centreon Web vérifie les droits d’accès auprès du serveur LDAP grâce à l’en-tête de la requête

8. Le serveur LDAP renvoie les informations d el’utilisateur

9. Centreon Web renvoie les informations au handler

10. Le handler SSO transfère les informations à l’utilisateur
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13.1.2 Comment configurer le SSO dans Centreon ?

Vous pouvez configurer le SSO dans le menu Administration > Paramètres :

Pour plus d’informations, se référer ici

13.1.3 Avertissement de sécurité

La fonctionnalité SSO doit être activée seulement dans un environnement dédié et sécurisé pour le SSO. Les accès
direct des utilisateurs à Centreon Web doivent être désactivés.

Si vous avez des expériences que vous souhaitez partager avec la communauté Centreon, n’hésitez pas à vous en faire
part sur le github de Centreon. Votre guide pourrait faire partie de la documentation officielle de Centreon.

13.1. Implementation du SSO
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CHAPITRE 14

Developper

Ce chapitre est une reprise sans traduction de la documentation anglaise.

14.1 How to write a module

You want to create a new module for Centreon 2 or to adapt an existing one ? You’re at the right place !

You should know Centreon contains a page dedicated to the installation and the uninstallation of modules (Administra-
tion > Modules). To make the module appears on this page, its directory must be placed inside Cetreon’s modules/
directory. Example :

/usr/local/centreon/www/modules/module-Dummy

An empty module template can be found inside ‘Centreon’s repository
<http://svn.centreon.com/trunk/module-Dummy>‘_.

*****
Basis

*****

The essential elements your module’s directory must contain are presented below (\* = required):

**[conf.php]\***::

// Short module’s name. Must be equal to your module’s directory name
$module_conf[’dummy’][’name’] = "dummy";
// Full module’s name
$module_conf[’dummy’][’rname’] = "Dummy Module";
// Module’s version
$module_conf[’dummy’][’mod_release’] = "2.0";
// Additional information
$module_conf[’dummy’][’infos’] = "First of all";
// Allow your module to be uninstalled
$module_conf[’dummy’][’is_removeable’] = "1";
// Module author’s name
$module_conf[’dummy’][’author’] = "Centreon Team";
// 1: the module executes an SQL file for installation and/or uninstallation
// 0: the module doesn’t execute any SQL file
$module_conf[’dummy’][’sql_files’] = "1";
// 1: the module executes a PHP file for installation and/or uninstallation
// 0: the module doesn’t execute any SQL file
$module_conf[’dummy’][’php_files’] = "1";
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[infos > infos.txt]

This file can contain various information about your module.

[php > install.php]

This PHP file is executed at module installation if it is configured inside the conf.php file.

[php > uninstall.php]

This PHP file is executed at module uninstallation if it is configured inside the conf.php file.

[sql > install.sql]

This SQL file is executed during the module installation if it is configured inside the conf.php file. If you want your
module to be available from Centreon menus, you must insert new entries into the topology table of the centreon
database. An example is available inside the Dummy module.

[sql > uninstall.sql]

This SQL file is executed during the module uninstallation if it is configured inside the conf.php file. It can also remove
your module from Centreon menus.

[generate_files > *.php]

The PHP files contained inside the generate_files directory will be executed during the configuration files
generation (inside Configuration > Monitoring Engines). Those files must generate configuration files.

[UPGRADE > dummy-x.x > sql > upgrade.sql]

Centreon provides an upgrade system for modules. To use it, just add a directory under UPGRADE named using the
following pattern : <module name>-<version>. When clicking on the upgrade button, Centreon will search for
scripts to execute, following the logical order of versions.

For example, if the version 1.0 of the dummy module is installed and the following directories exist :

$ ls UPGRADE
dummy-1.1 dummy-1.2

Centreon will execute the scripts in the following order : 1.1, 1.2. A configuration file in each upgrade directory is
present in order to allow (or not) the execution.

You’re free to organize the remaining files (your module’s content) as you like.

14.1.1 Advanced

That’s great, you know how to install a module ! As an empty module is not really usefull, put your imagination at
work. Knowing that you can do almost everything, it should not be too complicated :-).

Connecting to the database

You can use the centreon, centstorage and ndo databases by calling the following file :
centreon/www/class/centreonDB.class.php.

For example, execute requests like this :

<?
$pearDB = new CentreonDB();
$pearDB->query("SELECT * FROM host");
?>
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Existing functions

You can access most of the functions already developed within Centreon using include() statements. They’re
generally stored in centreon/www/class/.

Before developing your own function, check the existing code, it could spare your time !

14.2 How to write a widget

Centreon (since version 2.4) offers a custom view system which allows user to view one or different widgets in the
same page : Home > Custom views.

You may have specific needs that are not yet covered by our widget catalog and this tutorial will explain to you how
to write your first widget for Centreon.

14.2.1 Should I make a widget or a module ?

If you are wondering if you should be making a module or a widget, then ask yourself if your project is meant to
contain many menus or is it rather a plain page which is going to display little information ?

Of course, you could make a widget that would only work with a certain module.

14.2.2 Directory structure

Widgets work pretty much like Modules. They have to be placed in the following directory :

# centreon/www/widgets/name-of-your-widget/

Your widget must contain one mandatory file named configs.xml at its root.

14.2.3 Configuration file

This is the XML configuration file of our Dummy widget :

<configs>
<title>Dummy</title>
<author>Centreon</author>
<email>contact@centreon.com</email>
<website>http://www.centreon.com</website>
<description>Dummy widget</description>
<version>1.0.3</version>
<keywords>dummy, widget, centreon</keywords>
<screenshot></screenshot>
<thumbnail>./widgets/dummy/resources/logoCentreon.png</thumbnail>
<url>./widgets/dummy/index.php</url>
<autoRefresh></autoRefresh>
<preferences>

<preference label="text preference" name="text preference" defaultValue="default value" type="text"/>
<preference label="boolean preference" name="boolean preference" defaultValue="1" type="boolean"/>
<preference label="date" name="date" defaultValue="" type="date"/>
<preference label="host preference" name="host preference" defaultValue="" type="host"/>
<preference label="list preference" name="list preference" defaultValue="none" type="list">

<option value="all" label="all"/>
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<option value="none" label="none"/>
</preference>
<preference label="range preference" name="range preference" defaultValue="5" type="range" min="0" max="50" step="5"/>
<preference label="host search" name="host search" defaultValue="notlike _Module_%" type="compare"/>

</preferences>
</configs>

Now, let’s see what these tags refer to.

Basic tags

* = Mandatory tag

Tag nameDescription
title* Title of your widget
author* Your name
email Your email address
website URL of your project
descrip-
tion*

Short description of your widget

version* Version of your widget. Increment this number whenever you publish a new version.
keywords A few key words that describe your widget
screenshot Screenshot that shows the best side of your widget. Screenshot should be placed within your widget

directory.
thumbnail Logo of your project. Best size is 100px x 25px. Thumbnail shoud be placed within your widget

directory.
url* Path of the main page of your widget
autorefresh This parameter is not implemented yet

Parameter attributes

* = Mandatory parameter

Tag
attributes

Description

label* Label of the parameter
name* Name of the parameter that will be used for retrieving its value
defaultVa-
lue*

Default Value of the parameter

requirePer-
mission

Value can be “1” or “0”. When set to 1, this parameter will not be shown to unauthorized users.

type* Parameter type, must be one of the following :
text,boolean,date,list,range,compare,host,hostgroup, hostTemplate,servicegroup,serviceTemplate

min* For range type only. It refers to the minimum value of the range parameter
max* For range type only. It refers to the maximum value of the range parameter
step* For range type only. It refers to the step value of the range parameter
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Parameter type

Type name Description
text Renders a text input element
boolean Renders a checkbox
date Renders two text input elements. One for the date of

start, the other one for the date of end.
list Renders a selectbox. The selectbox will be populated

with the option tags which have to be defined within the
preference tag.

range Renders a selectbox which will be populated with values
depending on the min, max and step definitions.

compare Renders a selectbox and a text input. Selectbox will
contain SQL operands such as :
> : greater than
< : less than
>= : greater or equal
<= : less or equal
= : equal
!= : not equal
LIKE : can be used with the wildcard %%
NOT LIKE : can be used with the wildcard %%

host Renders a selectbox populated with a list of hosts.
hostgroup Renders a selectbox populated with a list of hostgroups.
hostTemplate Renders a selectbox populated with a list of host tem-

plates.
servicegroup Renders a selectbox populated with a list of service-

groups.
serviceTemplate Renders a selectbox populated with a list of service tem-

plates.

The preference window would look like this as a result :

14.2.4 Code

Now, let’s see how you could retrieve the parameter values in your PHP code.

widgets/dummy/index.php :
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<?php
// required classes
require_once "/etc/centreon/centreon.conf.php";
require_once _CENTREON_PATH_ . "www/class/centreon.class.php";
require_once _CENTREON_PATH_ . "www/class/centreonSession.class.php";
require_once _CENTREON_PATH_ . "www/class/centreonDB.class.php";
require_once _CENTREON_PATH_ . "www/class/centreonWidget.class.php";

// check if session is alive
session_start();
if (!isset($_SESSION[’centreon’])) {

echo "Session expired";
exit;

}
$centreon = $_SESSION[’centreon’];

// variable initialization
$db = new CentreonDB();
$widget = new CentreonWidget($centreon, $db);

// retrieve widget preferences
$preferences = $widget->getWidgetPreferences($_GET[’widgetId’]);
// print the retrieved preferences
print_r($preferences);
?>

The result :

Array ( [text preference] => default value
[boolean preference] => 1
[date] =>
[host preference] =>
[list preference] => none
[range preference] => 5
[host search] => notlike _Module_% )

14.3 How to write a Stream Connector

14.3.1 Overview

Centreon Stream Connector is a feature introduced in Centreon 3.4.6. It allows one to export Centreon data (events
and metrics) to an external storage or application such as ElasticSearch, Splunk, InfluxDB, files, etc.

In a Centreon platform, the component that carries information between the remote pollers and the Centreon central
server is called Centreon Broker. This broker stores received data into the Centreon local storage : MariaDB and
RRDtool.

The following diagram explains the transfer of collected data and insertion into storages :
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The Stream Connector functionality is a new Centreon Broker output getting data from Centreon Broker Master (also
known as Centreon Broker SQL) to aggregate and forward it to external storage :

This output loads a Lua script called a Stream Connector, which job is to handle, aggregate and enrich the data before
forwarding it to the defined protocol :

Because it is an output of Centreon Broker, the principle of creating retention files upon interrupting external storage
access is retained. In the same way, it is possible to filter input on the categories of flow to handle.

14.3.2 Requirements

To use the Centreon Stream connector functionality you need to update your Centreon platform to Centreon 3.4.6 :
— Centreon Web >= 2.8.18
— Centreon Broker >= 3.0.13
— Lua >= 5.1.x

14.3.3 Creating a new Lua script

The complete technical documentation is available here. In this how-to, we will write two scripts :
— The first one, easy, that explains the basics of Stream Connectors. Its goal is to export data to a log file.
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— The second one is more exigent for the reader ; it exports performance data to the TSDB InfluxDB but is easily
adaptable to export to another TSDB.

Programming language

Centreon chose the Lua programming language to let you handle, aggregate and transfer data. Lua is a programming
language that is easy to use. You can find more information with the Lua official documentation

Storage of Lua scripts

Broker’s Lua scripts can be stored in any directory readable by the centreon-broker user.

We recommend to store them in /usr/share/centreon-broker/lua.

Note : In a near future, this directory will be in the default path of the Lua scripts launched by broker. It will then be
easier to use user defined Lua libraries because you will just have to add your libraries there like stream connectors.

Write all information into a file

Store raw data

Let’s start with the first script. Our goal is to store all events given by Broker in a log file. We will call our stream
connector bbdo2file.lua.

As we said previously, we will store this file into the /usr/share/centreon-broker/lua directory on the Centreon central
server.

If the directory does not exist, as root, we can create it with the following command :

mkdir -p /usr/share/centreon-broker/lua

Centreon Broker provides several log functions to write logs, warnings or errors into a file. We will use one of these
functions info() to write Broker events. See technical documentation for more information.

The function info() makes part of the broker_log object. To call it, the syntax is the following :

broker_log:info(level, text)

— level is an integer from 1 (most important) to 3 (least important).
— text is the text to write as log.

Note : Did you notice the separator between broker_log and info, yes it is a colon ! Objects functions, also called
methods are called like this in Lua.

Let’s start our script. The more important function in a stream connector is the write() function. Each time an event is
received from a poller through Broker, this function is called with the event as an argument.

Note : You will never have to call the write() function by yourself, it is always Broker’s work to do so. And it would
be a fault to make such a call. In other words, there should not be any call to the write() function in your script.

See technical documentation for more information.

Here is the bbdo2file.lua first version :
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function init(conf)
broker_log:set_parameters(3, "/var/log/centreon-broker/bbdo2file.log")

end

function write(d)
for k,v in pairs(d) do
broker_log:info(3, k .. " => " .. tostring(v))

end
return true

end

Note : Information about the initialization of the Broker’s log function and its parameters are given here see technical
documentation.

Let’s explain what we are doing in this script.

We must provide an init() function, it is described in the technical documentation.

This function is called during the stream connector initialization. Here, we use it to initialize the broker_log object.
To achieve this, we call the broker_log : :set_parameters() method that needs two parameters :

— A max level (from 1 to 3). If you give 2 here, only logs of levels 1 and 2 will be returned.
— A file to write the logs in. This file must be in a writable directory for the centreon-broker user.

The second function is the write() function. We already said its argument is a Broker event. This type of object is a
collection of keys/values. For example :

{
"check_hosts_freshness": false,
"active_host_checks": true,
"category": 1,
"event_handlers": true,
"instance_id": 1,
"last_command_check": 1522836592,
"type": 65552,
"global_service_event_handler": "",
"obsess_over_services": false,
"passive_service_checks": true,
"last_alive": 1522836593,
"active_service_checks": true,
"check_services_freshness": true,
"flap_detection": false,
"global_host_event_handler": "",
"notifications": true,
"obsess_over_hosts": false,
"passive_host_checks": true,
"element": 16

}

In all events, you will find category, element and type.
— Information about the category can be found here in the bbdo documentation
— The element is the sub-category (also called type in the bbdo documentation).
— The type is a number built from the category and the element (binary concatenation).

In this example, the category is 1 and the element is 16. So, by reading the documentation, we can say this event is a
NEB event with sub-category instance-status.

To finish with the write() function, we make a loop on the d event parameters. For each step, k is a key and v is the
corresponding value. And we send to the log file a string k .. ” => ” .. tostring(v) that means the concatenation of k,
=> and v converted into a string. You will see an example of the result below.
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Another possibility would be to use the broker.json_encode(d) function that converts any Lua object to a json string
representation of it. So, we could write the function like this :

function write(d)
broker_log:info(3, broker.json_encode(d))
return true

end

Note : You can notice that broker.json_encode(d) is made of broker and json_encode(d) separated by a dot and not
a colon. This is because broker is not a Lua object. In fact, you can see it as a functions set provided by Centreon
Broker.

Once your file /usr/share/centreon-broker/lua/bbdo2file.lua is ready, verify it is readable by the centreon-broker
user (or the centreon-engine user who is the owner of the centreon-broker group), if it is not the case, as root you
can enter :

# chown centreon-engine:centreon-engine /usr/share/centreon-broker/lua/bbdo2file.lua

Then configure the new output into Centreon Web interface in Configuration > Pollers > Broker configuration >
Central Broker. In Output tab select Generic – Stream connector and click Add :

Define the name of this output and the path to the Lua connector :

Then click Save and go to generate the configuration and restart cbd.
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Once the Centreon Broker will be restarted on your Centreon central server, data will appear in your /var/log/centreon-
broker/bbdo2file.log log file :

mer. 28 mars 2018 14:27:35 CEST: INFO: flap_detection => true
mer. 28 mars 2018 14:27:35 CEST: INFO: enabled => true
mer. 28 mars 2018 14:27:35 CEST: INFO: host_id => 102
mer. 28 mars 2018 14:27:35 CEST: INFO: last_time_ok => 1522240053
mer. 28 mars 2018 14:27:35 CEST: INFO: state => 0
mer. 28 mars 2018 14:27:35 CEST: INFO: last_update => 1522240054
mer. 28 mars 2018 14:27:35 CEST: INFO: last_check => 1522240053
mer. 28 mars 2018 14:27:35 CEST: INFO: execution_time => 0.005025
mer. 28 mars 2018 14:27:35 CEST: INFO: acknowledged => false
mer. 28 mars 2018 14:27:35 CEST: INFO: service_id => 778
mer. 28 mars 2018 14:27:35 CEST: INFO: active_checks => true
mer. 28 mars 2018 14:27:35 CEST: INFO: notify => false
mer. 28 mars 2018 14:27:35 CEST: INFO: max_check_attempts => 3
mer. 28 mars 2018 14:27:35 CEST: INFO: obsess_over_service => true
mer. 28 mars 2018 14:27:35 CEST: INFO: check_type => 0
mer. 28 mars 2018 14:27:35 CEST: INFO: last_hard_state_change => 1522165654
mer. 28 mars 2018 14:27:35 CEST: INFO: category => 1
mer. 28 mars 2018 14:27:35 CEST: INFO: perfdata => used=41986296644o;48103633715;54116587930;0;60129542144 size=60129542144o
mer. 28 mars 2018 14:27:35 CEST: INFO: check_interval => 5
mer. 28 mars 2018 14:27:35 CEST: INFO: output => Disk /var - used : 39.10 Go - size : 56.00 Go - percent : 69 %
mer. 28 mars 2018 14:27:35 CEST: INFO: check_command => check-bench-disk
mer. 28 mars 2018 14:27:35 CEST: INFO: check_period => 24x7
mer. 28 mars 2018 14:27:35 CEST: INFO: type => 65560
mer. 28 mars 2018 14:27:35 CEST: INFO: last_hard_state => 0

Note : This log file will grow quickly, do not forget to add a log rotate.

Use parameters

The Centreon Broker log functions should be used for log only. To write into a file, we must use the Lua dedicated
function. Moreover, it is possible to use parameters to define the name of the log file.

So it is time to improve our Stream Connector :

function init(conf)
logFile = conf[’logFile’]
broker_log:set_parameters(3, "/var/log/centreon-broker/debug.log")

end

function writeIntoFile(output)
local file,err = io.open(logFile, ’a’)
if file == nil then
broker_log:info(3, "Couldn’t open file: " .. err)

else
file:write(output)
file:close()

end
end

function write(d)
for k,v in pairs(d) do
writeIntoFile(k .. " => " .. tostring(v) .. "\n")

end
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return true
end

Did you notice that expression local file,err = io.open(logFile, ‘a’) ?

Lua is able to store several variables at the same time. Also, Lua functions can return several variables !

For example, if you want to swap variables a and b, you can enter :

a, b = b, a

Another example that illustrates several values returned :

function fib(a, b)
return b, a + b

end

So, this call to io.open returns two variables, a first variable file that is a file descriptor used to access the file and a
second variable not always defined that contains error if one occurs or nil (not defined) otherwise.

The init() function allows to get parameters and define these from Centreon web interface. See technical documentation
for more information. Here, we add the possibility to choose the destination file name. The conf table has a key logFile
defined in the web interface. The corresponding value is the file name used to store events.

Edit your Broker output to declare this parameter :

It is important that the name of the parameter in the web interface matches the key name in the conf table. Here, it is
logFile.

Then click Save and go to generate the configuration and restart cbd.

Data are stored into /var/log/centreon-broker/bbdo2file.log log file as this :

name => error
category => 3
interval => 300
rrd_len => 3456000
value => 0
value_type => 0
type => 196612
ctime => 1522315660
index_id => 4880
element => 4
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state => 0
category => 3
interval => 300
rrd_len => 3456000
is_for_rebuild => false
service_id => 1056
type => 196609
ctime => 1522315660
host_id => 145
element => 1
is_for_rebuild => false
metric_id => 11920

Manipulate data

Here, we continue to improve our stream connector by choosing what events to export and also by improving outputs.

We will select only the NEB category and the events regarding hosts and services status.

We know that NEB is the category 1, also service status is the sub-category 24, whereas host status is the sub-category
14.

So, only events with the following criteria :
— category = 1
— element = 14 or element = 24

are interesting for us.

Moreover, we would prefer to have a host name instead of a host id and a service description instead of a service id.

At last, we would be interested to get status information and outputs.

NEB Events with elements 14 and 24 give almost all we want except host names and service descriptions.

To get those two information, we will have to use the broker_cache object. This one is filled when pollers are restarted
or reloaded. So, do not forget to restart your pollers if you want something in your broker_cache object !

If the cache is well filled, it is easy to get a host name from the host id :

broker_cache:get_hostname(host_id)

And it is also easy to get the service description from the host id and service id :

broker_cache:get_service_description(host_id, service_id)

To install the filter on events, there is a useful function called filter() that takes two parameters into account : category,
element.

This function, if defined, is called just before write(). If it returns true, the write() function will be called, otherwise,
the event will be thrown away.

Let’s complete our Lua script :

function init(conf)
logFile = conf[’logFile’]
broker_log:set_parameters(3, "/var/log/centreon-broker/debug.log")

end

local function writeIntoFile(output)
local file,err = io.open(logFile, ’a’)
if file == nil then
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broker_log:info(3, "Couldn’t open file: " .. err)
else
file:write(output)
file:close()

end
end

function write(d)
local output = ""

local host_name = broker_cache:get_hostname(d.host_id)
if not host_name then
broker_log:info(3, "Unable to get name of host, please restart centengine")
host_name = d.host_id

end

if d.element == 14 then
output = "HOST:" .. host_name .. ";" .. d.host_id .. ";" .. d.state .. ";" .. d.output
writeIntoFile(output)
broker_log:info(output)

elseif d.element == 24 then
local service_description = broker_cache:get_service_description(d.host_id, d.service_id)
if not service_description then
broker_log:info(3, "Unable to get description of service, please restart centengine")
service_description = d.service_id

end
output = "SERVICE:" .. host_name .. ";" .. d.host_id .. ";" .. service_description .. ";" .. d.service_id .. ";" .. d.state .. ";" .. d.output
writeIntoFile(output)
broker_log:info(output)

end
return true

end

function filter(category, element)
-- Get only host status and services status from NEB category
if category == 1 and (element == 14 or element == 24) then
return true

end
return false

end

Just several remarks on this new script before showing what we get.

In the init() function, we access the logFile key in the conf table by using conf[’logFile’]. Whereas, in the write()
function, we access the element key in the d table by using d.element...

In fact, the two syntaxes are allowed : d.element is the same value than d[’element’].

Another remark, in the write() function we can see something like :

if not host_name then

And in the writeIntoFile() function, we can see that :

if file == nil then

Do they mean the same thing ? Where is the difference ?

You must know that in Lua, a variable is considered to be true if it is defined and not false :

so, the following code
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if toto then
print("Good")

else
print("Bad")

end

will write Good if toto is defined and not false. More precisely, it will write Good in the following cases :
— toto=12
— toto=true
— toto=”A string”
— toto=0 (surprising !)

It will write Bad in these cases :
— toto=nil (by default a variable is nil, which means not defined)
— toto=false

The /var/log/centreon-broker/bbdo2file.log file will now contain :

HOST:srv-DC-djakarta;215;0;OK - srv-DC-djakarta: rta 0.061ms, lost 0%
SERVICE:mail-titan-gateway;92;disk-/usr;623;0;Disk /usr - used : 42.98 Go - size : 142.00 Go - percent : 30 %
SERVICE:mail-sun-master;87;memory-stats;535;0;Memory usage (Total 13.0GB): 0.12GB [buffer:0.00GB] [cache:0.01GB] [pages_tables:0.00GB] [mapped:0.00GB] [active:0.07GB] [inactive:0.00GB] [apps:0.02GB] [unused:12.88GB]
SERVICE:mail-saturn-frontend;86;traffic-eth1;512;0;Traffic In : 4.73 Mb/s (4.73 %), Out : 4.79 Mb/s (4.79 %) - Total RX Bits In : 396.01 Gb, Out : 393.88 Gb
SERVICE:mail-saturn-frontend;86;memory-stats;515;0;Memory usage (Total 16.0GB): 8.89GB [buffer:0.43GB] [cache:0.95GB] [pages_tables:0.27GB] [mapped:0.15GB] [active:3.92GB] [inactive:0.29GB] [apps:2.88GB] [unused:7.11GB]
SERVICE:mail-neptune-frontend;80;traffic-eth1;392;0;Traffic In : 4.82 Mb/s (4.82 %), Out : 6.48 Mb/s (6.48 %) - Total RX Bits In : 398.40 Gb, Out : 396.44 Gb
HOST:srv-DC-casablanca;207;0;OK - srv-DC-casablanca: rta 2.042ms, lost 0%
SERVICE:mail-neptune-frontend;80;memory-stats;395;0;Memory usage (Total 9.0GB): 0.54GB [buffer:0.03GB] [cache:0.00GB] [pages_tables:0.01GB] [mapped:0.00GB] [active:0.48GB] [inactive:0.00GB] [apps:0.01GB] [unused:8.46GB]
SERVICE:mail-mercury-frontend;82;traffic-eth1;432;0;Traffic In : 8.28 Mb/s (8.28 %), Out : 1.23 Mb/s (1.23 %) - Total RX Bits In : 397.71 Gb, Out : 400.34 Gb
SERVICE:mail-mercury-frontend;82;memory-stats;435;0;Memory usage (Total 12.0GB): 1.58GB [buffer:0.00GB] [cache:0.63GB] [pages_tables:0.00GB] [mapped:0.00GB] [active:0.75GB] [inactive:0.00GB] [apps:0.19GB] [unused:10.42GB]
SERVICE:mail-mars-frontend;84;traffic-eth1;472;0;Traffic In : 7.24 Mb/s (7.24 %), Out : 3.36 Mb/s (3.36 %) - Total RX Bits In : 399.93 Gb, Out : 395.67 Gb
SERVICE:mail-mars-frontend;84;memory-stats;475;0;Memory usage (Total 3.0GB): 1.19GB [buffer:0.01GB] [cache:0.59GB] [pages_tables:0.00GB] [mapped:0.00GB] [active:0.15GB] [inactive:0.04GB] [apps:0.39GB] [unused:1.81GB]
SERVICE:mail-jupiter-frontend;85;traffic-eth1;492;0;Traffic In : 1.41 Mb/s (1.41 %), Out : 9.08 Mb/s (9.08 %) - Total RX Bits In : 388.86 Gb, Out : 394.85 Gb
SERVICE:mail-jupiter-frontend;85;memory-stats;495;0;Memory usage (Total 12.0GB): 0.57GB [buffer:0.04GB] [cache:0.23GB] [pages_tables:0.02GB] [mapped:0.02GB] [active:0.07GB] [inactive:0.03GB] [apps:0.16GB] [unused:11.43GB]
SERVICE:mail-io-backend;88;traffic-eth1;547;0;Traffic In : 1.51 Mb/s (1.51 %), Out : 7.12 Mb/s (7.12 %) - Total RX Bits In : 389.61 Gb, Out : 390.54 Gb
SERVICE:mail-io-backend;88;diskio-system;551;0;Device /dev/sda: avg read 4.78 (MB/s) and write 9.08 (MB/s)

14.3.4 Export performance data to InfluxDB

Now, you have already seen many things about stream connectors. It is time to create something more useful !

InfluxDB is a Time Series database. We will use this storage to insert performance data collected by the Centreon
platform. For this example, we will use the predefined InfluxDB Docker.

To send data to InfluxDB, we need parameters to access to InfluxDB storage :
— http_server_address : IP address of the storage
— http_server_port : 8086 by default
— http_server_protocol : http or https
— influx_database : name of database
— influx_user : user to access to database if defined
— influx_password : password of user to access to database if defined

In order to not saturate the storage, we will add all events in a queue and once its max size is reached, we will send
data by bulk.

We need to define the size of the queue and the maximum delay before sending events :
— max_buffer_size
— max_buffer_age

To create this queue, we introduce a code a little more complicated. We construct an object event_queue. It is compo-
sed of parameters such as events, influx_database and methods like new(), add().
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To understand how to create such an object in Lua, we recommend the Lua documentation here for classes and there
for metatables.

To send data to a server, we provide a broker_tcp_socket object.

Its API is very simple (too simple ?). This socket is a TCP socket, it does not support encryption and it can be tricky to
send data in http. Here is an example :

-- Here, we create our socket
local socket = broker_tcp_socket.new()

-- We establish the connection with the server
socket:connect(address, port)

-- Now, we can send data
socket:write("This is a text to send")

-- If, we want an answer, we also have a function to read
local content = socket:read()

-- When exchanges are finished, we can close the socket
socket:close()

For our purpose, we do not use broker_tcp_socket because of its limitations. We want to be able to send data to an
https server.

A prerequisite is to install the lua-socket library. This library provides several functionalities, we need two of them :
— http socket
— ltn12

To access them, Lua provides the require function.

Let’s introduce the beginning of our new Stream Connector.

The queue parameters

-- We declare the objects to import here
local http = require("socket.http")
local ltn12 = require("ltn12")

-- Here are predefined queue parameters
local event_queue = {

__internal_ts_last_flush = nil,
http_server_address = "",
http_server_port = 8086,
http_server_protocol = "http",
events = {},
influx_database = "mydb",
influx_user = "",
influx_password = "",
max_buffer_size = 5000,
max_buffer_age = 5

}

In this table, we give default values to parameters that can possibly be changed during the init() call. This table will
be used to store important data for the script and is also our queue object.
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A method to create the queue

To declare this table as a Lua object, we need a constructor. So, here it is :

-- Constructor of the event_queue
function event_queue:new(o, conf)
o = o or {}
setmetatable(o, self)
self.__index = self
for i,v in pairs(conf) do
if self[i] and i ~= "events" and string.sub(i, 1, 11) ~= "__internal_" then

broker_log:info(1, "event_queue:new: getting parameter " .. i .. " => " .. v)
self[i] = v

else
broker_log:warning(1, "event_queue:new: ignoring parameter " .. i .. " => " .. v)

end
end
self.__internal_ts_last_flush = os.time()
broker_log:info(2, "event_queue:new: setting the internal timestamp to " .. self.__internal_ts_last_flush)
return o

end

Note : In this function, we use a Lua sugar “o = o or {}” that means o stays the same if it is true, otherwise it is
affected with an empty table {}.

Another point to notice is the ~= operator that means different from.

And to finish on this function, the variable self is implicitly defined when we declare an object’s method. Its meaning
is the same as this in Java or in C++. It represents the object we are working on.

A method to add event in queue

We have a queue object. It would be great to use it like this :

-- We construct it
local queue = event_queue:new(nil, conf)

-- We add an event to it
queue:add(event)

-- When the queue is full, we would like to do something like this
queue:flush()

Let’s do it ! Below, we present an add() method that retrieves a host name and service description from the cache,
builds a string from the event and pushes it on its stack.

function event_queue:add(e)
local metric = e.name
-- time is a reserved word in influxDB so I rename it
if metric == "time" then
metric = "_" .. metric

end

-- retrieve objects names instead of IDs
local host_name = broker_cache:get_hostname(e.host_id)
local service_description = broker_cache:get_service_description(e.host_id, e.service_id)
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-- what if we could not get them from cache
if not host_name then
broker_log:warning(1, "event_queue:add: host_name for id " .. e.host_id .. " not found. Restarting centengine should fix this.")
host_name = e.host_id

end
if not service_description then
broker_log:warning(1, "event_queue:add: service_description for id " .. e.host_id .. "." .. e.service_id .. " not found. Restarting centengine should fix this.")
service_description = e.service_id

else
service_description = service_description:gsub(" ", "_")

end

-- we finally append the event to the events table
metric = metric:gsub(" ", "_")
broker_log:info(3, ’event_queue:add: adding ’ .. service_description .. ",host=" .. host_name .. " " .. metric .. "=" .. e.value .. " " .. e.ctime .. ’000000000" to event list.’)
self.events[#self.events + 1] = service_description .. ",host=" .. host_name .. " " .. metric .. "=" .. e.value .. " " .. e.ctime .. "000000000\n"

-- then we check whether it is time to send the events to the receiver and flush
if #self.events >= self.max_buffer_size then
broker_log:info(2, "event_queue:add: flushing because buffer size reached " .. self.max_buffer_size .. " elements.")
self:flush()
return true

elseif os.time() - self.__internal_ts_last_flush >= self.max_buffer_age then
broker_log:info(2, "event_queue:add: flushing " .. #self.events .. " elements because buffer age reached " .. (os.time() - self.__internal_ts_last_flush) .. "s and max age is " .. self.max_buffer_age .. "s.")
self:flush()
return true

else
return false

end
end

A method to flush the queue

Once the events added in the queue and the maximum size of the queue or the timeout is reached, events will be sent
to the InfluxDB storage.

This function builds data from the queue and sends them to the storage. If an error occurs, it dumps a log error.

It is here that we use the http and ltn12 objects loaded at the beginning of the script.

function event_queue:flush()
broker_log:info(2, "event_queue:flush: Concatenating all the events as one string")
-- we concatenate all the events
local http_post_data = ""
local http_result_body = {}
for i, raw_event in ipairs(self.events) do
http_post_data = http_post_data .. raw_event

end
broker_log:info(2, ’event_queue:flush: HTTP POST request "’ .. self.http_server_protocol .. "://" .. self.http_server_address .. ":" .. self.http_server_port .. "/write?db=" .. self.influx_database .. ’"’)
broker_log:info(3, "event_queue:flush: HTTP POST data are: ’" .. http_post_data .. "’")

-- build url
local influxdb_url = self.http_server_protocol .. "://" .. self.http_server_address .. ":" .. self.http_server_port .. "/write?db=" .. self.influx_database
-- add authentication if needed
if string.len(self.influx_user) >= 1 and string.len(self.influx_password) >= 1 then
influxdb_url = influxdb_url .. "&u=" .. self.influx_user .. "&p="..self.influx_password

end
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local hr_result, hr_code, hr_header, hr_s = http.request{
url = influxdb_url,
method = "POST",
-- sink is where the request result’s body will go
sink = ltn12.sink.table(http_result_body),
-- request body needs to be formatted as a LTN12 source
source = ltn12.source.string(http_post_data),
headers = {

-- mandatory for POST request with body
["content-length"] = string.len(http_post_data)

}
}
-- Handling the return code
if hr_code == 204 then
broker_log:info(2, "event_queue:flush: HTTP POST request successful: return code is " .. hr_code)

else
broker_log:error(1, "event_queue:flush: HTTP POST request FAILED: return code is " .. hr_code)
for i, v in ipairs(http_result_body) do

broker_log:error(1, "event_queue:flush: HTTP POST request FAILED: message line " .. i .. ’ is "’ .. v .. ’"’)
end

end

-- now that the data has been sent, we empty the events array
self.events = {}
-- and update the timestamp
self.__internal_ts_last_flush = os.time()

end

The init() function to get parameters and create the queue

In this case, the init() function creates the queue with parameters defined by users in the web interface or uses default
parameters already defined in the queue. This alternative is managed by the queue constructor.

function init(conf)
broker_log:set_parameters(1, "/var/log/centreon-broker/stream-connector-influxdb.log")
broker_log:info(2, "init: Beginning init() function")
queue = event_queue:new(nil, conf)
broker_log:info(2, "init: Ending init() function, Event queue created")

end

Note : queue is not defined as local, this is important so that it is accessible from all the functions.

The write() function to insert events in queue

The write() function is only used to insert filtered events into the queue :

function write(e)
broker_log:info(3, "write: Beginning write() function")
queue:add(e)
broker_log:info(3, "write: Ending write() function\n")
return true

end
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The filter() function to select only performance data events

To select only performance data, we need to select category 3 (“Storage”) and element 1 for metric :

function filter(category, element)
if category == 3 and element == 1 then
return true

end
return false

end

Complete script

The complete script can be downloaded here.

Configure Centreon Broker

Configure the new output into Centreon Web interface in Configuration > Pollers > Broker configuration > Central
Broker. In Output tab select Generic – Stream connector and click Add :

Define the name of this output and the path to the Lua connector :
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Then click Save and go to generate the configuration and restart cbd.

Note : Don’t forget to restart “centengine” too to create the Centreon Broker cache.

If you install the Grafana dashboard, you can visualize the stored data :

Discover other Centreon Stream Connectors

Centreon provides a Github repository to host Lua scripts developed by Centreon and the community. Please go to the
dedicated Github.

Need help to develop your Stream connector ? You want to share your experience with the community ? Join the
Centreon community Slack channel.

14.4 How to translate Centreon

If you want to contribute to translate Centreon, this new tutorial is for you ! Discover how to translate Centreon web
interface and how to help us to add new language in Centreon.

14.4.1 Install translation environment

Download the following archive and copy it on a Linux server.

Execute the following commands :

$ unzip centreon-translation.zip
$ cd centreon-translation

Your environment to translate Centreon is now ready.

14.4.2 First generation

During the first generation, the script will clone Centreon sources from GitHub on your server.

Execute the following command :

$ bash make-translation.sh

At the end of execution, two files are available :
— messages.pot to translate Centreon web interface menu and forms
— help.pot to translate help tooltips in configuration forms
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Rename messages.pot to messages.po and help.po to help.po

You can now start translation of Centreon by editing files with a PO file editor like poedit.

Note : Keep always your *.po files for next translation.

14.4.3 Use your translation

On your Centreon server, install gettext :

$ sudo yum install gettext

Create the locale directory for your Centreon :

$ sudo mkdir -p /usr/share/centreon/www/locale/‘locale | grep LC_MESSAGES | cut -d \" -f 2‘/LC_MESSAGES

Note : /usr/share/centreon is the Centreon installed directory.

If you want to translate Centreon in other language than use by your Centreon server, you have to define manually the
locale.

For example, for Brazilian users, execute the following command :

$ sudo mkdir -p /usr/share/centreon/www/locale/pt_BR/LC_MESSAGES

Compile translated files :

$ msgfmt messages.po -o messages.mo
$ msgfmt help.pot -o help.mo

Copy compiled translated files :

$ sudo cp *.mo /usr/share/centreon/www/locale/‘locale | grep LC_MESSAGES | cut -d \" -f 2‘/LC_MESSAGES

Change rights on directory :

$ sudo chown -R apache.apache /usr/share/centreon/www/locale/‘locale | grep LC_MESSAGES | cut -d \" -f 2‘

Restart Apache :

$ sudo service httpd restart

Connect to your Centreon web interface, edit your profil and select new language :
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Save the form and access to another menu, your interface will be translated.

14.4.4 Upgrade translation

Centreon developers released every month a new version of Centreon Web. So translation could be modified with
every new release.

To maintain translation up-to-date follow this steps :

$ bash make-translation.sh

At the end of execution, two files up-to-date are available :
— messages.pot to translate Centreon Web interface menu and forms
— help.pot to translate help tooltips in configuration forms

Merge this files with previous translation (messages.po and help.po) :

$ msgmerge help.po help.pot -o new_help.po
$ msgmerge messages.po messages.pot -o new_messages.po

Follow chapter “Use your translation” to upgrade translation for Centreon.

14.4.5 Participate to Centreon project

Once your translation is up-to-date, you can ask to the Centreon team to add your translation to Centreon project. This
will allow for all person using Centreon to have access to your translation on their Centreon platform.

— Create an account on GitHub
— Fork centreon/centreon project on GitHub
— Add your translated *.mo and *.po files to lang/<your_lang>/LC_MESSAGES directory
— Commit your change on your project
— Create a pull request on centreon/centreon project
— We will add your translation to Centreon.

Thank you for your help !
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CHAPITRE 15

API

Ce chapitre est une reprise sans traduction de la documentation anglaise.

15.1 API Rest

15.1.1 Introduction

Welcome to the Centreon API rest documentation. This documentation is for developers familiar with HTTP requests
and JSON. It explains various API operations, related request and response structure, and error codes. If you are not
familiar with the JSON API, we recommend you to use the Centreon command line API documentation.

This documentation is available in english only.

15.1.2 Permissions

To perform API calls using a specific Centreon user, you need permissions to do so.

There are two types of permission :

You can give access to the configuration for a specific Centreon user. To do so you have to edit user settings on the
menu Configuration > Users > Contacts/Users, edit user and on second tab check box Reach API Configuration.

You can give access to the realtime for a specific Centreon user. To do so you have to edit user settings on the menu
Configuration > Users > Contacts/Users, edit user and on second tab check box Reach API Realtime.

If you want both then check both checkboxes

15.1.3 Authentication

Using POST method and the URL below :

api.domain.tld/centreon/api/index.php?action=authenticate

Body form-data :

Parameter Type Value
username Text The user name you use to login on Centreon
password Text Your Centreon password

The response is a json flow getting back the authentication token
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{
"authToken": "NTc1MDU3MGE3M2JiODIuMjA4OTA2OTc="
}

This token will be used later on the other API actions.

15.1.4 Realtime information

Host Status

All monitoring information regarding hosts are available in throw the Centreon API.

Using GET method and the URL below :

api.domain.tld/centreon/api/index.php?object=centreon_realtime_hosts&action=list

Header :
key value
Content-Type application/json
centreon-auth-token the value of authToken you got on the authentication response

Parameters

You can pass a list of parameters in order to select the data you want.

Parameters values
viewType select the predefined filter like in the monitoring view : all, unhandled, problems
fields the fields list that you want to get separated by a ”,”
status the status of hosts that you want to get (up, down, unreachable, pending, all)
hostgroup hostgroup id filter
instance instance id filter
search search pattern applyed on host name
criticality a specific criticity
sortType ASC ou DESC
limit number of line you want
number page number
order the order type (selected in the field list)

Field list :
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Fields Description
id host id
name host name
alias host alias (description of the host)
address host address (domain name or ip)
state host state (UP = 0, DOWN = 2, UNREA = 3)
state_type host state type (SOFT = 0, HARD = 1)
output Plugin output - state message
max_check_attempts maximum check attempts
check_attempt current attempts
last_check last check time
last_state_change last time the state change
last_hard_state_change last time the state change in hard type
acknowledged acknowledged flag
instance name of the instance who check this host
instance_id id of the instance who check this host
criticality criticality fo this host
passive_checks accept passive results
active_checks active checks are enabled
notify notification is enabled
action_url shortcut for action URL
notes_url shortcut for note URL
notes note
icon_image icone image for this host
icon_image_alt title of the image
scheduled_downtime_depth scheduled_downtime_depth
flapping is the host flapping ?

Using GET method and the URL below :

api.domain.tld/centreon/api/index.php?object=centreon_realtime_hosts&action=list&limit=60&viewType=all&sortType=name&order=desc&fields=id,name,alias,address,state,output,next_check

Service Status

All monitoring information regarding services are available in throw the Centreon API. With this call, you can also
get host informations in the same time that service information. This web service provide the same possibility that the
service monitoring view.

Using GET method and the URL below :

api.domain.tld/centreon/api/index.php?object=centreon_realtime_services&action=list

Header :
key value
Content-Type application/json
centreon-auth-token the value of authToken you got on the authentication response

Parameters

You can pass a list of parameters in order to select the data you want.
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Parameters values
viewType select the predefined filter like in the monitoring view : all, unhandled, problems
fields the fields list that you want to get separated by a ”,”
status the status of services that you want to get (ok, warning, critical, unknown, pending, all)
hostgroup hostgroup id filter
servicegroup servicegroup id filter
instance instance id filter
search search pattern applied on service
searchHost search pattern applied on host
searchOutput search pattern applied on output
criticality a specific criticity
sortType ASC ou DESC
limit number of line you want
number page number
order the order type (selected in the field list)

Field list :

Fields Description
host_id host id
host_name host name
host_alias host alias (description of the host)
host_address host address (domain name or ip)
host_state host state (UP = 0, DOWN = 2, UNREA = 3)
host_state_type host state type (SOFT = 0, HARD = 1)
host_output Plugin output - state message
host_max_check_attempts maximum check attempts for host
host_check_attempt current attempts
host_last_check last check time
host_acknowledged acknowledged flag
instance name of the instance who check this host
instance_id id of the instance who check this host
host_action_url shortcut for action URL
host_notes_url shortcut for note URL
host_notes note
description service description - service name
display_name service display name
service_id service id
state service state
state_type service state type (SOFT = 0, HARD = 1)
output service output returned by plugins
perfdata service perfdata returned by plugins
current_attempt maximum check attempts for the service
last_update last update date for service
last_state_change last time the state change
last_hard_state_change last time the state change in hard type
next_check next check time for service
max_check_attempts maximum check attempts for service
action_url shortcut for action URL
notes_url shortcut for note URL
notes notes
icone_image icone image for service
passive_checks accept passive results
active_checks active checks are enabled

Suite sur la page suivante
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TABLE 15.1 – Suite de la page précédente
Fields Description
acknowledged acknowledged flag
notify notification is enabled
scheduled_downtime_depth scheduled_downtime_depth
flapping is the host flapping ?
event_handler_enabled is the event-handfler enabled
criticality criticality fo this service

Example :

Using GET method and the URL below :

api.domain.tld/centreon/api/index.php?action=list&object=centreon_realtime_services&limit=60&viewType=all&sortType=name&order=desc&fields=id,description,host_id,host_name,state,output

Submit results

You can use the centreon API to submit information to the monitoring engine. All information that you submit will be
forwarded to the centreon engine poller that host the configuration.

To provide information, Centreon need to have specific and mandatory information.

The user must be admin or have access to “Reach API Configuration”.

For the service submission please provide the following information :

Fields Description
host host name
service service description
status status id (0, 1, 2, 3) or ok, warning, critical, unknown
output a specific message
perfdata (optional) all performance metric following the nagios plugin API
updatetime the check time (timestamp)

For the host submission please provide the following information :

Fields Description
host host name
status status id (0, 1, 2, 3)
output a specific message
updatetime the check time (timestamp)

To send status, please use the following URL using POST method :

api.domain.tld/centreon/api/index.php?action=submit&object=centreon_submit_results

Header
key value
Content-Type application/json
centreon-auth-token the value of authToken you got on the authentication response

Example of service body submit : The body is a json with the parameters provided above formated as below :

{
"results": [
{

"updatetime": "1528884076",
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"host": "Centreon-Central"
"service": "Memory",
"status": "2"
"output": "The service is in CRITICAL state"
"perfdata": "perf=20"

},
{

"updatetime": "1528884076",
"host": "Centreon-Central"
"service": "fake-service",
"status": "1"
"output": "The service is in WARNING state"
"perfdata": "perf=10"

}
]

}

Example of body response : : : The response body is a json with the HTTP return code and a message for each
submit :

{
"results": [
{

"code": 202,
"message": "The status send to the engine"

},
{

"code": 404,
"message": "The service is not present."

}
]

}

15.1.5 Configuration

Getting started

Most of the actions available (about 95%) in the command line API is available in the rest API.

Here is an example for listing hosts using rest API.

Using POST method and the URL below :

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header :
key value
Content-Type application/json
centreon-auth-token the value of authToken you got on the authentication response

Body :

{
"action": "show",
"object": "HOST"

}
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— The key action corresponds to the option -a in Centreon CLAPI, the value show corresponds to the -a option
value.

— The key object corresponds to the option -o in Centreon CLAPI, the value HOST corresponds to the -o option
value.

The equivalent action using Centreon CLAPI is :

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a show

Response : The response is a json flow listing all hosts and formated as below :

{
"result": [
{

"id": "12",
"name": "mail-uranus-frontend",
"alias": "mail-uranus-frontend",
"address": "mail-uranus-frontend",
"activate": "1"

},
{

"id": "13",
"name": "mail-neptune-frontend",
"alias": "mail-neptune-frontend",
"address": "mail-neptune-frontend",
"activate": "1"

},
{

"id": "14",
"name": "srvi-mysql01",
"alias": "srvi-mysql01",
"address": "srvi-mysql01",
"activate": "1"

}
]

}

Note : Some actions need the values key ( the option -v in Centreon CLAPI ). Depending on the called action, the
body can contain values key. We will see that in detail later.

API Calls

All API calls you can do on objects are described below. Note that you need to be authenticate before each call.

API calls on the Host object are fully-detailed below. For the next objects, only the actions available are listed, so just
follow the same approach as for the host object for an API call.

Host

List hosts

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi
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Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "show",
"object": "host"

}

Response

{
"result": [

{
"id": "79",
"name": "mail-uranus-frontend",
"alias": "mail-uranus-frontend",
"address": "mail-uranus-frontend",
"activate": "1"

},
{
"id": "80",
"name": "mail-neptune-frontend",
"alias": "mail-neptune-frontend",
"address": "mail-neptune-frontend",
"activate": "1"

},
{
"id": "81",
"name": "mail-earth-frontend",
"alias": "mail-earth-frontend",
"address": "mail-earth-frontend",
"activate": "1"

}
]
}

Add host

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "add",
"object": "host",
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"values": "test;Test host;127.0.0.1;generic-host;central;Linux-SerVers"
}

Response

{
"result": []

}

Delete host

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "del",
"object": "host",
"values": "test"

}

Response

{
"result": []

}

Set parameters

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "setparam",
"object": "host",
"values": "test;ParameterToSet;NewParameter"

}

Available parameters
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Parameter Description
2d_coords 2D coordinates (used by statusmap)
3d_coords 3D coordinates (used by statusmap)
action_url Action URL
activate Whether or not host is enabled
active_checks_enabled Whether or not active checks are enabled
address Host IP Address
alias Alias
check_command Check command
check_command_arguments Check command arguments
check_interval Normal check interval
check_freshness Check freshness (in seconds)
check_period Check period
checks_enabled Whether or not checks are enabled
contact_additive_inheritance Enables contact additive inheritance
cg_additive_inheritance Enables contactgroup additive inheritance
event_handler Event handler command
event_handler_arguments Event handler command arguments
event_handler_enabled Whether or not event handler is enabled
first_notification_delay First notification delay (in seconds)
flap_detection_enabled Whether or not flap detection is enabled
flap_detection_options Flap detection options
icon_image Icon image
icon_image_alt Icon image text
max_check_attempts Maximum number of attempt before a HARD state is declared
name Host name
normal_check_interval value in minutes
notes Notes
notes_url Notes URL
notifications_enabled Whether or not notification is enabled
notification_interval Notification interval
notification_options Notification options
notification_period Notification period
obsess_over_host Whether or not obsess over host option is enabled
passive_checks_enabled Whether or not passive checks are enabled
process_perf_data Process performance data command
retain_nonstatus_information Whether or not there is non-status retention
retain_status_information Whether or not there is status retention
retry_check_interval Retry check interval
snmp_community Snmp Community
snmp_version Snmp version
stalking_options Comma separated options : ‘o’ for OK, ‘d’ for Down, ‘u’ for Unreachable
statusmap_image Status map image (used by statusmap
host_notification_options Notification options (d,u,r,f,s)
timezone Timezone

Response

{
"result": []

}
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Set instance poller

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "setinstance",
"object": "host",
"values": "test;Poller-2"

}

Response

{
"result": []

}

Get macro

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "getmacro",
"object": "host",
"values": "mail-uranus-frontend"

}

Response Here is a response example

{
"result": [
{
"macro name": "ALIVENUM",
"macro value": "1",
"is_password": "",
"description": "",
"source": "generic-host-bench"

},
{
"macro name": "ALIVEWARNING",
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"macro value": "3000,80",
"is_password": "",
"description": "",
"source": "generic-host-bench"

},
{
"macro name": "ALIVECRITICAL",
"macro value": "5000,100",
"is_password": "",
"description": "",
"source": "generic-host-bench"

}
]
}

Set macro

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "setmacro",
"object": "host",
"values": "mail-uranus-frontend;MacroName;NewValue"

}

To edit an existing custom macro, The MacroName used on the body should be defined on the Custom Marco of the
chosen host. If the marco doesn’t exist, it will be created.

Response

{
"result": []

}

Delete macro

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body
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{
"action": "delmacro",
"object": "host",
"values": "mail-uranus-frontend;MacroName"

}

The MacroName used on the body is the macro to delete. It should be defined on the Custom Marco of the chosen
host.

Response

{
"result": []

}

Get template

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "gettemplate",
"object": "host",
"values": "mail-uranus-frontend"

}

Response Here is a response example

{
"result": [
{

"id": "3",
"name": "Servers-Linux"

},
{

"id": "62",
"name": "Postfix-frontend"

},
{

"id": "59",
"name": "Cyrus-murder-frontend"

}
]
}
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Set template

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "settemplate",
"object": "host",
"values": "mail-uranus-frontend;MyHostTemplate"

}

The MyHostTemplate used on the body should exist as a host template. The new template erase templates already
exist.

Response : : { “result” : [] }

Add template

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "addtemplate",
"object": "host",
"values": "mail-uranus-frontend;MyHostTemplate"

}

The MyHostTemplate used on the body should exist as a host template. The new template is added without erasing
template already linked

Response : : { “result” : [] }

Delete template

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi
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Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "deltemplate",
"object": "host",
"values": "mail-uranus-frontend;MyHostTemplate"

}

The MyHostTemplate used on the body should exist as a host template.

Response : : { “result” : [] }

Apply template

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "applytpl",
"object": "host",
"values": "mail-uranus-frontend"

}

Response : : { “result” : [] }

Get parent

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "getparent",
"object": "host",
"values": "mail-uranus-frontend"

}

15.1. API Rest
CENTREON 46-52 RUE ALBERT FR75014 PARIS

393



Response

{
"result": [
{

"id": "219",
"name": "mail-uranus-frontdad"

}
]

}

Add parent

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "addparent",
"object": "host",
"values": "mail-uranus-frontend;fw-berlin"

}

Response

{
"result": []

}

To add more than one parent to a host, use the character ‘|’. Ex :

"values": "mail-uranus-frontend;fw-berlin|fw-dublin"

The add action add the parent without overwriting he previous configuration.

Set parent

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body
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{
"action": "setparent",
"object": "host",
"values": "mail-uranus-frontend;fw-berlin"

}

Response

{
"result": []

}

To set more than one parent to a host, use the character ‘|’. Ex :

"values": "mail-uranus-frontend;fw-berlin|fw-dublin"

The set action overwrite the previous configuration before setting the new parent.

Delete parent

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "delparent",
"object": "host",
"values": "mail-uranus-frontend;fw-berlin"

}

Response

{
"result": []

}

To delete more than one parent, use the character ‘|’. Ex :

"values": "mail-uranus-frontend;fw-berlin|fw-dublin"

Get contact group

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi
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Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "getcontactgroup",
"object": "host",
"values": "mail-uranus-frontend"

}

Response

{
"result": [

{
"id": "6",
"name": "Mail-Operators"

}
]
}

Add contact group

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "addcontactgroup",
"object": "host",
"values": "mail-uranus-frontend;Supervisors"

}

Response

{
"result": []

}

To add more than one contactgroup to a host, use the character ‘|’. Ex :

"values": "mail-uranus-frontend;Supervisors|Guest"

The add action add the contact without overwriting he previous configuration.
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Set contact group

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "setcontactgroup",
"object": "host",
"values": "mail-uranus-frontend;Supervisors"

}

Response

{
"result": []

}

To set more than one contactgroup to a host, use the character ‘|’. Ex :

"values": "mail-uranus-frontend;Supervisors|Guest"

The set action overwrite the previous configuration before setting the new contactgroup.

Delete contact group

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "delcontactgroup",
"object": "host",
"values": "mail-uranus-frontend;Guest"

}

Response

{
"result": []

}

To delete more than one contactgroup, use the character ‘|’. Ex :
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"values": "mail-uranus-frontend;Guest|Supervisors"

Get contact

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "getcontact",
"object": "host",
"values": "mail-uranus-frontend"

}

Response

{
"result": [

{
"id": "20",
"name": "user-mail"

}
]
}

Add contact

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "addcontact",
"object": "host",
"values": "mail-uranus-frontend;admin"

}

Response
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{
"result": []

}

To add more than one contact to a host, use the character ‘|’. Ex :

"values": "mail-uranus-frontend;admin|SuperAdmin"

The add action add the contact without overwriting he previous configuration.

Set contact

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "setcontact",
"object": "host",
"values": "mail-uranus-frontend;admin"

}

Response

{
"result": []

}

To set more than one contact to a host, use the character ‘|’. Ex :

"values": "mail-uranus-frontend;admin|SuperAdmin"

The set action overwrite the previous configuration before setting the new contact.

Delete contact

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body
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{
"action": "delcontact",
"object": "host",
"values": "mail-uranus-frontend;Guest"

}

Response

{
"result": []

}

To delete more than one contact, use the character ‘|’. Ex :

"values": "mail-uranus-frontend;admin|SuperAdmin"

Get hostgroup

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "gethostgroup",
"object": "host",
"values": "mail-uranus-frontend"

}

Response

{
"result": [
{

"id": "53",
"name": "Linux-Servers"

},
{

"id": "63",
"name": "Mail-Cyrus-Frontend"

}
]

}

Add hostgroup

POST
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api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "addhostgroup",
"object": "host",
"values": "mail-uranus-frontend;Mail-Postfix-Frontend"

}

Response

{
"result": []

}

To add more than one hostgroup to a host, use the character ‘|’. Ex :

"values": "mail-uranus-frontend;Mail-Postfix-Frontend|Linux-Servers"

The add action add the hostgroup without overwriting he previous configuration.

Set hostgroup

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "sethostgroup",
"object": "host",
"values": "mail-uranus-frontend;Linux-Servers"

}

Response

{
"result": []

}

To set more than one hostgroup to a host, use the character ‘|’. Ex :

"values": "mail-uranus-frontend;Linux-Servers|Mail-Postfix-Frontend"

The set action overwrite the previous configuration before setting the new hostgroup.
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Delete hostgroup

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "delhostgroup",
"object": "host",
"values": "mail-uranus-frontend;Linux-Servers"

}

Response

{
"result": []

}

To delete more than one hostgroup, use the character ‘|’. Ex :

"values": "mail-uranus-frontend;Linux-Servers|Mail-Postfix-Frontend"

Enable

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "enable",
"object": "host",
"values": "mail-uranus-frontend"

}

Response

{
"result": []

}
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Disable

POST

api.domain.tld/centreon/api/index.php?action=action&object=centreon_clapi

Header
key value
Content-Type application/json
centreon_auth_token the value of authToken you got on the response of the authentication part

Body

{
"action": "disable",
"object": "host",
"values": "mail-uranus-frontend"

}

Response

{
"result": []

}

ACL

Object
— ACL

Actions
— reload
— lastreload

Action ACL

Object
— ACLACTION

Actions
— show
— add
— del
— setparam
— getaclgroup
— grant
— revoke
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ACL groups

Object
— ACLGROUP

Actions
— show
— add
— del
— setparam
— getmenu
— getaction
— getresource
— getcontact
— getcontactgroup
— setmenu
— setaction
— setresource
— addmenu
— addaction
— addresource
— delmenu
— delaction
— delresource
— setcontact
— setcontactgroup
— addcontact
— addcontactgroup
— delcontact
— delcontactgroup

Menu ACL

Object
— ACLMENU

Actions
— show
— add
— del
— setparam
— getaclgroup
— grant
— revoke

Resource ACL

Object
— ACLRESOURCE

Actions
— show
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— add
— del
— setparam
— getaclgroup
— grant
— revoke

Centreon Broker

Object
— CENTBROKERCFG

Actions
— show
— add
— del
— setparam
— listinput, listoutput, listlogger, listcorrelation, listtemporary, liststats
— getinput , getoutput, getlogger, getcorrelation, gettemporary, getstats
— addinput, addoutput, addlogger, addcorrelation, addtemporary, addstats
— delinput, deloutput, dellogger, delcorrelation, deltemporary, delstats
— setinput, setoutput, setlogger, setcorrelation, settemporary, setstats

CGI CFG

Object
— CGICFG

Actions
— show
— add
— del
— setparam

Commands

Object
— CMD

Actions
— show
— add
— del
— setparam

Contacts

Object
— CONTACT

Actions
— show
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— add
— del
— setparam
— enable
— disable

Contact templates

Object
— CONTACTTPL

Actions
— show
— add
— del
— setparam
— enable
— disable

Contact groups

Object
— CG

Actions
— show
— add
— del
— setparam
— enable
— disable
— getcontact
— addcontact
— setcontact
— delcontact

Dependencies

Object
— DEP

Actions
— show
— add
— del
— setparam
— listdep
— addparent
— addchild
— delparent
— delchild
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Downtimes

Object
— DOWNTIME

Actions
— show
— add
— del
— listperiods
— addweeklyperiod
— addmonthlyperiod
— addspecificperiod
— addhost, addhostgroup, addservice, addservicegroup
— delhost, delhostgroup, delservice, delservicegroup
— sethost, sethostgroup, setservice, setservicegroup

Host template

Object
— HTPL

Actions APPLYTPL and SETINSTANCE actions on HTPL
— show
— add
— del
— setparam
— getmacro
— setmacro
— delmacro
— getparent
— addparent
— setparent
— delparent
— getcontactgroup
— addcontactgroup
— setcontactgroup
— delcontactgroup
— getcontact
— addcontact
— setcontact
— delcontact
— gethostgroup
— addhostgroup
— sethostgroup
— delhostgroup
— setseverity
— unsetseverity
— enable
— disable
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Host categories

Object
— HC

Actions
— show
— add
— del
— getmember
— addmember
— setmember
— setseverity
— unsetseverity
— delmember

Hostgroups

Object
— HG

Actions
— show
— add
— del
— setparam
— getmember
— addmember
— setmember
— delmember

Instances ( Pollers)

Object
— INSTANCE

Actions
— show
— add
— del
— setparam
— gethosts

Service templates

Object
— STPL

Actions
— show
— add
— del
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— setparam
— addhosttemplate
— sethosttemplate
— delhosttemplate
— getmacro
— setmacro
— delmacro
— getcontact
— addcontact
— setcontact
— delcontact
— getcontactgroup
— setcontactgroup
— delcontactgroup
— gettrap
— settrap
— deltrap

Services

Object
— SERVICE

Actions
— show
— add
— del
— setparam
— addhost
— sethost
— delhost
— getmacro
— setmacro
— delmacro
— setseverity
— unsetseverity
— getcontact
— addcontact
— setcontact
— delcontact
— getcontactgroup
— setcontactgroup
— delcontactgroup
— gettrap
— settrap
— deltrap

Service groups

Object
— SG

Actions
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— show
— add
— del
— setparam
— getservice
— gethostgroupservice
— addservice
— setservice
— addhostgroupservice
— sethostgroupservice
— delservice
— delhostgroupservice

Service categories

Object
— SC

Actions
— show
— add
— del
— setparam
— getservice
— getservicetemplate
— addservice
— setservice
— addservicetemplate
— setservicetemplate
— delservice
— delservicetemplate
— setseverity
— unsetseverity

Time periods

Object
— TIMEPERIOD

Actions
— show
— add
— del
— setparam
— getexception
— setexception
— delexception

Traps

Object
— TRAP
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Actions
— show
— add
— del
— setparam
— getmatching
— addmatching
— delmatching
— updatematching

Vendors

Object
— VENDOR

Actions
— show
— add
— del
— setparam
— generatetraps

15.1.6 Code errors

Code Messages
200 Successful
400

— Missing parameter
— Missing name parameter
— Unknown parameter
— Objects are not linked

401 Unauthorized
404

— Object not found
— Method not implemented into Centreon API

409
— Object already exists
— Name is already in use
— Objects already linked

500 Internal server error (custom message)

15.2 CLAPI

Centreon CLAPI is a Centreon API that enables users to configure their monitoring system through command lines.

This documentation aims to introduce all the actions you can perform with Centreon CLAPI, from adding host objects
to restarting a remote monitoring poller.

Contents :
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15.2.1 Overview

Centreon CLAPI aims to offer (almost) all the features that are available on the user interface in terms of configuration.

Features

— Add/Delete/Update objects such as hosts, services, host templates, host groups, contacts etc...
— Generate configuration files
— Test configuration files
— Move configuration files to monitoring pollers
— Restart monitoring pollers
— Import and export objects

Basic usage

All actions in Centreon CLAPI will require authentication, so your commands will always start like this :

# cd /usr/share/centreon/bin
# ./centreon -u admin -p centreon [...]

Obviously, the -u option is for the username and the -p option is for the password. The password can be in clear or the
encrypted in the database.

Note : If your passwords are encoded with SHA1 in database (MD5 by default), use the -s option :

# ./centreon -u admin -p centreon -s [...]

15.2.2 Poller management

List available pollers

In order to list available pollers, use the POLLERLIST command :

[root@centreon core]# ./centreon -u admin -p centreon -a POLLERLIST
poller_id;name
1;Local Poller
2;Remote Poller

Generate local configuration files for a poller

In order to generate configuration files for poller “Local Poller” of id 1, use the POLLERGENERATE command :

[root@centreon core]# ./centreon -u admin -p centreon -a POLLERGENERATE -v 1
Configuration files generated for poller 1

You can generate the configuration using the poller name :

[root@centreon core]# ./centreon -u admin -p centreon -a POLLERGENERATE -v "Local Poller"
Configuration files generated for poller ’Local Poller’
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Test monitoring engine configuration of a poller

In order to test configuration files for poller “Remote Poller” of id 2, use the POLLERTEST command :

[root@centreon core]# ./centreon -u admin -p centreon -a POLLERTEST -v 1
OK: Nagios Poller 2 can restart without problem...

You can test the configuration using the poller name :

[root@centreon core]# ./centreon -u admin -p centreon -a POLLERTEST -v "Local Poller"
Warning: Nagios Poller poller can restart but configuration is not optimal. Please see debug bellow :
---------------------------------------------------------------------------------------------------
[1440681047] [15559] Reading main configuration file ’/usr/share/centreon//filesGeneration/nagiosCFG/5/nagiosCFG.DEBUG’.
[1440681047] [15559] Warning: temp_path variable ignored
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/hosts.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/hostTemplates.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/serviceTemplates.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/services.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/misccommands.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/checkcommands.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/contactgroups.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/contactTemplates.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/contacts.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/hostgroups.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/servicegroups.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/timeperiods.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/escalations.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/dependencies.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/connectors.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/centreon-bam-command.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/centreon-bam-contact.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/centreon-bam-contactgroup.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/centreon-bam-dependencies.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/centreon-bam-escalations.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/centreon-bam-host.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/centreon-bam-services.cfg’
[1440681047] [15559] Processing object config file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/centreon-bam-timeperiod.cfg’
[1440681047] [15559] Reading resource file ’/usr/share/centreon/filesGeneration/nagiosCFG/5/resource.cfg’
[1440681047] [15559] Checking global event handlers...
[1440681047] [15559] Checking obsessive compulsive processor commands...
[1440681047] [15559]
[1440681047] [15559] Checked 55 commands.
[1440681047] [15559] Checked 0 connectors.
[1440681047] [15559] Checked 7 contacts.
[1440681047] [15559] Checked 0 host dependencies.
[1440681047] [15559] Checked 0 host escalations.
[1440681047] [15559] Checked 0 host groups.
[1440681047] [15559] Checked 1 hosts.
[1440681047] [15559] Checked 0 service dependencies.
[1440681047] [15559] Checked 0 service escalations.
[1440681047] [15559] Checked 0 service groups.
[1440681047] [15559] Checked 1 services.
[1440681047] [15559] Checked 5 time periods.
[1440681047] [15559]
[1440681047] [15559] Total Warnings: 1
[1440681047] [15559] Total Errors: 0

---------------------------------------------------------------------------------------------------
Return code end : 0
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Move monitoring engine configuration files

In order to move configuration files for poller “Local Poller” of id 1 to the final engine directory, use the CFGMOVE
command :

[root@centreon core]# ./centreon -u admin -p centreon -a CFGMOVE -v 2
OK: All configuration will be send to ’Remote Poller’ by centcore in several minutes.
Return code end : 1

You can move the configuration files using the poller name :

[root@centreon core]# ./centreon -u admin -p centreon -a CFGMOVE -v "Remote Poller"
OK: All configuration will be send to ’Remote Poller’ by centcore in several minutes.
Return code end : 1

Restart monitoring engine of a poller

In order to restart the monitoring process on poller “Local Poller” of id 1, use the the POLLERRESTART command :

[root@centreon core]# ./centreon -u admin -p centreon -a POLLERRESTART -v 2
OK: A restart signal has been sent to ’Remote Poller’
Return code end : 1

You can restart the poller using its name :

[root@centreon core]# ./centreon -u Remote Poller -p centreon -a POLLERRESTART -v "Remote Poller"
OK: A restart signal has been sent to ’Remote Poller’
Return code end : 1

All in one command

Use the APPLYCFG command in order to execute all of the above with one single command :

[root@centreon core]# ./centreon -u admin -p centreon -a APPLYCFG -v 1

You can execute using the poller name :

[root@centreon core]# ./centreon -u admin -p centreon -a APPLYCFG -v "Remote Poller"

This will execute POLLERGENERATE, POLLERTEST, CFGMOVE and POLLERRELOAD.

Reload monitoring engine of a poller

In order to reload the monitoring process on poller “Remote Poller” of id 2, use the POLLERRELOAD command :

[root@centreon core]# ./centreon -u admin -p centreon -a POLLERRELOAD -v 2
OK: A reload signal has been sent to Remote Pollerpoller’
Return code end : 1

You can reload poller using its name :

[root@centreon core]# ./centreon -u admin -p centreon -a POLLERRELOAD -v "Remote Poller"
OK: A reload signal has been sent to ’Remote Poller’
Return code end : 1
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Execute post generation commands of a poller

In order to execute post generation commands of a poller, use the POLLEREXECCMD command :

[root@centreon core]# ./centreon -u admin -p centreon -a POLLEREXECCMD -v 2
Running configuration check...done.
Reloading nagios configuration...done

You can execute post generation commands of a poller using its name :

[root@centreon core]# ./centreon -u admin -p centreon -a POLLEREXECCMD -v "Remote Poller"
Running configuration check...done.
Reloading nagios configuration...done

15.2.3 Object management

ACL

Overview

Object name : ACL

Reload

In order to reload ACL, use the RELOAD command :

[root@centreon ~]# ./centreon -u admin -p centreon -o ACL -a reload

Lastreload

In order to check when the ACL was last reloaded, use the LASTRELOAD command :

[root@centreon ~]# ./centreon -u admin -p centreon -o ACL -a lastreload
1329833702

If you wish to get a human readable time format instead of a timestamp, use the following command :

[root@centreon ~]# ./centreon -u admin -p centreon -o ACL -a lastreload -v "d-m-Y H:i:s"
21-02-2012 15:17:01

You can change the date format :

Format character Description
d Day
m Month
Y Year
H Hour
i Minute
s Second
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Action ACL

Overview

Object name : ACLACTION

Show

In order to list available ACL Actions, use the SHOW action :

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLACTION -a show
id;name;description;activate
1;Simple User;Simple User;1
[...]

Columns are the following :

Column Description
ID
Name
Description
Activate 1 when ACL Action is enabled, 0 otherwise

Add

In order to add an ACL Action, use the ADD action :

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLACTION -a add -v "ACL Action test;my description"

Required fields :

Column Description
Name
Description

Del

If you want to remove an ACL Action, use the DEL action. The Name is used for identifying the ACL Action to
delete :

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLACTION -a del -v "ACL Action test"

Setparam

If you want to change a specific parameter of an ACL Action, use the SETPARAM action. The Name is used for
identifying the ACL Action to update :

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLACTION -a setparam -v "ACL Action test;description;my new description"
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Arguments are composed of the following columns :

Order Column description
1 Name of ACL action rule
2 Parameter name
3 Parameter value

Parameters that you may change are the following :

Column Description
name
description
activate 1 when ACL Action is enabled, 0 otherwise

Getaclgroup

If you want to retrieve the ACL Groups that are linked to a specific ACL Action, use the GETACLGROUP command.

Arguments are composed of the following columns :

Order Column description
1 Name of ACL action rule

Example : :

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLACTION -a getaclgroup -v "ACL Action test"
id;name
1;ALL
3;Operators

Grant and Revoke

If you want to grant or revoke actions in an ACL Action rule definition, use the following commands : GRANT,
REVOKE.

Arguments are composed of the following columns :

Order Column description
1 Name of ACL action rule
2 Actions to grant/revoke

Example : :

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLACTION -a grant -v "ACL Action test;host_acknowledgement|service_acknowledgement"

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLACTION -a revoke -v "ACL Action test;host_schedule_downtime|service_schedule_downtime"

The ‘*‘ wildcard can be used in order to grant or revoke all actions : :

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLACTION -a grant -v "ACL Action test;*"

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLACTION -a revoke -v "ACL Action test;*"

Below is the list of actions that you can grant/revoke :
Suite sur la page suivante

15.2. CLAPI
CENTREON 46-52 RUE ALBERT FR75014 PARIS

417



TABLE 15.3 – Suite de la page précédente
Action Description

Action Description
global_event_handler Permission to globally enable/disable event handlers
global_flap_detection Permission to globally enable/disable flap detection
global_host_checks Permission to globally enable/disable host active checks
global_host_obsess Permission to globally enable/disable obsess over host
global_host_passive_checks Permission to globally enable/disable host passive checks
global_notifications Permission to globally enable/disable notifications
global_perf_data Permission to globally enable/disable performance data
global_restart Permission to restart the monitoring engine
global_service_checks Permission to globally enable/disable service active checks
global_service_obsess Permission to globally enable/disable obsess over service
global_service_passive_checks Permission to globally enable/disable service passive checks
global_shutdown Permission to shut down the monitoring engine
host_acknowledgement Permission to acknowledge hosts
host_checks Permission to enable/disable host active checks
host_checks_for_services Permission to enable/disable active checks of a host’s services
host_comment Permission to put comments on hosts
host_event_handler Permission to enable/disable event handlers on hosts
host_flap_detection Permission to enable/disable flap detection on hosts
host_notifications Permission to enable/disable notification on hosts
host_notifications_for_services Permission to enable/disable notification on hosts’ services
host_schedule_check Permission to schedule a host check
host_schedule_downtime Permission to schedule a downtime on a host
host_schedule_forced_check Permission to schedule a host forced check
host_submit_result Permission to submit a passive check result to a host
poller_listing Permission to see the Poller list on the monitoring console
poller_stats Permission to see the poller statistics (on top screen)
service_acknowledgement Permission to acknowledge services
service_checks Permission to enable/disable service active checks
service_comment Permission to put comments on services
service_event_handler Permission to enable/disable event handlers on services
service_flap_detection Permission to enable/disable flap detection on services
service_notifications Permission to enable/disable notification on services
service_passive_checks Permission to enable/disable service passive checks
service_schedule_check Permission to schedule a service check
service_schedule_downtime Permission to schedule a downtime on a service
service_schedule_forced_check Permission to schedule a service forced check
service_submit_result Permission to submit a passive check result to a service
top_counter Permission to see the quick status overview (top right corner of the screen)

ACL Groups

Overview

Object name : ACLGROUP

Show

In order to list available ACL Groups, use the SHOW action : :
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[root@centreon ~]# ./centreon -u admin -p centreon -o ACLGROUP -a show
id;name;alias;activate
1;ALL;ALL;1
[...]

Columns are the following :

Column Description
ID ID
Name Name
Alias Alias
Activate 1 when ACL Group is enabled, 0 otherwise

Add

In order to add an ACL Group, use the ADD action : :

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLGROUP -a add -v "ACL Group test;my alias"

Required fields are :

Column Description
Name Name
Alias Alias

Del

If you want to remove an ACL Group, use the DEL action. The Name is used for identifying the ACL Group to
delete : :

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLGROUP -a del -v "ACL Group test"

Setparam

If you want to change a specific parameter of an ACL Group, use the SETPARAM action. The Name is used for
identifying the ACL Group to update : :

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLGROUP -a setparam -v "ACL Group test;alias;my new alias"

Arguments are composed of the following columns :

Order Column description
1 Name of ACL Group
2 Parameter name
3 Parameter value

Parameters that you may change are :

Column Description
name
alias
activate 1 when ACL Group is enabled, 0 otherwise
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Getmenu

If you want to retrieve the Menu Rules that are linked to a specific ACL Group, use the GETMENU action : :

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLGROUP -a getmenu -v "ACL Group test"
id;name
1;Configuration
3;Reporting
4;Graphs
2;Monitoring + Home

Arguments are composed of the following columns :

Order Column description
1 Name of ACL group

Getaction

If you want to retrieve the Action Rules that are linked to a specific ACL Group, use the GETACTION action : :

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLGROUP -a getaction -v "ACL Group test"
id;name
1;Simple action rule

Arguments are composed of the following columns :

Order Column description
1 Name of ACL group

Getresource

If you want to retrieve the Resource Rules that are linked to a specific ACL Group, use the GETRESOURCE action : :

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLGROUP -a getresource -v "ACL Group test"
id;name
1;All Resources

Arguments are composed of the following columns :

Order Column description
1 Name of ACL group

Getcontact and Getcontactgroup

If you want to retrieve the Contacts that are linked to a specific ACL Group, use the GETCONTACT action : :

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLGROUP -a getcontact -v "ACL Group test"
id;name
1;user1

If you want to retrieve the Contact Groups that are linked to a specific ACL Group, use the GETCONTACTGROUP
action : :
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[root@centreon ~]# ./centreon -u admin -p centreon -o ACLGROUP -a getcontactgroup -v "ACL Group test"
id;name
1;usergroup1

Arguments are composed of the following columns :

Order Column description
1 Name of ACL group

Setmenu, Setaction, Setresource, Addmenu, Addaction, Addresource

If you want to link rules to a specific ACL Group, use the following actions : SETMENU, SETACTION, SETRE-
SOURCE, ADDMENU, ADDACTION, ADDRESOURCE :

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLGROUP -a setmenu -v "ACL Group test;Menu rule 1|Menu rule 2"

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLGROUP -a addresource -v "ACL Group test;All Routers"

Command type Description
set* Overwrites previous definitions. Use the delimiter | to set multiple rules
add* Appends new rules to the previous definitions. Use the delimiter | to add multiple rules

Arguments are composed of the following columns :

Order Column description
1 Name of ACL group
2 Name of the ACL rule to link

Delmenu, Delaction, Delresource

If you want to remove rules from a specific ACL Group, use the following actions : DELMENU, DELACTION,
DELRESOURCE :

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLGROUP -a delaction -v "ACL Group test;Ack rule|Downtime rule"

Arguments are composed of the following columns :

Order Column description
1 Name of ACL group
2 Name of the ACL rule to remove

Setcontact, Setcontactgroup, Addcontact, Addcontactgroup

If you want to link contacts or contact groups to a specific ACL Group, use the following actions : SETCONTACT,
SETCONTACTGROUP, ADDCONTACT, ADDCONTACTGROUP :

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLGROUP -a setcontact -v "ACL Group test;user1"

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLGROUP -a addcontactgroup -v "ACL Group test;usergroup1"

Arguments are composed of the following columns :

Order Column description
1 Name of ACL group
2 Contact/Contact group to add/set
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Command
type

Description

set* Overwrites previous definitions. Use the delimiter | to set multiple contacts/contact groups
add* Appends new contacts/contact groups to the previous definitions. Use the delimiter | to add

multiple rules

Delcontact, Delcontactgroup

If you want to remove rules from a specific ACL Group, use the following actions : DELCONTACT, DELCON-
TACTGROUP :

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLGROUP -a delcontact -v "ACL Group test;user1"

Arguments are composed of the following columns :

Order Column description
1 Name of ACL group
2 Contact/Contact group to remove from ACL group

Menu ACL

Overview

Object name : ACLMENU

Show

In order to list available ACL Menus, use the SHOW action : :

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLMENU -a show
id;name;alias;comment;activate
1;Configuration;Configuration;;1
2;Monitoring + Home;Monitoring + Home;;1
3;Reporting;Reporting;;1
4;Graphs;Graphs;just a comment;1
[...]

Columns are the following :

Column Description
ID ID
Name Name
Alias Alias
Comment Comment
Activate 1 when ACL Menu is enabled, 0 otherwise

Add

In order to add an ACL Menu, use the ADD action : :

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLMENU -a add -v "ACL Menu test;my alias"
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Required fields are :

Column Description
Name Name
Alias Alias

Del

If you want to remove an ACL Menu, use the DEL action. The Name is used for identifying the ACL Menu to delete :

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLMENU -a del -v "ACL Menu test"

Setparam

If you want to change a specific parameter of an ACL Menu, use the SETPARAM action. The Name is used for
identifying the ACL Menu to update :

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLMENU -a setparam -v "ACL Menu test;alias;my new alias"

Arguments are composed of the following columns :

Order Column description
1 Name of ACL menu rule
2 Parameter name
3 Parameter value

Parameters that you may change are :

Column Description
name Name
alias Alias
activate 1 when ACL Menu is enabled, 0 otherwise
comment Comment

Getaclgroup

If you want to retrieve the ACL Groups that are linked to a specific ACL Menu, use the GETACLGROUP action :

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLMENU -a getaclgroup -v "ACL Menu test"
id;name
1;ALL
3;Operators

Arguments are composed of the following columns :

Order Column description
1 Name of ACL menu rule

Grant and Revoke

If you want to grant in Read/Write, Read Only or revoke menus in an ACL Menu rule definition, use the following
actions : GRANTRW, GRANTRO, REVOKE

Let’s assume that you would like to grant full access to the [Monitoring] menu in your ACL Menu rule : :
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[root@centreon ~]# ./centreon -u admin -p centreon -o ACLMENU -a grantrw -v "ACL Menu test;1;Monitoring"

Then, you would like to grant access to the [Home] > [Poller statistics] menu : :

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLMENU -a grantrw -v "ACL Menu test;1;Home;Poller statistics"

Then, you would like to grant access in read only to the [Configuration] > [Hosts] menu : :

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLMENU -a grantro -v "ACL Menu test;1;Configuration;Hosts"

Then, you decide to revoke access from [Monitoring] > [Event Logs] : :

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLMENU -a revoke -v "ACL Menu test;1;Monitoring;Event Logs"

Arguments are composed of the following columns :

Order Column description
1 Name of ACL menu rule
2 Grant/revoke children menus
3 Menu name to grant/revoke
n Possible sub menu name

Resource ACL

Overview

Object name : ACLRESOURCE

Show

In order to list available ACL Resources, use the SHOW action : :

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLRESOURCE -a show
id;name;alias;comment;activate
1;All Resources;All Resources;;1
[...]

Columns are the following :

Column Description
ID ID
Name Name
Alias Alias
Comment Comment
Activate 1 when ACL Resource is enabled, 0 otherwise

Add

In order to add an ACL Resource, use the ADD action : :

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLRESOURCE -a add -v "ACL Resource test;my alias"
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Required fields are :

Column Description
Name Name
Alias Alias

Del

If you want to remove an ACL Resource, use the DEL action. The Name is used for identifying the ACL Resource to
delete : :

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLRESOURCE -a del -v "ACL Resource test"

Setparam

If you want to change a specific parameter of an ACL Resource, use the SETPARAM action. The Name is used for
identifying the ACL Resource to update : :

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLRESOURCE -a setparam -v "ACL Resource test;alias;my new alias"

Arguments are composed of the following columns :

Order Column description
1 Name of ACL resource rule
2 Parameter name
3 Parameter value

Parameters that you may change are :

Column Description
name Name
alias Alias
activate 1 when ACL Resource is enabled, 0 otherwise

Getaclgroup

If you want to retrieve the ACL Groups that are linked to a specific ACL Resource, use the GETACLGROUP action : :

[root@centreon ~]# ./centreon -u admin -p centreon -o ACLRESOURCE -a getaclgroup -v "ACL Resource test"
id;name
1;ALL
3;Operators

Arguments are composed of the following columns :

Order Column description
1 Name of ACL group

Grant and revoke

Arguments are composed of the following columns :
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Order Column description
1 Name of ACL group
2 Name of resource

If you want to grant or revoke resources in an ACL Resource rule definition, use the following commands :

Command Description Example Wildcard ‘*’
supported

grant_host Put host name(s) [...] -a grant_host -v “ACL Resource
Test ;srv-esx”

Yes

grant_hostgroup Put hostgroup
name(s)

[...] -a grant_hostgroup -v “ACL Resource
Test ;Linux servers”

Yes

grant_servicegroup Put servicegroup
name(s)

[...] -a grant_servicegruop -v “ACL Resource
Test ;Ping”

Yes

grant_metaservice Put metaservice
name(s)

[...] -a grant_metaservice -v “ACL Resource
Test ;Traffic Average”

No

addhostexclusion Put host name(s) [...] -a addhostexclusion -v “ACL Resource
Test ;srv-test|srv-test2”

No

revoke_host Put host name(s) [...] -a revoke_host -v “ACL Resource
Test ;srv-esx”

Yes

revoke_hostgroup Put hostgroup
name(s)

[...] -a revoke_hostgroup -v “ACL Resource
Test ;Linux servers”

Yes

re-
voke_servicegroup

Put servicegroup
name(s)

[...] -a revoke_servicegroup -v “ACL Resource
Test ;Ping”

Yes

re-
voke_metaservice

Put metaservice
name(s)

[...] -a revoke_metaservice -v “ACL Resource
Test ;Traffic Average”

Yes

delhostexclusion Put hostgroup
name(s)

[...] -a delhostexclusion -v “ACL Resource
Test ;srv-test|srv-test2”

Yes

addfilter_instance Put instance
name(s)

[...] -a addfilter_instance -v “ACL Resource
Test ;Monitoring-2”

No

addfil-
ter_hostcategory

Put host category
name(s)

[...] -a addfilter_hostcategory -v “ACL Resource
Test ;Customer-1”

No

addfil-
ter_servicecategory

Put service category
name(s)

[...] -a addfilter_servicecategory -v “ACL
Resource Test ;System”

No

delfilter_instance Put instance
name(s)

[...] -a delfilter_instance -v “ACL Resource
Test ;Monitoring-2”

Yes

delfil-
ter_hostcategory

Put host category
name(s)

[...] -a delfilter_hostcategory -v “ACL Resource
Test ;Customer-1”

Yes

delfil-
ter_servicecategory

Put service category
name(s)

[...] -a delfilter_servicecategory -v “ACL
Resource Test ;System”

Yes

Note : Use delimiter “|” for defining multiple resources.

Centreon broker

Overview

Object name : CENTBROKERCFG

Show

In order to list available Centreon Broker CFG, use the SHOW action :
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[root@centreon ~]# ./centreon -u admin -p centreon -o CENTBROKERCFG -a show
config id;config name;instance
1;Central CFG;Central
2;Sattelite CFG;Sattelite
[...]

Columns are the following :

Order Description
1 ID
2 Name of configuration
3 Instance that is linked to broker cfg

Add

In order to add a Centreon Broker CFG, use the ADD action :

[root@centreon ~]# ./centreon -u admin -p centreon -o CENTBROKERCFG -a add -v "broker cfg for poller test;Poller test"

Required fields are :

Order Description
1 Name of configuration
2 Instance that is linked to broker cfg

Del

If you want to remove a Centreon Broker CFG, use the DEL action. The Name is used for identifying the configuration
to delete :

[root@centreon ~]# ./centreon -u admin -p centreon -o CENTBROKERCFG -a del -v "broker cfg for poller test"

Setparam

If you want to change a specific parameter of a Centreon Broker configuration, use the SETPARAM action. The
configuration name is used for identifying the configuration to update :

[root@centreon ~]# ./centreon -u admin -p centreon -o CENTBROKERCFG -a setparam -v "broker cfg for poller test;name;new broker cfg name"

Arguments are composed of the following columns :

Order Column description
1 Name of Centreon Broker configuration
2 Parameter name
3 Parameter value

Parameters that you may change are :
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Column Description
filename Filename of configuration (.xml extension)
name Name of configuration
instance Instance that is linked to Centreon Broker CFG
event_queue_max_size Event queue max size (when number is reached, temporary output will be used).
cache_directory Path for cache files
daemon Link this configuration to cbd service (0 or 1)
correlation_activate Enable correlation (0 or 1)

Listinput, Listoutput and Listlogger

If you want to list specific input output types of Centreon Broker, use one of the following commands : listinput
listoutput listlogger

Example :

[root@centreon ~]# ./centreon -u admin -p centreon -o CENTBROKERCFG -a listoutput -v "broker cfg for poller test"
id;name
1;Storage
2;RRD
3;PerfData

Columns are the following :

Column Description
ID I/O ID
Name I/O Name

Getinput, Getoutput and Getlogger

In order to get parameters of a specific I/O object, use one of the following commands :
— getinput
— getoutput
— getlogger

Example :

[root@centreon ~]# ./centreon -u admin -p centreon -o CENTBROKERCFG -a getoutput -v "broker cfg for poller test;3"
parameter key;parameter value
db_host;localhost
db_name;centreon_storage
db_password;centreon
db_port;3306
db_type;mysql
db_user;centreon
interval;60
length;
name;PerfData
type;storage

The ID is used for identifying the I/O to get.

Columns are the following :

Order Description
1 Parameter key of the I/O
2 Parameter value of the I/O
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Addinput, Addoutput and Addlogger

In order to add a new I/O object, use one of the following commands :
— ADDINPUT
— ADDOUTPUT
— ADDLOGGER

Example :

[root@centreon ~]# ./centreon -u admin -p centreon -o CENTBROKERCFG -a addlogger -v "broker cfg for poller test;/var/log/centreon-broker/central-module.log;file"
[root@centreon ~]# ./centreon -u admin -p centreon -o CENTBROKERCFG -a listlogger -v "broker cfg for poller test"
id;name
1;/var/log/centreon-broker/central-module.log

Arguments are composed of the following columns :

Order Column description
1 Name of Centreon Broker CFG
2 Name of the I/O object
3 Nature of I/O object

Delinput, Deloutput and Dellogger

In order to remove an I/O object from the Centreon Broker configuration, use one of the following commands :

— DELINPUT
— DELOUTPUT
— DELLOGGER

Example :

[root@centreon ~]# ./centreon -u admin -p centreon -o CENTBROKERCFG -a dellogger -v "broker cfg for poller test;1"

The I/O ID is used for identifying the object to delete.

Setintput, Setoutput and Setlogger

In order to set parameters of an I/O object, use one of the following commands :
— SETINPUT
— SETOUTPUT
— SETLOGGER

Example :

[root@centreon ~]# ./centreon -u admin -p centreon -o CENTBROKERCFG -a setlogger -v "broker cfg for poller test;1;debug;no"

Arguments are composed of the following columns :

Order Column description
1 Name of Centreon Broker CFG
2 ID of I/O object
3 Parameter name
4 Parameter value, for multiple values, use the ”,” delimiter

You may get help with the following CLAPI commands :

15.2. CLAPI
CENTREON 46-52 RUE ALBERT FR75014 PARIS

429



— GETTYPELIST
— GETFIELDLIST
— GETVALUELIST

Example :

[root@localhost core]# ./centreon -u admin -p centreon -o CENTBROKERCFG -a gettypelist -v "output"
type id;short name;name
27;bam_bi;BI engine (BAM)
16;sql;Broker SQL Database
32;correlation;correlation
28;db_cfg_reader;Database configuration reader
29;db_cfg_writer;Database configuration writer
11;file;File
3;ipv4;IPv4
10;ipv6;IPv6
26;bam;Monitoring engine (BAM)
14;storage;Perfdata Generator (Centreon Storage)
13;rrd;RRD File Generator
30;graphite;Storage - Graphite
31;influxdb;Storage - InfluxDB

[root@localhost core]# ./centreon -u admin -p centreon -o CENTBROKERCFG -a getfieldlist -v "ipv4"
field id;short name;name
3;ca_certificate;Trusted CA’s certificate;text
2;host;Host to connect to;text
46;negotiation;Enable negotiation;radio
48;one_peer_retention_mode;One peer retention;radio
1;port;Connection port;int
4;private_key;Private key file.;text
12;protocol*;Serialization Protocol;select
5;public_cert;Public certificate;text
6;tls;Enable TLS encryption;radio

Note : Note that the “protocol” entry is followed by a star. This means that you have to use one of the possible values.

This is how you get the list of possible values of a given field :

[root@localhost core]# ./centreon -u admin -p centreon -o CENTBROKERCFG -a getvaluelist -v "protocol"
possible values
ndo

The following chapters describes the parameters of each Object type

input ipv4 :
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ID Label Description Possible values
buffering_timeout Buffering timeout Time in seconds to wait be-

fore launching failover.
—

compression Compression (zlib) Enable or not data stream
compression.

—

compression_buffer Compression buffer size The higher the buffer size
is, the best compression.
This however increase data
streaming latency. Use with
caution.

—

compression_level Compression level Ranges from 0 (no com-
pression) to 9 (best com-
pression). Default is -1 (zlib
compression)

—

retry_interval Retry interval Time in seconds to wait bet-
ween each connection at-
tempt.

—

category Filter category Category filter for flux in in-
put

—

ca_certificate Trusted CA’s certificate Trusted CA’s certificate. —

host Host to connect to IP address or hostname of
the host to connect to (leave
blank for listening mode).

—

one_peer_retention_mode One peer retention This allows the retention to
work even if the socket is
listening

—

port Connection port Port to listen on (empty
host) or to connect to (with
host filled).

—

private_key Private key file. Private key file path when
TLS encryption is used.

—

protocol Serialization protocol Serialization protocol. ndo
public_cert Public certificate Public certificate file path

when TLS encryption is
used.

—

tls Enable TLS encryption Enable TLS encryption. —

ipv6 :
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ID Label Description Possible values
buffering_timeout Buffering timeout Time in seconds to wait be-

fore launching failover.
—

compression Compression (zlib) Enable or not data stream
compression.

—

compression_buffer Compression buffer size The higher the buffer size
is, the best compression.
This however increase data
streaming latency. Use with
caution.

—

compression_level Compression level Ranges from 0 (no com-
pression) to 9 (best com-
pression). Default is -1 (zlib
compression)

—

retry_interval Retry interval Time in seconds to wait bet-
ween each connection at-
tempt.

—

category Filter category Category filter for flux in in-
put

—

ca_certificate Trusted CA’s certificate Trusted CA’s certificate. —

host Host to connect to IP address or hostname of
the host to connect to (leave
blank for listening mode).

—

one_peer_retention_mode One peer retention This allows the retention to
work even if the socket is
listening

—

port Connection port Port to listen on (empty
host) or to connect to (with
host filled).

—

private_key Private key file. Private key file path when
TLS encryption is used.

—

protocol Serialization protocol Serialization protocol. ndo
public_cert Public certificate Public certificate file path

when TLS encryption is
used.

—

tls Enable TLS encryption Enable TLS encryption. —

file :
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ID Label Description Possible values
buffering_timeout Buffering timeout Time in seconds to wait be-

fore launching failover.
—

compression Compression (zlib) Enable or not data stream
compression.

—

compression_buffer Compression buffer size The higher the buffer size
is, the best compression.
This however increase data
streaming latency. Use with
caution.

—

compression_level Compression level Ranges from 0 (no com-
pression) to 9 (best com-
pression). Default is -1 (zlib
compression)

—

retry_interval Retry interval Time in seconds to wait bet-
ween each connection at-
tempt.

—

max_size Maximum size of file Maximum size in bytes. —

path File path Path to the file. —

protocol Serialization protocol Serialization protocol. ndo

logger file :

ID Label Description Possible values
config Configuration messages Enable or not configuration

messages logging.
—

debug Debug messages Enable or not debug mes-
sages logging.

—

error Error messages Enable or not error mes-
sages logging.

—

info Informational messages Enable or not informational
messages logging.

—

level Logging level How much messages must
be logged.

high,low,medium

max_size Max file size in bytes The maximum size of log
file.

—

name Name of the logger For a file logger this is the
path to the file. For a stan-
dard logger, one of ‘stdout’
or ‘stderr’.

—

standard :
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ID Label Description Possible values
config Configuration messages Enable or not configuration

messages logging.
—

debug Debug messages Enable or not debug mes-
sages logging.

—

error Error messages Enable or not error mes-
sages logging.

—

info Informational messages Enable or not informational
messages logging.

—

level Logging level How much messages must
be logged.

high,low,medium

name Name of the logger For a file logger this is the
path to the file. For a stan-
dard logger, one of ‘stdout’
or ‘stderr’.

—

syslog :

ID Label Description Possible values
config Configuration messages Enable or not configuration

messages logging.
—

debug Debug messages Enable or not debug mes-
sages logging.

—

error Error messages Enable or not error mes-
sages logging.

—

info Informational messages Enable or not informational
messages logging.

—

level Logging level How much messages must
be logged.

high,low,medium

monitoring :

ID Label Description Possible values
config Configuration messages Enable or not configuration

messages logging.
—

debug Debug messages Enable or not debug mes-
sages logging.

—

error Error messages Enable or not error mes-
sages logging.

—

info Informational messages Enable or not informational
messages logging.

—

level Logging level How much messages must
be logged.

high,low,medium

name Name of the logger For a file logger this is the
path to the file. For a stan-
dard logger, one of ‘stdout’
or ‘stderr’.

—

output ipv4 :
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ID Label Description Possible values
buffering_timeout Buffering timeout Time in seconds to wait be-

fore launching failover.
—

compression Compression (zlib) Enable or not data stream
compression.

—

compression_buffer Compression buffer size The higher the buffer size
is, the best compression.
This however increase data
streaming latency. Use with
caution.

—

compression_level Compression level Ranges from 0 (no com-
pression) to 9 (best com-
pression). Default is -1 (zlib
compression)

—

failover Failover name Name of the output which
will act as failover

—

retry_interval Retry interval Time in seconds to wait bet-
ween each connection at-
tempt.

—

category Filter category Category filter for flux in
output

—

ca_certificate Trusted CA’s certificate Trusted CA’s certificate. —

host Host to connect to IP address or hostname of
the host to connect to (leave
blank for listening mode).

—

one_peer_retention_mode One peer retention This allows the retention to
work even if the socket is
listening

—

port Connection port Port to listen on (empty
host) or to connect to (with
host filled).

—

private_key Private key file. Private key file path when
TLS encryption is used.

—

protocol Serialization protocol Serialization protocol. ndo
public_cert Public certificate Public certificate file path

when TLS encryption is
used.

—

tls Enable TLS encryption Enable TLS encryption. —

ipv6 :
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ID Label Description Possible values
buffering_timeout Buffering timeout Time in seconds to wait be-

fore launching failover.
—

compression Compression (zlib) Enable or not data stream
compression.

—

compression_buffer Compression buffer size The higher the buffer size
is, the best compression.
This however increase data
streaming latency. Use with
caution.

—

compression_level Compression level Ranges from 0 (no com-
pression) to 9 (best com-
pression). Default is -1 (zlib
compression)

—

failover Failover name Name of the output which
will act as failover

—

retry_interval Retry interval Time in seconds to wait bet-
ween each connection at-
tempt.

—

category Filter category Category filter for flux in
output

—

ca_certificate Trusted CA’s certificate Trusted CA’s certificate. —

host Host to connect to IP address or hostname of
the host to connect to (leave
blank for listening mode).

—

one_peer_retention_mode One peer retention This allows the retention to
work even if the socket is
listening

—

port Connection port Port to listen on (empty
host) or to connect to (with
host filled).

—

private_key Private key file. Private key file path when
TLS encryption is used.

—

protocol Serialization protocol Serialization protocol. ndo
public_cert Public certificate Public certificate file path

when TLS encryption is
used.

—

tls Enable TLS encryption Enable TLS encryption. —

file :
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ID Label Description Possible values
buffering_timeout Buffering timeout Time in seconds to wait be-

fore launching failover.
—

compression Compression (zlib) Enable or not data stream
compression.

—

compression_buffer Compression buffer size The higher the buffer size
is, the best compression.
This however increase data
streaming latency. Use with
caution.

—

compression_level Compression level Ranges from 0 (no com-
pression) to 9 (best com-
pression). Default is -1 (zlib
compression)

—

failover Failover name Name of the output which
will act as failover

—

retry_interval Retry interval Time in seconds to wait bet-
ween each connection at-
tempt.

—

category Filter category Category filter for flux in
output.

—

max_size Maximum size of file Maximum size in bytes. —

path File path Path to the file. —

protocol Serialization protocol Serialization protocol. ndo

rrd :
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ID Label Description Possible values
buffering_timeout Buffering timeout Time in seconds to wait be-

fore launching failover.
—

failover Failover name Name of the output which
will act as failover

—

retry_interval Retry interval Time in seconds to wait bet-
ween each connection at-
tempt.

—

category Filter category Category filter for flux in
output.

—

metrics_path RRD file directory for me-
trics

RRD file direc-
tory, for example
/var/lib/centreon/metrics

—

path Unix socket The Unix socket used to
communicate with rrdca-
ched. This is a global op-
tion, go to Administration >
Options > RRDTool to mo-
dify it.

—

port TCP port The TCP port used to com-
municate with rrdcached.
This is a global option, go to
Administration > Options >
RRDTool to modify it.

—

status_path RRD file directory for sta-
tuses

RRD file direc-
tory, for example
/var/lib/centreon/status

—

write_metrics Enable write_metrics Enable or not
write_metrics.

—

write_status Enable write_status Enable or not write_status. —

store_in_data_bin Enable store_in_data_bin Enable or not store in per-
formance data in data_bin.

—

storage :
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ID Label Description Possible values
buffering_timeout Buffering timeout Time in seconds to wait be-

fore launching failover.
—

failover Failover name Name of the output which
will act as failover

—

retry_interval Retry interval Time in seconds to wait bet-
ween each connection at-
tempt.

—

category Filter category Category filter for flux in
output.

—

check_replication Replication enabled When enabled, the broker
engine will check whether
or not the replication is up
to date before attempting to
update data.

—

db_host DB host IP address or hostname of
the database server.

—

db_name DB name Database name. —

db_password DB password Password of database user. —

db_port DB port Port on which the DB server
listens

—

db_type DB type Target DBMS. db2,ibase,mysql,oci,odbc,postgresql,sqlite,tds
db_user DB user Database user. —

interval Interval length Interval length in seconds. —

length RRD length RRD storage duration in se-
conds.

—

queries_per_transaction Maximum queries per tran-
saction

The maximum queries per
transaction before commit.

—

read_timeout Transaction commit ti-
meout

The transaction timeout be-
fore running commit.

—

rebuild_check_interval Rebuild check interval in
seconds

The interval between check
if some metrics must be re-
build. The default value is
300s

—

store_in_data_bin Enable store_in_data_bin Enable or not store in per-
formance data in data_bin.

—

sql :
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ID Label Description Possible values
buffering_timeout Buffering timeout Time in seconds to wait be-

fore launching failover.
—

failover Failover name Name of the output which
will act as failover

—

retry_interval Retry interval Time in seconds to wait bet-
ween each connection at-
tempt.

—

category Filter category Category filter for flux in
output.

—

check_replication Replication enabled When enabled, the broker
engine will check whether
or not the replication is up
to date before attempting to
update data.

—

db_host DB host IP address or hostname of
the database server.

—

db_name DB name Database name. —

db_password DB password Password of database user. —

db_port DB port Port on which the DB server
listens

—

db_type DB type Target DBMS. db2,ibase,mysql,oci,odbc,postgresql,sqlite,tds
db_user DB user Database user. —

queries_per_transaction Maximum queries per tran-
saction

The maximum queries per
transaction before commit.

—

read_timeout Transaction commit ti-
meout

The transaction timeout be-
fore running commit.

—

Commands

Overview

Object name : CMD

Show

In order to list available commands, use SHOW action :

[root@centreon ~]# ./centreon -u admin -p centreon -o CMD -a show
id;name;type;line
1;check-ping;check;$USER1$/check_ping -H $HOSTADDRESS$ -w $ARG1$ -c $ARG2$
2;check_dummy;check;$USER1$/check_dummy -o $ARG1$ -s $ARG2$
[...]

Columns are the following :
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Column Description
Command ID
Command name
Command type check, notif, misc or discovery
Command line System command line that will be run on execution

Add

In order to add a command use ADD action :

[root@centreon ~]# ./centreon -u admin -p centreon -o CMD -a ADD -v ’check-host-alive;check;$USER1$/check_ping -H $HOSTADDRESS$ -w 3000.0,80% -c 5000.0,100% -p 1’

Required columns are the following :

Column Description
Command name
Command type check, notif, misc or discovery
Command line System command line that will be run on execution

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Del

If you want to remove a command use DEL action :

[root@centreon ~]# ./centreon -u admin -p centreon -o CMD -a del -v ’check-host-alive’

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Setparam

If you want to change a specific parameters for a command, use the SETPARAM command :

[root@centreon ~]# ./centreon -u admin -p centreon -o CMD -a setparam -v ’check-host-alive;type;notif’
[root@centreon ~]# ./centreon -u admin -p centreon -o CMD -a setparam -v ’check-host-alive;name;check-host-alive2’

Parameters that you can change are the following :

Parameter Description
name Name of command
line Command line
type check, notif, misc or discovery
graph Graph template applied on command
example Example of arguments (i.e : !80 !90)
comment Comments regarding the command

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.
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Contacts

Overview

Object name : CONTACT

Show

In order to list available contacts, use the SHOW action :

[root@centreon ~]# ./centreon -u admin -p centreon -o contact -a show
id;name;alias;email;pager;gui access;admin;activate
4;Guest;guest;guest@localhost;;0;0;0
5;Supervisor;admin;root@localhost;;1;1;1
6;User;user;user@localhost;;0;0;0

Columns are the following :

Column Description
ID ID of contact
Name Name of contact
Alias Alias of contact (also login id)
Email Email of contact
Pager Phone number of contact
GUI Access 1 (can access UI) or 0 (cannot access UI)
Admin 1 (admin) or 0 (non admin)
activate 1 (enabled) or 0 (disabled)

Add

In order to add a contact, use the ADD action :

[root@centreon ~]# ./centreon -u admin -p centreon -o CONTACT -a ADD -v "user;user;user@mail.com;mypassword;1;1;en_US;local"

The required parameters are the following :

Parameter Description
Name Name of contact
Alias (login) Alias of contact (also login id)
Email Email of contact
Password Password of contact
Admin 1 (admin) or 0 (non admin)
GUI Access 1 (can access UI) or 0 (cannot access UI)
Language Language pack has to be installed on Centreon
Authentication type local or ldap

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Del

In order to delete one contact, use the DEL action. The contact name is used for identifying the contact you would like
to delete :
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[root@centreon core]# ./centreon -u admin -p centreon -o contact -a del -v "user"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Setparam

If you want to change a specific parameter for a contact, use the SETPARAM action :

[root@centreon core]# ./centreon -u admin -p centreon -o contact -a setParam -v "contact alias;hostnotifcmd;command name"
[root@centreon core]# ./centreon -u admin -p centreon -o contact -a setParam -v "contact alias;svcnotifcmd;command name"
root@centreon core]# ./centreon -u admin -p centreon -o contact -a setParam -v "contact alias;hostnotifperiod;period name"

The required parameters are the following :

Parameter Description
Contact alias Alias of contact to update
Parameter Parameter to update
Value New value of parameter

Parameters that you can change are the following :

Parameter Description
name Name
alias Alias
comment Comment
email Email Address
password User Password
access Can reach centreon, 1 if user has access, 0 otherwise
language Locale
admin 1 if user is admin, 0 otherwise
authtype ldap or local
hostnotifcmd host notification command(s). Multiple commands can be defined with delimiter “|”
svcnotifcmd service notification command(s). Multiple commands can be defined with delimiter “|”
hostnotifperiod host notification period
svcnotifperiod service notification period
hostnotifopt can be d,u,r,f,s,n
servicenotifopt can be w,u,c,r,f,s,n
address1 Address #1
address2 Address #2
address3 Address #3
address4 Address #4
address5 Address #5
address6 Address #6
ldap_dn LDAP domain name
enable_notifications 1 when notification is enable, 0 otherwise
autologin_key Used for auto login
template Name of the template to apply to the contact

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Enable

In order to enable a contact, use the ENABLE action :
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[root@centreon core]# ./centreon -u admin -p centreon -o contact -a enable -v "test"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Disable

In order to disable a contact, use the DISABLE action :

[root@centreon core]# ./centreon -u admin -p centreon -o contact -a disable -v "test"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Contact templates

Overview

Object name : CONTACTTPL

Refer to the CONTACT object

Contact Groups

Overview

Object name : CG

Show

In order to list available contact groups, use the SHOW action :

[root@centreon core]# ./centreon -u admin -p centreon -o CG -a show
id;name;alias;members
Guest;Guests Group;gest-user1,guest-user2
Supervisors;Centreon supervisors;Admin

Columns are the following :

Column Description
Name
Alias
Members List of contacts that are in the contact group

Add

In order to add a contact group, use the ADD action :

[root@centreon core]# ./centreon -u admin -p centreon -o CG -a ADD -v "Windows;Windows admins"
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Required fields are the following :

Column Description
Name Name
Alias Alias

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Del

In order to delete one contact group, use the DEL action :

[root@centreon core]# ./centreon -u admin -p centreon -o CG -a DEL -v "Windows"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Setparam

In order to change the name or the alias of a contactgroup, use the SETPARAM action :

[root@centreon core]# ./centreon -u admin -p centreon -o CG -a setparam -v "Windows;name;Windows-2K"
[root@centreon core]# ./centreon -u admin -p centreon -o CG -a setparam -v "Cisco;alias;Cisco-Routers"

Parameters that you can change are the following :

Parameter Description
name Name
alias Alias

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Enable

In order to enable a contact group, use the ENABLE action :

[root@centreon core]# ./centreon -u admin -p centreon -o CG -a enable -v "Guest"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Disable

In order to disable a contact group, use the DISABLE action :

[root@centreon core]# ./centreon -u admin -p centreon -o CG -a disable -v "Guest"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.
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Getcontact

In order to view the contact list of a contact group, use the GETCONTACT action :

[root@centreon core]# ./centreon -u admin -p centreon -o CG -a getcontact -v "Guest"
id;name
1;User1
2;User2

Columns are the following :

Column Description
ID Id of contact
Name Name of contact

Addcontact and Setcontact

In order to add a contact to a contact group, use the ADDCONTACT or SETCONTACT action where ‘add’ will
append and ‘set’ will overwrite previous definitions :

[root@centreon core]# ./centreon -u admin -p centreon -o CG -a addcontact -v "Guest;User1"
[root@centreon core]# ./centreon -u admin -p centreon -o CG -a setcontact -v "Guest;User1|User2"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Delcontact

In order to remove a contact from a contact group, use the DELCONTACT action :

[root@centreon core]# ./centreon -u admin -p centreon -o CG -a delcontact -v "Guest;User1"
[root@centreon core]# ./centreon -u admin -p centreon -o CG -a delcontact -v "Guest;User2"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Dependencies

Overview

Object name : DEP

Show

In order to list available dependencies, use the SHOW action :

[root@centreon ~]# ./centreon -u admin -p centreon -o DEP -a show
id;name;description;inherits_parent;execution_failure_criteria;notification_failure_criteria
62;my dependency;a description;1;n;n
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Columns are the following :

Column Description
ID Unique ID of the dependency
Name Name
Description Short description of the dependency
inherits_parent Whether or not dependency inherits higher level dependencies
execution_failure_criteria Defines which parent states prevent dependent resources from being checked
notification_failure_criteria Defines which parent states prevent notifications on dependent resources

Add

In order to add a new dependency, use the ADD action :

[root@centreon ~]# ./centreon -u admin -p centreon -o DEP -a ADD \
-v "my new dependency;any description;HOST;dummy-host"

The required parameters are the following :

Order Description
1 Name of the dependency
2 Description of the dependency
3 Dependency type : HOST, HG, SG, SERVICE, META
4 Name of the parent resource(s)

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Del

In order to delete a dependency, use the DEL action. The dependency name is used for identifying the dependency
you would like to delete :

[root@centreon ~]# ./centreon -u admin -p centreon -o DEP -a DEL -v "my dependency"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Setparam

In order to set a specific parameter for a dependency, use the SETPARAM action :

[root@centreon ~]# ./centreon -u admin -p centreon -o DEP -a setparam \
-v "my dependency;name;my new dependency name"

You may change the following parameters :

Parameter Description
name Name
description Description
comment Comment
inherits_parent 0 or 1
execution_failure_criteria o,w,u,c,p,d,n
notification_failure_criteria o,w,u,c,p,d,n
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Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Listdep

If you want to retrieve the dependency definition of a dependency object, use the LISTDEP action :

[root@centreon ~]# ./centreon -u admin -p centreon -o DEP -a LISTDEP -v "my dependency"
parents;children
HostParent1|HostParent2;HostChild1|HostChild2,ServiceChild2

Addparent and Addchild

If you want to add a new parent or a new child in a dependency definition, use the ADDPARENT or ADDCHILD
action :

[root@centreon ~]# ./centreon -u admin -p centreon -o DEP -a ADDPARENT \
-v "my dependency;my_parent_host"
[root@centreon ~]# ./centreon -u admin -p centreon -o DEP -a ADDCHILD \
-v "my dependency;my_child_host"
[root@centreon ~]# ./centreon -u admin -p centreon -o DEP -a ADDCHILD \
-v "my dependency;my_child_host2,my_child_service2"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Delparent and Delchild

In order to delete a parent or a child in a dependency definition, use the DELPARENT or DELCHILD action :

[root@centreon ~]# ./centreon -u admin -p centreon -o DEP -a DELPARENT \
-v "my dependency;my_parent_host"
[root@centreon ~]# ./centreon -u admin -p centreon -o DEP -a DELCHILD \
-v "my dependency;my_child_host"
[root@centreon ~]# ./centreon -u admin -p centreon -o DEP -a DELCHILD \
-v "my dependency;my_child_host2,my_child_service2"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Downtimes

Overview

Object name : DOWNTIME

Show

In order to list available recurring downtimes, use the SHOW action :
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[root@centreon ~]# ./centreon -u admin -p centreon -o DOWNTIME -a show
id;name;description;activate
1;mail-backup;sunday backup;1
1;my downtime;a description;1

Columns are the following :

Column Description
ID Unique ID of the recurring downtime
Name Name
Description Short description of the recurring downtime
Activate Whether or not the downtime is activated

In order to show resources of a downtime, use the Show action with parameters :

[root@centreon ~]# ./centreon -u admin -p centreon -o DOWNTIME -a show -v "mail-backup;host"

The parameters are the following :

Order Description
1 Name of the downtime
2 (optional) Object type (host, hg, service, sg)

Add

In order to add a new downtime, use the ADD action :

[root@centreon ~]# ./centreon -u admin -p centreon -o DOWNTIME -a ADD -v "my new downtime;any description"

The required parameters are the following :

Order Description
1 Name of the downtime
2 Description of the downtime

Del

In order to delete a downtime, use the DEL action. The downtime name is used for identifying the recurring downtime
you would like to delete :

[root@centreon ~]# ./centreon -u admin -p centreon -o DOWNTIME -a DEL -v "my downtime"

Setparam

In order to set a specific parameter for a downtime, use the SETPARAM action :

[root@centreon ~]# ./centreon -u admin -p centreon -o DOWNTIME -a setparam -v "my downtime;name;my new downtime name"

You may change the following parameters :

Parameter Description
name Name
description Description

15.2. CLAPI
CENTREON 46-52 RUE ALBERT FR75014 PARIS

449



Listperiods

If you want to retrieve the periods set on a recurring downtime, use the LISTPERIODS action :

[root@centreon ~]# ./centreon -u admin -p centreon -o DOWNTIME -a LISTPERIODS -v "my downtime"
position;start time;end time;fixed;duration;day of week;day of month;month cycle
1;1;23:00:00;24:00:00;1;;7;;all
2;1;00:00:00;02:00:00;1;;;1,2;none
3;1;13:45:00;14:40:00;1;;5;;first

Columns are the following :

Column Description
Position Position of the period ; used for deleting a period from a

recurring downtime
Start time Start time of the recurring downtime
End time End time of the recurring downtime
Fixed Type of downtime (1 = fixed, 0 = flexible)
Duration Duration of downtime when in flexible mode (seconds)
Day of week 1 - 7 (1 = monday ... 7 = sunday)
Day of month 1 - 31
Month cycle

“all”, “none”, “first” or “last”. Determines when the downtime
will be effective on specific weekdays (i.e : all
Sundays, last Sunday of the month, first Sunday
of the month...)

Addweeklyperiod

In order to add a weekly period, use the ADDWEEKLYPERIOD action :

[root@centreon ~]# ./centreon -u admin -p centreon -o DOWNTIME -a ADDWEEKLYPERIOD \
-v "my downtime;00:00;04:00;0;7200;saturday,sunday"

The above example will set a downtime every saturday and sunday between 00 :00 and 04 :00.

Parameter Description
Name Name of the recurring downtime
Start time Start time of the recurring downtime
End time End time of the recurring downtime
Fixed 0 for flexible downtime, 1 for fixed
Duration Duration of downtime when in flexible mode (seconds)
Day of week Can be written with letters or numbers (1 to 7 or monday to sunday)

Addmonthlyperiod

In order to add a monthly period, use the ADDMONTHLYPERIOD action :

[root@centreon ~]# ./centreon -u admin -p centreon -o DOWNTIME -a ADDMONTHLYPERIOD \
-v "my downtime;19:00;22:00;1;;14,21"

450
CENTREON 46-52 RUE ALBERT FR75014 PARIS

Chapitre 15. API



The above example will set a downtime on every 14th and 21st day for all months.

Parameter Description
Name Name of the recurring downtime
Start time Start time of the recurring downtime
End time End time of the recurring downtime
Fixed 0 for flexible downtime, 1 for fixed
Duration Duration of downtime when in flexible mode (seconds)
Day of month 1 to 31

Addspecificperiod

In order to add a specific period, use the ADDSPECIFICPERIOD action :

[root@centreon ~]# ./centreon -u admin -p centreon -o DOWNTIME -a ADDSPECIFICPERIOD \
-v "my downtime;19:00;22:00;1;;wednesday;first"

The above example will set a downtime on every first wednesday for all months.

Parameter Description
Name Name of the recurring downtime
Start time Start time of the recurring downtime
End time End time of the recurring downtime
Fixed 0 for flexible downtime, 1 for fixed
Duration Duration of downtime when in flexible mode (seconds)
Day of week Can be written with letters or numbers (1 to 7 or monday to sunday)
Month cycle first or last

Addhost, addhostgroup, addservice, addservicegroup

If you want to associate a host, host group, service or service group to a recurring downtime, use the ADDHOST,
ADDHOSTGROUP, ADDSERVICE or ADDSERVICEGROUP action :

[root@centreon ~]# ./centreon -u admin -p centreon -o DOWNTIME -a ADDHOST -v "my downtime;host_1"
[root@centreon ~]# ./centreon -u admin -p centreon -o DOWNTIME -a ADDSERVICE -v "my downtime;host_1,service_1"

Use the “|” delimiter in order to define multiple relationships.

Delhost, delhostgroup, delservice, delservicegroup

If you want to remove a host, host group, service or service group from a recurring downtime, use the DELHOST,
DELHOSTGROUP, DELSERVICE or DELSERVICEGROUP action :

[root@centreon ~]# ./centreon -u admin -p centreon -o DOWNTIME -a DELHOST -v "my downtime;host_1"
[root@centreon ~]# ./centreon -u admin -p centreon -o DOWNTIME -a DELSERVICE -v "my downtime;host_1,service_1"

Sethost, sethostgroup, setservice, setservicegroup

The SETHOST, SETHOSTGROUP, SETSERVICE AND SETSERVICEGROUP actions are similar to their
ADD counterparts, but they will overwrite the relationship definitions instead of appending them :
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[root@centreon ~]# ./centreon -u admin -p centreon -o DOWNTIME -a ADDHOST -v "my downtime;host_1|host_2"
[root@centreon ~]# ./centreon -u admin -p centreon -o DOWNTIME -a ADDSERVICE -v "my downtime;host_1,service_1|host_2,service_2"

Use the “|” delimiter in order to define multiple relationships.

Real time Downtimes

Overview

Object name : RTDOWNTIME

Show host real time downtime

In order to list available real time downtimes, use the SHOW action : : You can use the value “HOST” to display all
the downtimes :

[root@centreon ~]# ./centreon -u admin -p centreon -o RTDOWNTIME -a show -v "HOST;generic-host"
id;host_name;author;actual_start_time;actual_end_time;start_time;end_time;comment_data;duration;fixed
6;generic-host;admin;2017/09/28 14:21;N/A;2017/09/26 17:00;2017/09/30 19:00;’generic-comment’;3600;1

Columns are the following :

Column Description
id Name of the downtime
Host_name Name of the host
Author Name of the author
Actual_start_time Actual start date in case of flexible downtime
Actual_end_time Actual end date in case of flexible downtime
Start_time Beginning of downtime
End_time End of downtime
Comment_data Short description of the real time downtime
Duration Duration of Downtime
Fixed Downtime starts and stops at the exact start and end times

Show service real time downtime

In order to list available real time downtimes, use the SHOW action : : You can use the value “SVC” to display all the
downtimes :

[root@centreon ~]# ./centreon -u admin -p centreon -o RTDOWNTIME -a show -v "SVC;generic-host,generic-service"
id;host_name;service_name;author;start_time;end_time;comment_data;duration;fixed
42;generic-host;generic-service;admin;2017/09/28 14:21;N/A;2017/09/26 17:00;2017/09/30 19:00;’generic-comment’;3600;1

Columns are the following :
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Column Description
id Name of the downtime
Host_name Name of the host
Service_name Name of the service
Author Name of the author
Actual_start_time Actual start date in case of flexible downtime
Actual_end_time Actual end date in case of flexible downtime
Start_time Beginning of downtime
End_time End of downtime
Comment_data Short description of the real time downtime
Duration Duration of Downtime
Fixed Downtime starts and stops at the exact start and end times

Real time Downtime for : Addhost, addhostgroup

If you want to associate a host, host group to a real time downtime, use the ADD action : : To set the value of the
start/end, use following format : YYYY/MM/DD HH :mm :

[root@centreon ~]# ./centreon -u admin -p centreon -o RTDOWNTIME -a add -v "HOST;central;2017/09/24 10:00;2017/09/24 12:00;1;3600;my comments;1"
[root@centreon ~]# ./centreon -u admin -p centreon -o RTDOWNTIME -a add -v "HG;linux-servers;2017/09/24 10:00;2017/09/24 12:00;1;3600;my comments;1"

The required parameters are the following :

Order Description
1 Value you want to associate
2 Name of the host (Name of the service)
3 Beginning of downtime
4 End of downtime
5 Type of downtime (1 = fixed, 0 = flexible)
6 Duration of downtime for flexible mode (seconds)
7 Short description of the real time downtime
8 Apply downtime on linked services (0/1)

Real time Downtime for : addservice, addservicegroup

If you want to associate a service or service group to a real time downtime, use the ADD action : : To set the value of
the start/end, use following format : YYYY/MM/DD HH :mm :

[root@centreon ~]# ./centreon -u admin -p centreon -o RTDOWNTIME -a add -v "SVC;central,ping|central,memory;2017/09/24 10:00;2017/09/24 12:00;1;3600;my comments"
[root@centreon ~]# ./centreon -u admin -p centreon -o RTDOWNTIME -a add -v "SG;servicegroup1;2017/09/24 10:00;2017/09/24 12:00;1;3600;my comments"

The required parameters are the following :

Order Description
1 Value you want to associate
2 Name of the host (Name of the service)
3 Beginning of downtime
4 End of downtime
5 Type of downtime (1 = fixed, 0 = flexible)
6 Duration of downtime for flexible mode (seconds)
7 Short description of the real time downtime
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Add instance real time downtime

In order to add a new real time downtime for a poller, use the ADD action : : To set the value of the start/end, use
following format : YYYY/MM/DD HH :mm :

[root@centreon ~]# ./centreon -u admin -p centreon -o RTDOWNTIME -a add -v "INSTANCE;Central;2017/09/24 10:00;2017/09/24 12:00;1;3600;my comments

The required parameters are the following :

Order Description
1 Value you want to associate
2 Name of the poller
3 Beginning of downtime
4 End of downtime
5 Type of downtime (1 = fixed, 0 = flexible)
6 Duration of downtime for flexible mode (seconds)
7 Short description of the real time downtime

Cancel a real time downtime

In order to cancel a real time downtime, use the CANCEL action : : To get the value of the id, use the SHOW action :

[root@centreon ~]# ./centreon -u admin -p centreon -o RTDOWNTIME -a CANCEL -v "6|42"

The required parameters are the following :

Order Description
1 Id of downtime

Engine CFG

Overview

Object name : ENGINECFG

Show

In order to list available Engine conf, use the SHOW action :

[root@centreon ~]# ./centreon -u admin -p centreon -o ENGINECFG -a show
engine id;engine name;instance;engine comment
1;Engine CFG Central;Central;Default Engine.cfg
[...]

Columns are the following :

Order Description
1 Engine ID
2 Engine configuration name
3 Instance that is linked to engine.cfg
4 Comments regarding the configuration file

454
CENTREON 46-52 RUE ALBERT FR75014 PARIS

Chapitre 15. API



Add

In order to add a Engine conf, use the ADD action :

[root@centreon ~]# ./centreon -u admin -p centreon -o ENGINECFG -a add -v "Engine cfg for poller NY;Poller-NY;Just a small comment"

Required fields are :

Order Description
1 Nagios configuration name
2 Instance that is linked to engine.cfg
3 Comment regarding the configuration file

Del

If you want to remove a Engine conf, use the DEL action. The name is used for identifying the configuration to delete :

[root@centreon ~]# ./centreon -u admin -p centreon -o ENGINECFG -a del -v "Engine cfg for poller NY"

Setparam

If you want to change a specific parameter of a Engine conf, use the SETPARAM action. The name is used for
identifying the configuration to update :

[root@centreon ~]# ./centreon -u admin -p centreon -o ENGINECFG -a setparam -v "Engine cfg for poller NY;cfg_dir;/usr/local/engine/etc"

Arguments are composed of the following columns :

Order Column description
1 Name of Engine configuration
2 Parameter name
3 Parameter value

Parameters that you may change are :

Column Description
nagios_name Name
instance Instance that is linked to engine.cfg
broker_module example : [...] -v “Engine CFG

1 ;broker_module ;/usr/lib64/nagios/cbmod.so
/etc/centreon-broker/central-module.xml”, you can
use a | delimiter for defining multiple broker modules

nagios_activate 1 if activated, 0 otherwise
— Centreon CLAPI handles pretty much all the options

available in a Engine configuration file. Because the list
is quite long, it is best to refer to the official documenta-
tion of Engine

Addbrokermodule

If you want to add new broker module without removing existing modules, use the ADDBROKERMODULE :
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[root@centreon ~]# ./centreon -u admin -p centreon -o ENGINECFG -a addbrokermodule -v "Engine cfg for poller NY;/usr/lib64/centreon-engine/externalcmd.so"

Arguments are composed of the following columns :

Order Column description
1 Name of Engine configuration
2 Module name

To add multiple modules in one line, it will put the separator “|” between the name of the modules
[root@centreon ~]# ./centreon -u admin -p centreon -o ENGINECFG -a addbrokermodule -v “Engine
cfg for poller NY ;/usr/lib64/centreon-engine/externalcmd.so|/etc/centreon-broker/central-module.xml”

Delbrokermodule

If you want to delete broker module, use the DELBROKERMODULE : : [root@centreon ~]# ./centreon -u ad-
min -p centreon -o ENGINECFG -a delbrokermodule -v “Engine cfg for poller NY ;/usr/lib64/centreon-
engine/externalcmd.so”

Arguments are composed of the following columns :

Order Column description
1 Name of Engine configuration
2 Module name

To delete multiple modules in one line, it will put the separator “|” between the name of the modules
[root@centreon ~]# ./centreon -u admin -p centreon -o ENGINECFG -a delbrokermodule -v “Engine
cfg for poller NY ;/usr/lib64/centreon-engine/externalcmd.so|/etc/centreon-broker/central-module.xml”

Host templates

Overview

Object name : HTPL

Refer to the HOST object

Note : You cannot use the APPLYTPL and SETINSTANCE actions on HTPL objects.

If you are looking for service templates association to host templates refer to ADDHOSTTEM-
PLATE/SETHOSTTEMPLATE command from STPL object.

Hosts

Overview

Object name : HOST

Show

In order to list available hosts, use the SHOW action :
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[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a show
id;name;alias;address;activate
82;sri-dev1;dev1;192.168.2.1;1
83;sri-dev2;dev2;192.168.2.2;1
84;sri-dev3;dev3;192.168.2.3;0
85;sri-dev4;dev4;192.168.2.4;1
86;sri-dev5;dev5;192.168.2.5;1
87;sri-dev6;dev6;192.168.2.6;1
94;sri-dev7;dev7;192.168.2.7;1
95;sri-dev8;dev8;192.168.2.8;1

Columns are the following :

Column Description
ID ID of host
Name Host name
Alias Host alias
IP/Address IP of host
Activate 1 when enabled, 0 when disabled

Add

In order to add a host, use the ADD action :

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a ADD -v "test;Test host;127.0.0.1;generic-host;central;Linux"

Required parameters :

Order Description
1 Host name
2 Host alias
3 Host IP address
4 Host templates ; for multiple definitions, use delimiter |
5 Instance name (poller)
6 Hostgroup ; for multiple definitions, use delimiter |

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Del

In order to delete one host, use the DEL action. You have to list the available hosts in order to identify the one you
want to delete :

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a DEL -v "test"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Setparam

In order to change parameters on a host configuration, use the SETPARAM action :
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[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a setparam -v "test;alias;Development test "
[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a setparam -v "test;address;192.168.1.68"
[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a setparam -v "test;check_period;24x7"
[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a setparam -v "test;timezone;Europe/Berlin"

You may edit the following parameters :

Parameter Description
2d_coords 2D coordinates (used by statusmap)
3d_coords 3D coordinates (used by statusmap)
action_url Action URL
activate Whether or not host is enabled
active_checks_enabled Whether or not active checks are enabled
address Host IP Address
alias Alias
check_command Check command
check_command_arguments Check command arguments
check_interval Normal check interval
check_freshness Enables check freshness
check_period Check period
contact_additive_inheritance Enables contact additive inheritance
cg_additive_inheritance Enables contactgroup additive inheritance
event_handler Event handler command
event_handler_arguments Event handler command arguments
event_handler_enabled Whether or not event handler is enabled
first_notification_delay First notification delay (in seconds)
flap_detection_enabled Whether or not flap detection is enabled
flap_detection_options Flap detection options : ‘o’ for Up, ‘d’ for Down, ‘u’ for Unreachable
host_high_flap_threshold High flap threshold
host_low_flap_threshold Low flap threshold
icon_image Icon image
icon_image_alt Icon image text
max_check_attempts Maximum number of attempt before a HARD state is declared
name Host name
notes Notes
notes_url Notes URL
notifications_enabled Whether or not notification is enabled
notification_interval Notification interval
notification_options Notification options
notification_period Notification period
recovery_notification_delay Recovery notification delay
obsess_over_host Whether or not obsess over host option is enabled
passive_checks_enabled Whether or not passive checks are enabled
process_perf_data Process performance data command
retain_nonstatus_information Whether or not there is non-status retention
retain_status_information Whether or not there is status retention
retry_check_interval Retry check interval
snmp_community Snmp Community
snmp_version Snmp version
stalking_options Comma separated options : ‘o’ for OK, ‘d’ for Down, ‘u’ for Unreachable
statusmap_image Status map image (used by statusmap)
host_notification_options Notification options (d,u,r,f,s)
timezone Timezone
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Getparam

In order to get specific parameters on a host configuration, use the GETPARAM action :

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a getparam -v "test;alias"
alias : test
[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a setparam -v "test;alias|alia|timezone"
alias : test
timezone : Europe/Berlin
Object not found:alia

You may edit the following parameters :

Parameter Description
2d_coords 2D coordinates (used by statusmap)
3d_coords 3D coordinates (used by statusmap)
action_url Action URL
activate Whether or not host is enabled
active_checks_enabled Whether or not active checks are enabled
address Host IP Address
alias Alias
check_command Check command
check_command_arguments Check command arguments
check_interval Normal check interval
check_freshness Enables check freshness
check_period Check period
contact_additive_inheritance Enables contact additive inheritance
cg_additive_inheritance Enables contactgroup additive inheritance
event_handler Event handler command
event_handler_arguments Event handler command arguments
event_handler_enabled Whether or not event handler is enabled
first_notification_delay First notification delay (in seconds)
flap_detection_enabled Whether or not flap detection is enabled
flap_detection_options Flap detection options ‘o’ for Up, ‘d’ for Down, ‘u’ for Unreachable
host_high_flap_threshold High flap threshold
host_low_flap_threshold Low flap threshold
icon_image Icon image
icon_image_alt Icon image text
max_check_attempts Maximum number of attempt before a HARD state is declared
name Host name
notes Notes
notes_url Notes URL
notifications_enabled Whether or not notification is enabled
notification_interval Notification interval
notification_options Notification options
notification_period Notification period
recovery_notification_delay Recovery notification delay
obsess_over_host Whether or not obsess over host option is enabled
passive_checks_enabled Whether or not passive checks are enabled
process_perf_data Process performance data command
retain_nonstatus_information Whether or not there is non-status retention
retain_status_information Whether or not there is status retention
retry_check_interval Retry check interval
snmp_community Snmp Community

Suite sur la page suivante

15.2. CLAPI
CENTREON 46-52 RUE ALBERT FR75014 PARIS

459



TABLE 15.5 – Suite de la page précédente
Parameter Description
snmp_version Snmp version
stalking_options Comma separated options : ‘o’ for OK, ‘d’ for Down, ‘u’ for Unreachable
statusmap_image Status map image (used by statusmap
host_notification_options Notification options (d,u,r,f,s)
timezone Timezone

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Setinstance

In order to set the instance from which a host will be monitored, use the SETINSTANCE action :

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a setinstance -v "Centreon-Server;Poller 1"

Getmacro

In order to view the custom macro list of a host, use the GETMACRO action :

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a getmacro -v "Centreon-Server"
macro name;macro value;is_password;description
$_HOSTMACADDRESS$;00:08:C7:1B:8C:02;0;description of macro

Setmacro

In order to set a custom host macro, use the SETMACRO action :

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a setmacro -v "Centreon-Server;warning;80;0;description of macro"
[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a setmacro -v "Centreon-Server;critical;90;0;description of macro"

Note : If the macro already exists, this action will only update the macro value. Otherwise, macro will be created.

Delmacro

In order to delete a macro host, use the DELMACRO action :

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a delmacro -v "Centreon-Server;warning"
[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a delmacro -v "Centreon-Server;critical"

Gettemplate

In order to view the template list of a host, use the GETTEMPLATE action :

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a gettemplate -v "Centreon-Server"
id;name
2;generic-host
12;Linux-Servers
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Addtemplate and Settemplate

In order to add a host template to an existing host, use the ADDTEMPLATE or the SETTEMPLATE action, where
add will append and set will overwrite previous definitions :

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a addtemplate -v "Centreon-Server;srv-Linux"
[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a settemplate -v "Centreon-Server;hardware-Dell"

Note : All service templates linked to the new host template will be automatically deployed on the existing host. (no
longer the case with version later than 1.3.0, use the ‘applytpl’ action manually)

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Deltemplate

In order to remove a host template to an existing host, use the DELTEMPLATE action :

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a deltemplate -v "test;srv-Linux|hardware-Dell"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Applytpl

When a template host undergoes modified link-level service template, the change is not automatically reflected in hosts
belonging to that template. For the change to take effect, it must then re-apply the template on this host. For this, use
the APPLYTPL action :

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a applytpl -v "test"
All new services are now created.

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Getparent

In order to view the parents of a host, use the GETPARENT action :

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a getparent -v "Centreon-Server"
id;name
43;server-parent1
44;server-parent2

Addparent and Setparent

In order to add a host parent to an host, use the ADDPARENT or SETPARENT actions where add will append and
set will overwrite the previous definitions :

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a addparent -v "host;hostParent1"
[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a setparent -v "host;hostParent1|hostParent2"
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Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Delparent

In order to remove a parent, use the DELPARENT action :

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a delparent -v "Centreon-Server;server-parent1|server-parent2"

Getcontactgroup

In order to view the notification contact groups of a host, use the GETCONTACTGROUP action :

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a getcontactgroup -v "Centreon-Server"
id;name
17;Administrators

Addcontactgroup and Setcontactgroup

If you want to add notification contactgroups to a host, use the ADDCONTACTGROUP or SETCONTACTGROUP
actions where add will append and set will overwrite previous definitions :

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a addcontactgroup -v "Centreon-Server;Contactgroup1"
[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a setcontactgroup -v "Centreon-Server;Contactgroup1|Contactgroup2"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Delcontactgroup

If you want to remove notification contactgroups from a host, use the DELCONTACTGROUP action :

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a delcontactgroup -v "Centreon-Server;Contactgroup2"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Getcontact

In order to view the notification contacts of a host, use the GETCONTACT action :

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a getcontact -v "Centreon-Server"
id;name
11;guest
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Addcontact and Setcontact

If you want to add notification contacts to a host, use the ADDCONTACT or SETCONTACT actions where add will
append and set will overwrite previous definitions :

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a addcontact -v "Centreon-Server;Contact1"
[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a setcontact -v "Centreon-Server;Contact1|Contact2"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Delcontact

If you want to remove a notification contacts from a host, use the DELCONTACT action :

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a delcontact -v "Centreon-Server;Contact2"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Gethostgroup

In order to view the hostgroups that are tied to a host, use the GETHOSTGROUP action :

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a gethostgroup -v "Centreon-Server"
id;name
9;Linux-Servers

Addhostgroup and Sethostgroup

If you want to tie hostgroups to a host, use the ADDHOSTGROUP or SETHOSTGROUP actions where add will
append and set will overwrite previous definitions :

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a addhostgroup -v "Centreon-Server;Hostgroup1"
[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a sethostgroup -v "Centreon-Server;Hostgroup1|Hostgroup2"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Delhostgroup

If you want to remove hostgroups from a host, use the DELHOSTGROUP action :

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a delhostgroup -v "Centreon-Server;Hostgroup2"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.
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Setseverity

In order to associate a severity to a host, use the SETSEVERITY action :

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a setseverity -v "Centreon-Server;Critical"

Required parameters :

Order Description
1 Host name
2 Severity name

Unsetseverity

In order to remove the severity from a host, use the UNSETSEVERITY action :

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a unsetseverity -v "Centreon-Server"

Required parameters :

Order Description
1 Host name

Enable

In order to enable an host, use the ENABLE action :

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a enable -v "test"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Disable

In order to disable a host, use the DISABLE action :

[root@centreon ~]# ./centreon -u admin -p centreon -o HOST -a disable -v "test"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Host categories

Overview

Object name : HC
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Show

In order to list available host categories, use the SHOW action :

[root@centreon ~]# ./centreon -u admin -p centreon -o HC -a show
id;name;alias;members
1;Linux;Linux Servers;host1
2;Windows;Windows Server;host2
3;AS400;AS400 systems;host3,host4

Columns are the following :

Column Description
Name Name of host category
Alias Alias of host category

Add

In order to add a host category, use the ADD :

[root@centreon ~]# ./centreon -u admin -p centreon -o HC -a add -v "Databases;Databases servers"

Required parameters are the following :

Order Description
1 Name of host category
2 Alias of host category

Del

In order to delete a host category, use the DEL action. The name is used for identifying the host category you want to
delete :

[root@centreon ~]# ./centreon -u admin -p centreon -o HC -a DEL -v "Databases"

Getmember

In order to view the list hosts in a host category, use the GETMEMBER action :

[root@centreon ~]# ./centreon -u admin -p centreon -o HC -a getmember -v "Linux"
id;name
14;Centreon-Server
15;srv-test

Addmember and Setmember

In order to add a host or a host template into a host category, use the ADDMEMBER or SETMEMBER action where
add will append and set will overwrite previous definitions :

[root@centreon ~]# ./centreon -u admin -p centreon -o HC -a addmember -v "Linux;host7"
[root@centreon ~]# ./centreon -u admin -p centreon -o HC -a setmember -v "Windows;host7|host8|host9"
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The needed parameters are the following :

Order Description
1 Host category name
2 Host names to add/set. For multiple definitions, use the | delimiter

Setseverity

In order to turn a host category into a severity, use the SETSEVERITY action :

[root@centreon ~]# ./centreon -u admin -p centreon -o HC -a setseverity -v "Critical;3;16x16/critical.gif"

The needed parameters are the following :

Order Description
1 Host category name
2 Severity level - must be a number
3 Icon that represents the severity

Unsetseverity

In order to turn a severity into a regular host category, use the UNSETSEVERITY action :

[root@centreon ~]# ./centreon -u admin -p centreon -o HC -a unsetseverity -v "Critical"

The needed parameters are the following :

Order Description
1 Host category name

Delmember

In order to remove a host or a host template from a host category, use the DELMEMBER action :

[root@centreon ~]# ./centreon -u admin -p centreon -o HC -a delmember -v "Linux;host7"
[root@centreon ~]# ./centreon -u admin -p centreon -o HC -a delmember -v "Windows;host8"

The needed parameters are the following :

Order Description
1 Host category name
2 Host names to remove from host category

Host groups

Overview

Object name : HG
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Show

In order to list available host groups, use the SHOW action :

[root@centreon ~]# ./centreon -u admin -p centreon -o HG -a show
id;name;alias
53;Linux-Servers;All linux servers
54;Windows-Servers;All windows servers
55;Networks;All other equipments
56;Printers;All printers
58;Routers;All routers
59;Switchs;All switchs
60;Firewall;All firewalls
61;Unix-Servers;All unix servers

Columns are the following :

Column Description
ID ID
Name Name
Alias Alias

Add

In order to add a hostgroup, use the ADD action :

[root@centreon ~]# ./centreon -u admin -p centreon -o HG -a add -v "SAP;SAP servers"

The required parameters are the following :

Order Description
1 Name of host group
2 Alias of host group

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Del

In order to delete one hostgroup, use the DEL action. The host group name is used for identifying the host group you
would like to delete :

[root@centreon ~]# ./centreon -u admin -p centreon -o HG -a DEL -v "SAP"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Setparam

In order to set a specific parameter for a host group, use the SETPARAM action :

[root@centreon ~]# ./centreon -u admin -p centreon -o HG -a setparam -v "SAP;name;hg1"
[root@centreon ~]# ./centreon -u admin -p centreon -o HG -a setparam -v "SAP;alias;hg2"
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You may change the following parameters :

Parameter Description
name Name
alias Alias
comment Comment
activate 1 when enabled, 0 otherwise
notes Notes
notes_url Notes URL
action_url Action URL
icon_image Icon image
map_icon_image Map icon image

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Getmember

If you want to retrieve the members of a host group, use the GETMEMBER action :

[root@centreon ~]# ./centreon -u admin -p centreon -o HG -a getmember -v "Linux-Servers"
id;name
34;Centreon-Server
35;srv-web

Addmember and Setmember

If you want to add members to a specific host group, use the SETMEMBER or ADDMEMBER action :

[root@centreon ~]# ./centreon -u admin -p centreon -o HG -a setmember -v "Linux-Servers;srv-test|srv-test2"
[root@centreon ~]# ./centreon -u admin -p centreon -o HG -a addmember -v "Linux-Servers;srv-new"

Action Description
set* Overwrites previous definitions. Use the delimiter | to set multiple members
add* Appends new members to the existing ones. Use the delimiter | to add multiple members

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Delmember

If you want to remove members from a specific host group, use the DELMEMBER action :

[root@centreon ~]# ./centreon -u admin -p centreon -o HG -a delmember -v "Linux-Servers;srv-test"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Host group services

Overview

Object name : HGSERVICE

468
CENTREON 46-52 RUE ALBERT FR75014 PARIS

Chapitre 15. API



Refer to the SERVICE object

Note : HGSERVICE works just like SERVICE, you only need to replace the host name with the host group name.

Instances (Pollers)

Overview

Object name : INSTANCE

Show

In order to list available instances, use the SHOW action :

[root@centreon ~]# ./centreon -u admin -p centreon -o INSTANCE -a show
id;name;localhost;ip address;activate;status;init script;monitoring engine;bin;stats bin;perfdata;ssh port
1;Central;1;127.0.0.1;1;0;/etc/init.d/nagios;NAGIOS;/usr/local/nagios/bin/nagios;/usr/local/nagios/bin/nagiostats;/usr/local/nagios/var/service-perfdata;22
[...]

Columns are the following :

Column Description
ID ID
Name Name
Localhost 1 if it is the main poller, 0 otherwise
IP Address IP address of the poller
Activate 1 if poller is enabled, 0 otherwise
Status 1 if poller is running, 0 otherwise
Init script Init script path
Monitoring Engine Engine used on poller : NAGIOS, ICINGA, SHINKEN...
Bin Path of the Scheduler binary
Stats Bin Path of the Nagios Stats binary
Perfdata Path of perfdata file
SSH Port SSH Port

Add

In order to add an instance you use the ADD action :

[root@centreon ~]# ./centreon -u admin -p centreon -o INSTANCE -a add -v "Poller test;10.30.2.55;22;NAGIOS"

Required fields are :

Column Description
Name
Address IP address of the poller
SSH Port SSH port
Monitoring Engine Engine used on poller : NAGIOS, ICINGA, SHINKEN
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Del

If you want to remove an instance, use the DEL action. The Name is used for identifying the instance to delete :

[root@centreon ~]# ./centreon -u admin -p centreon -o INSTANCE -a del -v "Poller test"

Setparam

If you want to change a specific parameter of an instance, use the SETPARAM command. The Name is used for
identifying the instance to update :

[root@centreon ~]# ./centreon -u admin -p centreon -o INSTANCE -a setparam -v "Poller test;ns_ip_address;10.30.2.99"

Arguments are composed of the following columns :

Order Column description
1 Name of instance
2 Parameter name
3 Parameter value

Parameters that you may change are :

Column Description
name
localhost 1 if it is the main poller, 0 otherwise
ns_ip_address IP address of the poller
ns_activate 1 if poller is enabled, 0 otherwise
init_script Init script path
monitoring_engine Engine used on poller : NAGIOS, ICINGA, SHINKEN
nagios_bin Path of the Scheduler binary
nagiostats_bin Path of the Nagios Stats binary
nagios_perfdata Path of perfdata file
ssh_port SSH Port
centreonbroker_cfg_path Centreon Broker Configuration path
centreonbroker_module_path Centreon Broker Module path

Gethosts

If you want to list all hosts that are monitored by a poller, use the GETHOSTS action. The Name is used for identifying
the instance to query :

[root@centreon ~]# ./centreon -u admin -p centreon -o INSTANCE -a GETHOSTS -v "Poller test"
14;Centreon-Server;127.0.0.1
17;srv-website;10.30.2.1

Returned info is the following :

Order Description
1 Host ID
2 Host name
3 Host address
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LDAP configuration

Overview

Object name : LDAP

Show

In order to list available LDAP configurations, use the SHOW action :

[root@centreon ~]# ./centreon -u admin -p centreon -o LDAP -a show
id;name;description;status
3;ad;my ad conf;1
2;openldap;my openldap conf;1
[...]

Columns are the following :

Order Description
1 ID
2 Configuration name
3 Configuration description
4 1 when enabled, 0 when disabled

Add

In order to add an LDAP configuration, use the ADD action :

[root@centreon ~]# ./centreon -u admin -p centreon -o LDAP -a add -v "my new configuration;my description"

Required fields are :

Order Description
1 Configuration name
2 Configuration description

Del

If you want to remove an LDAP configuration, use the DEL action. The Configuration Name is used for identifying
the LDAP configuration to delete :

[root@centreon ~]# ./centreon -u admin -p centreon -o LDAP -a del -v "my new configuration"

Setparam

If you want to change a specific parameter of an LDAP configuration, use the SETPARAM action. The Configuration
Name is used for identifying the LDAP configuration to update :

[root@centreon ~]# ./centreon -u admin -p centreon -o LDAP -a SETPARAM -v "my new configuration;description;my new desc"
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Parameters use the following order :

Order Description
1 Configuration to update
2 Parameter key
3 Parameter value

Parameters that you may change are the following :

Key Description
name Configuration name
description Configuration description
enable 1 when enabled, 0 when disabled
alias Alias
bind_dn Bind DN
bind_pass Bind password
group_base_search Group base search
group_filter Group filter
group_member Group member
group_name Group name
ldap_auto_import Enable or disable auto import (0 or 1)
ldap_contact_tmpl Contact template to use on import
ldap_dns_use_domain Use domain or not (0 or 1)
ldap_search_limit Search size limit
ldap_search_timeout Timeout delay (in seconds)
ldap_srv_dns DNS server (only used when ldap_dns_use_domain is set to 1)
ldap_store_password Store password in database or not (0 or 1)
ldap_template Possible values : Posix, Active Directory
protocol_version Protocl version (2 or 3)
user_base_search User base search
user_email User email
user_filter User filter
user_firstname User firstname
user_lastname User lastname
user_name User name
user_pager User phone number
user_group User group

Showserver

In order to show the server list of an LDAP configuration, use the SHOWSERVER action. The Configuration Name
is used for identifying the LDAP configuration to query :

[root@centreon ~]# ./centreon -u admin -p centreon -o LDAP -a SHOWSERVER -v "openldap"
id;address;port;ssl;tls;order
2;10.30.2.3;389;0;0;1

Addserver

In order to add a server to an LDAP configuration, use the ADDSERVER action :

[root@centreon ~]# ./centreon -u admin -p centreon -o LDAP -a ADDSERVER -v "openldap;10.30.2.15;389;0;1"
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Required parameters are the following :

Order Description
1 Configuration name
2 Server address
3 Server port
4 Use SSL or not
5 Use TLS or not

Delserver

In order to remove a server from an LDAP configuration, use the DELSERVER action. The server ID is used for
identifying the server to delete :

[root@centreon ~]# ./centreon -u admin -p centreon -o LDAP -a DELSERVER -v 2

Setparamserver

In order to update the server parameters of an LDAP configuration, use the SETPARAMSERVER action. The server
ID is used for identifying the server to update :

[root@centreon ~]# ./centreon -u admin -p centreon -o LDAP -a SETPARAMSERVER -v "2;use_ssl;1"

Parameters that you may update are the following :

Key Description Possible values
host_address Address of the server
host_port Port of the server
host_order Priority order in case of failover
use_ssl Use SSL or not 0 or 1
use_tls Use TLS or not 0 or 1

Resource CFG

Overview

Object name : RESOURCECFG

Show

In order to list available Resource variables, use the SHOW action :

[root@centreon ~]# ./centreon -u admin -p centreon -o RESOURCECFG -a show
id;name;value;comment;activate;instance
1;$USER1$;/usr/local/nagios/libexec;path to the plugins;1;Central
[...]

Columns are the following :
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Column Description
ID ID
Name Name
Value Value of $USERn$ macro
Comment Comment
Activate 1 when activated, 0 otherwise
Instance Instances that are tied to the $USERn$ macro

Add

In order to add a resource macro, use the ADD action :

[root@centreon ~]# ./centreon -u admin -p centreon -o RESOURCECFG -a add -v "USER2;public;Poller test;my comment"

Required fields are :

Column Description
Name Macro name ; do not use the $ symbols
Value Macro value
Instances Instances that are tied to $USERn$ macro
Comment Comment

Del

If you want to remove a Resource variable, use the DEL action. The ID is used for identifying the variable to delete :

[root@centreon ~]# ./centreon -u admin -p centreon -o RESOURCECFG -a del -v "1"

Setparam

If you want to change a specific parameter of a Resource macro, use the SETPARAM action. The ID is used for
identifying the macro to update :

[root@centreon ~]# ./centreon -u admin -p centreon -o RESOURCECFG -a setparam -v "1;instance;Poller test|AnotherPoller"

Arguments are composed of the following columns :

Order Column description
1 ID number of resource configuration
2 Parameter name
3 Parameter value

Parameters that you may change are :

Column Description
name Macro name ; do not use the $ symbols
value Macro value
activate 1 when activated, 0 otherwise
comment Comment
instance Instances that are tied to $USERn$ macro Use delimiter | for multiple instance definitions
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Service templates

Overview

Object name : STPL

Show

In order to list available service, use the SHOW action :

[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a show
id;description;check command;check command arg;normal check interval;retry check interval;max check attempts;active checks enabled;passive checks enabled
1;generic-service;generic-service;;;5;1;3;1;0
3;Ping-LAN;Ping;check_centreon_ping;!3!200,20%!400,50%;;;;2;2
4;Ping-WAN;Ping;check_centreon_ping;!3!400,20%!600,50%;;;;2;2
5;SNMP-DISK-/;Disk-/;check_centreon_remote_storage;!/!80!90;;;;2;2
6;SNMP-DISK-/var;Disk-/var;check_centreon_remote_storage;!/var!80!90;;;;2;2
7;SNMP-DISK-/usr;Disk-/usr;check_centreon_remote_storage;!/usr!80!90;;;;2;2
8;SNMP-DISK-/home;Disk-/home;check_centreon_remote_storage;!/home!80!90;;;;2;2
9;SNMP-DISK-/opt;Disk-/opt;check_centreon_remote_storage;!/opt!80!90;;;;2;2

Columns are the following :

Order Description
1 Service ID
2 Service Description
3 Check command
4 Check command arguments
5 Normal check interval
6 Retry check interval
7 Maximum check attempts
8 1 when active checks are enabled, 0 otherwise
9 1 when passive checks are enabled, 0 otherwise

Add

In order to add a service template, use the ADD action :

[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a add -v "MyTemplate;mytemplate;Ping-LAN"

The required fields are :

Order Description
1 Service template description
2 Alias will be used when services are deployed through host templates
3 Service template ; Only one service template can be defined

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Del

In order to remove a service template, use the DEL action :
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[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a del -v "MyTemplate"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Setparam

In order to set a specific parameter for a service template, use the SETPARAM action :

[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a setparam -v "MyTemplate;max_check_attempts;10"
[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a setparam -v "MyTemplate;normal_check_interval;2"
[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a setparam -v "MyTemplate;normal_check_interval;http://192.168.1.2/admincp"

The required fields that you have pass in options are :

Order Description
1 service template description
2 parameter that you want to update
3 new paramater value

Parameters that may be modified :

Parameter Description
activate 1 when service is enabled, 0 otherwise
description Service template description
alias Service template alias
template Name of the service template
is_volatile 1 when service is volatile, 0 otherwise
check_period Name of the check period
check_command Name of the check command
check_command_arguments Arguments that go along with the check command, prepend each argument with the ‘ !’ characteri
max_check_attempts Maximum number of attempt before a HARD state is declared
normal_check_interval value in minutes
retry_check_interval value in minutes
active_checks_enabled 1 when active checks are enabled, 0 otherwise
passive_checks_enabled 1 when passive checks are enabled, 0 otherwise
contact_additive_inheritance Enables contact additive inheritance=
cg_additive_inheritance Enables contactgroup additive inheritance
notification_interval value in minutes
notification_period Name of the notification period
notification_options Status linked to notifications
first_notification_delay First notification delay in seconds
recovery_notification_delay Recovery notification delay
parallelize_check 1 when parallelize checks are enabled, 0 otherwise
obsess_over_service 1 when obsess over service is enabled, 0 otherwise
check_freshness 1 when check freshness is enabled, 0 otherwise
freshness_threshold Service freshness threshold in seconds
event_handler_enabled 1 when event handler is enabled, 0 otherwise
flap_detection_enabled 1 when flap detection is enabled, 0 otherwise
process_perf_data 1 when process performance data is enabled, 0 otherwise
retain_status_information 1 when status information is retained, 0 otherwise
retain_nonstatus_information 1 when non status information is retained, 0 otherwise
stalking_options Comma separated options : ‘o’ for OK, ‘w’ for Warning, ‘u’ for Unknown and ‘c’ for Critical

Suite sur la page suivante
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TABLE 15.6 – Suite de la page précédente
Parameter Description
event_handler Name of the event handler command
event_handler_arguments Arguments that go along with the event handler, prepend each argument with the ” !” character
notes Notes
notes_url Notes URL
action_url Action URL
icon_image Icon image
icon_image_alt Icon image alt text
graphtemplate Graph template namei
comment Comment
service_notification_options Notification options (w,u,c,r,f,s)

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Addhosttemplate and Sethosttemplate

You may want to tie a service template to an extra host template. In order to do so, use the ADDHOSTTEMPLATE
or SETHOSTTEMPLATE actions where add will append and set will overwrite previous definitions :

[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a sethosttemplate -v "MyTemplate;generic-host-template"
[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a addhosttemplate -v "MyTemplate;Linux-Servers"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Delhosttemplate

In order to remove the relation between a host template and a service template, use the DELHOSTTEMPLATE
action :

[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a delhosttemplate -v "MyTemplate;Linux-Servers"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Getmacro

In order to view the custom macro list of a service template, use the GETMACRO action :

[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a getmacro -v "MyTemplate"
macro name;macro value;description
$_SERVICETIME$;80;description of macro1
$_SERVICEPL$;400;description of macro2

Setmacro

In order to set a macro for a specific service template use the SETMACRO action :
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[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a setmacro -v "MyTemplate;time;80"
[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a setmacro -v "MyTemplate;pl;400"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Delmacro

In order to remove a macro from a specific service template, use the DELMACRO action :

[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a delmacro -v "MyTemplate;time"
[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a delmacro -v "MyTemplate;pl"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Getcontact

In order to view the contact list of a service template, use the GETCONTACT action :

[root@localhost core]# ./centreon -u admin -p centreon -o STPL -a getcontact -v "MyTemplate"
id;name
28;Contact_1
29;Contact_2

Addcontact and Setcontact

In order to add a new contact to notification contact list, use ADDCONTACT or SETCONTACT actions where add
will append and set will overwrite previous definitions :

[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a addcontact -v "MyTemplate;User1"
[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a setcontact -v "MyTemplate;User1|User2"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Delcontact

In order to remove a contact from the notification contact list, use the DELCONTACT action :

[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a delcontact -v "MyTemplate;User1"
[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a delcontact -v "MyTemplate;User2"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.
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Getcontactgroup

In order to view the contactgroup list of a service template, use the GETCONTACTGROUP action :

[root@localhost core]# ./centreon -u admin -p centreon -o STPL -a getcontactgroup -v "MyTemplate"
id;name
28;ContactGroup_1
29;ContactGroup_2

Setcontactgroup

In order to add a new contactgroup to notification contactgroup list, use the ADDCONTACTGROUP or SETCON-
TACTGROUP actions where add will append and set will overwrite previous definitions :

[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a addcontactgroup -v "MyTemplate;Group1"
[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a setcontactgroup -v "MyTemplate;Group1|Group2"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Delcontactgroup

In order to remove a contactgroup from the notification contactgroup list, use the DELCONTACTGROUP action :

[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a delcontactgroup -v "MyTemplate"
[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a delcontactgroup -v "MyTemplate;Group1"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Gettrap

In order to view the trap list of a service template, use the GETTRAP action :

[root@localhost core]# ./centreon -u admin -p centreon -o "STPL" -a gettrap -v "Ping-LAN"
id;name
48;ciscoConfigManEvent
39;ospfVirtIfTxRetransmit

Settrap

In order to add a trap to a service template, use the ADDTRAP or SETTRAP actions where add will append and set
will overwrite previous definitions :

[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a addtrap -v "Ping-LAN;snOspfVirtIfConfigError"
[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a settrap -v "Ping-LAN;snOspfVirtNbrStateChange|snTrapAccessListDeny"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.
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Deltrap

In order to remove a trap from a service template, use the DELTRAP action :

[root@centreon ~]# ./centreon -u admin -p centreon -o STPL -a deltrap -v "Ping-LAN;snOspfVirtIfConfigError"

Services

Overview

Object name : SERVICE

Show

In order to list available service, use the SHOW action :

[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a show
host id;host name;id;description;check command;check command arg;normal check interval;retry check interval;max check attempts;active checks enabled;passive checks enabled;activate
14;Centreon-Server;19;Disk-/;;;;;;2;2;1
14;Centreon-Server;20;Disk-/home;;;;;;2;2;1
14;Centreon-Server;21;Disk-/opt;;;;;;2;2;1
14;Centreon-Server;22;Disk-/usr;;;;;;2;2;1
14;Centreon-Server;23;Disk-/var;;;;;;2;2;1
14;Centreon-Server;151;Load;;;;;;2;2;1
14;Centreon-Server;25;Memory;;;;;;2;2;1
14;Centreon-Server;26;Ping;;;;;;2;2;0
14;Centreon-Server;40;dummy;check_centreon_dummy;!2!critical;;;;2;2;1

Columns are the following :

Column Description
Host ID Host ID
Host name Host name
Service ID Service ID
Service description Service description
Check Command Check command
Command arguments Check command arguments
Normal check interval Normal check interval
Retry check interval Retry check interval
Max check attempts Maximum check attempts
Active check enable 1 when active checks are enabled, 0 otherwise
Passive check enable 1 when passive checks are enabled, 0 otherwise
Activate 1 when enabled, 0 when disabled

Add

In order to add a service, use the ADD action :

[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a add -v "Host-Test;ping;Ping-LAN"
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The required fields are :

Order Description
1 Host name
2 Service description
3 Service template - Only one service template can be defined

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Del

In order to remove a service, use the DEL action :

[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a del -v "test;ping"

The required fields are :

Order Description
1 Host name
2 Service description

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Setparam

In order to set a specific paremeter for a particular service, use the SETPARAM action :

[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a setparam -v "test;ping;max_check_attempts;10"
[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a setparam -v "test;ping;normal_check_interval;2"
[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a setparam -v "test;ping;normal_check_interval;10"

The required fields are :

Order Description
1 Host name
2 Service description
3 Paramater that you want to update
4 New parameter value

Parameters that may be modified :

Parameter Description
activate 1 when service is enabled, 0 otherwise
description Description
template Name of the service template
is_volatile 1 when service is volatile, 0 otherwise
check_period Name of the check period
check_command Name of the check command
check_command_arguments Arguments that go along with the check command, prepend each argument with the ‘ !’ characteri
max_check_attempts Maximum number of attempt before a HARD state is declared
normal_check_interval value in minutes
retry_check_interval value in minutes
active_checks_enabled 1 when active checks are enabled, 0 otherwise
passive_checks_enabled 1 when passive checks are enabled, 0 otherwise

Suite sur la page suivante
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TABLE 15.7 – Suite de la page précédente
Parameter Description
notifications_enabled 1 when notification is enabled, 0 otherwise
contact_additive_inheritance Enables contact additive inheritance
cg_additive_inheritance Enables contactgroup additive inheritance
notification_interval value in minutes
notification_period Name of the notification period
notification_options Status linked to notifications
first_notification_delay First notification delay in seconds
obsess_over_service 1 when obsess over service is enabled, 0 otherwise
check_freshness 1 when check freshness is enabled, 0 otherwise
freshness_threshold Value in seconds
event_handler_enabled 1 when event handler is enabled, 0 otherwise
flap_detection_enabled 1 when flap detection is enabled, 0 otherwise
retain_status_information 1 when status information is retained, 0 otherwise
retain_nonstatus_information 1 when non status information is retained, 0 otherwise
event_handler Name of the event handler command
event_handler_arguments Arguments that go along with the event handler, prepend each argument with the ‘ !’ character
notes Notes
notes_url Notes URL
action_url Action URL
icon_image Icon image
icon_image_alt Icon image alt text
comment Comment
service_notification_options Notification options (w,u,c,r,f,s)

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Addhost and Sethost

You may want to tie a service to an extra host. In order to do so, use the ADDHOST or SETHOST actions where add
will append and set will overwrite previous definitions :

[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a sethost -v "host1;ping;host2"

[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a addhost -v "host1;ping;host2"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Delhost

In order to remove the relation between a host and a service, use the DELHOST action :

[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a delhost -v "host1;ping;host2"

The service ping which was originally linked to host1 and host2 is now only linked to host1.

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.
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Getmacro

In order to view the custom macro list of a service, use the GETMACRO action :

[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a getmacro -v "host1;ping"
macro name;macro value;is_password;description
$_SERVICETIME$;80;0;description of macro
$_SERVICEPL$;400;0;description of macro

Setmacro

In order to set a macro for a specific service use the SETMACRO action :

[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a setmacro -v "test;ping;time;80;0;description of macro"
[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a setmacro -v "test;ping;pl;400;0;description of macro"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Delmacro

In order to remove a macro from a specific service use the DELMACRO action :

[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a delmacro -v "test;ping;time"
[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a delmacro -v "test;ping;pl"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Setseverity

In order to associate a severity to a service, use the SETSEVERITY action :

[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a setseverity -v "Centreon-Server;ping;Critical"

Required parameters :

Order Description
1 Host name
2 Service description
3 Severity name

Unsetseverity

In order to remove the severity from a service, use the UNSETSEVERITY action :

[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a unsetseverity -v "Centreon-Server;ping"

Required parameters :

Order Description
1 Host name
2 Service description
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Getcontact

In order to view the contact list of a service, use the GETCONTACT action :

[root@localhost core]# ./centreon -u admin -p centreon -o "SERVICE" -a getcontact -v "Centreon-Server;Ping"
id;name
28;Contact_1
29;Contact_2

Addcontact and Setcontact

In order to add a new contact to notification contact list, use the ADDCONTACT or SETCONTACT actions where
add will append and set will overwrite previous definitions :

[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a addcontact -v "test;ping;User1"
[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a setcontact -v "test;ping;User1|User2"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Delcontact

In order to remove a contact from the notification contact list, use the DELCONTACT action :

[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a delcontact -v "test;ping;User1"
[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a delcontact -v "test;ping;User2"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Getcontactgroup

In order to view the contact group list of a service, use the GETCONTACTGROUP action :

[root@localhost core]# ./centreon -u admin -p centreon -o "SERVICE" -a getcontactgroup -v "Centreon-Server;Ping"
id;name
28;ContactGroup_1
29;ContactGroup_2

Addcontactgroup and Setcontactgroup

In order to add a new contactgroup to notification contactgroup list, use the ADDCONTACTGROUP or SETCON-
TACTGROUP actions where add will append and set will overwrite previous definitions :

[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a addcontactgroup -v "test;ping;Group1"
[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a setcontactgroup -v "test;ping;Group1|Group2"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.
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Delcontactgroup

In order to remove a contactgroup from the notification contactgroup list, use DELCONTACTGROUP action :

[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a delcontactgroup -v "test;ping;Group1"
[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a delcontactgroup -v "test;ping;Group2"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Gettrap

In order to view the trap list of a service, use the GETTRAP action :

[root@localhost core]# ./centreon -u admin -p centreon -o "SERVICE" -a gettrap -v "Centreon-Server;Ping"
id;name
48;ciscoConfigManEvent
39;ospfVirtIfTxRetransmit

Addtrap and Settrap

In order to add a new trap, use the ADDTRAP or SETTRAP actions where add will append and set will overwrite
previous definitions :

[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a addtrap -v "test;ping;snOspfVirtIfConfigError"
[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a settrap -v "test;ping;snOspfVirtNbrStateChange|snTrapAccessListDeny"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Deltrap

In order to remove a trap from a service, use the DELTRAP command :

[root@centreon ~]# ./centreon -u admin -p centreon -o SERVICE -a deltrap -v "test;ping;snOspfVirtIfConfigError"

Service groups

Overview

Object name : SG

Show

In order to list available servicegroups, use the SHOW action :

[root@centreon ~]# ./centreon -u admin -p centreon -o SG -a show
id;name;alias
11;Alfresco;Alfresco Services
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Add

In order to add a servicegroup, use the ADD action :

[root@centreon ~]# ./centreon -u admin -p centreon -o SG -a ADD -v "Alfresco;Alfresco Services"

Required fields are :

Order Description
1 Name of service group
2 Alias of service group

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Del

In order to remove a servicegroup, use the DEL action :

[root@centreon ~]# ./centreon -u admin -p centreon -o SG -a del -v "Alfresco"

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Setparam

In order to change parameters for a servciegroup, use the SETPARAM action :

[root@centreon ~]# ./centreon -u admin -p centreon -o SG -a setparam -v "SG1;name;Web Service"

You can change the following parameters :

Parameter Description
activate 1 when service is enabled, 0 otherwise
name Name of service group
alias Alias of service group
comment Comments regarding service group

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Getservice and Gethostgroupservice

In order to view the members of a service group, use the GETSERVICE or GETHOSTGROUPSERVICE actions :

[root@centreon ~]# ./centreon -u admin -p centreon -o SG -a getservice -v "Web-Access"
host id;host name;service id;service description
14;Centreon-Server;28;http
14;Centreon-Server;29;TCP-80

[root@centreon ~]# ./centreon -u admin -p centreon -o SG -a gethostgroupservice -v "Web-Access"
hostgroup id;hostgroup name;service id;service description
22;Web group;31;mysql

Note : hostgroupservice is a service by hostgroup
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Addservice, Setservice, Addhostgroupservice and Sethostgroupservice

In order to add a new element to a specific service group, you can use ADDSERVICE, SETSERVICE, ADDHOST-
GROUPSERVICE, SETHOSTGROUPSERVICE where add will append and set will overwrite previous defini-
tions :

[root@centreon ~]# ./centreon -u admin -p centreon -o SG -a addservice -v "Web-Access;www.centreon.com,http"
[root@centreon ~]# ./centreon -u admin -p centreon -o SG -a setservice -v "Web-Access;www.centreon.com,TCP-80|www.centreon.com,http|www.centreon.com,mysql"
[root@centreon ~]# ./centreon -u admin -p centreon -o SG -a sethostgroupservice -v "Web-Access;web group,TCP-80"

Note : hostgroupservice is a service by hostgroup

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Delservice and Delhostgroupservice

In order to remove a service from a service group, use the DELSERVICE or DELHOSTGROUPSERVICE actions :

[root@centreon ~]# ./centreon -u admin -p centreon -o SG -a delservice -v "Web-Access;www.centreon.com,http"
[root@centreon ~]# ./centreon -u admin -p centreon -o SG -a delhostgroupservice -v "Web-Access;Web group,mysql"

Note : hostgroupservice is a service by hostgroup

Note : You need to generate your configuration file and restart monitoring engine in order to apply changes.

Service categories

Overview

Object name : SC

Show

In order to list available service categories, use the SHOW action :

[root@centreon ~]# ./centreon -u admin -p centreon -o SC -a show
id;name;description
1;Ping;ping
2;Traffic;traffic
3;Disk;disk

Columns are the following :

Column Description
Name Name of service category
Description Description of service category
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Add

In order to add a service category, use the ADD action :

[root@centreon ~]# ./centreon -u admin -p centreon -o SC -a ADD -v "Alfresco;Alfresco Services"

Required parameters are :

Column Description
Name Name of service category
Description Description of service category

Del

In order to remove a service category, use the DEL :

[root@centreon ~]# ./centreon -u admin -p centreon -o SC -a del -v "Alfresco"

Setparam

In order to change parameters for a service category, use the SETPARAM action :

[root@centreon ~]# ./centreon -u admin -p centreon -o SC -a setparam -v "SG1;name;Web Service"

You can change the following parameters :

Parameter Description
Name Name of service category
Description Description of service category

Getservice and Getservicetemplate

In order to view the member list of a service category, use the GETSERVICE or GETSERVICETEMPLATE action :

[root@centreon ~]# ./centreon -u admin -p centreon -o SC -a getservice -v "Ping-Category"
host id;host name;service id;service description
14;Centreon-Server;27;Ping
27;srv-web;42;Ping

[root@centreon ~]# ./centreon -u admin -p centreon -o SC -a getservicetemplate -v "Ping-Category"
template id;service template description
22;Ping-LAN
23;Ping-WAN

Addservice, Setservice , Addservicetemplate and Setservicetemplate

In order to add a new element to a specific service category, you use the following action ADDSERVICETEM-
PLATE, where add will append and set will overwrite previous definitions :

[root@centreon ~]# ./centreon -u admin -p centreon -o SC -a addservicetemplate -v "Ping-Category;my template"
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Delservice and Delservicetemplate

In order to remove a service from a specific service category, use the DELSERVICE OR DELSERVICETEM-
PLATE actions :

[root@centreon ~]# ./centreon -u admin -p centreon -o SC -a delservice -v "Ping-Category;my host,my service"

[root@centreon ~]# ./centreon -u admin -p centreon -o SC -a delservicetemplate -v "Ping-Category;my template"

Setseverity

In order to turn a service category into a severity, use the SETSEVERITY action :

[root@centreon ~]# ./centreon -u admin -p centreon -o SC -a setseverity -v "Critical;3;16x16/critical.gif"

The needed parameters are the following :

Order Description
1 Service category name
2 Severity level - must be a number
3 Icon that represents the severity

Unsetseverity

In order to turn a severity into a regular service category, use the UNSETSEVERITY action :

[root@centreon ~]# ./centreon -u admin -p centreon -o SC -a unsetseverity -v "Critical"

The needed parameters are the following :

Order Description
1 Service category name

Settings

Overview

Object name : Settings

Show

In order to list editable settings, use the SHOW action :

[root@centreon ~]# ./centreon -u admin -p centreon -o SETTINGS -a show
parameter;value
broker;ndo
broker_correlator_script;
centstorage;1
debug_auth;0
debug_ldap_import;0
debug_nagios_import;0
debug_path;/var/log/centreon/
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debug_rrdtool;0
enable_autologin;1
enable_gmt;0
enable_logs_sync;1
enable_perfdata_sync;1
gmt;1
interval_length;60
mailer_path_bin;/bin/mail
nagios_path_img;/usr/share/nagios/html/images/logos/
perl_library_path;/usr/local/lib
rrdtool_path_bin;/usr/bin/rrdtool
snmpttconvertmib_path_bin;/usr/share/centreon/bin/snmpttconvertmib
snmptt_unknowntrap_log_file;snmptrapd.log

Setparam

If you want to change a specific parameter of a Vendor, use the SETPARAM action :

[root@centreon ~]# ./centreon -u admin -p centreon -o SETTINGS -a setparam -v ";"

Arguments are composed of the following columns :

Order Column description
1 Parameter name
2 Parameter value

Parameters that you may change are :
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Column Description Possible values and
examples

broker Broker engine ‘broker’ for Centreon Broker,
‘ndo’ for NDOUtils

bro-
ker_correlator_script

This parameter is misleading (subject to changes) Refers
to the Centreon Broker init script

i.e : cbd

centstorage Enable/disable CentStorage Enable : ‘1’, Disable : ‘0’
debug_auth Enable/disable authentication debug Enable : ‘1’, Disable : ‘0’
de-
bug_ldap_import

Enable/disable LDAP debug Enable : ‘1’, Disable : ‘0’

de-
bug_nagios_import

Enable/disable Nagios configuration import Enable : ‘1’, Disable : ‘0’

debug_path Debug log files directory i.e : /var/log/centreon/
debug_rrdtool Enable/disable RRDTool debug Enable : ‘1’, Disable : ‘0’
enable_autologin Enable/disable autologin Enable : ‘1’, Disable : ‘0’
enable_gmt Enable/disable GMT management Enable : ‘1’, Disable : ‘0’
enable_logs_sync Enable/disable CentCore log synchronization (not

necessary when using Centreon Broker)
Enable : ‘1’, Disable : ‘0’

en-
able_perfdata_sync

Enable/disable Centcore PerfData synchronization (not
necessary when using Centreon Broker)

Enable : ‘1’, Disable : ‘0’

gmt GMT timezone of monitoring system i.e : 2 (for GMT+2)
interval_length Monitoring interval length in seconds (default : 60) i.e : 120
mailer_path_bin Mail client bin path i.e : /bin/mail
nagios_path_img Nagios image path i.e :

/usr/share/nagios/html/images/logos/
perl_library_path Perl library path i.e : /usr/local/lib
rrdtool_path_bin RRDTool bin path i.e : /usr/bin/rrdtool
snmpttconvert-
mib_path_bin

SNMPTT mib converter bin path i.e :
/usr/share/centreon/bin/snmpttconvertmib

snmptt_unknowntrap_log_fileSNMPTT unknown trap log file i.e : snmptrapd.log

Time periods

Overview

Object name : TP

Show

In order to list available time periods, use the SHOW action :

[root@centreon ~]# ./centreon -u admin -p centreon -o TP -a show
id;name;alias;sunday;monday;tuesday;wednesday;thursday;friday,saturday
1;24x7;24_Hours_A_Day,_7_Days_A_Week;00:00-24:00;00:00-24:00;00:00-24:00;00:00-24:00;00:00-24:00;00:00-24:00;00:00-24:00
2;none;No Time Is A Good Time;;;;;;;
3;nonworkhours;Non-Work Hours;00:00-24:00;00:00-09:00,17:00-24:00;00:00-09:00,17:00-24:00;00:00-09:00,17:00-24:00;00:00-09:00,17:00-24:00;00:00-09:00,17:00-24:00;00:00-24:00
4;workhours;Work hours;;09:00-17:00;09:00-17:00;09:00-17:00;09:00-17:00;09:00-17:00;

Add

In order to add a Time Period, use the ADD action :
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[root@centreon ~]# ./centreon -u admin -p centreon -o TP -a add -v "Timeperiod_Test;Timeperiod_Test"

Required fields are :

Order Description
1 Name
2 Alias

Del

If you want to remove a Time Period, use the DEL action. The Name is used for identifying the Time Period to delete :

[root@centreon ~]# ./centreon -u admin -p centreon -o TP -a del -v "Timeperiod_Test"

Setparam

If you want to change a specific parameter of a time period, use the SETPARAM action. The Name is used for
identifying the Time Period to update :

[root@centreon ~]# ./centreon -u admin -p centreon -o TP -a setparam -v "Timeperiod_Test;monday;00:00-24:00"

Arguments are composed of the following columns :

Order Column description
1 Name of time period
2 Parameter name
3 Parameter value

Parameters that you may change are :

Column Description
name Name
alias Alias
sunday Time Period definition for Sunday
monday Time Period definition for Monday
tuesday Time Period definition for Tuesday
wednes-
day

Time Period definition for Wednesday

thursday Time Period definition for Thursday
friday Time Period definition for Friday
saturday Time Period definition for Saturday
include example : [...] -v “Timeperiod_Test ;include ;workhours” ; Use delimiter | for multiple inclusion

definitions
exclude example : [...] -v “Timeperiod_Test ;exclude ;weekend” use delimiter | for multiple exclusion

definitions

Getexception

In order to view the exception list of a time period, use the GETEXCEPTION action :
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[root@centreon ~]# ./centreon -u admin -p centreon -o TP -a getexception -v "mytimeperiod"
days;timerange
january 1;00:00-00:00
december 25;00:00-00:00

Setexception

In order to set an exception on a timeperiod, use the SETEXCEPTION action :

[root@centreon ~]# ./centreon -u admin -p centreon -o TP -a setexception -v "mytimeperiod;january 1;00:00-24:00"

Note : If exception does not exist, it will be created, otherwise it will be overwritten.

Delexception

In order to delete an exception, use the DELEXCEPTION action :

[root@centreon ~]# ./centreon -u admin -p centreon -o TP -a delexception -v "mytimeperiod;january 1"

Arguments are composed of the following columns :

Order Column description
1 Name of timeperiod
2 Exception to remove from timeperiod

Traps

Overview

Object name : TRAP

Show

In order to list available traps, use the SHOW action :

[root@centreon ~]# ./centreon -u admin -p centreon -o TRAP -a show
id;name;oid;manufacturer
576;alertSystemUp;.1.3.6.1.4.1.674.10892.1.0.1001;Dell
577;alertThermalShutdown;.1.3.6.1.4.1.674.10892.1.0.1004;Dell
578;alertTemperatureProbeNormal;.1.3.6.1.4.1.674.10892.1.0.1052;Dell
599;alertFanEnclosureInsertion;.1.3.6.1.4.1.674.10892.1.0.1452;Dell
600;alertFanEnclosureRemoval;.1.3.6.1.4.1.674.10892.1.0.1453;Dell
601;alertFanEnclosureExtendedRemoval;.1.3.6.1.4.1.674.10892.1.0.1454;Dell
602;alertLogNormal;.1.3.6.1.4.1.674.10892.1.0.1552;Dell
605;ccmCLIRunningConfigChanged;.1.3.6.1.4.1.9.9.43.2.0.2;Cisco
[...]
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Add

In order to add a trap, use the ADD action :

[root@centreon ~]# ./centreon -u admin -p centreon -o TRAP -a add -v "aNewTrap;.1.3.6.1.4.1.11.2.3.9.7.1.0.30"

Required fields are :

Order Description
1 Trap name
2 OID of the SNMP Trap

Del

If you want to remove a Trap, use the DEL action. The Name is used for identifying the Trap to delete :

[root@centreon ~]# ./centreon -u admin -p centreon -o TRAP -a del -v "aNewTrap"

Setparam

If you want to change a specific parameter of a Trap, use the SETPARAM command. The Name is used for identifying
the Trap to update :

[root@centreon ~]# ./centreon -u admin -p centreon -o TRAP -a setparam -v "aNewTrap;vendor;3com"

Arguments are composed of the following columns :

Order Column description
1 Name of Trap
2 Parameter name
3 Parameter value

Parameters that you may change are :

Column Description Possible values
name Name
comments Comments
output Output
oid OID
status Status ok, warning, critical, unknown or

0, 1, 2, 3
vendor Vendor name A valid vendor name
matching_mode Advanced regexp matching mode 1 to enable, 0 to disable
resche-
dule_svc_enable

Whether or not will reschedule service check when
trap is received

1 to enable, 0 to disable

execution_command Command to be executed when trap is received A valid Unix command line
execu-
tion_command_enable

Whether or not will execute the
‘execution_command’

1 to enable, 0 to disable

submit_result_enable Whether or not will submit result to Service 1 to enable, 0 to disable
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Getmatching

In order to display the list of matching rules defined for a specific trap, use the GETMATCHING command :

[root@centreon ~]# ./centreon -u admin -p centreon -o TRAP -a getmatching -v "aNewTrap"
id;string;regexp;status;order
8;@OUTPUT@;/test/;UNKNOWN;1

Column Description
ID ID of the matching rule
String String to match
Regexp Matching Regular Expression
Status Status to submit
Order Priority order of the matching rule

Addmatching

In order to add a matching rule, use the ADDMATCHING command :

[root@centreon ~]# ./centreon -u admin -p centreon -o TRAP -a addmatching -v "aNewTrap;@OUTPUT@;/test2/;critical"

Required fields are :

Order Description Possible values
1 Trap name
2 String to match
3 Matching Regular Expression
4 Status to submit ok, warning, critical, unknown or 0, 1, 2, 3

Delmatching

In order to delete a matching rule, use the DELMATCHING command :

[root@centreon ~]# ./centreon -u admin -p centreon -o TRAP -a delmatching -v "8"

Required fields are :

Column Description
ID ID of the matching rule

Updatematching

In order to delete a matching rule, use the UPDATEMATCHING command :

[root@centreon ~]# ./centreon -u admin -p centreon -o TRAP -a updatematching -v "8;status;critical"

Arguments are composed of the following columns :

Order Column description
1 ID of the matching rule
2 Parameter name
3 Parameter value

Parameters that you may change are :
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Column Description Possible values
string String to match
order Priority order
status Status to submit ok, warning, critical, unknown or 0, 1, 2, 3
regexp Matching Regular Expression

Vendors

Overview

Object name : VENDOR

Show

In order to list available vendors, use the SHOW action :

[root@centreon ~]# ./centreon -u admin -p centreon -o VENDOR -a show
id;name;alias
1;Cisco;Cisco Networks
2;HP;HP Networks
3;3com;3Com
4;Linksys;Linksys
6;Dell;Dell
7;Generic;Generic
9;Zebra;Zebra
11;HP-Compaq;HP and Compaq Systems

Add

In order to add a Vendor, use the ADD action :

[root@centreon ~]# ./centreon -u admin -p centreon -o VENDOR -a add -v "DLink;DLink routers"

Required fields are :

Order Description
1 Name
2 Alias

Del

If you want to remove a Vendor, use the DEL action. The Name is used for identifying the Vendor to delete :

[root@centreon ~]# ./centreon -u admin -p centreon -o VENDOR -a del -v "DLink"

Setparam

If you want to change a specific parameter of a Vendor, use the SETPARAM command. The Name is used for
identifying the Vendor to update :
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[root@centreon ~]# ./centreon -u admin -p centreon -o VENDOR -a setparam -v "3com;name;HP"

Arguments are composed of the following columns :

Order Column description
1 Name of Vendor
2 Parameter name
3 Parameter value

Parameters that you may change are :

Column Description
name Name
alias Alias
description Description

Generatetraps

It is possible to generate new SNMP traps from a given MIB file. In order to do so, use the GENERATETRAPS
command :

[root@centreon ~]# ./centreon -u admin -p centreon -o VENDOR -a generatetraps -v "3com;/usr/share/mymibs/3com/A3COM-SWITCHING-SYSTEMS-MIB.mib"
[...]
Done

Total translations: 10
Successful translations: 10
Failed translations: 0

Note : Make sure to put all the mib file dependencies in the /usr/share/snmp/mibs/ directory before starting the
generation. Then, remove them when it is done.

Required fields are :

Column Description
Name Name of Vendor
Mib file File path of .mib

15.2.4 Import/Export

Export

At some point, you might need to export all of the object configuration parameters into a plain text file, either for
synchronizing or backuping purpose.

The following items will not be exported :
— Escalation
— ACL (ACL Groups, ACL Resources, ACL actions)
— LDAP settings
— Global Centreon settings

This export feature is ran like this :

[root@centreon ~]# ./centreon -u admin -p centreon -e > /tmp/clapi-export.txt
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This will generate CLAPI commands and redirect them to the /tmp/clapi-export.txt file.

This file can now be read by the import command.

With this, you can also build your own CLAPI command file if you know the straight forward syntax.

For instance : :

HOST;ADD;Host-Test1;Test host;127.0.0.1;generic-host;Local Poller;Linux
HOST;ADD;Host-Test2;Test host;127.0.0.1;generic-host;Local Poller;Linux
HOST;ADD;Host-Test3;Test host;127.0.0.1;generic-host;Local Poller;Linux
HOST;ADD;Host-Test4;Test host;127.0.0.1;generic-host;Local Poller;Linux
HOST;ADD;Host-Test5;Test host;127.0.0.1;generic-host;Local Poller;Linux

Export of a subset of objects

Compatibility : Centreon Web >= 2.7.7

You can choose to export only predefined hosts or services.

For example, to export all services linked to “srv-mssql-01” host you have to execute following command :

[root@centreon ~]# ./centreon -u admin -p centreon -e --select=’HOST;srv-mssql-01’ --filter-type=’^(HOST|SERVICE)$’

To export “memory” and “mssql-listener” services execute following command :

[root@centreon ~]# ./centreon -e --select=’SERVICE;memory’ --select=’SERVICE;mssql-listener’ --filter-type=’^SERVICE$’

To export all commands run :

[root@centreon ~]# ./centreon -u admin -p centreon -o CMD -a show | awk -F\; ’NR > 2 { print "--select=\"CMD;" $2 "\"" }’ | xargs --verbose php ./centreon -u admin -p centreon -e

Import

You can import configuration from the exported file /tmp/clapi-export

[root@centreon ~]# ./centreon -u admin -p centreon -i /tmp/clapi-export.txt

In case you have a very large export file, it is advised to redirect the output of the above command to a file. Indeed,
when errors occur during the import process, CLAPI will print out an error message along with the line number of the
file, you might need to store those output message for troubleshooting later on.

You can build your own CLAPI command file if you know the straight forward syntax. You can use parameter descri-
bed in Object Management with the syntax you can see in export files

OBJECT;AACTION;Parameter1;Parameter2;Parameter3;...

15.3 Centreon Plugin API

15.3.1 Other Resources

If you’re looking at writing your own plugins for Centreon Engine, please make sure to visit these other resources :
— The official Nagios plugin project website
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15.3.2 Plugin Overview

Scripts and executables must do two things (at a minimum) in order to function as Centreon Engine plugins :
— Exit with one of several possible return values
— Return at least one line of text output to STDOUT

The inner workings of your plugin are unimportant to Centreon Engine. Your plugin could check the status of a TCP
port, run a database query, check disk free space, or do whatever else it needs to check something. The details will
depend on what needs to be checked - that’s up to you.

15.3.3 Return Code

Centreon Engine determines the status of a host or service by evaluating the return code from plugins. The following
tables shows a list of valid return codes, along with their corresponding service or host states.

Plugin Return Code Service State Host State
0 OK UP
1 WARNING UP
2 CRITICAL DOWN/UNREACHABLE
3 UNKNOWN DOWN/UNREACHABLE

15.3.4 Plugin Output Spec

At a minimum, plugins should return at least one of text output. Beginning with Centreon Engine 3, plugins can
optionally return multiple lines of output. Plugins may also return optional performance data that can be processed by
external applications. The basic format for plugin output is shown below :

TEXT OUTPUT | OPTIONAL PERFDATA LONG TEXT LINE 1 LONG TEXT LINE 2 ... LONG TEXT LINE N | PERFDATA LINE 2 PERFDATA LINE 3 ... PERFDATA LINE N

The performance data (shown in orange) is optional. If a plugin returns performance data in its output, it must separate
the performance data from the other text output using a pipe (|) symbol. Additional lines of long text output (shown in
blue) are also optional.

15.3.5 Plugin Output Examples

Let’s see some examples of possible plugin output...
— Case 1 : One line of output (text only) Assume we have a plugin that returns one line of output that looks like

this :

DISK OK - free space: / 3326 MB (56%);

If this plugin was used to perform a service check, the entire line of output will be stored in the SERVICEOUT-
PUT macro.

— Case 2 : One line of output (text and perfdata) A plugin can return optional performance data for use by external
applications. To do this, the performance data must be separated from the text output with a pipe | symbol like
such :

DISK OK - free space: / 3326 MB (56%);|/=2643MB;5948;5958;0;5968

If this plugin was used to perform a service check, the first portion of output (left of the pipe separator) will be
stored in the SERVICEOUTPUT macro and the second portion of output (right of the pipe separator) will be
stored in the SERVICEPERFDATA macro.

— Case 3 : Multiple lines of output (text and perfdata) A plugin optionally return multiple lines of both text output
and perfdata, like such :
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DISK OK - free space: / 3326 MB (56%);|/=2643MB;5948;5958;0;5968
/ 15272 MB (77%);
/boot 68 MB (69%);
/home 69357 MB (27%);
/var/log 819 MB (84%);|/boot=68MB;88;93;0;98
/home=69357MB;253404;253409;0;253414
/var/log=818MB;970;975;0;980

If this plugin was used to perform a service check, the red portion of first line of output (left of the pipe
separator) will be stored in the SERVICEOUTPUT macro.

The orange portions of the first and subsequent lines are concatenated (with spaces) are stored in the SERVICEPERF-
DATA macro. The blue portions of the 2nd - 5th lines of output will be concatenated (with escaped newlines) and
stored in LONGSERVICEOUTPUT the macro.

The final contents of each macro are listed below :

Macro Value
$SERVICEOUT-
PUT$

DISK OK - free space : / 3326 MB (56%) ;

$SERVICEPERF-
DATA$

/=2643MB ;5948 ;5958 ;0 ;5968 /boot=68MB ;88 ;93 ;0 ;98
/home=69357MB ;253404 ;253409 ;0 ;253414 /var/log=818MB ;970 ;975 ;0 ;980

$LONGSERVI-
CEOUTPUT$

/ 15272 MB (77%) ;\ /boot 68 MB (69%) ;\ /var/log 819 MB (84%) ;

With regards to multiple lines of output, you have the following options for returning performance data :
— You can choose to return no performance data whatsoever
— You can return performance data on the first line only
— You can return performance data only in subsequent lines (after the first)
— You can return performance data in both the first line and subsequent lines (as shown above)

15.3.6 Plugin Output Length Restrictions

Centreon Engine will only read the first 4 KB of data that a plugin returns. This is done in order to prevent ru-
naway plugins from dumping megs or gigs of data back to Centreon Engine. This 4 KB output limit is fairly
easy to change if you need. Simply edit the value of the MAX_PLUGIN_OUTPUT_LENGTH definition in the
include/centengine.h.in file of the source code distribution and recompile Centreon Engine. There’s no-
thing else you need to change !

15.3.7 Examples

If you’re looking for some example plugins to study, I would recommend that you download the official Centreon
Engine plugins and look through the code for various C, Perl, and shell script plugins. Information on obtaining the
official Centreon Engine plugins can be found here.

Ressources en ligne supplémentaires :
— Demo
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